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INTRODUCTION

This document is for Consultant and State Employees responsible for working on Capital
Projects. This manual covers the preparation, review, and delivery of capital project documents
across the whole project timeline from project initiation to project completion. This manual also

covers design phase scheduling.

Questions or inquiries regarding the subject matter can be forwarded to the following contacts:

William Pratt P.E.

Transportation Principal Engineer
AEC Applications
william.pratt@ct.gov
860.594.3320

Bruce Bourgoin P.E.

Transportation Supervising Engineer
AEC Applications
bruce.bourgoin@ct.gov
860.594.2760

Mathew Calkins P.E.
Transportation Engineer
AEC Applications
mathew.calkins@ct.gov
860.594.2988
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DEFINITIONS

ACD — The attribute applied to a revision requested by the Processing unit to an ADP discipline
subset.

ACD2 - The attribute applied to a revision requested by the Processing unit to an ACD discipline
subset.

ADP — The attribute applied to an Addendum discipline subset.
ATLAS — This tool is used to manage the location of various assets, projects, and investigations.

Bluebeam — PDF software similar to Adobe Acrobat. Bluebeam software will be required to
package and markup all Shop Drawing Submittals.

CIM — Civil Integrated Management
CSI — Construction Special provisions Institute

DCD — The attribute applied to a revision requested by the Processing unit to an FDP discipline
subset.

DCD2 —The attribute applied to a revision requested by the Processing unit to a DCD discipline
subset.

Discipline Subset — A multi-page PDF document that includes all the contract plan sheets for a
discipline. Example would be all the structures sheets would be packaged in (1) multi-page PDF
document.

DCO —The attribute applied to a design initiated change order discipline subset.

DPD — Digital Project Development Manual.

EED — Electronic Engineering Data

Engineer of Record — The engineer’s digital signature that is applied to the discipline subsets.
For CTDOT staff this would be the Principal Engineer.

FDP —The attribute applied to a final design plans discipline subset.
FIO — The attribute applied to a “for information only” discipline subset.
FPL —The attribute applied to an advertised FDP discipline subset

Project Manager — Lead designer on the project. For CTDOT staff this would be the TE 3 or
Supervisor of the lead discipline or consultant liaison TE3 or Supervisor.

Projectwise - CTDOT is currently using Bentley’s Projectwise as a data management software for

digital projects and asset document storage. Projectwise allows the CTDOT, and authorized
business partners to access its data anywhere internet access is available.
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Set File — Is a consolidated viewer file that is created using Bluebeam. When this file is opened
all of the contract plans, FDP, Addendum, Change Orders, are sorted by their page labels in the
correct order.
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Section 1 Prerequisites and Policies

The following details various requirements and policies that need to be followed when working
on a Capital projects for the Connecticut Department of Transportation (CTDOT).
Software Requirements

1. Document Management Software — CTDOT uses Bentley’s Projectwise for our document
management solution. See Section 2 for more information.

2. PDF Software — CTDOT has standardized on Bluebeam for our PDF software and shall be
the only PDF software supported by the Connecticut Department of Transportation for
the processes set forth in this manual.

a. Bluebeam Revu was used in the production of all figures and procedures in this
manual. A license of Bluebeam Revu version 12 or higher must be purchased to
perform all the procedures in this manual.

b. A CTDOT Bluebeam profile has been created that includes a standard set of
tools in the tool chest. This profile can be found in Appendix A of this manual.

Digital Signatures Requirements

1. All contract plans, working drawings, and applicable engineering reports submitted to
the Department shall be digitally signed by a CT licensed Engineer or CT licensed
Architect in accordance with this manual.

2. Digital contract plans, in the following stages: Final Design Plans (FDP), Design
Completion Data (DCD), Addenda, Addenda Completion Data (ACD), Design Initiated
Change Order (DCO), and Working Drawing (WDP) and all engineering reports shall be
digitally signed in conformance with this manual.

a. Digital signatures must meet the requirements of Adobe’s Certified Document
Services (CDS) or Adobe Approved Trusted List (AATL).

b. CDS, and CDS vendor information is provided at the following website:
http://www.adobe.com/security/partners cds.html

c. AATL and AATL vendor information is provided at the following website:
https://helpx.adobe.com/acrobat/kb/approved-trust-list2.html

d. Trial CDS/AATL Signatures will not be accepted by the Department, a signature
must be purchased from one of the CDS/AATL Vendors.

3. Bluebeam Revu or Extreme is required for all digital signature processes. After contract
plans have been advertised, the digital signature is not allowed to be removed.

CAD Standards

1. Standard Computer Aided Design (CAD) Applications shall conform to those listed here
CTDOT CAD Standards Website

2. This manual is designed to be used with the latest CTDOT Digital Design Environment.

Policies

1. The Consulting Engineer acknowledges and agrees that Contract Plans submitted using
the [Digital Submission Procedure set forth in this Manual] has the same force and
effect for the purposes of the Consulting Engineer’s agreement with the State as a
signature and seal of a Connecticut Licensed Professional Engineer or Architect as set
forth in § 20-300-10 of the Regulations of Connecticut State Agencies or § 20-293 of the
Connecticut General Statutes, as applicable. Nothing in this DPD serves as an
authorization for, or endorsement of, the use of this [Digital Submission Procedure]
generally by the Consulting Engineer, its subcontractor(s), or any Connecticut Licensed
Professional Engineer or Architect with respect to other work it performs for the State
or work it performs for other clients.

2. When on call consultants are used for CTDOT projects, the title sheet shall be digitally
signed by CTDOT following the procedure in Section 5.6.1 of this manual.

3. When a document reaches a final status a “Final Status” shall be placed on the
document. This will lock for editing and ensure document retention.
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Section 2 CTDOT Document Management
System

CTDOT is currently using Bentley’s ProjectWise as a data management software for CTDOT
Capital Projects and CTDOT Assets. Projectwise has the ability to store documents and
associated business data in one centralized location and allows the CTDOT, and its authorized
business partners access its data anywhere internet access is available. Projectwise access is
available to all CTDOT employees, consultant engineers, contractors, municipalities, utility
companies, or any other supporting agencies that work on Capital Projects or Assets for CTDOT.

The following form can be filled out to gain access to the CTDOT’s Projectwise Site: ProjectWise
New User Form

Each users working at a consultant firm, contractor, municipality, utility company, and other
supporting agency is given a unique user name. If a person leaves a firm, it is the firm’'s
responsibility to notify CTDOT so we can disable that person’s account.

The following links allow the user to change their password or reset the password if it is
forgotten or lost:
Change Projectwise Password
Forgot or Lost Projectwise Password

2.1 ProjectWise

There are two ways to access CTDOT’s Projectwise site: Either Projectwise Thin Client (Web
Version) or Projectwise Explorer Client (thick client —installed software).

Projectwise Thin Client

Thin client is a web based version of Projectwise, which does not require any software
installation. All that is required to access Projectwise over the web is a user name and password
supplied by CTDOT. Thin client allows access to the CTDOT dataset anywhere internet access is
available. To use Thin Client, follow this document for the initial setup. This only needs to be
done once: Thin Client First Time Set Up

After the above settings document has been followed, use this link to access Projectwise Thin
Client: https://ctdot.projectwiseonline.com

Projectwise Thick Client
The thick client conversely requires the installation of the Projectwise client software. In
addition to performing all the functions of thin client; thick client has the addition functionality:

- Deltafile transfer — Improves speed of downloads
- Managed workspaces — Eliminates the need to install the CTDOT DDE
- Attributing multiple documents at once

Download Projectwise Explorer Client from Bentley using your select ID. Once Projectwise is
installed on your computer use this document to connect to the datasource:

Connecting to Datasource Using Thick Client
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Projectwise Apps

Users can also get to CTDOT'’s Projectwise datasource using the various applications. These
applications require a URL to connect to a Projectwise datasource. The table below lists the
server URL for each application:

Applications URL
Projectwise ctdot-ws.projectwiseonline.com/pwmobileaccess
WorkSite https://Ctdot-ws.projectwiseonline.com/ws
Projectwise Edge

Access in Projectwise
Access to content in Projectwise is set at the folder level based on the group a userisin. The
following details, at a high level, the access for the various groups. Section 2.3 of this document
provides more information for the folders mentioned below:
e CTDOT Employees - Access to all projects and all asset content.
e Consultants and CE & | Firms
o Active Projects — Can only access projects that the firm is working on.
o Legacy Projects — Access to all the legacy projects.
o Assets — Access for asset content if firm is pre-qualified to work on that asset
based on CTDOT's pre-qualified consultant lists.
e Contractors
o No Access to Projectwise
e Municipalities
o Active Projects — Can only access projects in their town.
o Legacy Projects — Access to all the legacy projects.
o Assets — No access to asset content.
e Utility Companies
o Active Projects — Can only access projects that a firm is working on.
o Legacy Projects — Access to all the legacy projects.
o Assets — No access to asset content.
e Other Supporting Agencies
o Active Projects — Can only access projects that an agency is working on.
o Legacy Projects — Access to all the legacy projects.
o Assets — No access to asset content.
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2.2 Projectwise Project Container for an Active Capital
Project

Projectwise is setup to automatically create a project container for any project that is added to
the Obligation Plan. This automatic process runs on a nightly basis. CTDOT employees will have
access to all projects, but access for consultants, municipalities or other agencies must be
requested by the Consultant Liaison Engineer. The Consultant Liaison Engineer can request
access for these groups by emailing: Julie.Annino@ct.gov.

2.3 Projectwise Project Folder Structure and Required
Documents for Capital Projects

This section details the Projectwise project folder structure and the required project documents
that must be submitted for each project. Section 3 of this manual details the processes for each
contract document. The figure below shows the folder structure for a Capital Project: If the
project container does not look like the following, contact DOT.AECapplications@ct.gov

o CTDOT_Project_Template_Jan_2011
100_Contract_Plans (PDF)
110_Contract_Documents

120_Contractor_Submittals (POF)
130_Final_Engineering_Reports

131_Engineering_Reperts_Confidential
140_Project_Administration
141_Project_Administration_Confidential
142 Project Administration Correspondence
150_Quantity Calculations
151_Final Design Calculations
160_Project Photos
170_ROW Files
210_Construction
0 01 - Project Documents

1 02 - Internal Docurments

U

L4703 - Measurements and Payments
220_FHWA
230_Contract_Administration
240_Contract_Development
241_Contract_Development_Confidential

HHHE

310_Milestone_Submissions
- 30% Review
4 B0% Review
- 90% Review
0 100% Review
-~ 320_Permit_Development
—1-4_ 330_Design_Data

DOT Cenfidential
Environmental_Planning
Facilities
Highway_Ops
Highways
Hydraulics
Landscape

Public_Trans
Rights_of_Way
Soils
Structure_Bridge
Traffic
Utilities
Z_Projectdata
0_Survey
01_Central_Survey
02_District_Survey
03_Consultant Survey

e
o
=
e
e
A
=
4 Maintenance
e
A
A
L
e
A
e
5

=)

e
e

04_Survey_Transfer

- 600 Project Initation Documents

Figure 1 - Capital Project Folder Structure
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Note: In the case where two or more projects are combined or advertised as (1) project, all
contract documents for these projects will be submitted into the lowest numbered project in
Projectwise.

Projectwise Folder Structure and List of Project Documentation

100_Contract Plans (PDF) — This folder contains only final Contract Plans, which includes the following:
There shall not be any working documents uploaded into this folder.

e Final plans

e Addendum plans

e Design Initiated Change Order plans

e As-Built plans

e Electronic Engineering Data (EED) — Final Prepared by AEC Applications

110_Contract Documents (PDF) — This folder shall only contain the following final documents. There
shall not be any working documents uploaded into this folder.

e Signed Contract

e Environmental Permit Applications/Approvals

e Pre-Bid Questions and Answers

e Contract Special Provisions — Final, Addendum, and Change Order special provisions

e State and Federal Minimum Wage Rates and Classifications.

e SOM (Source of Materials)

e Insurance documents

e Pre-Award DBE Review — Specific Contractor

e Bonds

120_Contractor Submittals (PDF) — This folder contains the following:
e Working drawings

Shop drawings

Product data submittals

e RFCs
121_Contractor RFIs— This folder contains the following:
e RFlIs

122 Contractor Closeout Documents — This folder contains contractor closeout documents.
e Operation and Maintenance Manuals
e Warranties

130_Engineering Reports — This folder contains all the final engineering reports. There shall not be any
working documents uploaded into these folders.
e Hydraulic
o Hydraulic Report and Hydraulic Report Data
o Scour Report and Scour Report Data
o Floodway Report and Floodway Report Data
o Final Drainage Reports and Final Drainage Report Data
O USGS Bridge and Channel Assessment Reports
o Miscellaneous Technical Data, Studies, Investigations or Reports
e Environmental Compliance

o Task 110

o Task210

o Task 310

o Underground Storage Tank System Closure Reports
e Bridge

o Load Rating
e Geotechnical
o Geotechnical Report Project files - including test boring, laboratory testing data file, and
computations
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Projectwise Folder Structure and List of Project Documentation

131_Engineering Reports Confidential =This folder is only seen by a select number of people.
e Bid Analysis

140_Project_Administration_Documents— This folder is for final permanent milestone project
administration documents. These project administration documents can be defined as, but not limited
to, deliverables such as agreements, project approvals, project scope, regulatory documents, design
phase schedules, etc. There shall not be any draft documents uploaded into this folder.

e Agreements — Utility, Railroad, Municipal, etc.

e Categorical Exclusion

e Certification Acceptance Checklist

e Commitment list

e Consultant Selection Documents — Scope of Services, Notice to Proceed, etc.

e Construction Incidental Cost Establishment Report

e DBE/SBE Approval with percentage, participation level

e Design Approval

e Design Exceptions

e Design Phase Microsoft Project Schedule

e Environmental Impact Study — EIS

e Final Design Report

e Finding of No Significant Impact - FONSI

e Lighting Agreement
Record of Decision —ROD
Rehabilitation Study Report
Risk Management Documents
RPM — Request for Project Memorandum
e Sidewalk Maintenance Agreement
e Standalone Transportation Management Plan Document, taken from the final design report
e Stewardship Agreement

e Structure Type Study
e Waiver to Obligate Funds
e White Papers

141_Project Administration Confidential — This folder shall be used for documents that only CTDOT
should have access to.
e Consultant Payroll information

142_Project Administration Correspondence — This folder is for all final project correspondence
documents. This is defined as any request memos, response memos, letters, etc, and does not include
any documents that are defined in the 140_Project Administration folder. This folder shall not include
any working/draft documents.

e Meeting Minutes

e Request Memos — Survey Request, Design Reviews, Support unit design.

e Response Memos — Response to the Request Memos

150_Quantity Calculations — This folder is where all the final quantity calculations for contract items
shall be stored.

151_Final Design Calculations — This folder is where all the final design calculations shall be stored.

160_Project Photos — This folder is where all project photos shall be stored. Both engineering and
construction photos shall be stored in this folder.

170_ROW and GIS Files - This folder is where the final property maps shall be stored until they are
uploaded into the IRMS. Also the project polygons and parcel polygons file shall be stored here.

210_Construction Folders — See Construction Documentation for more information
e 01-Project Documents
o Semiand Monthly Payment Estimates
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Projectwise Folder Structure and List of Project Documentation

Construction Orders with Backup
Copies of Cost-Plus Sheets with backup
All Delivery Tickets, Bituminous Concrete, Processed Aggregate Base, Concrete, etc.
Material Certifications, etc. (All Laboratory Reports)
Nuclear Density Test and Data Sheets (CON-125, 133)
Pile Driving Logs (CON-87)
Environmental Correspondence, Logs, etc.
Utility Forms (CON-40 and 41)
Contractor Payrolls
EEO/AA Reports (30-60-90s)
Labor Wage Checks (CON-131)
Hazardous Waste Manifests
Stores Requisitions and Transfer Vouchers
Purchase Orders and Requisitions
Correspondence
Consultants Billings with Backup
Computer Disks - properly labeled
Any Other Related Records
Town Correspondence File - Includes:
General Material
Request for and response to matters concerning highway, bridge, signing, lighting, etc.
by town officials
o Written commitments to first officials and/or elected, appointed state, federal officials
o Mapping Prepared by district or filed with district
e 02 - Internal Documents
o Consultant Ratings
o Other Sensitive Documents
e 03 - Measurements and Payments
o Field Books (all) Volumes 1,2,3,& 4s

O O O O O O 0O 0O 0O OO O O0oOO0oOO0o0OO0OO0OO0O O0O O0OO0

220_FHWA - This folder is used by the FHWA for their purposes

230_Contract Administration — This folder is used by the CTDOT Contracts unit.

240_Contract Development — This folder contains the paper plan order form and the location where the
Designer uploads the following supplemental contract documents:
e All contract special provisions and Notice to Contractors (NTC), in word format, both final and
addendum special provisions
e Estimator Proposal Estimate
e Calendar Day Estimate
e Electronic Engineering Data Files uploaded by the Designer

241_Contract Development Confidential — This folder contains the final engineers estimate and
calendar day estimate developed by the cost estimating unit.

e Final Engineers Estimate

e Final Calendar Day Estimate

310_Milestone_Submissions — The designer shall submit all milestone submission documents into this
folder. This includes plans, special provisions, reports, estimates, etc. This folder has sub-folders for
30%, 60%, 90%, and 100% submissions

320_Permit_Development — This folder can be used to store documents for the development of
permits. Note: At FDP, the permit applications and approvals must be uploaded into the 240 Contract
Documents folder. The processing unit then adds the permits and applications to the contract and
uploads the contract into the 110 Contract Documents folder.
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Projectwise Folder Structure and List of Project Documentation

e Permits Needs Determination Form (PNDF)

e Wetland Flagging Coordination

e Natural Diversity Database (NDDB) Coordination
e CTDEEP Fisheries Correspondence

e LEAN Meeting Minutes

e Project Manager Meeting (PMM) Minutes

e Permit Review Comments

e Responses to Permit Review Comments

330_Design_Data — This area is used for working on documents such as letters, memos, etc. and
working on CAD files. Under this folder there are discipline specific sub-folders that provide each
discipline an area prepare their design documents. The DOT Confidential subfolder shall be used to
work on draft confidential documents.

500_Survey
e 01_Central_Surveys — This folder is where the approved survey files will be stored for use by
design.

e 02_District_Surveys — This folder is used by the district survey units. The files stored in this
folder are considered working files.

e 03_Consultant_Survey — This folder is used to store consultant survey information.

e 04_Survey Transfer — This folder is used by District Survey units to transfer their completed
survey files to Central Surveys. Central Surveys will review the files in this folder and then when
they are found acceptable, the files will be transferred into the 01_Central Survey folder for use
by design.

600_Project Initiation Documents — This folder is where any project initiation documents can be stored.
This would include any plans developed by the Project Concepts unit or any other documents created in
the project concepts phase.
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2.4 Asset Areas in Projectwise

Projectwise is also being used to store all asset related documentation and asset information.
The following details the assets and documents are being stored for that asset:
e 02.0-— Assets — Bridges
Inspection Reports
Fracture Critical Reports
Maintenance Memos
Load Ratings not performed for a Capital Project
e 02.1- Assets — Bridges (under 20’ Town owned)
o Inspection Reports
e 02.2 — Assets — Signal Intersections
o Signal Plans — Active and Legacy
e 02.3 — Assets —Sign Structures
o Inspection Reports
e 02.4-Assets—Towns
o Office State Traffic Administration (OSTA) documents
o Bridge Safety Town Letters
e 02.5- Assets — Buildings
o Building Inspection Reports
e 02.6 — Assets Radio Towers
o Inspection Reports
e 02.7— Asset — Railroad Crossing Signals
o Inventory document that provides detail for the crossing.
o Photos

o O O O

2.5 Setting Documents to Final Status in Projectwise

Once a document has reached it final status, where no more editing is required and it is ready
for permanent storage a final status will be applied to the document as shown below:
1. Right click on the file and select Change State>Set Final Status.

Label (User Defined) Description

/ 173-464_90%_TR_Review_TR_Final_0173-0464

eDacicpa B e 90% Design Review Request
(7 R :
o beam end repair bearing replacement
A= Projeft Schedul Open ect Schedule

Open as Read-Only
Open With...
Markup

View

Check Out
CheckIn

W™D nad® oo 7 P = P g

Right Click on the file
and select Change
State>Set Final Status

e PrOpet

I Delet
cee Preview | Dependency Viewer | Access

IRaa\ (Docum Eﬂh:z;:"fmm b =1

Name 5 Modify Spatial Attributes... Document Securi
Enter filter here P, blalx @ 2 =

£ € ADMINISTR! ot . B BB =

€ BRB-Admin F F F F F

€ BruceBourg. SendTo Y EmEmEEEEE

€ CDJ-Admin Copy List To " F FFF

rF F F F &

€ Chuck.Lawso 5

§7CLS'Admm Change State 3 Next
stonnDOT_I ) Previous

€= Consultant E... UL

e Change...
S.=Contractors Properties...

€ Copy of MA... Set Final Status
€ Copy of SVC... Change filename to CT_Code

€ (TCodeCha.. v T v T [+
i_ F F I F

. ctdot-pw.co...
€ ctdot-p

i b 2 2 2 B i i e

Edit attributes for multiple documents

Figure 2 - Set Final Status

This will lock the file so no one can delete it. If a user needs to remove the final status contact
DOT.AECApplications@ct.gov
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Section 3 Digital Project Processes

3.1 Processes by Project Phase

The following shows the processes included in this manual separated by project phase. Also
included in this table is a link to the process map that corresponds to each document/process:

Project Initiation Phase

Document/Process

Requirements

PPl Form

Link for Video of Process: PPI Video or Document Workflow.
The PPl form shall be uploaded into this folder in Projectwise
04.00 - Engineering Libraries\PPI Request

in accordance with Section 6 of this manual.

Project Schedule

Project Schedule should be set up in accordance with Section 11

Preliminary Design Phase

Preliminary
Contract Plans

Plans shall be grouped in accordance with Section 4.1
Plans shall be formatted in accordance with Section 4.2

Preliminary
Contract Special
Provisions

Contract Special Provisions shall be prepared in accordance with Section 4.5

Cost Estimate

Cost Estimates shall be prepared in accordance with Section 4.6

Preliminary Design
(30%) Review

Design Reviews shall be accomplished in accordance with Section 10

Project Schedule

Project Schedule should be set up in accordance with Section 11

Permit
Applications/
Documents

Shall be uploaded and formatted in accordance with Section 4.7

Rehabilitation
Study Reports

Shall be uploaded and formatted in accordance with Section 4.9

Structure Type e Shall be uploaded and formatted in accordance with Section 4.9
Studies
Categorical e Shall be uploaded and formatted in accordance with Section 4.10
Exclusion

Design Exception

Shall be uploaded and formatted in accordance with Section 4.10

Design Approval
Letter

Shall be uploaded and formatted in accordance with Section 4.10

Project
Correspondence

Shall be uploaded and formatted in accordance with Section 4.10

Project Polygon

Shall be prepared and uploaded in accordance with section 4.11
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Final Design Phase

Document/Process

Requirements

Contract Plans °

Plans shall be grouped in accordance with Section 4.1
Plans shall be formatted in accordance with Section 4.2

Contract Special °

Special Provisions shall be prepared in accordance with Section 4.5

Provisions
Engineering e Engineering Reports shall be prepared in accordance with Section 4.9
Reports
Project Schedule | e Project Schedule should be set up in accordance with Section 11
Cost Estimate e Preliminary Cost Estimates shall be prepared in accordance with Section 4.6
Permit e Shall be uploaded and formatted in accordance with Section 4.7
Applications/
Approvals

Design Calculations | e

Design Calculations shall be submitted in accordance with Section 4.13

Semi Final (60%) |e
and Final Design
(90%) Reviews

Design Reviews shall be accomplished in accordance with Section 10

Quantity e Quantity Calculations shall be submitted in accordance with Section 4.6
Calculations
Final Design Report | ¢  Shall be uploaded and formatted in accordance with Section 4.10
Final Design e Shall be uploaded and formatted in accordance with Section 4.10
Statement
Sidewalk e Shall be uploaded and formatted in accordance with Section 4.10
Maintenance
Agreement

Lighting Agreement | e

Shall be uploaded and formatted in accordance with Section 4.10

DBE/SBE Goals °

Shall be uploaded and formatted in accordance with Section 4.10

Commitment List | o

Shall be uploaded and formatted in accordance with Section 4.10

Waivers °

Shall be uploaded and formatted in accordance with Section 4.10

Standalone °
Transportation
Management Plan

Shall be uploaded and formatted in accordance with Section 4.10

Project °
Correspondence

Shall be uploaded and formatted in accordance with Section 4.10
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Contract Processing Phase

Document/Process

Requirements

FDP

Contract Plans

Plans shall be grouped in accordance with Section 4.1
Plans shall be formatted in accordance with Section 4.2
Plans shall be checked by the PDF checker in accordance with Section 6.2

Contract Special Provisions

Special Provisions shall be prepared in accordance with Section 4.5

Proposal Estimate

Preliminary Cost Estimates shall be prepared in accordance with Section
4.6

Federal Estimate

Preliminary Cost Estimates shall be prepared in accordance with Section
4.6

Calendar Day Estimate

Calendar Day Estimate shall be prepared in accordance with Section 4.6

Permit Applications/
Approvals

Shall be uploaded and formatted in accordance with Section 4.7

Ordering Paper Copies of
Contract Documents

Paper copies of contract documents can be ordered in accordance with
Section 3.2.11

EED

Shall be prepared and uploaded in accordance with Section 4.14.

Project Polygon

Shall be prepared and uploaded in accordance with section 4.11

DCD

Contract Plans

Plans shall be grouped in accordance with Section 4.1
Plans shall be formatted in accordance with Section 4.2
Plans shall be checked by the PDF checker in accordance with Section 6.2

Contract Special Provisions

Special Provisions shall be prepared in accordance with Section 4.5

Proposal Estimate

Preliminary Cost Estimates shall be prepared in accordance with Section
4.6

Federal Estimate

Preliminary Cost Estimates shall be prepared in accordance with Section
4.6

Calendar Day Estimate

Preliminary Cost Estimates shall be prepared in accordance with Section
4.6

Permit Applications/
Approvals

Shall be uploaded and formatted in accordance with Section 4.7

Addendum

Contract Plans

Plans shall be prepared in accordance with Section 7.1

Contract Special Provisions

Special Provisions shall be prepared in accordance with Section 7.1.5

EED

Shall be prepared and uploaded in accordance with Section 4.13.

Award Phase

Signed Contract

Signed Contract will be uploaded into Projectwise in accordance with
section xx.
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Construction Phase

Document/Process Requirements
Contractor e Contractor submittals shall be uploaded in accordance with Section 9
Submittals
Contract Plans e Plans shall be prepared in accordance with Section 7.2
Contract Special e Special Provisions shall be prepared in accordance with Section 7.2.5
Provisions
DCO Memo e DCO memo shall be prepared in accordance with Section 7.2.6
Plan As-Builts e Plan As-Builts shall be accomplished in accordance with Section 8
Project e Shall be uploaded and formatted in accordance with Section 4.10
Correspondence
EED e Shall be prepared and uploaded in accordance with Section 4.13.
Project Polygon e Shall be prepared and uploaded in accordance with section 4.11
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3.2 Digital Project Process Maps

This section provides high level process maps for the procedures detailed in this manual.

3.2.1 PPI Form

Click Here for Formatting and Submittal Requirements

PPl Form Approval Process

Fill out and digitally sign PPI Form.

!

Upload PPI form into Projectwise in the
04.00 - Engineering Libraries\PP| Requests',
folder.

y

Notify Manger Approval Signer that the PPI
form has been uploaded into Projectwise and
ready for their review and signature.

!

Review the PPl form and digitally sign if
found acceptable. Then notify the Division
Chief that the PPI Form is ready for their
review and signature.

!

Review the PPl Form and digitally signs if
found acceptable. Then notify the

Review the PPl form and digitally sign if

Engineering Administrator that the PPl Form I found acceptable.
is ready for their review and signature.
Manager L ) Engineering
PPI Developer Division Chief .
P Approval Administrator
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3.2.2 Digital Reviews
Click here to go to the Digital Review Section

Join review session and comment on review
documents.

Reviewers
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3.2.3 FDP Contract Plan Processing
Click Here for Formatting and Submittal Requirements

Submit FOP subsets inta the 100
Contract Plans Falder in Projectwise.

Y

Change FDP subsets ta the Processing
State and mark up with comments as
NECESsary,

Revision

Required

Final Design Plans (Discipline Subsets)

Create a new subset(s] with the
required changes and submit DCO, |
DCD2, ete, subsets into the 100
Centract Plans Folder in Projectwise.

Change DCDr subsets to the Processing
State, perform a document compare
between the FOP and DCD subsets and
mark up with comments as necessary, Yes

h

Change the Sub-Category Attribute on
all the subsets to FPL and delete all
previous subset versions [FDP, DCD,

£rc.)

tate Design

I
™D

Revision
Reguired

ol

Project

fes

v

Change the state of all the subsets into
the Manager and Engineenng Admin

Title sheet is signed

THCH

h J

h J

State and notify the designer that the P  and the designer
title shieet of the project can be digitally notifies Processing
signed.
Designer Processing Contracts
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the Contracts state and notify Contracts
that the subsets have been approved
for Advertising
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Change the state of the subsets to the
Advertise state and export the files out

to be posted to the DAS Portal for
Advertising,
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3.2.4 Addenda Plans
Click Here for Formatting and Submittal Requirements

Submit ADP subsets into the 100
Contract Plans Folder in Projectwise.

h

Change ADP subsets to the Processing
State and mark up with comments as

Necessany,

Revision

Reguired

B

Addendum Plans (Discipline Subsets)

Create a new subset(s) with the
required changes and submit ACD,
ACD2, etc. subsets into the 100
Contract Plans Folder in Projechwise.

h 4

Change ACD subsets to the Processing
State, perform a document compare
between the ADP and ACD subsets and

mark up with comments as necessary,

Rewvision

Recuired

¥

N

Change the Sub-Category Attribute on
all the subsets to ADP and delete all
previows subset versions (ACD, ACD2,
&te.]

'

Change the state of all the subsets into
the Contracts state and notify Contracts
that the subsets have been approved
for Advertising

I

Motify the designer that the subsets
hawe been approved for Advertising and
thie Red Xs can be placed on the revised

sheets.

h 4

Change the state of the subsets to the
Advertise state and export the files out
to be posted to the DAS Portal for
Advertising

¥

Designer Processing

Contracts
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Click Here for Formatting and Submittal Requirements

3.2.5 Design Initiated Change Order (DCO) Plans

Design Initiated Change Order (DCO) Plans

(Discipline Subsets)

Submit DCO subsets into the 100 Contract Plans
Folder in Projectwise.

l

When the DCO plans are to be released to the
contractor, the state of the plans shall be changed to
Contractor.

l

Notify the Contractor and Designer that the DCO
plans have are available.

v

Place Red Xs on the revised sheets.

v

Issued 10/2017
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3.2.6 Contractor Submittals

See section 9 for detailed instructions. Process maps for Shop Drawings, Working Drawings,
Product Data Sheets, and RFls are in development.

3.2.7 Paper Plan Order Form

The Paper Plan Order Form was created to allow each unit in the Department to order contract
plans and special provisions for DOT Projects. This form is located in each project in Projectwise
and each unit in the Department that needs paper copies of contract plans and special
provisions is required to update this form for their paper needs. This form is then used by the
Department’s Engineering Records unit to make the prints and send them out.

Any Addendum or Change Order that is submitted for a project will be printed and sent out
using the information indicated on the form. Addendums will be printed and sent out
automatically. When a Change Order is submitted, the designer must notify Engineering records
that a Change Order has been submitted and that paper copies of the Change Order need to
printed and sent to the applicable units indicated on the Paper Plan Order Form.

This following shows the procedure for how the Paper Plan Order Form is filled out and the
prints are made. Contact Information for Engineering Records: Print Shop: 860-594-3086 Plan
and Specification Printing

Step | Project Stage Group Action

1 FDP Processing After the contract plans and special provisions have been
submitted for FDP an email is sent to each unit in the
Department that requires paper copies of contract plans and
special provisions.

2 FDP Units Open the Paper Plan Order Form from Projectwise and fill out
the form for their unit’s needs. Save the form and check the
form back into Projectwise.

3 DCD Processing At DCD, lock the form by placing it in the Processing state.

4 Advertise Contracts Notify Engineering Records that the project is going to be
advertised and they can print the required paper copies
indicated on the Paper Plan Order Form.

5 Advertise Engineering Print the required paper copies indicated on the Paper Plan

Records Order Form.
6 All Contracts Notify Engineering Records that an Addendum is going to be
Addendums advertised and they can print the required paper copies
indicated on the Paper Plan Order Form for this Addendum.
Make sure to tell Engineering Records which subsets are
included in the Addendum.

7 All Engineering Print the required paper copies indicated on the Paper Plan

Addendums Records Order Form for the Addendum. Make sure to print all the
subset that were affected by the Addendum including the 02-
Revisions subset.

8 All Change Lead Designer | Notify Engineering Records that a Change Order has been

Orders submitted and they can print the required paper copies
indicated on the Paper Plan Order Form. Make sure to tell
Engineering Records which subsets are included in the Change
Order. If a unit is not listed on the Paper Plan Order Form,
give Engineer Records those units’ contact information so
those units’ can receive a copy of the Change Order.

9 All Change Engineering Print the required paper copies indicated on the Paper Plan

Orders Records Order Form for the Change Order and for any other units’

requested by the Lead Designer. Make sure to print all the
subsets that were affected by the Change Order including the
02-Revisions subset.
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Section 4 Document Preparation and
Format

4.1 Contract Plan Grouping

Contract plans shall be grouped, by discipline into individual multiple page PDF files called
discipline subsets. The project manager is tasked with determining the discipline subset
numbering and grouping and whether to use a single volume or multiple volumes for the
project. The number of sheets in a discipline subset shall contain a maximum of 150 sheets.
The following details each of these options:

Single volume digital contracts are used when each discipline or consulting firm designing the
project is responsible for 3 subsets or less. The following is an example of a single volume
project.
Note: The first and second subsets shall always be 01-General and 02-Revisions. The 03
subset does not always need to be 03-Highways, the 04 does not always need to be 04-
Structure, etc. FIO subsets shall be numbered at the end of the project before the
standard subsets. The Standards subsets shall not be numbered.

Multiple volumes are used if the project has 1 or more of the following characteristics:

a. The majority of the discipline/firm designers are responsible for more than 3
subsets each. This allows the individual designers to number their subsets
independently of the other disciplines.

b. There are multiple sites on the project. Splitting these sites up into volumes will
provide better organization of the project.

c. Combining multiple projects into one project.

The larger the project is, typically the more subsets will be required and their labels will be more
specific. The subsets shall be split up by volume and each volume shall be controlled by its
assigned designer. For example, all the subsets designed by the highway designer shall be in
the same volume (02) and each subset shall have a unique subset number.

Note: The first and second subsets when using multiple volumes shall always be 01.01-

General and 01.02-Revisions. The 01.03 subset does not always need to be 01.03-

Highways, the 01.04 does not always need to be 01.04-Structure, etc. FIO subsets shall

be numbered at the end of the project before the standard subsets. The Standards

subsets shall not be numbered.
Combining Projects
In the event 2 or more projects are combined into one project, the following shall be done:
e Each project shall be given its own volume.
e The lowest project shall always be volume 1.
e Each project shall have its own title sheet, which reference each other with a note.
e There shall only be (1) Revisions subset. This subset shall be in volume 1 and named

01.02 — Revisions.

e The Revisions subset shall be the responsibility of the project manager on the projects.

e Each project shall have its own detailed estimate sheets.

e There shall only be (1) set of Highway Standards and (1) set of Traffic Standards when
the projects are combined.

e There shall not be any duplicate special provisions after the projects are combined.

e There shall only be (1) calendar day chart.
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The next two figures show examples of the single volume and multiple volume options.
Single Volume Option

Label File contents
(Discipline Subset) (but not limited to)
01-General Title Sheet

Detail Estimate Sheet
Index of Revisions Sheets

02-Revisions
Index of Plans Boring Logs
Survey Data Highway Plans
Alignments Breakout Drainage

. ROW Highway Profile
-High . .

03-Highways Typ Sections Highway X-
Misc Details Sections
Intersect Grading Landscape Plan

Wetland Mitigation

Index of Drawings

All Structure Sheets
04-Structure Note: Multiple subsets may be required for
multiple Sites

Ex: 04_Structure_Br.No.1266
Index of Drawings

Signing

Pavement Markings

MPT

Traffic Signal Plans

Etc.

Index of Drawings

All Environmental Compliance Sheets required
Utility Design plans. For example 07_AT & T,

05-Traffic

06-Environmental

7-Utilti
07-Utitly 07_CL & P, 07_MDC, etc.
08-CL&P FIO** CL & P For Information Only plans
09-AT&T FIO** AT & T For Information Only plans
CTDOT Highway STD CTDOT Highway Design Standard Index and

Sheets required

CTDOT Traffic Engineering Standard Index and
Sheets required

CTDOT Traffic STD

Figure 3 Typical Highway Project Discipline Subset Contents

* If a discipline has to be broken up into more than one subset, keep the label the same with the
addition of “1” at the end of the first subset, “2” at the end of the second subset, etc.

** For Information only discipline subset shall be submitted as individual pdf files based on the
entity providing the information only.
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Multiple Volume Option

Label File contents Designer/

(Discipline Subset) (but not limited to) Firm
01.01-General Title Sheet, Detail Estimate Sheet Lead
01.02-Revisions Index of Revision Sheets Lead
01.03-Wtind Re-establish Wetland Reestablishment plans Designer 1
01.04-Stg Acc. Staging and Access Plans Designer 1
02.01-Typ Sections Typical Sections Designer 2
02.02-Alignments Alignment Geometry Designer 2
02.03-Plan Plans Designer 2
02.04-Profiles Profiles Designer 2
02.05-ROW Brk Right of Way Breakout Designer 2
02.06-Drain Drainage Plans Designer 2
03.01-Retaining Wall 1 Retaining wall details Designer 3
03.02-Retaining Wall 2 Retaining wall details Designer 3
03.03-Bridge 00456 Bridge_456 Designer 3
03.04-Bridge 01983 Bridge_1983 Designer 3
03.05-Bridge 01984 Bridge_1984 Designer 3
04.01-Stage 1 Stage Construction Details 1 Designer 4
04.02-Stage 2 Stage Construction Details 2 Designer 4
04.03-Stage 3 Stage Construction Details 3 Designer 4
05.01-SPM Signing and Pavement Marking Site 1 Designer 5
05.02-SPM Signing and Pavement Marking Site 2 Designer 5
05.03-SPM Signing and Pavement Marking Site 3 Designer 5
06.01-IMS IMS Plans and Details Sitel,2,3 Designer 6
07.01-Env 1 Environmental Details Site 1 Designer 7
07.02-Env 2 Environmental Details Site 2 Designer 7
07.03-Env 3 Environmental Details Site 3 Designer 7
08.01-"Utiltiy gt;llfyogel\sﬂllgjrg)ggs. For example 07_AT & T, 07_CL Designer 8
09.01-CL&P FIO CL & P For Information Only plans Designer 8
09.02-AT&T FIO AT & T For Information Only plans Designer 8
CTDOT Highway STD :g(;l’ul?r(g; Highway Design Standard Index and Sheets Designer 1
CTDOT Traffic STD CTDOT Traffic Engineering Standard Index and Designer 5

Sheets required
Figure 4 — Multiple Design Firms CTDOT Project Subsets
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4.2 Contract Plan Format

Digital contract plans (preliminary, semi-final, FDP, ADP, DCO, etc.) shall be formatted in
accordance with the following:

1.
2.

Nousw

10.

Contract Plans shall be in submitted to CTDOT in PDF format
PDF Plans must be sized either 36” x 24” for projects created before June 2007 or sized
34” x 22” for projects created after June 2007
PDF plans shall be measurable to scale in the PDF
PDF plans shall be able to be printed to paper and scaled appropriately
Text must be searchable
All levels must have the ability to be displayed on or off, unless approved otherwise.
All information on the digital contract PDF plans shall have been created from
MicroStation or an approved alternate. The only information that shall be added to the
plans using a PDF editing software are as follows:

e Page labels (see Section 4.14.2)

e Sheet numbers (see Section 4.14.2)

e Watermarks and flatten comments(see Section 5.4)

e Any digital signature fields (see Section 5.5)

e Digital Signature (see Section 5.6)
Discipline subsets shall be published directly from a CAD application. Scanned images or
raster image formats will not be accepted with the exception of For Information Only
sheets, these can be scanned. See Publishing CAD Files for more instructions on how
to publish from Microstation.
Each discipline subset shall contain bookmarks; one for each page.
The first page of each subset shall be a subset cover sheet, this includes FIO subsets.
This cover sheet shall contain both; an index of drawings contained within the subset
that includes both drawing numbers and drawing titles and the form field place
holder(s) which receives the digital signatures. The following cell has a table for the
index of drawings and the digital signature cell place holder BDR Discipline Cover
Sheet cell. This table must include the subset name and number displayed as a heading
in the table as shown in the figure below.

CT_CON_FPL_0092-0640_05-TRAFFIC &
T T T T T O T W S O I W L 2 . T T N T T ST T T T T N R 2

Index of Drawings

- )\

05 - TRAFFIC
INDEX OF DRAWINGS

Digital Signature form
jfield place holder

with digital signature

Watermark of
Engineer of Record

S FR R [ DEPARTMENT OF TRANSPORTAT: "

Figure 5 Discipline Subset Bookmarks, Index of Drawings, and Signature fields
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11. The first page of the subset 01_General shall be the CTDOT digital project title sheet
which includes an index of the subsets contained within the project, sheet count totals
for all subsets, a list of drawings for the 01_General Subset, and an area(s) reserved for
applying the digital signature(s) (see section Section 5.5).

Link to digital title sheet: Digital Title Sheet
Consultants will need to delete the CTDOT signature blocks on the title sheet and place
a digital signature placeholder as detailed in section Section 5.5 CTDOT engineers can
find the digital title sheet in the seed files on our W: drive.

12. The 01-General subset shall include all detailed estimate sheets.

13. The 02_Revisions subset must be included in each digital project and there shall only be
(1) revisions subset.

14. Subset 02_Revisions shall contain only revision sheet(s), titled “Index of Revisions”, See
Section 7.3. These revision sheets are used for tracking all sheet changes due to
addenda and design initiated change order (DCO) with respect to the entire project.
These sheets are originally blank and unsigned, and shall be managed and updated as
needed by the Project Manager. The CTDOT Revision Contract Sheets can be obtained
here:

CTDOT Designed Projects - 02-Revisions Subset
Consultant Designed Projects - 02-Revisions CE Subset
15. Plans For Information Only (FIO) shall be submitted digitally, in individual subsets based
on the entity providing the information, Amtrak, CL & P, AT&T, Designer etc. These
subsets do not require a digital signature, but each sheet in the subset shall be labeled;
“For Information Only”. The subset numbers shall be selected by the lead designer so
that the FIO subsets are last. Each sheet shall be numbered correctly, see Section
4.14.2. Upload and attribute in accordance with Section 6.1.
16. Utility drawings shall be submitted in accordance with the following:

e Utility plans For Information Only (FIO) shall be submitted in a utility subset
based on the utility company, AT&T subset, CL&P subset, etc. These subsets do
not require a digital signature, but each sheet shall be labeled; “For Information
Only”. FIO utility subsets shall be numbered so that they are the last subsets.
Example Labels; 10_CL&P_FIO, 11_AT&T_FIO. These subsets must have page
labels assigned, see Section 4.14.2

e Utility company designed plans that include work being done by the State’s
Contractor shall be submitted in a utility subset based on the utility company,
AT&T subset, CL&P subset, etc. These subsets do not require a digital signature.
Example Labels; 10 CL&P, 11 AT&T. These subsets must have page labels
assigned, see Section 4.14.2

e Utility plans that are designed by a Consultant firm that include work being
done by the States Contractor shall be submitted in a utility subset based on the
utility company, AT&T subset, CL&P subset, etc., and shall be digitally signed in
accordance with this manual. Example Labels; 10_CL&P, 11_AT&T. These
subsets must have page labels assigned, see Section 4.14.2

17. CTDOT Standard sheets shall also be delivered digitally. See Section 4.4 for how to
prepare and submit CTDOT Standard Sheets.

18. Footers, displaying the sheet number, shall be placed on each page of each PDF subset.
See Section 4.14.2, “Sheet Numbering”

19. As-built information shall be digitally applied to the contract subsets by District
Personnel after the job is complete using Bluebeam. See Section 8.

20. Preliminary Contract Plans shall be submitted to CTDOT in accordance with this section,
but do not need to be digitally signed. These review documents shall be uploaded into
the 310_Milestone Submission folders in Projectwise in accordance with Section 6.1.
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21. A Bluebeam set file shall be created at FDP and updated for any addendums or change
orders in accordance with Section 4.15.2.

22. Contract Plan subsets, FDP, DCD, DCD2, ADP, and DCO, must be checked by the
Discipline Subset PDF Checker in accordance with Section 6.2.

4.3 CTDOT For Information Only Sheets

Plans provided For Information Only (FIO) shall be submitted digitally, in individual subsets
based on the entity providing the information, Amtrak, CL & P, AT&T, Designer etc. These
subsets do not require a digital signature, but each sheet in the subset shall be labeled; “For
Information Only”. The first sheet of each FIO subset shall be a subset cover sheet. These
sheets shall be placed on a border and numbered in accordance with section 4.14.2.

The subset numbers shall be selected by the Project Manager so that the FIO subsets are last.
See Section 6.1 for uploading and attributing FIO Plans. Information only sheets may be
scanned, but must conform to the following:

e  Minimum Size 22”x34"

e  Minimum dpi = 300.

This link shows an optional procedure that can be used to create a For Information Only subset
that uses Bluebeam: Preparing a For Information Only Subset

4.4 CTDOT Standard Plan Sheets

Standard sheets shall also be delivered digitally into Projectwise. The following shows how to
obtain the latest version of the CTDOT Standard Sheets and how to prepare them for a digital
project.

1. Download the latest standards from the following link for the project: CTDOT Standard

Drawings Website
2. Upload the standard subset into Projectwise in accordance with Section 6.1.
3. Next open up the standards from Projectwise by double clicking on it. Once it opens
click onhe index sheet.

ctdot_highway_std.pdf

PDF Package

Double click on
the index sheet

1o e it Cima
- Hiw-07 INDEX pdf 2013 11:19 Ak

Hw-0ZINDEX pdf TB201311:19 Ak
Hw-0506_01.pdf TE1 KB 17872013 11:19 A

Figure 6 - Preparing the Standard Subsets
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4. Then enter the project number and check the standards to bq inclugjed in the project.

Enter Project Number
L P D . and check drawings

SMEE — AL H H H APPROVAL
KT o AP to be included in Project &
| Hw-5 01 | ENOWALLS, SLOPE PAVED INLETS AND OUTLETS 1-26-12 TR 2612
| v 02| e 06 s ' enowaits . [RTED I
| oo o3 | enowaiis ron e arca — Sie 0 MISCELLANEDUS DETAILS FOR BARRIER TRANSTTIONS
HHEE INETE ASIN 11-10-11 TEMPORARY PRECAST CONCRETE BARRIER CURS
| rw-sh7 02 | TveE - -1 11-10-11 | || fw-905.01 | FEncES anD BaARWAYS
7| w7 03| Tvee - o roae =910 01 | W- BEAM METAL BEAM RAIL NARDUARE
| ;*’( "L & KOUND PRECAST CONCRETE CB [TRT=T] Vi-910 07 | WETAL BEAM RATL (TYE A5 350) GUIDERAIL

tiw-of Y £CAST CONCRETE CB DOUBLE GRATE TYPE - | 12-10-11 || | Jf-910-03 | METAL BEAM RALL (TVFE MD-8 350}

T I = PRECAST CONCRETE CB DOUBLE GRATE TYPE - II [TEEST] VWi-310_04 | METAL BEAM RAIL (TVPE R-5 350) SYSTENS 5,54, 8 §
| ww-shr 07 | TveE "ct s rc-L CATCH BASIN TOPS AND CURBS 11-10-11 Wi-910-05 | METAL BEAM RALL R-B 350 SPAN TYPE I, 11, il SECTIONS
/| twish7 05 | CATCH BASIN FRAMES AND GRATES 51809 Vi-910_06 | R-B 350 BRIDGE ATTACHMENT SAFETY SHAPE PARAPET
w-7.05 | HEAVY DUTY LOCK GOWN TOPS 7121z W-510.07 | R-B 350 BRIDGE ATTACHMENT VERTICAL SHAPE PARAPET
| vwshr 10| manmole - FramE & cover 6-09-11 wi-910.08 | R-8 350 BRIDGE ATTACHMENT TRAILING END
| vw-ch1 01 | FIGURES FOR DATES ON BRIDGE PARAPETS 8e09-11 i-910_ 0%a] MISCELLANEOUS GUIDERAIL TRANSITIONS SHEET 1
| vw-cf1 o1 | c.cuPiee INSTALLATIONS IN FILL & ROCK SLOPES & CULVERT TRENCH DETAL| 71212 51609t MISCELLANFOUS GUIDERAIL TRANSITIONS SHEET 2
| rvw-dfi 02| siomED oram PreE 12+ 15-18%24"300 (305-361-457-610-762) 7-12-12 i 010 10| METAL BERM RAIL 8" (203) X & (152) BOX BEAM
twr-cf2 o1 | CULVERT Emps r1212 w510 11| CURVED GUIDERAIL TREATMENT DETAL
| w7k 01 | unoERDRAMS AND UNDERDRAIN OUTLETS 7-12-12 wi-G10_ 120 MERRITT PARKWAY GUIDERAIL ATTACHMENT - SYSTEM 2 & 3
| tw-afson | paveD DITCH AND PAVED APRON 7-12-12 W-810.120) MERRITT PARKWAY GUIDERAIL
| vw-alion| cursime 7-12-12 w-o10 12c| MERRITT PARKWAY GUIDERAIL TRAILING END ATTACHMENTS
| tw-als 01| GRANITE STONE TRANSITION CURBING 10-18-10 W-510_12d|  MERRITT PARKWAY MEGIAN GUIDERAIL AND END ANCHOR
Hw-gf1 012 TRANSITION 45° (1145) F-SHAPE TO 45" (1145] VERTICAL SHAPE SHEET 1 12612 | || fw-10 13 THRiE-sEAM METAL BEAM mAIL HaRDWARE
v TRANSITION 45" (1145) F-SHAPE T0 45" (1145) VERTICAL SHAPE SHEET 2 101610 W-910_ 13 THRIE-BEAM TRANSITIONS
'd TRANSITION 45" {1145) F-SHAPE TO 45" (1145) VERTICAL SHAPE SHEET 3 1-26-12 W-910.148 THRIC-BEAM 350 BRIDGE ATTACHMENT
| 457 (1145) F-SHAPE PAECAST COMCRETE BARRIER CURB SHEET | 7121z w310 14l THRIEBEAM 350 GUIDERAIL TRANSITION TD R-B 350 GUIDERAIL
Vi 45" (1145) F-SHAPE PAECAST COMCRETE BARRIER CURB SHEET 2 L2z [HW-910_15] MO-B 350 MEDIAN BARRIER SAFETY SHAPE ATTACHMENT TYPE 1
TRANSITICN - 32" (813) JERSEY SHAPE TO 45" (1145) VERTICAL SHAPE SHEET 1| 12512 Hw-910 16 MO-B 350 MEDIAN BARRIER SAFETY SHAPE ATTACHMENT TYPE It
TRANSITION - 32° (813) JERSEY SHAPE TO 45" (1145) VERTICAL SHAPE SHEET 2| 10-18-10 Hw-010 17| B TERMINAL SECTION
TRANSITION - 32° (513) JERSEY SHAFE TO 45" {1145) VERTICAL SHAPE SHEET 3| 10-18-10 W-510.18 | METAL BEAM RAIL (TYPE MO-1)

v TRANSITION - 32° (B13) JERSEY SHAPE TO 45" (1145) VERTICAL SHAPE SHEET 4| 10-18:10 W-910_10a| METAL BEAM RAIL {MODIFIED TVPE A-) AND END ANCHORAGE TYPE I

HW-E§1.04al MERRITT PARKWAY NARROW MEDIAN BARRIER 6-09-11 W-910.19b] METAL BEAM RAIL (MODIFIED TYPE R-I) AND END ANCHORAGE TYPE II
| rw-ghi 0sb] MERRITT pasiwaY - 2'(610) WIDE MEDIAN BARRIER AWD ROADSIDE BARRIER 6-09-11 HW-911.01] BB END ANCHORAGE TYPE 1AND I

K HW-E§1 0Sal TRAMSITION - 45" {1145) F-SHAPE TO 54" {1372) VERTICAL SHAPE SHEET 1 1-26-12 HW-911.02| MD-B END ANCHORAGE TYPE I

€TDOT HIGHWAY

DEPARTMENT OF TRANSPORTATION Lotz

e ST T — | OFFICE OF ENGINEERING

Figure 7 - Enter Project Number and Check Boxes

5. Delete the standards that are not included in the project as shown below:

ctdot_highway_std.pdf* =

1. Click on the

PDF Packzge standards file

Hyw-01INDEX pdf 11812013 17:18 &M
Huw/-02INDExgpdt 1782012 11:18 AM
Hyw/-0506_01.gdf 1782012 11:18 AM

Hy/-0506_02.py 1782012 11:18 AM

Hiw-0508_03.pdf 2. Right Click 118120131118 &M
and select delete
on drawings not
e 0507 G2pdt . included in project

Hyw-0507_01.pdf 1782013 11:18 AM
1782013 11:18 AM
Hyw-0507_03.pdf - 1182013 11:18 A

Hyw-0507_04.pdf 1182013 11:18 A

Hyw-0507_05.pdf 1182013 11:18 A

Figure 8 - Deleting Drawings from Standard Set

6. Next digitally sign all index sheets in accordance with Section 5.6.4.
7. Then upload the standards into the 100_Contract Plans folder in Projectwise in
accordance with Section 6.1 of this manual.
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4.5 Contract Special provisions

1. Digital Contract Special provisions shall be submitted in MS Word format and in
accordance with the Departments policies and procedures for Contract Development.
CSl special provisions shall be submitted in pdf format.

2. Preliminary special provisions and CSI special provisions shall be combined into (1) pdf
document and then uploaded to the applicable folder under the 310_Review
Documents folder under the project in Projectwise.

3. FDP and Addendum special provisions and CSI special provisions shall be submitted to
CTDOT in accordance with the following:

For projects where a consultant is the Project Manager on the project, the
Specification and CSI special provisions in WORD format shall be submitted in
(1) zipped folder.

For projects where a CTDOT design unit is the Project Manager on the project,
the Specification and CSl special provisions in WORD format shall be submitted
in individual zipped folders per discipline.

Addendum special provisions shall be submitted in WORD Format in a zipped
folder. Each page of the specification section shall be marked in the bottom
right corner of the footer with “Addendum No. Y”, where “Y” equals the
addendum number. Also a line shall be placed on the right side indicating
where language was changed in the specification.

Special provisions shall be submitted in a zipped folder for the following
submissions: FDP, revised FDP special provisions, Addendum special provisions,
and revised addendum special provisions. Revised FDP and revised addendum
submissions shall only include the revised special provisions.

FDP, revised FDP special provisions, Addendum special provisions, and revised
addendum special provisions shall be uploaded into the 240 Contract
Development folder under the project in Projectwise in accordance with Section
6.1 and attributed in accordance with Projectwise Attribute Table of this
manual.

4. Design Initiated Change Order special provisions shall be prepared and submitted in
accordance with the following:

Issued 10/2017

On each sheet of the revised specification, “C#” and the date shall be placed in
the bottom right corner of the footer. An example would be “Rev. C1 -
mm/dd/yy”.

For projects where a consultant is the Project Manager on the project, the
Specification and CSI special provisions in WORD format do not need to be
uploaded into Projectwise.

For projects where a CTDOT design unit is the Project Manager on the project,
the DCO Specification and DCO CSI special provisions in WORD format shall be
submitted in individual zipped folders per discipline.

The project manager shall combine all the DCO specifications into (1) multi-page
PDF document.

The consultant or state design Project Manager shall upload the Design Initiated
Change Orders special provisions pdf file into the 110_Contract Documents
folder under the project in Projectwise in accordance with Section 6.10f this
manual and attributed in accordance with Projectwise Attribute Table of this
manual.
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4.6 Estimates and Quantity Calculations

Estimates
Cost Estimates shall be prepared in accordance with the procedures detailed on this website:
Cost Estimating

Preliminary cost estimates shall be uploaded into the 310_Milestone Submissions under the
applicable project in accordance with Section 6.1 of this manual.

Final Proposal and Federal Estimates shall be uploaded into the 240_Contract Development
folder under the applicable project in accordance with Section 6.1 of this manual.

Calendar Day estimates shall be uploaded into the 240_Contract Development folder under the
applicable project in accordance with Section 6.1 of this manual.

Quantity Calculations

Quantity Calculations shall be formatted and submitted in accordance with the following:

e Shall be native PDF whenever possible.

e Scanned pages shall be readable and have a minimum resolution of 200 dpi.

e Pagesin the PDF can be any size. 8.5” x 11” is recommended.

e Shall be uploaded into the 150 — Quantity Calculations folder under the project in
Projectwise in accordance with Section 6.1 and attributed in accordance with
Projectwise Attribute Table of this manual. The final status shall also be applied as
shown in section 2.5.

4.7 Environmental Permits

Environmental permit applications, permit approvals, and other permit documents shall be
uploaded into Projectwise and formatted in accordance with the following:
Permit Need Determination Form (PNDF) and Other Permit Documents

e Shall be native PDF whenever possible.

e The PNDF shall be uploaded into the 320_Permit Development Folder under the project
in Projectwise in accordance with Section 6.1 and attributed in accordance with
Projectwise Attribute Table.

Environmental Permit Applications:

e Shall be native PDF whenever possible.

e Scanned pages in the application must have a maximum resolution of 200 dpi and a
minimum of 125 dpi.

o All pages, except plans sheets, shall be sized 8.5” x 11”. Plan sheets can be sized up to
34" x 22",

e Before FDP, each permit application shall be in an individual multi-page PDF file. Each
permit shall be shall be then uploaded into the 320_Permit Development Folder under
the project in Projectwise in accordance with Section 6.1 and attributed in accordance
with the Projectwise Attribute Table.

e At FDP, the individual multi-page PDF files shall be uploaded into the 240_Contract
Development folder under the project in Projectwise in accordance with Section 6.1 and
attributed in accordance with the Projectwise Attribute Table .

Environmental Permit Approval

e Shall be native PDF whenever possible.

e Scanned pages in the permit must have a maximum resolution of 200 dpi and a
minimum of 125 dpi.

e Shall be sized 8.5” x 11”.

e Before FDP, each permit approval shall be in an individual multi-page PDF file. Each
permit shall be shall be then uploaded into the 320 _Permit Development Folder under
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the project in Projectwise in accordance with Section 6.1 and attributed in accordance
with Projectwise Attribute Table.

e At FDP, the individual multi-page PDF files be uploaded into the 240_Contract
Development folder under the project in Projectwise in accordance with Section 6.1 and
attributed in accordance with Projectwise Attribute Table .

4.8 Contractor Submittals

See Section 9 for format, submittal and review requirements for Contractor Submittals: Working
Drawings, Shop Drawings, Product Data, RFl, and RFC.

4.9 Engineering Reports

Hydraulic, Scour, Floodway, and Final Drainage reports: Shall be formatted in accordance with
the following:
e Shall be native PDF whenever possible.
e Scanned sheets in the reports must have a maximum resolution of 200 dpi and a
minimum of 125 dpi.
e All sheets except plans sheets shall be sized 8.5” x 11”. Plan sheets can be sized up to
34" x 22”.
e Shall be digitally signed and watermarked in accordance with Section 5 of this manual.
e Any data files that must accompany the PDF report shall be uploaded into Projectwise in
a zipped folder.
e The reports and zipped folder for any data files shall be submitted into the
130_Engineering Reports folder under the applicable project in accordance with Section
6.1 of this manual. The final status shall also be applied as shown in section 2.5.
e Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in
Projectwise.
Task 110, Task 220, Underground Storage Tank System Closure Reports: Shall be formatted in
accordance with the following. The content of the report shall be in accordance with the Scope
defined by the Division of Environmental Compliance:
e Shall be native PDF whenever possible.
e Scanned sheets in the reports must have a maximum resolution of 200 dpi and a
minimum of 125 dpi.
e All sheets except plans sheets shall be sized 8.5” x 11”. Plan sheets can be sized up to
34” x 22”.
e Shall be digitally signed in accordance with Section 5 of this manual.
e These reports shall be submitted into the 130_Engineering Reports folder under the
applicable project in accordance with Section 6.1 of this manual. The final status shall
also be applied as shown in section 2.5.
e Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in
Projectwise.
Rehabilitation Study Reports and Type Study Reports: Shall be created and formatted in
accordance with the Bridge Manual:
e Final reports shall be uploaded into the 140_Project Administration folder in
Projectwise. The final status shall also be applied as shown in section 2.5.
e Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in
Projectwise.
Bridge Load Ratings: Shall be created and formatted in accordance with the Bridge Load Rating
Manual:
e Final load ratings shall be digitally signed in accordance with Section 5 of this manual.
e Final reports shall be uploaded into the 130_Engineering Reports folder in Projectwise.
The final status shall also be applied as shown in section 2.5.
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e Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in

Projectwise.
Geotechnical Reports:

e Shall be native PDF whenever possible.

e Scanned sheets in the reports must have a maximum resolution of 200 dpi and a
minimum of 125 dpi.

e All sheets except plans sheets shall be sized 8.5” x 11”. Plan sheets can be sized up to
34” x 22”.

e These reports shall be submitted into the 130_Engineering Reports folder under the
applicable project in accordance with Section 6.1 of this manual. The final status shall
also be applied as shown in section 2.5.

e Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in
Projectwise.

4.10 Project Administration and Project Correspondence
Documents

Project Administration Documents
Final project administration documents shall be stored in the 140_Project Administration folder
under the project in Projectwise in accordance with the following:

e Shall be in PDF Format.

e Scanned documents must have a maximum resolution of 200 dpi and a minimum of 125
dpi.

e The document must be uploaded into Projectwise in accordance with Section 6.1 and
attributed in accordance with Projectwise Attribute Table of this manual. The final
status shall also be applied as shown in section 2.5.

Note: The discipline attribute must match the author of the document. For example, if the
Highway design unit sends out a memo for a design review, the discipline attribute on this
document shall be HW.

e Draft project administration documents can also be created and worked on in
Projectwise. These file shall be located under the user’s discipline 330_Design_Data
folder under the project in Projectwise.

Project Correspondence Documents
Project correspondence documents shall be stored in the 142_Project Administration
Correspondence folder under the project in Projectwise in accordance with the following:

e Shall be in PDF Format.

e Scanned documents must have a maximum resolution of 200 dpi and a minimum of 125
dpi.

e The document must be uploaded into Projectwise in accordance with Section 6.1 and
attributed in accordance with Projectwise Attribute Table of this manual. The final
status shall also be applied as shown in section 2.5.

Note: The discipline attribute must match the author of the document. For example, if the
Highway design unit sends out a memo for a design review, the discipline attribute on this
document shall be HW.

This folder is for all final project correspondence documents. This is defined as any request
memos, response memos, emails, letters, etc. and does not include any documents that are
defined in the 140_Project Administration folder. This folder shall not include any working/draft
documents. The final status shall also be applied as shown in section 2.5.
e Emails — The sender of the email is required to store a PDF of the email message in
Projectwise.
e letters
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Meeting Minutes
Request Memos — Survey Request, Design Reviews, Support unit design.
Response Memos — Response to the Request Memos

4.11 Project Location (Geo-Spatial Boundary or Route
ID and Mileage)

The project location shall be prepared and submitted in accordance with section 13.

4.12 Design Calculations

Design Calculations for all structural elements on a project shall be formatted and submitted in
accordance with the following:

Shall be native PDF format whenever possible.

Scanned pages shall be readable and have a minimum resolution of 125 dpi.

Pages in the PDF can be any size. 8.5” x 11” page size is recommended.

Shall be uploaded into the 151 — Final Design Calculations folder under the project in
Projectwise in accordance with Section 6.1 and attributed in accordance with
Projectwise Attribute Table of this manual. The final status shall also be applied as
shown in section 2.5.

4.13 Electronic Engineering Data (EED)

Electronic Engineering Data shall be prepared and submitted in accordance with section 12.
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4.14 Contract Plan Drawing and Sheet Numbering

4.14.1  Drawing Number

The drawing number is used primarily for sheet to sheet referencing, typically in, but not limited
to; section details, section cuts, and detail callouts. Drawing numbers in digital contracts shall
consist of the discipline designator followed by a hyphen and the sheet number. Examples of
discipline designators are HWY, PRO, IND, XSC, S, TR, A, E, etc.

The first sheet in a discipline subset shall have “01” in the drawing number as shown below:

“"TOWN OF WESTPORT [173-420

{ DRAWING NO.

DRAWING TITLE: \ HWY'01
INDEx SHEET SHEET NO.
04.01

Figure 9 Contract Drawing Numbering

4.14.2 Final Plan Page Labels and Sheet Numbers

Page labels and sheet numbers are applied to the discipline subset after the contract plans are
published to PDF.

Page labels and sheet numbers shall be managed and placed on the discipline subsets, using the
number pages and header and footer tools within Bluebeam. Page labels and sheet numbers
shall be applied to all submissions of contract plans.

The first sheet in every subset shall start out at 01. For example the first sheet in the 05-Traffic
subset shall be 05.01.

Created in Microstation

a

TOWN: PROJECT NO.
CITY OF NEW HAVEN\QL_Q.Zzﬁﬂ.D_
T [°*AWiNe TIE Created in Bluebeam it TRA-01

DRAWING INDEX (

05.01

Figure 10 - Drawing and Sheet Numbering

The page label and sheet number place holder shall be determined by the total estimated sheet
count. For less than 100 sheets two place holders is adequate. For greater than or equal to 100
sheets three place holders are necessary. For subsets less than 10 sheets, two placeholders
shall be used i.e. 01.01 thru 01.04 for a four sheet subset.

The page labels and sheet numbers must be placed correctly because it is used to correctly
assemble the contract plans into a properly ordered consolidated set that District Construction
takes advantage of during construction of the project.

Single Volume Projects:

The page labels and sheet numbers, for single volume projects shall be a concatenation of the
discipline subset number, a decimal point, and the sheet number. For example; the page labels
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and sheet numbers for subset “4” would be as follows; less than 100 sheets 04.01, 04.02, 04.03,
etc or Greater than 100 sheets 04.001, 04.002, 04.003 etc.

The Project Manager should determine the total number of subsets and give each discipline
their corresponding subset number, see Section 4.1.

Multi Volume Projects:

For a multi volume project the page labels and sheet numbers shall be a concatenation of the
volume number, a decimal point, the discipline subset number, a decimal point, and finally the
sheet number. Example: Volume 2, Subset 5; 02.05.01, 02.05.02, 02.05.03.

Volume numbers shall be used on large projects. They are effective because the Project
Manager only has to deliver to the other engineers their perspective volume numbers, allowing
them to manage their subset numbers independently of the other discipline volumes and subset

counts, see Section 4.1.

Subset numbers shall start at 01 for all volumes.
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BLUEBEAM - Applying Page Labels and Sheet Numbers

To apply page labels and sheet numbers in Bluebeam follow the figures below:
1. First page labels must be applied to the discipline subset. Go to the thumbnail pane as
shown below, right click on a thumbnail and select Number Pages:

Document Form Markup Measure Window Help

g %

(2) Right Click
on a thumbnail

(N EEEEEEN]

cl+Alt+C

Ctrl+Shift-+N

TLLLITILLLOCT 1

cutishftn (3) Select Number
Pages

Ctrl+Shift+M

Figure 11 - Adding Page Labels

For subsets that contain less than 10 sheets the page labels can be applied to all the sheets at
once. Inthe case where there are 10 or more sheets in the subset the following will have to be
done twice in order to get the correct number of place holders.

2. Select the correct style, insert correct prefix for the sheets being numbered, and apply
to the correct pages. For example, if the 04 subset has 99 sheets the prefix shall be
“04.0” for sheets 1-9 and “04.” For sheet 10 through 99.

+— (1) Select this style
+— (2) Insert correct prefix

(3) Start at 1 for sheets 1-9

Page Rangs and 10 for sheets 10-99
Croos [7oe 16 v ) -— (4) Apply to correct pages
PPly pPag

==~ (5) Click OK

Figure 12- Page Labeling
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3. Now the pages will be labeled:
Edit View Document Form Markup Measure Win
\
NG

Securnty Hgnatunes

a1 5

| : -

CT_CON_FPL_0120_00386_04-

= Pages are
e m D now labeled

Figure 13 - Labeled Pages

4. Next we will apply the sheet numbers. From Bluebeam select the Document tab and
then “Header & Footer”

View Document Form Markup Measure Window

-_'._-."x‘vq 6 ".-

.
P Security

(2) Select Pages

=) . (3) Select header
(1) Select . e & footers
Document

TRAFFIC - LEGENDS &
LIST OF DRAWINGS

LIST OF DRAWINGS
e

Figure 14 - Header Footer Tool
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5. Place the sheet numbers, as shown below: Note the margins may have to be adjusted
as necessary. After you select the font, set the margins, and type in <<Pagelabel>> as
shown below. Then click save for save settings. The next time you are going to apply
sheet numbers to a subset, you can simply select the saved settings. Then click OK.

Header and Footer

_——
ECCEC Sl S HEET NUMBERS | Save... '

Fort

|\-’erclana
(3) Click ¢

[] Fit content inside margins

\ (1) Select these

S ave Header and Footer
Header Left
Footer Left —
‘ ‘ qzzpage Label>>
Insert: [ Page Number ] [ Date ][ Bates Number ] [ File Data ]

Preview

TRAFFIC - LEGENDS &
LIST OF DRAWINGS

===
N N S
CT_CON_FPL_01120_0086_04T b b Pages ange (1)

()

Figure 15 - Insert Sheet Numbers

Issued 10/2017 44

options

—— (2) Type

<<PageLabel>>

(4) Click OK

Version 4.03



Connecticut Department of Transportation — Digital Project Development Manual

4.14.3

Addendum and Design Initiated Change

Order Page Labeling and Sheet Numbers

Page labels and sheet numbers for an Addendum need to have “.A##” at the end and Change
Orders need to have “.C##” at the end (see Section 7 for addendum and change order sheet

numbering requirements).

To apply page labels and sheet numbers in Bluebeam follow the figures below:

1. First page labels must be applied to each sheet in the addendum or change order. This

can only be done one sheet at a time.
2. Go to the thumbnail pane as shown below and then double click on the page label.

Then type in the correct page label for the sheet.

L5

 Select the

thumbnail icon

e I s
B £ e=an
Sl
.-""-FF- - - i ’ -
- )1 E
=
D3.D5.AD1|
e -
Y
RS

wlla .___..-——"\“ .
£ e i
i e X
Lo . Sl
[ e e At
Sty - — -."'\.
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Figure 16 - Adding Page Labels
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Double click on the -
page number and
type in the correct
page label.
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3. After all page labels have been applied, the sheet numbers can be applied. From
Bluebeam select the Document tab and then “Header & Footer”

Document Form Marcup Measure Window Help

.;;-. qu,q — / e Iﬂ\'.-»-i}""{‘"

P

i Era ' s ;7 1 i Headers &Footers... B
(% N :

e (3) Select header
(1) Select Cirl+shifta1 & footers

Document

TRAFFIC - LEGENDS &
LIST OF DRAWINGS

Ctrl+5hift+C

LIST OF DRAWINGS

Figure 17 - Header Footer Tool
4. Select your sheet numbers saved settings from before and click OK. Note the margins
and size may have to be adjusted as necessary.

Header and Footer

Save Setting{ |FNESRMIEEE “ | ) save,. Delete [ Fit content inside margins

Fort Marginz (Inches)

Verdana v||1E v|@ BT U

(1) Select

Header and Footer yo u r s ave

Header Left Center Right -
settings

Footer Left

<<Pagelabel=>

Insert: | Page Mumber l ’ Diate ] [ Bates Number ] ’ File Data

Preview

______

TRAFFIC - LEGENDS &
LIST OF DRAWINGS

' (2) Click OK

CT_COMN_FPL_0120_0086_04-T

Add Fles || Delete Al |

() =0

Figure 18 - Applying Addendum or DCO Sheet Numbers
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4.15 Consolidating Contract Plan Discipline Subsets

The consolidation of the contract plan discipline subsets is accomplished using the Set feature in
Bluebeam version 11 or newer. This feature creates a single viewer file called a “Set File” that
allows users to take multiple digitally signed files, sort them by their sheet numbers, and view
them in order without actually combining the files.

The project manager shall create a Set file for the project at DCD that contains all the discipline
subsets, DO NOT include the highway and traffic standard subsets. When an Addendum or
Change Order is required for the project, the project manager shall update the set file to include
the Addenda or Change Order subsets.

The following shows when and how a set file will be created and updated throughout the life of
a project.

See Appendix C for general use of a set file.

Note: Steps 1-5 of Appendix A must be followed to create and use the Set File feature
in Bluebeam.

Also the PDF checker must be run on the subsets and they must receive a PASS status
for the Set File to sort the subsets correctly. See section 6.3 information on the PDF
checker

4.15.1 When a Set File is Created and Updated

Set File Creation
1. The project manager shall create a set file of all the discipline subsets at DCD, see

Section 4.15.2

Set File Updates
2. If any Addendum subsets are required for the project, these Addendum subsets shall be

added to the set file by the project manager.
3. Ifany Design Imitated Change Order subsets are required for the project, these Design
Initiated Change Order subsets shall be added to the set file by the project manager.

See section 4.15.3 for updating the set file.
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4.15.2 Creating a Set File

Note: Steps 1-5 of Appendix A must be followed to create and use the Set File feature
in Bluebeam.

Also the PDF checker must be run on the subsets and they must receive a PASS status
for the Set File to sort the subsets correctly. See section 6.3 information on the PDF
checker

After all the discipline subsets have been submitted into Projectwise for DCD the project
manager shall create the project’s set file in accordance with the following:
1. Launch Bluebeam from the desktop icon on your computer.

2. Next Click on the Set Icon and select New Set as shown below:

Q (S File Edit Wig Document Farm Markup Measure Window Help

= - &
h 4
€]

Frint E-mizil Studio abs Toalbars Frofiles Ro

'H*‘E_j" b 5

“n

(1) Click on the
Set icon

Open Set

Save Set

Save Set As

Select Al
Select Lakest

Seleck Previow

E:',- Close Set

(2) Click on the arrow
and select new Set

Figure 19 - Creating a Set File
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3. Then click Add and then Projectwise and OK as shown below:

Set: New Set.bex (= ==

File Name
Open From @
4 | .
- - zBE Location Status
‘m: m—— ' ProjectWise V10 ctdot projectwiseoniine.com:CTDOT Ready
N Project ps.//studio bluebeam com Reaay
|se Relative Paths My Computer Fi sk
[T] Show Paths
[ Open... ] ’ Save ] ’ Save 4

—

——

Figure 20 - Adding Files to the Set File

4. Next browse out to your project’s 100 Contract Plans folder and select all plans except
the standard subsets. Then click Open: After you click Open it may take a minute for
Bluebeam to load all the files into the set, please be patient.

[ Open Document: &‘

Select |

Folder

‘ [ 100_Contract_Plans (PDF)
M e

Document

Labe| (Lser Defined) Description Main Category  Sub Gefegory | Sub Categary De: m

(1) Browse out to your
project's 100 Contract
Plan folder

| iron
T_CON_FPL_N135-0270_CTDOT_HIGHWAY_STD . pdf A Standard Details Flans_04 - Final P

T_CON_FPL_0135-0270_CTDOT_TRAFFIC_STD. pdf 0T _TRAFFIC_STD Flans_04 - Finl P

(2) Select all the files

< ' N except the standard

Address: |pw:\\[tdnt.pru]ettwlsennllne.(Dm(TDOT\DD(uments\Dl.EI - Prajects - Active|0135-02704100_Contract_Plans (FDF)N o SU bS etS a nd C I | Ck OK Zl
Descriptian: [ = "REVISTONS *HWY Details & Misc” “HIGHWAY PLANS & SUPERELEVATION DIAGRANS" "5 STA, 5+00 TO 126-+00" "WIRETA. 125-+5u 1 caorkou Asie 314 219U 10 Uy dsomcrirmnal |
File Name: ["cT_con_FeL_135-0270_01.01 - General pdf"CT_CON_FPL_0135-0270_0L.02 - Revisions pef* ”CT_CON_FPL_EI[SE-EIZ?E: PG~ HWY Detal & Misc.pdf 'CT_CON_FPL_0135-0270_01.0¢ - lans & |
Application: [ acrobat PoF B v

[¥] Open documertt as read-only

7~

=~
([_cpen Y omen from ok Cancel

Figure 21 - Adding Files to the Set File
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5. Next Click on Relative Paths and then click options:

o

Set: Mew Set.bex

'y

[= =)=

File Mame

01-014General _CT_FPL_004040136 pdf
02-AZ-Revisions_CT_ADP_0040-0136 pdf
402-Revisions_A3_CT_ADP_0040-0136 pdf
402-Revisions_CT_FPL_0040-0136 pdf
01-03-Highway_»A3_CT_ADP_D040-0136 pdf
01-03-Highway_CT_FPL_0040-0136 pdf
01-04-Structure_A3 CT_ADP_ 00400136 pdf
01-04-Structure_CT_FPL_0040-01 36 pdf
0105-Landscaping_CT_FPL_0040-0136 pdf

1| 1]

-

m

3

NGS

Use Relative Paths —

[] Show Paths

[ Cpen... H Save HSave.ﬁs...

| oK || cancel |

Figure 22 - Set File Options

6. Next on the sorting tab, make sure all the options shown below are set:

Set Options (=23l
| Sortng | Categories | Tags |
Shiow: 'File Mame and Page Label v]
Sort By: | Page Label Only -

[7] Sort Tagged Sheets By Sheet Number

Sort Order: [Nphanumeric Ascending ']

[7] Stack Multi-Page Documents

Revision Filter: l‘l’lﬁldcard ']

Stack Revisions By: | Fage Label

@'il_dcard Syntac: 7 D

Previous Revisions: lcross Out "]

Cument Revisions: ’Highlight ']

|| Copy markups to newly added revisions
Unflatten Marups before Copy

Flatten Markups after Copy

[] Stamp previous revisions "Superseded’

Figure 23 - Configuring the Set File
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7. Then on the Categories Tab make sure the categories are turned off:

Set Options
Sortinfy | Categories [ Nags
Categories: | Off -
Categorize By: Sheet Number
Category Filter
ry
E] Cavil C
Landscape
@ Structural 5
Architectural Demalition AD
Architectural A
Interiors |
Plumbing P
Mechanical M
Fire Protection FP
Electrical E
Telecom

[Cox_ ] [cancel |

Figure 24 - Set File Categories

8. Then on the Tags Tab make sure nothing is checked and then click OK:
Set Options

Sorung|[:ategon'¥ Tags '
\-—-/

Add Tags to sheets within a Set. Tags can be applied manually
or by a user-defined region, which finds text on the sheets via AutoMark.

Tag Mame Type
Sheet Name Text
Shest Number Text
Revision Number Number

FER)

] Ao Tag: Revision Number per Shest Number
Il o Tag: Discipline per Sheet Mumber (A4 Standands)
= o Tag: Sheet Type per Sheet Number (41A Standards)

(o[ cancel |

Figure 25 - Tags Tab
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9. Next click Save, this may take a while depending on how big the project is, please be

patient. When the box pops up choose Projectwise and click OK:

Mew Sel.Dbex

File Mame

P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
F:ctdot. projectwizeoniine. com: CTDOTA01.0 - Projects
Fi:ctdot. projectwiseoniine. com: CTDOTY01.0 - Projects
P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
Pz ctdot. projectwizeoniine. com: CTDOTA01.0 - Projects
P ctdot. projectwiseoniine. com: CTDOTS01.0 - Projects
P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
Fif:ctdat. projectwizeoniine. com:CTDOTA01.0 - Projects
P ctdot. projectwiseoniine, com CTDOTA01.0 - Projects
P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
Fif:ctdot. projectwigeoniine, com: CTDOTA01.0 - Projects
P ctdot. projectwiseoniine. com: CTDOTA01.0 - Projects
P ctdot. projectwizeonline, com: CTDIOTAY01.0 - Projects
F/:ctdot. projectwizeoniine. com: CTDOTA01.0 - Projects
Fi:ctdot. projectwiseoniine. com: CTDOTY01.0 - Projects
P ctdot. projectwiseoniine. com: CTDOTA01.0 - Projects
P ctdot. projectwizeoniine. com: CTDOTA.0 - Projects -
F:ctdot. projectwizeoniine. com: CTDOTA01.0 - Projects -
Fi:ctdot. projectwiseoniine. com: CTDOTY01.0 - Projects -

(1) Click
— Save

Optiong

- Activeh0135-02705100_Contract_Plans (PDFISCT_CON_FPL_0135-0270_01.01

- Activeh0135-02708100_Contract_Plans (PDFICT_CON_FPL_0135-0270_02.01

- Aclive’(135-02705100_Contract_Plans (PDFINCT_COM_FPL_0135-0270_03.01
- Active(1 35027051 00_Contact_Plans [PDFINCT_CON_FPL_0135-0270_04.01

- Activel0135-027085 00_Contract_Plans (POFMCT_CON_FPL_0135-0270_05.01

- General pdf. 67E10.63
- Achived0135-027045100_Contract_Plans (PDFMCT_COMN_FPL_0135-0270_01.02 -
- Active’h0135-02705100_Contract_Plans (PDFRCT_COMN_FPL_0135-0270_01.03 -
- Active’0135-02704100_Contract_Plans (PDFMCT_CON_FPL_0135-0270_01.04 -
- Active’0135-02704100_Contract_Plans (PDFMCT_CON_FPL_0135-0270_01.05 -
- Achived0135-027045100_Contract_Plans (PDFMCT_CON_FPL_0135-0270_071.06 -
- Active’h0135-02705100_Contract_Plans (PDFRCT_COMN_FPL_0135-0270_01.07 -
- Structures. pdf. 67E510,80
- Active’h0135-02704100_Contract_Plans (PDFMCT_CON_FPL_0135-0270_02.02 -
- Actived0135-02708100_Contract_Plans (PDFRCT_CON_FPL_0135-0270_02.03 -
- Active’h0135-02708100_Contract_Plans (PDFRCT_CON_FPL_0135-0270_02.04 -
- Active’0135-02704100_Contract_Plans (PDFMCT_CON_FPL_0135-0270_02.05 -
- Active’0135-02704100_Contract_Plans (PDFMCT_CON_FPL_0135-0270_02.06 -
- Traffic. pdf. 6761068

- Landzcape.pdi. 6761081
- Active’0135-02704100_Contract_Plans (PDFMCT_CON_FPL_0135-0270_04.02 -
- General pdf B7E10.71
- Activedh0135-02705100_Contract_Plans (PDFRCT_COMN_FPL_0135-0270_05.02 -
- Activeth0135-02708100_Comtract Plans (POEACT COR _FPL_013R-0270 0 07 -

Revisions.pdf. 67610,28

HwY Detail & Mizc.pdf 67610,32
Planz & Super Dia.pdf. E7610,29
Crozs-Sections.pdf. 67E10,25
Cross-Sections. pdf 67610,25
Cross-Sections.pdf 67610,27

Structures. pdf B7E10,64
Structures. pdf 57510,65
Structures.pdf. 67610,86
Structures. pdf B7E10,87
Structures. pdf B7E10,57

Invasive Removal pdf. 67610,49

Revizions.pdl. 67610.75
Ciwil nlf £7R10.72

Type Location Status
Projectwize Wi ctdot. projectwizeonline. com: CTDOT Logged In ]
gy s g L

(2) Choose Projectwise
and click OK

e =1

Sort By: | Page Label Only

yau

Sort Type: |.&Iphanumeric As%ding v|

H

Open... Save

ave fs..

Issued 10/2017
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10. Select the Advanced Wiza

rd, and then on the Select target folder browse out to your

project’s 100_Contract_Plans folder. Then click next until you get to the attributes

page. Attribute the Set File as shown below:

Advanced Document Creation Wizard

Define Document Altributes

il

*fou should define environment specific document attibutes.

Discipline

cT
Main Category
COMN

Sub Category
Set File

-

Project Number(s)
01710346

00-Set File
Description

/

Main Category Description

All Contract Plans & Specs ‘
Sub Category Description

Blugbeam Set File

(1) Select these
attributes

(2) Type these
attributes

m

Up to Addendum Mo. 1

CT Code (Auto Fill In}

00-Set File_CT_Set File_0171-0346

CTDOT Asset Tags

Sign Structures

Bridge Mo(s)
[

Signal Intersections

(3) Click Next until
the document uploads

Building No(s)

LI

Ve

< Back Next > Cancel |

N—

Figure 27 - Attributing the Set File

11. Click OK after the set file has been saved into Projectwise:

File Mame

Pw:ctdot. projectwiseonling. com: CTDOTH01.0 -
P ctdot. projectwiseonling. com: CTDOTSO1.0 -
P ctdot. projectwizeonline. com: CTDOTS01 .0 -
P ctdot. projectwizeonline. com: CTDOTS01 .0 -
P :ctdot. projectwizeonline. com: CTDOTO01.0 -
P :ctdot. projectiwizeaniing. com: CTDOTAIM.0 -
P :ctdot. projectwizeonling. com: CTDOTS01.0 -
P sctdot. projectwiseonline. com: CTDOTH01.0 -
Pcctdot. projectwiseonling. com: CTDOTH01.0 -
Pcctdot. projectwiseonling. com: CTDOTH01.0 -
P sctdot. projectwiseonling. com: CTDOTH01.0 -

Praojects -
Projects -
Projects -
Projects -
Projects -
Projects -
Projects -
Projects -
Projects - Actives0001-0001%100_Contract_Plans (PDFISCT_COM_FPL_0001-0001_09-Electrical pdf. 823766
Projects - Actives0001-0001%100_Contract_Plans (PDFINCT_COM_FPL_0001-0001_10-Environmental.pdf.82...
Projects - Actives0007-0001%100_Contract_Plans (PDFISCT_COM_FPL_0001-0001_11-Traffic. pdf. B2376.8

Actives0001-0001%100_Contract_Plans [POFSCT_CON_FPL_D00-0001_0N-General pdf. 82376.11
Activet0001-00014100_Contract_Plans [PDFNCT_COM_FPL_0001-0001_02-Revisions.pdf. 82376,13
Activeh0001-00014100_Contract_Plans [PDFSCT_COM_FPL_0001-0001_03-Supporting Docs. pdf.
Activet0001-00014100_Contract_Plans [PDFNCT_COM_FPL_0001-0001_04-Civil pdf 823761
Activehd001-00014100_Contract_Plans (PDFNCT_COM_FPL_0001-0001_05-Architectural. pdf.823...
Activet0001-00014100_Contract_Plans (PDFNCT_COM_FPL_0001-0001_0E-Structural pdf. 82376,3
Activet0001-0001%100_Contract_Plans (PDFNWCT_COM_FPL_0001-0001_07-Plumbing. pdf. 82376 4
Activet0001-0001%4100_Contract_Plans [PDFNCT_COM_FPL_0001-0001_08-Mechanical pdf. 8237...
] _|
) _|
I |

Add

Options

SortBy: | Page Label Orly

“|

Sart Type: | Alphanumeric Ascending

Click OK

v

Cancel

Issued 10/2017
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12. When the Tags box pops up just click OK:

Tags EI@
Edit tag values here...

File MName Page Label Sheet Name Sheet Mumber EE;i;igrn -
3 01014General... | 01.01.01 3

01-01General.. | 01.01.02 N

01-01-General .. |01.01.03

01-02-A2Revi... |01.02.01.A2

0102-Revisio... |01.02.01.A3

01-02-Revisio... |01.02.01

01-03-Highwa... |01.03.04.A3

01-03-Highwa... |01.03.01

01-03-Highwa... |01.03.02

01-03-Highwa... |01.03.03

01-03-Highwa... |01.03.04

01-03-Highwa... |01.03.05

0103 Highwa... |01.03.06 ~ i

l oK l Cancel

Figure 29 - Set File Tag Dialog Box

13. Now the set file has been created. As you see below all the sheets from the files are

listed and crossed out accordingly. For use of the Set File see Appendix C:

¢ RE =

ITHLY

_FPL_0040-0136 pcf

Issued 10/2017

Figure 30 - Set File
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4.15.3

in Bluebeam.

Updating a Set File
Note: Steps 1-5 of Appendix A must be followed to create and use the Set File feature

Also the PDF checker must be run on the subsets and they must receive a PASS status
for the Set File to sort the subsets correctly. See section 6.3 information on the PDF

checker

The following will show how to update a set file. When an Addendum or Change Order is
required for the project, the set file shall be updated by the project manager.

4.15.3.1

Adding a File to the Set File

1. Double click on the set file from Projectwise and open as shown below:

while depending on how big the project is, please be patient.

This may take a

N = 2 @ | @A - search| @ ~| > interface| CTDOT_Da_Cade | : view| Document | : spatial View:| Defautt iew |  Backar
Address| | pur\\ctdot,projectwiseonline.com:CTDOT\Dacuments\0L 0 - Projects - Active\0135-02701100_Contract_Plans (F | B> Go
-2 B
L—: 0036-0093 ~ List |@ Geospatial
% gg::g:g; Description Main Category | Sub Category | Sub Category Description Application
3 0098-0103 # | 00-Plan Set Updated ta FDP Plans con fa s Plans_08 - Consolidated 4j3
% 01020278 con AL Plans_04 - Final Plans {Adv) Acrobat PDF 45
(%% 0102-0317 /Bl o1.02 - Revisions REVISIONS con FrL Plans_04 - Final Plans {Adv) Acrobat PDF 31
* 01000325 7 [B) 01.03 - Huy Detail & Hi¥ Detalls & Misc con FrL Plans_04 - Final Plans {Adv) Acrobat PDF ajey
01020328 7 [B) 01.03 - Huiv Detail_ant Pages from CT_COW_FPL_0135-0270_01.03 - HW...  CON ADP Plans_05 - Addenda Acrobat PDF 43
01040164 01,04 - Plans & Super Dia HIGHWAY PLANS & SUPERELEVATION DIAGRAMS  CON FrL Plans_04 - Final Plans (Ads Acrobat PDF 3
il I I 1 Plans (4dh b,
% 0104-0167 7 [B) 01.05 - Cross-sections XSC 5TA. 500 TO 125400 con FrL Plans_04 - Final Plans {Adv) Acrobat PDF 3t
1 01050206 ./ [B) 01.05 - Cross-Sections C STA. 125450 TO 245450 con FrL Plans_04 - Final Plans {Adv) Acrobat PDF 3t
(% n107-0158 _/‘@ 01.07 - Cross-Sections RSMSTA. 245-+00 TO 350400 Con FAL Plans_04 - Final Plans {adw) Acrobat PDF 3f
: 0108-0178 / Bloz.o1 - structures 135-2% Final design Plans_Structures con FPL Plans_04 - Final Plans (Adv) Acrobat PDF 3j2
. 0105-0162 2 Bl 0z.02 - structures 89-125 F3Q_Structures con FAL Plans_04 - Final Plans {Adv) acrabat PDF 3
x oLie-nizz /Bl 02.03 - structures 9-126 FOP Nfructures o o "= 4 - Final Plans {Adv) Acrobat PDF 3t
e Eﬁgg:ﬁ /Bl oz.04 - structures 135-304 FOP - Mguctures Double click 4 - Final Plans (Adv) Acrobat POF 4f
I g
02,05 - Struct . bat POF 4
M n115-0117 jg I, StmEt w< Open document with ﬁiﬂ hat el 3:
* 0116-0123 - ot 1 I
N 160105 /gm o1 - Troff ool | on the set file bat PDF 31
3 0116-0134 # Bl 04.01 - Lands| H bat PDF 3j2
(2% 0117059 ZBlosoz-owesi| | program a nd c I 1 Ck O K bat PDF 32
[ 0118-0163 ./ [B) 05.01 - Gener| bat POF 3pz
* 0120-0081 / [B) 05.02 - Revisi Mame Descriptio Application Enc bat POF 31
" 0120-0088 /g 05.03 - Civil % Blusbeam Revu Set Bluebeam RewMGet "C:\Program FilesiBluebeam Software\Blusbeam RevulRevulRevu.exe”"... Mo bat PDF 3j12
* n1z24-0162 # Blos.04 - struct bat POF 3pz
™ 0124-0165 7 Bl 05.05 - Existir hat PDF 32
[ o1ze-nie2 ./ [B) 05.06 - Envvr hat PDF 3i2
(2% n127-0088 _/‘@ CTDOT_HIGH! bat PDF 211
* 01300173 7 Bl cTooT_TRa bat PDF 11
* 0130-0178
* 0131-0191 ]
% 0131-0194 & 0131-0195 -
[ ovato1g7 Document Propeties|
£ 0131-0202
Name
* 0133-0094
(% 0133-0095
= [ 01350270 € ADMINISTRA
[ 100_Conkrack_Plans (PDF) € Ene-admin
L= 110_Contract_Specifications {(PC s CDI-Admin < >
L 120_Contractor_Submittsls (POF € Qs -admin
| 130_Soil_archaedlogical_Misc_R [
w0 [2 210_Construct ) =
# ZZU_F:nWSAmc on €5 Consultant £
=2z .
[ 230_Contract_Administration € croodechan| | o here for a st of suagested document viewers
[ 240_Contract_Development €E CT00T_Cont
[ 241 _Contract_Devslopment_Col €5 cT00T_Eng |
L 310_Preliminary_Design_Docume € CT0OT Proc) S
[ 320_Permit_Applications € ctdot-servic —
[© 330_Design_Data € Dave.Brumba... Dave Brumbaugh BENTLEY B F F F F F F F F F
[ 340_Administration € Exvraction Service Account Ext. .. 5B F F F F F F F F F -
LT - I e [ S = = = = =~ = = = = @—=

Figure 31 - Opening a Set File
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2. Next click on the Set icon and click Add as shown below:

Set: New Set.bex

File Name

01-01General_CT_FPL_0040-0136 pof
01-02-A2 Revisions_CT_ADP_0040-0136.pdf
01-02-Revisions_A3_CT_ADP_0040-0136 pof
01-02-Revisions_CT_FPL_00A0-0136 pof
T_FPL_DO40-01 0103 Highway_A3_CT_ADP_0040-0136 pcf Open From
0103 Highway_CT_FPL_0040-0136pdf
01-04-Structurs_A3_CT_ADP_0040-0136 pcf

(I
My Computer From Disk

T_FPL_0040-01
Use Relative Paths
[ Show Paths

[ open.. |[ Save |[Savess

Figure 32 - Modifying a Set File

3. Next browse out to your project and select the files to add to the set and click Open.
This may take a minute to add the additional file to the set so please be patient. After it
finishes click OK.

Q Open Document

Select |

Folder

‘ [ 100_Contract_Plans (PDF)

# (o
Document
Description Main Cateqe
con (1) Browse out to
CT_ZON_FPL_0135-0270_01,02 - Revisions.pef 01,02 - Revisians REVISIONS con R
CT_CON_FPL_D135-0270_01.03 - HWY Detail & Misc.pdf 01.03 - HW'Y Detail & Misc HY Details B Misc CON you r p rojeCt
CT_ON_FPL_D135-0270_01,04 - Plans & Super Dia.pdf 01,04 - Plars & Super Dia HIGHWAY PLANS & SUPEREL...  CON
# Bl CT_con_FRL_D135-0270_01.05 - Cross-Sections pdf 01,05 - Cross-Sections %SC STA, 5400 TO 125+00 con FrL Plans_us - Fnar
/B cT_con_FRL_0135-0270_01.06 - Cross-Sections pdf 01,06 - Crass-Sections HSCSTA, 125430 TO 245450 CON FRL Plans_D4 - Final
/a CT_CON_FPL_0135-0270_01.07 - Cross-Sections.pdf 01.07 - Cross-Sections ®SC STA. 245+00 TO 350400 CON FPL Plans_04 - Final
/B cT_con_FeL_0135-0270_02.01 - Structures.pdf 02.01 - Structures 135-270 Final design Plans_St...  CON FRL Plans_D4 - Final
@ B cr_con _FrL_n135-0270_02.02 - Structures. pdf 02.02 - Structures 9-125 FDP_Structures Con FRL Plans_04 - Final
/7 B cT_con_FRL_0135-0270_D2,03 - Structures.pef 02.03- Structures 126 FOP_Structures con FRL Plans_D4 - Final
# B CT_con_FRL_D135-0270_02.04 - Structures. pef 02.04 - Structures Con FRL Plans_04 - Final
/B cT_con_FRL_0135-0270_D2.05 - Structures.pef 02.05 - Structures con FRL Plans_D4 - Final
# B CT_CON_FPL_0135-0270_02.06 - Structures.pf 02,06 - Structures con FPL Plans_D4 - Final
# Bl cT_con_FPL_0135-0270_03.01 - Traffic,pdf 03.01 - Traffic con FRL Plans_04 - Final
# B CT_CON_FPL_0135-0270_04.01 - Landscape pdf 04.01 - Landscape con FPL Plans_D4 - Final
# Bl CT_con_FPL_0135-0270_04.02 - Irwasive Remavel, pof 04,02 - Irwasive Remaval con FRL Plans_04 - Final
# B cT_con_FRL_0135-0270_05.01 - Generl pdf 05.01 - General con FPL Plans 04 - Final
# Bl cT_con_FPL_0135-0270_05.02 - Revisions.pdf 05.02 - Revisions Index of Revisior [ .
# B CT_CON_FPL_0135-0270_05.03 - Civil pdf 05,03 - Civil c (2) Select the flle
# [B) CT_con_FPL_D135-0270_05.04 - Structural,pdf 05.04 - Structural [
# B cT_con_FPL_0135-0270_05.05 - Existing Plans pdf 05,05 - Existing Plans « to be added to
/Bl CT_con_FRL_D135-0270_05.06 - Environmental.pdf 05.06 - Environmental [ .
CT_ZOH_FPL_0135-0270_CTOOT_HIGHWAY_STD.pdf CTDOT_HIGHWY_STD Standard Detalls « the set and click
# Bl CT_com_FPL_D135-0270_CTDOT_TRAFFIC_STD.pdf CTDOT_TRAFFIC_STD CTDOT_TRAFFIC_STD [ 0 p en
< > |
Address: [pwitictdet projectmiseanline. comCTDOT|Documents\01 0 - Projects - Activel)135-02701100_Conkract_Plans (FOFYICT_COM_ADP_0NNG-0270_01.03 - HWH Detail_A01 pdf v
\
Description: I \ |
A%
File Mame: ‘ CT_CON_ADP_0135-0270_01.03 - HW¥ Detail_AQ01.pdf \ ‘
\
Application: | tcrobat PDF \ ~|

[¥] open document as read-only

(™ open Fpenfmmmsk Cancel

Figure 33 - Adding Files to the Set File

Issued 10/2017 56 Version 4.03



Connecticut Department of Transportation — Digital Project Development Manual

4. Now the file will be added to the set, scroll down and you will see it.

=

.0z

CT_CON_ADP_0135-0270_01.03 - HWY Detail ...

CT_COM_FPL_0133-0270_01.0% - H¥Y [etail & ...

A,
!@gfﬁ[

Issued 10/2017
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111
i
»

L

Addendum No. 1
plan sheet

03 - HIGHWAY D
INDEX OF

Original Plan
sheets

SN €
HEE STATE OF CONMECTICUT
DEPARTMENT OF TRANSPORTATIC

301k

Figure 34 - Set File
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4.15.3.2 Deleting a File from the

Set

Note: Steps 1-5 of Appendix A must be followed to create and use the Set File feature

in Bluebeam.

1. Double click on the set file from Projectwise and open as shown below:

ProjectWise Explorer VB8i (SELECTseries 4

i @ R | & | B @ : B - seare | P> :intertace 00T Doc_code ~| : view| Document < | : spatial view: Defautt view | : Backgr

Address| ] pwiictdot, :CTDOTD 0 - Frojects - Active\0135-0270\100_Contract_Plans (F | > Go

PR
L% oose-0053 & List | @ Geaspatial
% 0098-0101 » . - S
% oms-0102 Descriptian Main Category | Sub Category | Sub Category Description Application
{4 ones-n103 /| 00-Plan Set Updated ko FOP Plans con s Plans_08 - Consolidated 43
% n102-0278 con FRL Plans_04 - Final Plans (adv) Acrabat PDF s
% 01020017 7 - Revisians REVISIONS on FRL Plans_04 - Final Plans (adv) Acrabat POF !
2
(% 010z-0325 7 - HY Detal & HWY Details & Misc con FRL Plans 04 - Final Plans (d) Acrabat PDF 27
(%% 01020328 7 - HY Detail_AD1 Pages from CT_CON_FPL_DI35-0270 01,03 - ...  CON ADP Plans_05 - Addenda Acrabat PDF Y3
[ 0104-0164 s - Plans & Super Dia HIGHWAT PLANS & SUPERELEVATION DIAGRAMS  CON FRL Plans_04 - Final Plans (adv) Acrabat PDF 3
(2% o104-m167 7 - Cross-Sections %5 STA, S+00 TO 125+00 on FRL Plans_04 - Final Plans (adv) Acrabat POF 3
(% 01050208 7 - Cross-Sections € STA. 125+50 TO 245-+50 con FRL Plans 04 - Final Plans (d) Acrabat PDF 3
(2% oio7-n158 7 - Cross-Sections ¥SISTA, 245+H00 TO 350+00 con FPL Plans_04 - Final Plans (adv) Acrobat PDF 3
2 10s-017 e - Structures 135-20QFinal design Plans_Structures con L Plans_04 - Final Plans (adv) Acrobat POF 3iz
£ ol0smez & - Structures 69-125 FOQ_Structures on FRL Plans_04 - Final Plans (adv) Acrabat POF 3
-4 olieoizz 7 - Structures 9-126 FDP Mructures o o -~ 4 - Final Plans (adv) Acrobat PDF 3
-4 gii;giﬁ rd - Structures 135-304 FDP - Muictures . 4 - Final Plans (Ady) Acrobat POF 4
R ouwonns 7 Double click pepor ol
5 01164 P - - bat FOF 3t
{8 o1160123
e 7B v | on the set file berr ot
01160134 7 - Landsf H bat PDF 3z
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(% o118-0163 P Gener] bat FOF iz
(%€ 01200081 7 - Revisi Hame Descriptiol Application Ene | foatPOF £
{2F 0120-0086 7 - Civl (B Bluebeam Revu Set Bluebeam Reviyget "Ci\Program o bat POF 3j12
[ 1240162 V4 - struct bat PDF 3j1z
{2F 01240165 s - Existi bat FOF £
[ n1ze-m6z 7 - Emvir bat POF Itz
(%% 0127-0088 7 DOT_HIGH bat PDF 201
% 0130-0173 # B cTooT_TRAF bat POF it

%% 0130-0178
% 0131-0191 =

% 0131-0194 & 0131-0195
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01310198 Real (Documer v

178 01310202

T~

,,' Name
(% 01330094
U* 0133-0095
= [ 0135-0270 €F ADMINISTRA|
£ 100_Contract_Flans (FOF) € Ere-adnin
= 110_Contract_Specifications (PC € i-adnin < >
[ 120_Contracter_Submittals {FOF € cis-aamn
C i | asae
[ 210_Construction € Consutart
(= 220 Friven =ConsukantEN | ] open documert as read-only
{7 230_Contract_admiristration € crcodeChon] | e op o st of siogested corument viewers
[ 240_Contract_Development B cTo0T _Con
[ 241_Contract_Development_Cor x 00T _Eng |
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[ 340_Administration € Extraction Servics Accourt Ext... AR+ F F F ~F FF F F F -
— i [ L L L

Figure 35 - Opening a Set File

2. Next click on the Set Icon. Then select the file to remove from the set and click delete:

Set s Mew Set.bex

File Mame

01-01-General_CT_FPL_0040-0136 pdf
01-02-A2-Revisions_CT_ADP_0040-0136 pdf

Revisions_CT_FPL_0040-0136 pdf
U T-U3-Highway _AJ _ADF_DOaiHDT 36,
01-03-Highway_CT§FPL_0040-0136 pdf
01-04-Structure_A3JCT_ADP_0040-0136 pdf
01-04-Structure_CT §FPL_0040-0136 pdf

01-05-Landscaping LT _FPL_0040-0136 pdf
' Il

m

—)

Use Relative Paths
[7] Show Paths

[ Open... ” Save ][Sa\re.ﬁs... [T]

Cancel

Figure 36 - Deleting a File from the Set File
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Section 5 Digital Signatures for Contract
and Other Engineering Documents

The follow contract documents must be digitally signed when submitted to the Department in
accordance with the following section:

e Contract Plans — FDP, Addendum, Change Orders

e Engineering Reports

o Hydraulic Report
Scour Report
Floodway Report
Final Drainage Reports
Bridge Inspection Reports
Bridge Load Ratings
Task 110
Task 220
o Underground Storage Tank System Closure Reports

e  Working Drawings for Permanent and Temporary Structures — Plans and Calculations

O 0O O O O O O

This manual refers to digital signatures in two ways: certifying signatures, and signing signatures.
The Engineer of Record or document signer will always digitally sign using a visible certifying
signature. If multiple signatures are required per document, the second signer or sub-engineers
shall always digitally sign using a visible signing signature after the primary signer or engineer
has applied his certifying signature. Certifying signatures allow controlled changes, to the now
certified document. These controlled changes include; allowing PDF digital comments, and the
application of additional signatures. Signing signatures should always be accompanied by a note
listing the sheets the signer is responsible for within a subset.

In order to digitally secure a PDF document the signer(s) applies a digital signature(s) to only the
first sheet of the document, regardless of the number of pages the document contains. This
digital signature secures the entire document.

A graphic image of the signer’s signature must be created, and shall be used for the following
purposes:
e It shall be attached to the digital signature and displayed when the digital signature is
applied.
e [t shall be placed as a watermark on all contract plan sheets a particular engineer of
record is responsible for (digitally signing for).
e It shall be placed on the first sheet by the preparer and checker of an engineering
report.
e The watermark shall be placed on all contract plan sheets and all plan sheets contained
in a working drawing submittal.

A digital ID must be purchased in order to apply a digital signature. Digital ID’s must meet the
special provisions of Adobe’s Certified Document Services (CDS) or Adobe Approved Trusted List
(AATL). The necessary hardware and software needed to apply the required digital signatures
may be purchased from the vendor list provided at the following website:
http://www.adobe.com/security/partners cds.html, additional information on Adobe’s CDS is
also available at this website.

Before digitally signing any document Bluebeam must be set up as detailed in Appendix A.
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5.1 Graphic Image of Signhature

5.1.1 Contract Plans

The following figures display an example of both a state designer and a consultant designer’s
digital signatures, and their accompanying graphic image(s) of their signature(s). See Section 5.2.
for instructions on how to create a graphic image.

The consultant engineer’s graphic image must contain his companies name and address; his
signature, his Professional Engineers stamp, or his Professional Architecture Stamp. The state
employee’s graphic image must contain only his signature. See Below.

TRAFFIC - LEGENDS &
LIST OF DRAWINGS

— | 1"page of Subset

- State Design
Digital Signature

. Consultant
Digital Signature

1. 24
145 DS-0eo

Scanned Signature "Graphic Appearance”

Figure 37 - Graphic Image of Signature

In addition to a digital signature being placed on the first sheet of any contract plan, working
drawing plans, and working drawing calculations, CTDOT also requires that all subsequent pages
be watermarked with a copy of the engineer of records graphic signature before they are
digitally signed. Watermarks containing these signatures are applied using Bluebeam and are
always placed in the border of contract plans and working drawings for permanent structures.
This is to prove validation of a digital document if printed.

Watermark of State Design Graphic
Signature
SCALES 35" = 1__5--’ ' SCA
W PROJECT T
T @ OFFICE OF ENGINEERI
ATI » N APPROVED BY! ‘mTF N

Watermark of Consultant Designers
Graphic Signature

Consultant Co. A
% Address

Figure 38 — Watermarks
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5.1.2 Engineering Reports

Hydraulic, Scour, Floodway, and Final Drainage Reports

The following shows the watermarks that need to be placed on the first sheet of a Hydraulic,
Scour, Floodway, or Final Drainage Report by the Preparer and the Checker and the digital
signature of the Approved Hydraulic Engineer. The digital signature must include the graphic
image of the signer’s PE stamp and signature as shown below, Section 5.2. for instructions on
how to create a graphic image. These reports shall be digitally signed in accordance with
Section 5.6.7

May, 2014
Revised November. 2014

Prepared for:
Siate of Connecticut

Digital Signature oc.oimen of orsporiaton

J FINAL HYDRAULIC ANALYSIS REPORT
Bprirvei By Bridge No. 00145
Project No. 170-2811 (P.E.)
;ﬁ:%\ David M. Cicia State Project No. 83-261
i 2014.11.03 F.A.P. No. 0951(351)
1 “"Vﬁ" f 09:33:39-05'00' I-95 over Wepawaug River
i Milford, CT
¢ Watermarks of
Prepared By? Date: 11/4:2014
= 4 Cameron Hendry Prepa rer and
Checked By: - Date: 11/4/2014
’ David Cicia > c hec ke r

Figure 39 - Engineering Reports
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Bridge Inspection Reports

The following shows how Bridge Inspection reports are to be digitally signed in the bottom right
hand corner of the report. The digital signature must include the graphic image of the signer’s
PE stamp and signature as shown below, Section 5.2. for instructions on how to create a graphic
image. These reports shall be digitally signed in accordance with Section 5.6.7

Inspection Type: Routine and Fracture Critical

BRIDGE NO.08069R

08070 - BRIDGEPORT
MAINLINE
over
KOSSUTH STREET

Routine and Fracture Critical Inspection
5/27/2015

Inspected by:  TranSystems

Digital

SIQnature Mathew J.

Calkins, P.E.
2015.08.20
10:37:09-04'00'

Figure 40 - Bridge Inspection Reports
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Bridge Load Ratings
The following shows how Bridge Load Ratings are to be digitally signed. The load ratings shall be
digitally signed in accordance with Section 5.6.1

STATE OF CONNECTICUT
DEPARTMENT OF TRANSPORTATION

LOAD RATING

Bridge No. 00634

Silver Street

over

Route 9

Middletown

Andrew Lessard
,2018.01.02
” 16:23:28-05'00'

BY PLACEMENT OF THE PROFESSIONAL ENGINEERING STAMP AND SIGNATURE | HEREBY
STATE THAT | HAVE PERFORMED AN INDEPENDENT CHECK OF THE METHODS, ASSUMPTIONS,
LOAD DISTRIBUTION, COMPUTER INPUT FILE(S) AND ALL CALCULATIONS FOR THIS LOAD
RATING REPORT FOR THE BRIDGE NUMBER STATED ABOVE. BY STAMPING AND SIGNING
ABOVE, | CONFIRM THAT | AGREE WITH ALL METHODS, ASSUMPTIONS, LOAD DISTRIBUTIONS,
AND CALCULATIONS CONTAINED IN THIS RATING REPORT.

% Stantec

Stantec Consulting Services Inc. James Fuller
55 Church Street Suite 601, New Haven, CT 06510 12/22/2017 (203) 495-1645

Version 201610

Figure 41 - Bridge Load Ratings

Environmental Compliance Reports

The digital signature for the Task 110, Task 220, and Underground Storage Tank System Closure
Reports must include a graphic image of the Professional engineer’s signature or a graphic
image of the signer’s signature where applicable, see section 5.2. for instructions on how to
create a graphic image. These reports shall be digitally signed in accordance with section 5.6.7
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5.1.3 Working Drawings

Working Drawings for Permanent and Temporary Structures

The following shows the digital signature and Professional Engineering watermark requirements
for the engineer who prepares the working drawing submittal. These types of submittals shall
be digitally signed in accordance with section 5.6.6 Note: Working Drawing for Temporary
Structures only require that the first sheet in the submittal be digitally signed, watermarks are
not necessary. See section 5.2 for instructions on how to create a graphic image.

Working Drawing Plans

The first plan sheet in the submittal shall have a digital signature and a watermark placed on it
as shown below. All others sheets will only have the watermark. A place in the border of the
plan sheets shall have a spot for this watermark.

BEAM END PAINTING AND BEARING REPLACEMENT IN DISTRICT 2.

CONNECTICUT DEPARTMENT OF TRANSPORTATION

STATE PROJECT NO. 172-405
BRIDGE #3415 & #3416 - WORK PLAN

130020101

DRAWING INDEX

DRAWING Na. | DRAWING TITLE

COVER SHEET

130020102

GENERAL NOTES

13002.01-03
13002-01-10
130020111

JACKING PROCEBURE

PLATFORM PLAN

PLATFORM PLAN

130020112

~| Digital Signature

JACKING PLAN

130020113

JACKING PLAN

130020120

PLATFORM SECTION

13002-01-21

PLATFORM SECTION

130020122

PLATFORM SECTION

p S 130020123
llam Fratt 130020124

PLATFORM WALKWAY
STAIR CASE

4 2014.03.12
13:49:10-04'0p' 20020130
130020031

13002-01-40

JACKING DETAIL
JACKING DETAIL

CONTAINMENT SECTION

13002-01-41

CONTAINMENT SECTION

13002-01-56

CONTAINMENT DETAIL

[13002.0160
130020161

CONTAINMENT KOTES
CONTAINMENT NOTES

cantraeT e

Watermark

PAINTING A

T2, CONNEC

ND BEARING REFLACEMENT
TICUT

BEAM END
N isTRIC

o T

=

Issued 10/2017
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Figure 42 - Working Drawing for Permanent Structures
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Working Drawing Calculations
The first sheet of the calculations shall have a digital signature as shown below:

ABHE
SvosoDA
INC.

W

BRIDGE BEAM END AND BEARING REPAIR
IN DISTRICT 2
CONNECTICUT DEPARTMENT OF
TRANSPORTATION

PROJECT NO.172-405, ASI JOB NO.13002
(BRIDGE #3415 & #3416)
Calculations

William Pratt

Digital =% , .
¥ ix 14.03.1
Sighature YRy Wz

Abhe & Svoboda, Inc.
17066 Revere Way, Prior Lake, MN 5537

June 24, 2013

Ane: & Sucbada, Inc. s an Equal Opparunity Employer

Figure 43 - Working Drawing for Permanent Structures

5.1.4 Other Documents

Documents that do not require to be signed by a Professional Engineer shall have a graphic
image of the signer’s signature attached to their digital signature. See section 5.2. for
instructions on how to create a graphic image.
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5.2 Creating Graphic Image of Signature:

5.2.1 In House CTDOT or Non-Professional
Engineering Signature:

The graphic signature will be used by CTDOT employees and signers that are not signing as a
Professional Engineer.

CTDOT graphic signatures shall be created as follows:

1. Signer must sign a blank piece of paper.

2. Scan this signature.

3. Crop the image so that the image is approximately 300 pixels wide by 100 pixels high.
4. Save the images, in PDF to an area on your PC.

12 30—

Figure 44 (Example of CTDOT Graphic Image of Signature — Used with Digital Signature and as a Watermark)

5.2.2 For Consultant Staff PE Stamp:

Consultant Engineers shall create two different graphic signature images: one that shall
accompany their digital signatures and a different one that shall be placed as a watermark on all
the plan sheets the engineer is signing for.

This section shows an example of a Professional Engineer preparing their graphic image of their
signature; Architect’s shall follow this section when they are preparing their digital signature.
Graphic Appearance Attached to Digital Signature

The graphic signature that accompanies the digital signature only needs to include the
designer’s signature and P.E. Stamp., and shall be created as follows:

Stamp and Sign a blank piece of paper.

Scan this signature.

Crop the image to approximately 250 pixels wide by 250 pixels high.

Save the image, in PDF to an area on your PC or server, where you can easily access it
for later use in the signature set-up procedure.

E

Figure 45 ((Example of Consultant Engineer Graphic image of Signature — Applied to 1%t page only with digital signature)
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Graphic Appearance used as a Watermark

In addition to the designer’s signature and P.E. Stamp, the graphic signature that is placed as a
watermark shall also include the designer’s company name and address, and shall be created as
follows:

On blank paper — Print company name and address.

Place P.E. stamp next to company name and address.

Sign P.E. Stamp.

Scan the image created in steps 1 thru 3 above.

Crop the image to approximately 500 pixels wide by 250 pixels high.

Save the image, in PDF to an area on your PC or server, where you can easily access it
for later use in the watermarking procedure.

oA WN R

Consultant Co. A
Address

Figure 46 (Example of Consultant Engineer Graphic image of Signature — applied to all pages as a watermark)

Once the graphic images have been properly created and saved, the digital signature
appearance preferences must be set as follows:

5.3 Setting Digital Sighature Appearance Preferences:

Once the graphic signatures are created the digital signature appearance settings must be
defined as follows:
Bluebeam Digital Appearance
1. Make sure your CDS USB token is inserted into the computer then in Bluebeam go to the
Document tab and select Signatures>Digital ID’s:

Document Form Marup Measurs Window Help

= - o s v H % R d

t E-m= Studio Security 3

J’_’_.. Sign Document
e N E i ¥ :2 ’ 3 | X. Add Signature Field

| | : - Certify Document. ..

Documentl® = Validate Signatures

Digital IDs...

Trusted Identities...

Figure 47 - Digital Appearance
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Mathew Calkins Appearances

Location

d:\Documents and Settings\calkinemihapp
“Windows Certificate Store D

/ B (3) Double Click B

|dentity

—_ . Mathew Calkinz lzzued By: —
Starts:
= : AEC Applicati Expires:
mathew. cafins@ct gov
— iy U5
Dijafftal Signatures and Drata Encryption
o
- [ Export... (I Manage Appearances... l R
(2) Click Manage
Appearance

Figure 48 - Manage Appearances

3. Next follow the figure below:

Signature Appearance
(Trtle: Mathew Calkins| _) e Type in Name
Graphic

) Mone

Browse to graphic

@ Fie D\Usershcalkinsm)\Desktop'mjc pe jpg D ) k-
Posttion: @ Left ) Right ) Background appearance
Text -
af [ Name <
¥ %E;t;iu:h'?d Heme Alignment: @DD / Make Sure these
) Goract o | o settings are set
N~ o o L as shown
Fart Size: |9 Auto % [ Logo
Preview
<Name>
<Reason> ]
Click OK
<Date>
Co D

Figure 49 - Setting the Digital Appearance

4. Now the digital appearance will be saved and can be used to digitally sign.

Issued 10/2017 68 Version 4.03



Connecticut Department of Transportation — Digital Project Development Manual

5.4 Watermarking Plans with Graphic Image of
Signature

The Engineer of Record (Principal Engineers for State Design), for each discipline, shall place a
copy of their graphic signature as a watermark on each sheet of each discipline subset, or
working drawing submittal(Plans and Calculations) that they are responsible for. For
Engineering Reports the preparer and checker of the report shall place a copy of their graphic
signature as a watermark only on the cover of the report.

Bluebeam - Watermarking Plans with Graphic Image of Signature (CTDOT and Consultant
Designed)

There are two ways to apply watermarks using Bluebeam, see below for options 1 and 2. The
following shows an example of a CTDOT signature, but the procedure is the same for a
consultant when they are placing their PE stamp in the border or on the first sheet of an
engineering report.

Watermarking Workflow:

Option 1
1. The watermark in Bluebeam is placed using the stamp function. First go to the Markup

tab and select Stamp and then choose your stamp. If your Principal’s or PE stamp is not
in the list follow Appendix A. If your stamp is in the list go to step 2.

2. Next place the stamp in the border on the first sheet.

|\ =

Place stamp in this
area in the border ——

SLONATURE! PROJECT  TITLE:
= BLOCE

F CONNECTICUT @ OFFICE OF DNGINEERING
)F TRANSPORTATION =t

L = L=
145 Duck Pan.dgn Méf‘

Figure 50 - Placing Watermark
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3. Next right click on the stamp and select “Apply to all pages”. If you are watermarking an
engineering report you do not need to apply to all pages.

Cut

Copy

Open Pop-Up Note
Change Colors

Crder

Alignment

Edit Action
Flatten

- Comments
Lock Ctrl45hift+L .

Reply

Set Status

Chede

Add to Tool Chest
Set as Default
Apply to All Pages

Properties

Figure 51 - Placing Watermark on All Pages

If more than one group has to watermark this subset, browse to the pages the other group is
responsible for and delete the watermark. Then they can come in a place their watermark on
these sheets.
Flatten Markups

4. After the watermarks have been placed, the watermarks must be “flattened” to the PDF

document. Go to Document>Flatten Markups. Use the default settings and click OK.

Option 2

1. Go tothe Document tab and Pages>Apply Stamp.

Document Form Markup Measure Window Help

=

Insert Blank Page... Ctrl+5hift-+M

Documentl™® ; - Ctrl+5hift+

Crop Pages... Ctrl+5hift+C

Number Pages...

Figure 52 - Applying Stamps
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2. Select stamp, input scale and coordinates as necessary, and page range as shown below.

Apply Stamp
Stamp Selection
HAVE_Admin'Bluebeam Stamps*Traffic

e

Vaiy

X
ect stamp

3|

@ﬂuck Harlow brx

Name:
Author:
Size: 3.77inx058in

Date: 10/18/2011 7:23 AM

Blend Mode: |Norrna| {nong)

Opacity: (100 &l %

-

Pag;
Pages |All Pages (1-36) v Of%)

Pages Range (1-36)

Edi Stamp | [ Add Fies |

k Choose page
14 | Fle[1cf1]: State Di*ﬁﬁmﬁué'sﬁﬁtiongwr: o0

Choose scale and
4+ position

o 1<
s

1 (100

: [17.9610 Inches

Inches

[ Lock

000

Figure 53 - Applying Stamps

Flatten Markups

3. After the watermarks have been placed on the subset, the watermarks must be
“flattened” to the PDF document. Go to Document>Flatten Markups. Use the default

settings and click OK.

5.5 Digital Signature Fields

Contract Plans

Digital signature fields are form fields created using Bluebeam, and are used to house the digital
signatures. Digital Signature form fields shall be placed within the form field place holders. The
form field place holders are cells that are placed in the MicroStation file on the title sheet and
the subset cover sheets and on any Addendum or Change Order Subset. The figure below
shows a CTDOT designed project with the form field place holders (circled) on the title sheet and

the discipline subset cover sheet.

EDIT FOR
PROJECT

TITLE

rgg’é CONNECTICUT DEPARTMENT OF TRANSPORTATION ‘-’5“;
. s L.

romnie iy ot
EDIT FOR
TOWNS AND/OR
CITIES

## - SUBSET NAME
INDEX OF DRAWINGS

‘, =

= '.""Lw“ 1B o e B s o s

Figure 54 - Digital Signature Fields
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The figure below shows a consultant designed project’s title sheet and discipline subset cover
sheet with their form field place holders.

ﬁ' CONNECTICUT DEPARTMENT OF TRANSPORTATION @

REPLACEMENT OF ## - SUBSET NAME
e BRIDGE NO. 02301, ROUTE 43 INDEX OF DRAWINGS

| T = OVER HOLLENBECK RIVER -
e e s =T
s s AN

CORNWALL

~—— 0031-0128 [ _’ = ’_:";g;... -

Figure 55 - Consultant Watermarks

Place holders determine the location and size of the digital signature form field.

Form field place holding cell library: CT Digital Sigs.zip

The digital signature place holder and form fields shall be created on the first page of each
discipline subset for each required digital signature.

Note: All signature form fields need to be created for both certifying and signing signatures
before any digital signatures is applied to the document.

Contractor Submittals
Contractor submittals will not be required to have a digital signature place holder.

Engineering Reports
Engineering reports will not be required to have a digital signature place holder.

5.5.1 Bluebeam - Creating Digital Signature Form
Fields

The following example shows how to place the (3) digital signature form fields on the 01-
General title sheet of a CTDOT designed project. For a discipline subset or a consultant designed
01-General title sheet, only one digital signature form field needs to be placed.

1. Gotothe Document tab and select Signatures>Add Signature Field.

Document Com Markup Measure Window Help

WA I d % hined BSB

Print E-ma

0% i NE & * AddSanatreField X

| |
Al-- |?-| 4 Documentl*

s Digital IDs...

Trusted Identities...

Figure 56 - Adding Signature Fields
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2. Next place three signature fields in the appropriate location and hit save as shown
below:

THE DESIGN APPEARS TO COMNFORM TO APPLICABLE CRITERIA. APPROVAL IS
NOT TO BE CONSTRUED TO MEAM THAT ALL ASPECTS OF THE DESIGN HAVE
BEEM PERSONALLY CHECKED BY THE UNDERSIGNED.

SUBMITTED BY TRANSPORTATION PRIMCIPAL ENGINEER P.E.
(>

WPPROVAL RECOMMENDED BY MANAGER OF STATE DESIGN - SCOTT A, HILL P.E.
[

APPROVED TRANSPORTATION ENGINEERING ADMINISTRATOR - JAMES H. NORMAN P.E.

Figure 57 - Placing Signature Fields

5.6 Applying Digital Signatures
This section describes how to apply digital signatures for contract plans, engineering reports,
working drawing plans, and working drawing calculations.

Contract Plans
Contract plan discipline subsets 01-General and 02-Revisions and the Highway and Traffic
Standard drawing subsets have unique requirements as described in the following sections.

CTDOT projects shall have their discipline subsets digitally signed after they have been uploaded
into projectwise because the Principal Engineer will be looking in projectwise to digitally sign
documents.

Discipline subsets designed by a single engineer shall be digitally signed, by the engineer of
record, using a single visible certifying signature, applied to the signature form field located on
the first page of each subset.

Discipline subsets designed by multiple engineers shall first be digitally signed by the Engineer of
Record who is responsible for the most sheets in the subsets. This engineer will apply a visible
certifying signature in the top most form field. The next Engineer of Record shall apply their
signing signatures in the subsequent form fields. This Engineer shall also include a reason, when
applying their digital signatures, listing the pages they are responsible for.

Digital signatures must be applied to digital signature form fields, previously. See Section 5.5
Engineering Reports

Engineering Reports shall be digitally signed, by the Engineer of Record using a certifying. See
Section 5.7 for instructions on how to apply a certifying signature to an engineering report.
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5.6.1 Applying Digital Signatures to 01_General
Subset (FDP and Addendum Subsets)

CTDOT DESIGNED PROJECTS:
The following procedure applies to both the 01_General subset at FDP and any 01_General_A#
subset.

The project title sheet of the 01_General subset shall first be digitally signed by the lead
discipline’s Principal Engineer, using a certifying signature. The Principal Engineer should make
sure that all three digital signature form fields (blue boxes in the signature block) are placed
before signing, as these forms cannot be added after the document is digitally certified. After
processing has approved the 01_general subset for Advertising, the Manager, and the
Transportation Engineering Administrator shall digitally sign the same sheet directly below the
principal’s signature, using a signing signature while the plans are in the Manager and Engineer
Admin. Sign state.

Processing shall notify the lead designer when the 01-General subset is placed in the Manager
and Engineer Admin. Sign state. The lead designer shall then coordinate the digital signing by
the Manager and Engineering Administrator of the 01_General subset. When both signatures
are applied to the plans, the lead designer shall then notify processing that the 01-General
subset has been signed.

See Section 5.7 Applying Digital Signature Workflows

Note: When digitally signing the 01_General subset all signers shall leave the reason code
blank.

The following image shows a typical project title sheet from the 01_General subset that is
digitally signed:

ifi CONNECTICUT DEPARTMENT OF TRANSPORTATION (ﬁ\
upsasoe =
OF
SIDEWALK RAMPS

NEW HAVEN

I[] o0s2-0855 [

THE DESIGN APPEARS TO CONFORM TO APPLICABLE CRITERIA. APPROVAL IS
NOT TO BE CONSTRUED TO MEAN THAT ALL ASPECTS OF THE DESIGN HAVE
BEEN PERSONALLY CHECKED BY THE UNDERSIGNED.

% ’ /

e e Leo L. Fontaine Visible Certifying Signature
X A s 2012.04.03 11:59:18-04'00"

7

SUBMITTED BY: TRANSPORTATION PRINCIPAL ENGINEER - LEO L. FOUNTAINE P.E

James A. Fallon

%) i :/ \J&A.A_ 2012 04.04 08:54:35-04'00" Visible Signing Signature

APPROVAL RECOMMENDED BY: MANAGER OF - JAMES A. FALLON P.E

4 James H. Norman =

2012.04.04 09:58:05-04'00' Visible Signing Signature

APPROVED BY: TRANSPORTATION ENGINEERING ADMINISTRATOR - JAMES H. NORMAN P.E.

Figure 58 - Title Sheet Digital Signatures
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CONSULTANT DESIGNED PROJECTS:
The project title sheet of the 01_General subset shall be digitally signed by the lead consultant,
using a certifying signature.

See Section 5.7 Applying Digital Signature Workflows

CONNECTICUT DEPARTMENT OF TRANSPORTATION 5

Plans For

REPLACEMENT OF BRIDGE No. 02973
Uus.1

M A5 S ACHUSE
BISTRICT & DISTRICT 1

OVER PATTAGANSETT RIVER

TTs
DISTRICT 2

Town(s)/City of /
EAST LYME

ROAD RESPONSIBILITY LENGTH
= B T TEE

LOCATION

OF PROJECT

MAINTENANCE
F.AP. # RESPONSIBILITY _ PROJECT #
- D

HIGHWAY CLASSFICATION URBAN MNOR ARTERIAL LOCATION PLAN
DES( ) 35 mPH A
0

AVERAGE DALLY TRAFFIC (2013} 1,700

0 DESIGN SPECIFICATIONS,
CONMECTICUT DEFARTMENT OF TRANSFORTATION "BRIDGE DESIGH MANUAL, 2005

AWGE ORDERS.

LIST OF DRAWINGS JR— i o
SUBSET 01 - GENERAL i REPLACEMENT OF BRIDGE No, 02073

i
OVER PATTAGANSETT RIVER

FounistTur
EAST LYME

2015.12.07
DB36:10-0500°

L Gl
| o04s-0148 |

Figure 59 - Consultant Designed Title Sheet

When more than one consultant works on a CTDOT digital project the project manager (prime
consultant) shall apply a visible certifying signature to the first page of the 01_General subset.
By applying this signature the prime consultant is accepting responsibility for the entire set of
digital contract plans. However the individual subsets shall be signed by the corresponding
firms.

Note: When applying certifying or signing signatures leave the reason code blank.
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5.6.2 Applying a Digital Signatures to 02_Revisions
Subset

This section applies to both CTDOT designed projects and Consultant designed projects. The
figures contained in this section show a CTDOT signature, but the workflows are the same.

This subset does not need to be signed at FDP. This subset must be signed when the sheet
is filled out for an Addendum or design initiated change order, whichever comes first.

The first index of revision sheet(s) located in the 02_Revisions subset shall be digitally signed
by the lead designer, using a certifying signature.

1. The lead designer shall apply a certifying signature as described in section 5.7 Applying
Digital Signature Workflows with the following EXCEPTION; the option “No Changes
Allowed” must be selected to eliminate unauthorized changes after certifying the
document. See the figure below:

Drigital 10 |
|Mattl:a|kin$ VH Wigw. ][ Mew. ] [

Pazsword:

Signature Type
() Digital Signature
(%) Document Certification

ermitted changes after certibying:
| Mo changes allowed w [

b —F

Optionz
Reazon: | v|
Location: | |
Contact Info: | |
Appearance I
|StandardTe:-:t v” Edit... H Mew... ] II
|
<Name>
T .
Haar f 9 < ocation>
<Date>
l OF. ” Cahcel ]

Figure 60 Certifying Dialog Box for 02_Revisions.pdf
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5.6.3 All Other Discipline Subsets - Single
Signature

This section applies to both CTDOT designed projects and Consultant designed projects. The
figures contained in this section show a consultant signature, but the workflow is the same.

Each discipline subset shall be digitally signed with a visible certifying signature, by ONLY the
responsible design engineer. As shown below.

See section 5.7 Applying Digital Signature Workflows

: Wiy, -
DECONSULTANT COMPANY NAME \\2’\(\8 29""8(,;’/,, William Pratt
~' . 8. "Rf* e
S 2Ol
SETHRSEZ 2009.01.27
="' '

~

w

= No.‘sw';;&es 10246:19
7 REEREE AN _0<'00"
s 0500

Figure 61 CTDOT Certified Plan Subset

5.6.4 Standard Drawing Subsets - Single Signature

This section applies to both CTDOT designed projects and Consultant designed projects. The
figures contained in this section show a consultant signature, but the workflow is the same.

Only the standard drawing subset index sheets, Highways and Traffic Standard Drawings, need

to be digitally signed with a visible certifying signature, by the responsible design engineer that
submits the subset to Projectwise. For example, in the case where the Traffic unit is submitting
a Highway standards subset, the Traffic Principal Engineer is responsible for digitally signing the
index sheets, not the Highway Principal Engineer.

See section 5.7 Applying Digital Signature Workflows

5.6.5 All Other Discipline Subsets — Multi-
Signatures

This section applies to both CTDOT designed projects and Consultant designed projects. The
figures contained in this section show a consultant signature, but the workflow is the same for
CTDOT designed projects.

Multiple signatures per a single subset are required where two or more disciplines/firms are
responsible for one subset.

The lead designer that is responsible for most of the pages within a discipline subset shall
digitally sign the subset using a certifying signature, and leave the reason code blank. See
Section 5.7 Applying Digital Signature Workflows

Once certified by the subset lead, the remaining designers(s) shall digitally sign the same subset
using a signing signature, and complete the reason code with a note stating which pages,
contained in this subset, that they are responsible for. See table 2-1 below:

See Section 5.7 Applying Digital Signature Workflows
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Table 1 Reason Codes for Prime and Sub

Consultants

Designer Certify or Responsible Reason Code
Sign Sheet
Numbers

Lead Designer Certify
Sub-Designer 1 Sign 03.78 Thru | am Signing for Sheet Nos. 03.78 thru

03.88 03.88
Sub-Designer 2 — Sign 03.88 Thru | am Signing for Sheet Nos. 03.88 thru
etc. 03.98 03.98

5.6.6 Working Drawings

Working drawing submittals shall be digitally certified in accordance with section 5.7 Visible
Digital Signature using a Certifying signature, of this manual.

5.6.7 Engineering Reports

Engineering Reports shall be digitally signed, by the applicable person using a certifying. See
section 5.7 for instructions on how to apply a certifying signature to an engineering report. Ifa
report needs to be digitally signed by more than one person, the first person must apply a
certifying signature as shown in section 5.7 and any subsequent signature will be a signing

signature as shown in section 5.7.

5.6.1 Bridge Load Ratings

Load Ratings shall be digitally signed, by the applicable person using a certifying signature with
the No Changes Allowed option selected as shown below:

P

Dvigital 10:
M att Calking
Password:
LI LIl LLLL}
Signature Type
() Digital Signature

(%) Document Certification

‘ermitted changes after certibing:
Mo changes allowed

Options
Reazon: g
Location:
Contact Info:
Appearance
Standard Test -
~ <Name>
Hitar f 95 <[ ocation>
<Date>

Issued 10/2017

Figure 62 Certifying Load Ratings
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5.7 Applying Digital Signature Workflows

This section applies to both CTDOT designed projects and Consultant designed projects. The
figures contained in this section show a CTDOT signature where the document is located in
Projectwise, but the workflows are the same.

Certifying Signature:
1. Leftclick on the signature field and then update the settings as shown below. Examples
below are for a CTDOT designed project’s title sheet and the first sheet of an
Engineering Report:

Discipline Subsets

Select your ID and
select as shown

V

0 Type -
O Diptal Sionature
]

Click on the signature
to certify

' Mado.0s M informs. and SOt signatures v }

Optiors

Contact info.

==

Mathew Calkin

bs
%’42 2011.10.18 10:

38:10-04'00

(Gous]

{4PPRONAL WECOONCD BT WAwaEh F STATE DEGHN - G011 & WLl PL.

TN DGDETARG Ads TPTIR - IS 1o W 71

Figure 63 - Certifying Discipline Subsets

Engineering Reports or Documents that Require (1) Digital Signature

FINAL HYDRAULIC REPORT

FOR SOUTH MAPLE STREET BRIDGE
OVER SCANTIC RIVER

(Bridge No. 03972)

Enfield, Connecticut

PREPARED BY: Tectonic Engineering & Surveying Consultants PC

March 8, 2010 .
Prepared By: Pl - Lkl Date: 1/21/14
Mathew Calkins C“ck on the
Checked By: Py Date: 1/21/V ; .
) iliam Pratt signature field
an -
to certify

Figure 64 - Certifying Engineering Reports
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2. Next for document in located in Projectwise click Projectwise V8i as shown below and
then click OK. If the document is located on your computer click My Computer list
below:

ocation

ctdot projectwiseonline.com:CTDOT Logged In

Login [ oK ”Cancel]

Figure 65 - Certifying Signature

3. Then select yes to overwrite existing file as shown below for projectwise or if the
document is located on your computer overwrite the existing file or save to a new
location:

ProjectWise Overwrite File

The file TT_DOC_PUE__Intro to Bluebeam pdf” already exists
A in ProjectWise.

Do you want to overwrite. Select ‘Mo’ to save as a new
filemame.

Yes Mo ] [ Cancel ]

Figure 66 - Certifying Signature

4. |If using Projectwise check the document back into Projectwise.
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Digital Signing Signature:

Once the prime engineer applies his certifying signature the additional signing signatures can be
applied by the sub-consultants as follows:

1. Left click on the signature field and then update the settings as shown below:

I
Select your ID, a reason

if necessary and select

Click on the | == as shown

/ signature

A\

e ocs Am TO COMTCAR TO APRICAMERATTERIA. APPROVAL 15
MLAN THAT ALL ASPEC THE OESIGN MAVE

u!w ’t!x-uu (u: !: L3 'n: UNDER SIOME:

' Calkins
20 10.18 10:40:43-04'00

SN IED 81 TRACTONTAT KN MIOCIR. DENL

Mathew Calkin

3
1%2&-:2011.10.13101

40:46-04'00'

A AN [ T

Figure 67 - Signing Signaure Bluebeam

2. Next for document in located in Projectwise click Projectwise V8i as shown below and
then click OK. If the document is located on your computer click My Computer list

below:

Save To

Logaged In

e Vi c:tdc-t projectwiseonline com:CTDOT

il| ProjectWis

(o] (oo

Figure 68 - Open from Projectwise
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3. Then select yes to overwrite existing file as shown below for projectwise or if the
document is located on your computer overwrite the existing file or save to a new
location:

ProjectWise Overwrite File

Thefile TT_DOC_PUE__Intro to Bluebeam pdf” already exists
A in ProjectWise.

Do you want to overwrite. Select 'No’ to save as a new
filename.

Yes Mo ] [ Cancel ]

Figure 69 - Overwriting a File

4. If using Projectwise check the document back into Projectwise.
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Section 6 Submitting Documents to CTDOT

This section details the procedures for submitting documents to Projectwise.

6.1 FDP Submittal to Processing

The files required to be submitted to Processing must be added to the set file stored in the
240_Contract Development folder as shown below. The set file creates a link to the document
so documents can be stored in separate folders, but show up together. When files are added to
a set file they are not moved, a link is created.

If there is not a set file in the 240_Contract Development folder in Projectwise contact
DOT.AECapplications@ct.gov or follow these steps to create a set file in the 240 Contract
Development folder:

1. Right click on the 240 folder, right click in the white area and select properties.

2. Then select Set>New

e Lapy uut

[ 160_Project Photos

[ 170_ROW and GIS Files Export...

| 210_Construction Import

L 20 FHWA Start Studio Session...

10 230_Contract_Administration ( )

{7 240_Contract_Development xport Dependency Map(s)...

Pt Comiract —Eomitllential e

i 310_Review_Documents ! BI'OWSG Out tO the
L7 30% Review Update Server Capy
I 0% Revien o o o 240 folder and then
7 0% R : 1 P
7 S0% Review Purge Local Copy right click in the
{7 320_Permit_Applications N
L7 330 Desgn Date P lerees white area, select
-7 _Projectdata Cut 1
L DOT Corfidentis < cons properties, Set>New
- ¥
tf Enw‘r:nmental_manmng Project Prope . [ Access Contro\l
- Facilities s |
- [ Propertie]
I Highway_0
t H::hx:;; b GENERAL Copy To.. 0051-0269
T Hydrauiics GENERAL  MoveTo..
-7 Landscape GENERAL Rename...
~{_" Maintenance GENERAL Delete
= Public Trans GENERAL Route 1773t
I Rights.of Way GENERA|  DMSconform * MINOR INTE
O seils GENERAL Modify... Major interse:
I Structure_Bridge GENERAL Modify Spatial Attrib N
AT Traffic GENERAL - petete Audit Trail PERW.CN
= Utiies GENERAL o oot 03_Final-Des
- - GENERAL oy
I Visuslization

[ 500_Pre_Design GENERALE  get 3 New.

@ Saved Searches GENERA e v Toaiy.. cTooT
1% 00510270 LOCATIO : Famington
i oostozrs LOCATIO Copy List To » Content 0770004
2% 00510273 LOCRTION [t T 00000000

Figure 70 - Creating a Set File
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After the file is created populate the set file as follows:
1. Open the Set file by double clicking on it.
2. Then browse out the folder where the documents are stored.
3. Then drag and drop the document(s) into the set file window as shown below:

ot projectwiseonline com: CTDOT\Documents\01.0 - Projects - Active\test\140_Project_Administration = [B* Go

| Label (User Defined)  Description Application File Updated Discipline State Document Date (m... Format
£4 | Cat Ex Acrobat PDF 7/28/2017 1:19:45 PM  HW 140_Project Admini...

[ | 240_Contract_Development - Documents for Processing = (==
|| Lockto Version  Label (User Defined) Description Applicati
B /B Set File Place Holder Tedt
Drag document(s)
57 into the set file
plate_Jan 2011 <
| Document Properiies | Project Propeties | Folde]
= Properties (Project Type - CTDOT Trany

GENERAL - Project Number(s)

GENERAL - Projects Inherited

GENERAL - Contract Number < ] b

GENERAL - Program Number
ns (PDF) GENERAL - Project Title
-uments GENERAL -CTDOT Improvement Type
ubmittals (PDF) GENERAL - General Description
sring_Reports GENERAL - Federal Proj Oversiaht
Reports_Confidential GENERAL - Phase Types Included
inistration GENERAL - Project Cument Phase
inistration_Confidentia GENERAL - Project Scope Code
nistration Corresponde GENERAL - TIF/STIP Stalus

FEMEDA Adiomtinnd B

Figure 71 - Adding Files to the Set File
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6.2 Uploading Documents
6.2.1 ProjectWise (Thin Client)

The following shows how to upload Contract plans into the 100 Contract Plan folder in
Projectwise, but this procedure can be followed for uploading documents into any folder in
Projectwise.
1. Once logged into Projectwise browse out to project and folder you need to upload into.
Then go to View>Interfaces and select the “CTDOT_Doc_Code” Interface.

Correspondance
/O Bridge_Data
Main Category
Folder Docu Oools Helj Sub Category 1
A Views » Disgiglios
» I
] Label (User DE‘in(
I J} Refresh
O - Touwn ‘roperties are updated nightly 1
O CTDOT_Project_Information
Label_Lookl)
O . P
Misc_PullDown
0 |
CTDOT_Doc_Code_Plus
O
CT_Doc_Xfer
O
CTDOT_Attributes(In Development)
O
Research
O

Research Label

Figure 72 - Selecting the Interface
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2. Next select Document>Upload as shown below:

Advanced search options

§—; ctdot.projectwiseonline.com:CTDOT

@View Tools Help

o Mew...

)

E | Documents

B " 01.0 - Projects - Active

B [ g 0001-0100
& (T pg 0001-0999
(| 100_Contract_Plans (PDF)
L 110_Contract_Specifications_&_Permits (PDF)
[ 120_Contractor_Submittals (PDF)
o 130_Final_Engineering_Reports
121 Engineerina Reports Confidential

Figure 73 - Uploading Document into Projectwise (Thin Client)

3. Next browse out to the document you want to upload.

No content available to display.

/2 Choose File to Upload =
(L)~ M pesicop + <[ %5 |[ search

Upload file X

Cancel

e v New folder

»

Name

%] Pages from 03-Highways CT_FDP 0043-0128.pdf )
Conndotsppwep. Zip
& Digitel_Project_Develgpment.pdf

451 Favorites

@& Creative Cloud Files

B Desktop
i Downloads
e - /% 76193 30 Model.dgn
Browse out to the @] Projectwise Bridge Pildh.docx
_ &) Paper Plan Order Form CT Misc_.pdf
file to upload and [#) 2015-2-EC pef
. | reportlan
click Open ) nqeementss
B Videos ) 2015-06-19_PW_Impor] Rail - Copyads
[1: P FE P T g =
- ([ . ‘P »
rojectwise Properties File name: Pages from 03-Highways CT FDP 0043- + |AlLEile -

o content available ta display.

Cancel

Figure 74 - Uploading a File to Projectwise
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4. After the file uploads, right click on the file and select Properties:

Folder Document View Tools Help

A — — —

|T-J Py & rd E

H Label (User Defined) Description

il Pages fron
B View

Right Click on the
file and select
Properties

&} Download...

uu‘ Export...

More...

Change State »

$ Copy Link(s) ]
_n Delete
v

ProjectWise Properties

No content available to display.

Figure 75 - Select Properties

5. Then assign the applicable attributes from the tables in Projectwise Attribute Table: If

you cannot assign attributes, the interface was not selected as detailed in step 1 or this
section.
ProjectWise Properties

4

General Document References Audit Tra*!
— Select these
Discipline o~
cT =l attrlbutes

Main Category Main Categaory Des

con [=]

Sub Category Sub Category Description

{

Project Number{s)

D001-0933 | ( -
abel (User Defined) Document Date (mm/dd/yyyy) *H'--_ Type in these
|04 - Bridge El -
Descriintion ' _ ! attrl butes
Eridge Plans | x
L 4
= X
ESSOT fset Sage Select these
Bridge No(s) Building No(s) ) i
poots B | | asset attributes
Signal Intersections Route_No E .
_ = 1 if necessary
Sign Structures

= ( v

Click Save J-—*

Figure 76 - Thin Client Attributes
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6.2.2 Uploading Documents — Projectwise (Thick
Client)

The following shows how to upload Contract plans into the 100 Contract Plan folder in
Projectwise, but this procedure can be followed for uploading documents into any folder in
Projectwise.

1. Select the Interface “CTDOT_Doc_Code” as shown below, if the interface box is not
shown go to View>Toolbars and select interface.
2. Drag and Drop files into the correct folder in the Project.
@ B0 S| EE @
84 - [seach D V| B> | ((ertece [c00T Do cCoge ]

AddrESS‘ pw:\\ctdot. projectwiseonline . com: CTDGT\Documents\11 - CTDGT Projects\0310_0062\100. CoRTacT Flans (POF)\
= | ¥ ConnDOT (mjc-admin) ~ List |. Geospatial

=" Documents
5 [ 01- CTDOT Projects Label {User Defined)

(%% 0015_0335 ,/’EDI.DI-GEnera\

L_?c 0017_0183 /" /- 01.02-Revisions

% 0034_0334 # "2 01.03-5tation_Plans

[* 0040_0136 A" 01,04Environmental .

(1% 0036_0309 ZTorosamirak Force (1) MaKe sure the interface
[* 0063_0543 & 0093_0180 # T coT_tighway SO j§ "CTDOT Doc Code"

1% 0o63_08672 # ") CTDOT Traffic_STD - -

L% 0079_0230
[ 0082_0299

{1 0084_0106

[/ 0083_0178 & 0093_0166

[ 0092_0531-0622-0627

[** 0092_n532

| 0092_0813

[** 0092_0834

|/ 0092_0833

(%% 0107_0158 (2) Select Project folder and

(£ ows o178 " then 100_Contract Plans

% 0110_0128 =

1% 0138_0221 folder

% 0138_0232

[ 0150-0126

%% 0152_0148

/% 0153_0207

[ 0166_009%

[** 0170_2296

|/ 0300_0138

[* 0301_0059 o

[%* 0301_0106 (3) Drag and drop discipline
£

[ 0301_0125 subsets

|/ 0301_0140

{1 0310_o038

|/ 0310_0056

% 0310_0057

[ 0310_0058

1% 0310_0058

9

= 0310 006

|’ 100_Contract_Plans (PDF)

L' 110_Contract_Spedfications (PDF)
120_Contractor_Submittals {PDF)
130_Soil_Archaeological_Misc_Reports (PDF)
210_Construction
220 FHWA
230_Contract_Administration
240_Contract_Development
241_Contract_Development_Confidential
310_Preliminary_Design_Documents{PDF)
320_Permit_Applications £
330_Design_Data

e

;

=3}

HHHHHHTEHTE

=

Figure 77 - Uploading Into Projectwise (Thick Client)
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3. Select the “Advanced Wizard”
4. Click “Next” until you reach the figure below:

5. Then assign the applicable attributes from the tables in Projectwise Attribute Table: If

you cannot assign attributes, the interface was not selected as detailed in step 1 or this

section.

Advanced Document Creation Wizard x|

Define Document Attributes

“ou should define environment specific document attributes. ‘/—\,\.
VAl
Discipline
fer = % Select these
Main Category Main Categary Description attributes

ICDN j ICDnlract Planz & Specs
Sub Category Sub Category Description

|F'Ians_02 - Final Design Plans

Project Mumber{s)
| 0004-0116_0004-0118

Label (User Defined)

Type in these

Description attrlbutes

Title Sheet and Detaled Estimate Sheets

CT Code (Auto Fill In;
| CT_CON_FDP_0004-0116_0004-0118_01-General

CTDOT Asset Tags
Bridges Sign Structures

| 01456; 01654 J [20010:20156 J

asset tags

Signal Intersections

I [

_+— Click Next
< Back m ancel |

Figure 78 - Attributing (Thick Client)

6. On the Document Properties page nothing needs to be edited.

Projectwise.

&+ Select the correct

On the create document page click next and the document will be uploaded into

8. Once the document is uploaded the user may need to click F5 (refresh) to see the file
name update.
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6.3 PDF Checker - Contract Plans

The Discipline Subset PDF Checker software was developed to check that Contract Plan
Discipline Subsets are formatted and delivered to CTDOT correctly. This checker replaces the
old requirements of attaching the discipline subset checklist to each subset and stamping each
subset with the green QA/QC stamp. These two things are no longer required.

This checker is an add-on to Projectwise Thick Client and can only be run using Projectwise Thick
Client. See Section 6.2.2 for the typical workflows for using the PDF Checker. This section
provides details for Projectwise Thin Client users.

The following details what is checked with this software:

(1) CAD Requirements have been completed correctly:
a. Page Size (see Section 4.2)
b. Searchable Text (see Section 4.2)
c. Levels (see Section 4.2)

(2) PDF post processing steps have been completed correctly:
a. Page labels (see Section 4.14.2)
b. Sheet numbers (see Section 4.14.2)
c. Watermarks and flatten comments(see Section 5.4)
d. Any digital signature fields (see Section 5.5)
e. Digital Signature (see Section 5.6)

(3) The subset was uploaded and attributed correctly in Projectwise.

After the PDF checker is run, an Excel report is created detailing what is incorrect on each
subset. Things that are incorrect will show up red and include a note on what is incorrect. Also
an attribute in Projectwise call Format Compliance will be set to PASS or FAIL when a document
is run through the checker:

+ [F 0w [@ Geospatd] ——
Label (User Defin;d] Description Document Date (m... Application State r Format_Compliance aJtto
# B 01- Title Sheet Title Sheet Acrobat PDF DOCUMENT TRAMSF..§  PASS
/E 02- Revisions Revision Sheet Acrobat PDF DOCUMENT TRAMSF..J PASS
/E 03- Supporting Docume...  Supporting Documents Plan Sheets Acrobat PDF DOCUMENT TRAMSF..J PASS
# B 04- Civil Civil Plan Sheets Acrobat PDF DOCUMENT TRAMSF..§  PASS
/E 05- Architectural Architectural Plan Sheets Acrobat PDF DOCUMENT TRAMSF..J PASS
/E 06- Structural Structural Plan Sheets Acrobat PDF DOCUMENT TRAMSF..J PASS
/E (07- Fire Protection Fire Protection Plan Sheets Acrobat PDF DOCUMENT TRAMSF..J PASS
/E 08- Plumbing Plumbing Plan Sheets Acrobat PDF DOCUMENT TRAMSF..J PASS
/E 03- Mechanical Mechanical Plan Sheets Acrobat PDF DOCUMENT TRAMSF..J PASS
# BI10- Electrical Electrical Plan &' tt TR DOCUMENT TRAMSF..§  PASS
/all-EnvirnnmEntal Environmental | Format c°mpliance :_M” FAIL
# Bl CTDOT Highway_STD Highway Stand: F DOCUMENT TRAMSF..§  PASS
# B CTDOT Traffic_5TD Traffic Standard Att ri bute F DOCUMENT TRAMSF..{ PASS

Figure 79 - Format Compliance Attribute

The PDF checker must be ran on all discipline subsets that are submitted to CTDOT, which
includes the following submittal types: FDP, DCD, DCD2, ADP, ACD, or DCO submittals.
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6.3.1 Installing the PDF Checker

This is step is for consultants only, DOT staff already have the checker installed.
1. Download the PDF checker executable from this link: Discipline Subset PDF Checker
2. Close Projectwise if it is open.
3. Run the executable.

6.3.2 Typical Workflow for using the PDF Checker

CTDOT Designed Projects
The following details the typical workflow for a CTDOT designed project.

1. Each discipline prepares their subset(s) and uploads their unsigned subsets into
Projectwise in accordance with this manual.

2. Then the PDF Checker is run on the unsigned subset(s). By running the checker on the
unsigned subsets, any errors can be found before the Principal digitally signs. Note: An
error will be returned that a signature was not found and the Projectwise attribute will
show FAIL.

3. Ifthere are any other errors, other than the signature error, they shall be fixed. If the
only error in the report is the signature error, then the plans can be digitally signed by
the principal.

4. After the plans are digitally signed, run the PDF Checker again on the subset(s) to check
the digital signature was applied correctly. If there are no errors then the check is
complete. If there are any errors they shall be fixed and the PDF Checker rerun.

5. The project lead should check in Projectwise that all subsets have PASS in the Format
Compliance attribute column.

6. The Processing unit will be looking for the Format Compliance attribute column to be
set to PASS before they process the subset.

Consultant Designed Projects
The following details the typical workflow for a Consultant designed project:

1. Each consultant prepares their subset(s) and uploads their subsets into Projectwise in
accordance with this manual.

2. Then the PDF Checker is run on the subset(s). If the consultant or sub-consultant does
not have Projectwise Thick Client, contact your CTDOT Consultant Liaison or the lead
consultant on the project to run the PDF Checker on those discipline subsets. Any error
shall be fixed and the checker rerun until the report does not have any red errors.

3. The CTDOT Consultant Liaison or the lead consultant should check in Projectwise that all
subsets have PASS in the Format Compliance attribute column.

4. The Processing unit will be looking for the Format Compliance attribute column to be
set to PASS before they process the subset.
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6.3.3 Using the PDF Checker

This software has the capability to check one subset at a time or multiple subsets. The
following shows how to check multiple discipline subsets, but the procedure is the same for
checking one subset.
1. Log into Projectwise.
2. Browse out to your project and open the 100_Contract_Plans folder.
3. Select a discipline subset(s) or all the subsets, right click and select DMSconform>PDF
Check. Hold control or shift to select multiple subsets.

- b EVie‘w[Dacument v] EInterface[C{Do‘[ﬁDogCode

MNDocuments\01.0 - Projects - Active’0077-0234'100_Contract_Plans I + > Go

List |. Geospatlall
Label (User Definea) Description Document Date (mm/dd/yyyy) Application

e a 01-General

MNew 3 Acrobat PDF|

/. 02-Revisions Acrobat PDF|
Wd 03-supporin| Open Acrobat PDF
PP
P4 - |04-Demoalitiol Open as Read-Only Acrobat PDF|
/‘ 05-Civil Open With... Acrobat PDF|
7 . 06-Mechanici Markup Acrobat PDF
rd ‘ 07-Electrical View 9/14,.'015 12:00:00 AM  Acrobat PDF
Check Qut
CheckIn
Free
Copy Out
Export...
o Select all subsets,
Stort Studio Sesson. right click and select
Export Dependency Mapi(s)...
DMSconform>PDF Check

Import Dependency Map(s)...

Update Server Copy
Refresh Local Copy
Purge Local Copy
Purge Workspace

Cut

Copy
Paste...

Copy To...

Move To...

Rename...

Delete

DMScenform

Moﬂy...

Modify Spatial Attributes...
Add Comment

-

PDF Check |)

Set 3
Send To 3
[P Copy List To >

Figure 80 - Selecting the Subsets and Running the Checker

4. Click OK on the dialog box shown below:
ContrelCAD Check Drawing & Attributes @

01 -General_CT_FDP_0032-0130.pdf
03-Highways_CT_FDP_0032-0130.pdf

04 Structures_CT_FDP_0032-0130.pdf
05-Traffic_CT_FDP_0032-0130.pdf
06-Tlumination_CT_FDP_0032-0130. pdf
07-Environmental_CT_FDP_0032-0130.pdf

TOTAL 6 PDFS

Co ) o ]

Figure 81 - PDF Checker
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5. After the PDF Checker runs click Yes Report on the dialog box shown below. Note: The
PDF Checker may take a few minutes to process depending on the size of the files it is
checking.

ControlCAD EX

Report complete. Open in Excel?

Figure 82 - PDF Checker Report

6. Inthe report, errors will show up in red and if you hover over a red piece of text it will
show the details of what is incorrect. If any false errors show up in the report, please
notify DOT.AECApplications@ct.gov with the project and document(s) you are having
issues with. Example of false errors could be the page labels were applied to the subset
but the report details they were not.

611 - £ | incorrect

A | B c
CTDOT CONTRACT PLAN QA REPORT

0 E F G H J K L M N o P Q R s

1
2 01.0 - Projects - Active/0032-0130/100_Contract_Plans (PDF) T 1] I I T | | | T | | I ]
3 I “ormat Checks ProjectWise Attribute C|
4_Tabel [Document ame Wodiied Type Description NoPages Sheet S\xeflgﬂ:\ue Searchable Layers _Flattened lPige Labels [Engineers Stamp |Drscipi Cat [Sub Cat [ AssetLabel [Bridge No|Signal in|
5 07 General CT_FDP_0032.0130 pol 7172015 10.3 [pol_JGeneral Plans FOP____ 14 C CoN P |none_ ank___[bank__|
7 [03Fhghways CT_FOP 0032-0130 pdl 73072015 116 5 [pof Jrighway Pians FOP 7 c con none ) ani
8 04 Structures CT_FDP_0032-0130 pal 19.21 PM_[pal JStructural Plans FOP 134 C coN__|Fi [none lank__[blank |
9 105-Traffic_CT_FDP_0032-0130.pdf 5047 pdf |Traffic Plans FDP 1 C CON FDP [none lan blani
A CT_FDP_0032-0130 pdf /12/2015 12:17 4. M [pdf lllumination Plans FDP [Sheet Size must be 34°x22° C CON FDP [none lani blank |
CT_FDP_0032-0130.pdf |4/28/2015 12.4152 PM |pdf Plans FOP Olp1 i 36"x24", p2 I 36"x24", p3 i 36"X24", p4 s C CON P__|none ani [bian
367x24", p5 15 36™24" |
|

Report created by calkinsm] N
| ControlCAD version 3784 |
T .

| I I | | | I

PDF Format Checks

No.Pages Sheet Size Signature Searchable Layers Flattened Page Labels |En

4 Incorrect  |OK OK Not Found |OK 01.01-01.04 |Inco

57 Incorrect  JOK Incomplete |Not Found |Comments]03.01-03.57 [Inco
> 14 Incorrect  |OK oK OK Comments ]04.01-04.14 [OK

11 Incorrect  |OK OK Not Found |Comments ]05.01-05.11 |incol
P 8 Incorrect Sheet Size must be 34"x22" Incol
FDP [5 Incorrect 0l p1 is 36"x24", p2 is 36"x24", p3 is 36"x24", p4is p_|OK

36"x24", p5 is 36"x24"

—J

Figure 83 - PDF Checker Report

The Format Compliance attribute will also be set when the checker is run. It will return a PASS
or FAIL value as shown below:

a Lst | @ Geospatial|  pr—
Label (User Defined) Description Document Date (m... Application State Format_Compliance Ot to
,/m 01- Title Sheet Title Sheet Acrobat PDF DOCUMENT TRANSF..4 PASS
/a 02- Revisions Revisicn Sheet Acrobat PDF DOCUMENT TRANSF..§4 PASS
#[B) 03- Supporting Docume... Supporting Documents Plan Sheets Acrabat PDF DOCUMENT TRANSF.{ PASS
/a 04- Civil Civil Plan Sheets Acrobat PDF DOCUMENT TRAMSF..4 PASS
/E 05- Architectural Architectural Plan Sheets Acrobat PDF DOCUMENT TRANSF.§ PASS
/m 06- Structural Structural Plan Sheets Acrobat PDF DOCUMENT TRANSF..4 PASS
/a 07- Fire Protection Fire Protection Plan Sheets Acrobat PDF DOCUMENT TRANSF..§4 PASS
/a 08- Plumbing Plumbing Plan Sheets Acrobat PDF DOCUMENT TRANSF..4 PASS
/a 09- Mechanical Mechanical Plan Sheets Acrobat PDF DOCUMENT TRAMSF..4 PASS
/Q 10- Electrical Electrical Plan 5™~ tT TR DOCUMENT TRANSF..4 PASS
# B 11- Environmental Envirenmental | Format com pllance _—W FALL
# B CTDOT Highway STD  Highway Stand: : DOCUMENT TRANSF.| PASS
/a CTDOT Traffic_STD Traffic Standard Attri bute F DOCUMENT TRANSF..{ PASS

Figure 84 - Format Compliance Attribute

7. Ifthere are no errors in the report and all document have PASS in the Format
Compliance attribute, this process is complete. If there are errors, the errors shall be
fixed and the checker rerun.
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Section 7 Contract Plan and Special
Provision Revisions (Addenda and Design
Initiated Change Order)

7.1 Addenda

Contract plans that are revised or added due to addenda shall be submitted in digitally signed
PDF discipline subsets containing only the changed sheets. The sheets being revised or deleted
shall not be included in the Addenda submittal. The first sheet of each addendum subsets shall
be digitally signed in a digital signature place holder, that is placed in Microstation as described
in Section 5 of this manual. Addendum subsets DO NOT need an index of drawings sheet. Once
digitally signed, the addendum subsets shall be submitted to CTDOT using Projectwise, as
described in Section 6 of this manual.

Addenda sheets from different subsets cannot be combined and submitted as one subset, they
must be submitted per their respected subsets.

The discipline Addenda subsets shall be attributed as follows, when uploaded into Projectwise
(See Section 6): The addenda subset shall have the same Projectwise label as the original final
plan subset with the addition of (_A##) added to the end, where the ## equals the addenda
number. The sub-category attribute shall be ADP and ACD if the ADP plans are revised. See
example below:

PROJECTWISE LABEL ATTRIBUTE

Original Discipline Subset: 04-Traffic

Addenda Discipline Subset: 04-Traffic_A01
2nd Addenda 04-Traffic_A02
6th Addenda 04-Traffic_A06

The contract sheets (previously submitted final plans or earlier addenda plans), being revised by
addenda shall NOT be modified except; the Engineer of Record shall place an addenda stamp on
the affected sheets. This addenda stamp crosses out the entire sheet with a red X and adds the
following note; "THIS SHEET REPLACED BY ADDENDUM NO."Y"; where "Y" equals the addendum
number. This stamp is placed over digital signatures therefore; removal of the signatures is not
required prior to placing the addenda stamp. For this process see Section 7.4.

WARNING — When placing the stamps, removing the digital signature is not allowed.
The Index of Revisions Sheet(s) located in the 02-Revisions subset(s) shall be managed by the
project manager for all addenda, and submitted as described in Section 7.3.1. A new subset

must be updated for each addendum.

A watermark of the signer’s signature; signature only for (CTDOT), or PE Stamp for (Consultants)
shall be placed on all added or revised sheets. See Section 5.2

Paper copies for all Addendums will be requested by the Department’s Contracts unit and sent
to all applicable units following Section 3.2.12.
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7.1.1 Revised Plans - Addenda

Microstation Processes

A note shall be placed, directly above the bottom right hand corner of the title block, on the
replacement sheets stating “ADDENDUM NO. “Y”, where “Y” equals the addenda number. This
note is a level in Microstation that needs to be turned on and edited.

For revised sheets the drawing numbers shall not be modified.

The areas on the sheet that are being revised shall be clouded and a numbered triangle shall be
placed somewhere on the line of the cloud. A like numbered triangle shall be placed in the
revision block of the changed sheet, accompanied by a description of the revision itself. The
revision number is specific to a particular sheet, and increases in consecutive order per revision
and per addenda. If a sheet is changed for the first time under addenda five the revision number
is 1 NOT 5. If it is changed again under addenda 7 the revision number becomes 2.

Note: If there are a lot of changes to a sheet and it is not possible to cloud all the changes in a
clear manner, do not void out the existing sheet and create a new sheet. In these instances,
the designer shall place a cloud just inside the border of the revised addendum sheet.

Note: When preparing an Addendum that will change quantities on a project that includes a
"Detailed Estimate Sheet", never revise the "Detailed Estimate Sheet." A "Detailed Estimate
Sheet" is never included in an addendum. Also, the "Quantities" box shown on the General
Plan sheet for any structure is never to be revised.

Bluebeam Processes
Sheet numbers for revised plans shall be as follows:
Original Final Plan Sheet;

Original: 02.25
Addenda 1: 02.25.A1
Previous Addenda Sheet;

Original: 02.25.A2
Addenda 4: 02.25.A4

If a sheet requires further revisions by a subsequent addendum, the addendum shall be
prepared, as detailed above. The previously revised sheet shall now be stamped using Bluebeam
after addendum approval, see Section 7.4.

7.1.2 New Sheets - Addenda

Microstation Processes
Changes that require a new sheet(s) to be added to a discipline subset shall be formatted in one
of two ways, as follows:

1. If the new sheet does not have to be placed in a specific location within the discipline
subset, the new sheet shall be placed last, and numbered sequentially from the last
sheet of the discipline subset. The total number of sheets noted on the project plans
and discipline subsets stays the same. A note shall be placed on the new sheet stating,
"NEW SHEET ADDED BY ADDENDUM NO."Y", where "Y" equals the addendum number.
This note shall be located directly above the right hand corner of the title block. This
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note is a level in Microstation that needs to be turned on and edited. The revision block
on the added sheet, shall not be filled out.

2. Ifthe designer determines that the new sheet must go in a specific location within the
discipline subset, the new sheet number shall be the number of the previous sheet
followed by (-1.A#), where # is the Addendum Number. For example, if the new sheet
must be placed in a discipline subset right after sheet 02.57, the new sheet shall be
numbered 02.57-1.A1, if an additional sheet needs to be added, in this case it would be
02.57-2.A1. The total number of sheets noted on the project plans stays the same. A
note shall be placed on the new sheet stating, "NEW SHEET ADDED BY ADDENDUM
NO."Y", where "Y" equals the addendum number. This note shall be located directly
above the right hand corner of the title block. This note is a level in Microstation that
needs to be turned on and edited.

When adding a new sheet a new drawing number is also required. As with the sheet
number the drawing number of the new sheet shall be the drawing number of the
previous sheet plus a decimal and the sheet count. For example, if the new drawing
must be placed in the project plans right after drawing number S-5, the drawing number
shall be S-5-1.

Bluebeam Processes
Added sheet numbers, inserted NOT added to the end of Subset, shall be as follows:

Original Final Plan Sheet;

Original: 04.31
Addenda 3: 04.31-1.A3

Previous Addenda - Added Sheet;

Original: 03.24.A1
Addenda 4: 03.24-1.A4

Previous Addenda - Revised Sheet;

Original: 05.14-1.A1
Addenda 2: 05.14-1.A2

Previous Addenda - Added Sheet;

Original: 05.14-1.A1
Addenda 2: 05.14-2.A2

If adding sheets to the end of a subset, the new sheet number shall be a continuation of the
previous sheet number plus .A#, where # equals the addenda number.

Original Final Plan Sheet;

Original Last Sheet: 04.31
Addenda 3: 04.32.A3
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7.1.3 Adding New Subset - Addenda

The new subset shall be submitted by an Addendum and be prepared the same way as an FDP
discipline subset, with the addition of an A# in the sheet numbers and a note shall be placed,
directly above the right hand corner of the title block, on the sheets stating “ NEW SHEET
ADDED BY ADDENDUM NO. “Y”, where “Y” equals the addenda number. This note is a level in
Microstation that needs to be turned on and edited. The label attribute on the new subset shall
contain an “_A##”. The first sheet of a new subset to the contract will be a subset cover sheet
and contain an index of drawings. Also the DO NOT update the project title sheet in the
General subset to show the addition of new subsets to the project.

7.1.4 Voiding Sheets

Sheets submitted within final design plan subsets and addenda subsets shall NOT be deleted;
but shall voided by the engineer of record with an addenda stamp, using Bluebeam. This
addenda stamp crosses out the entire sheet with a red X and adds the following note; "VOIDED
BY ADDENDUM NO.”Y"; where "Y" equals the addendum number. See Section 7.4

7.1.5 Addenda Special provisions

Contract Special provisions that are revised or added due to addenda shall be submitted digitally
in accordance with Section 4.5

7.1.6 Addendum CTDOT Standard Drawing Subsets

The designer shall prepare an addendum to a CTDOT Standard Drawing subset in accordance
with the following.

The Addendum for a standard subset shall only include the added sheets, do not include all the
standards for the project. Follow Section 4.4 to prepare the standard subset, only include the
added sheets and check off only those sheets on the index sheets.

When uploading to Projectwise, add an “A##” to the end of the label attribute.

Update the 02-Revision subset to record this change.
7.2 Design Initiated Change Order (DCO)

Design Initiated Change Orders (DCO) are change order requests in which the designer alters the
original contract by:

e Avrevision to an existing plan sheet(s) or specification(s)

e The addition of a new plan sheet(s) or specification(s)

e The deletion of an existing plan sheet(s) or specification(s)

The creation and management of DCO’s shall be as specified in this section.

Contract plans changed or added due to DCO’s shall be submitted in a digitally signed PDF
discipline subset(s) containing only the added or changed sheets. The sheets being revised or
deleted shall not be included in the Change Order submittal. The first sheet of each DCO subset
shall be digitally signed in a digital signature place holder, that is placed in Microstation as
described in Section 5 of this manual, DO NOT ADD a cover sheet. Once digitally signed the DCO
subset(s) shall be submitted, to the CTDOT, using Projectwise as described in Section 6 of this
manual.
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DCO sheets from different subsets cannot be combined and submitted as one subset.

The discipline DCO subsets shall be coded as follows, when uploaded into Projectwise (See
Section 6): The DCO subset shall have the same Label Attribute as the original final plan subset
with the addition of (_C###) added to the end, where the ### equals the DCO number. The sub-
category attribute shall be DCO (Design Initiated Change Order) See Examples below:

PROJECTWISE LABEL ATTRIBUTE

Original Discipline Subset: 04-Traffic

DCO Discipline Subset: 04-Traffic_C01
6th DCO 04-Traffic_C06
Original Addenda Subset: 04-Traffic_A03
DCO Discipline Subset: 04-Traffic_C01
39 DCO 04-Traffic_C03

The contract sheets (previously submitted final plans, addenda plans, or DCO plans), being
revised by DCO shall NOT be modified except; the Engineer of record shall place a DCO stamp on
the revised sheets using Adobe Acrobat. This digital DCO stamp crosses out the entire sheet
with a red X and adds the following note; "THIS SHEET REPLACED BY DESIGN INITATED CHANGE
ORDER NO."Y" —mm/dd/yy; where "Y" equals the Design Initiated Change Order number. This
stamp is placed over digital signatures therefore; removal of the signatures is not required prior
to placing stamp. For this process see Section 7.4

WARNING — When placing the stamps, removing the digital signature is not allowed.

The Index of Revisions Sheet(s) located in the 02-Revisions subset shall be updated by the
project manager for all DCO, and submitted as described in Section 7.3.2.

A watermark of the signer’s signature, signature only for (CTDOT), or PE Stamp for (Consultants)
shall be placed on all DCO sheets. See Section 6.2

Paper copies for all change orders will be requested and sent to all applicable units’ following
Section 3.2.12.

7.2.1 Revised Sheets - DCO

Microstation Processes

A note shall be placed, directly above the right hand corner of the title block, on the
replacement sheets stating “DESIGN INITIATED CHANGE ORDER NO. “Y” — mm/dd/yy, where “Y”
equals the Design Initiated Change Order number. This note is a level in Microstation that needs
to be turned on and edited.

The areas on the sheet that are being revised shall be clouded and a numbered triangle shall be
placed somewhere on the line of the cloud. A like numbered triangle shall be placed in the
revision block of the changed sheet, accompanied by a description of the revision itself. The
revision number is specific to a particular sheet, and increases in consecutive order per revision
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and per change to the sheet. If a sheet is changed for the first time under addenda #5 then
change for DCO #1 revision number is 2 NOT 1. If it is changed again under DCO 2 the revision
number becomes 3.

Details shown on the original PDF, but no longer required, shall not be deleted on the revised
PDF, but shall be crossed out. Any details to be deleted shall be crossed out with an “X” on the
revised sheet. Engineering judgment must be used to produce clear and concise information
for the contractor.

If the number of changes to the sheet cannot be clouded in a clear and concise manner, the
existing sheet should be voided in accordance with Section 7.2.4 and a new DCO sheet created
in accordance with Section 7.2.2

Bluebeam Processes
Sheet numbers for revised plans shall be as follows:

Original Final Plan Sheet;

Original: 02.25
DCO 1: 02.25.C1

Previous Addenda Sheet;

Original: 02.25.A2
DCO 4: 02.25.C4

Previous DCO Sheet;

Original: 02.25.C2
DCO 4: 02.25.C4

Drawing numbers shall not be modified on revised sheets.

Approval blocks on all new sheets shall be watermarked with a signature (CTDOT) or PE Stamp
(Consultant) and the first sheet of the subset shall be digitally signed in accordance with Section
5 of this document.

7.2.2 New Sheets - DCO

Microstation Processes
Changes that require new sheet(s) to be added to a discipline subset shall be formatted in one
of two ways, as follows:

1. If the new sheet does not have to be placed in a specific location within a discipline
subset, the new sheet shall be numbered sequentially from the last sheet of the
discipline subset. The total number of sheets noted on the project plans and discipline
subsets stays the same. A note shall be placed on the new sheet stating, “NEW SHEET
ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y — mm/dd/yy” where “mm/dd/yy”
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equals the month, day and year the change order request was submitted. This note
shall be located directly above the title block. This note is a level in Microstation that
needs to be turned on and edited.

2. Ifthe designer determines that the new sheet belongs in a specific location within a
discipline subset, the new sheet number shall be the number of the sheet it most closely
relates to followed by (-1.C#). For example, if the new drawing should reside in the 03-
Highway discipline subset right after sheet 03.57 but before sheet 03.58, the new sheet
shall be numbered 03.57-1.C#.

The total number of sheets noted on the project plans stays the same. A note shall be
placed on the new sheet stating, “NEW SHEET ADDED BY DESIGN INITIATED CHANGE
ORDER NO. Y- mm/dd/yy” where “mm/dd/yy” equals the month, day and year the
change order request was submitted. This note shall be located directly above the
bottom right hand corner of the title block. This note is a level in Microstation that
needs to be turned on and edited.

When adding a new sheet a new drawing number is also required. The drawing number
of the new sheet shall be the drawing number of the sheet it most closely relates to
followed by (-#). For example, if the new drawing must be placed in the project plans
right after drawing number HWY-10, the drawing number shall be HWY-10-1.

Bluebeam Processes
Added sheet numbers, to a specific location, shall be as follows:

Original Final Plan Sheet;
Original: 04.31
DCO 3: 04.31-1.C3

Previous Addenda — Added Sheet;
Original: 03.24.A1
DCO 4: 03.24-1.C4

Previous DCO — Revised Sheet;
Original: 02.45.C1
DCO 2: 02.45.C2

Previous Addenda - Added Sheet;
Original: 05.14-1A1
DCO 2: 05.14-2.C2

Previous DCO — Added Sheet;

Original: 02.45-1.C1

DCO 2: 02.45-2.C2
If adding sheets to the end of a subset, the new sheet number shall be a continuation of the
previous sheet number plus C#., where # equals the Design Initiated Change Order Request
number.

Original Final Sheet

Original Last Sheet: 04.35
DCO 4: 04.36.C4
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7.2.3 New Subset - DCO

The new subset shall be submitted by DCO and be prepared the same way as an FDP discipline
subset, with the addition of an C# in the sheet numbers and a note shall be placed, directly
above the right hand corner of the title block, on the replacement sheets stating “NEW SHEET
ADDED BY DESIGN INITIATED CHANGE ORDER NO. “Y” — mm/dd/yy, where “Y” equals the Design
Initiated Change Order number. This note is a level in Microstation that needs to be turned on
and edited. The label attribute shall contain “_C##”. The first sheet of a new subset to the
contract will be a subset cover sheet and contain an index of drawings.

7.2.4 Voided Sheets

Sheets submitted within final design plan subsets, addenda subsets, or design initiated change
order subsets shall NOT be deleted; but shall be voided by the engineer of record, with a DCO
stamp using Adobe Acrobat or Bluebeam. This DCO stamp crosses out the entire sheet with a
red X and adds the following note; "VOIDED BY DESIGN INTIATED CHANGE ORDER NO. Y —
mm/dd/yy; where "Y" equals the Design Initiated Change Order number. See Section 7.4

7.2.5 DCO Special provisions

Special provisions shall be created in accordance with the Departments policies and procedures
for Contract Development. The Engineer shall also combine all special provisions into (1) PDF
document and upload that into the 110_Contract Special provisions (PDF) folder in Projectwise
following Section 4.5

7.2.6 DCO Memorandum from Designer to
Construction

A DCO Memorandum from the Designer to Construction shall be prepared for all change orders
and include the following. This memorandum shall not include any digitally signed DCO plans
and/or DCO specifications. The digitally signed DCO plans shall be uploaded into the
100_Contract Plans folder in Projectwise and the DCO Specs. shall be uploaded into the
110_Contract folder in Projectwise :
e Adetailed description and justifications of the changes requested.
e |dentify the funding source if known.
e Alisting of each new, revised, replaced and/or voided plan sheet(s).
e Alisting of each new, revised, replaced and/or voided special provision(s).
e Alist of the changes in the estimated quantities for the project (increase, decrease). The
list should also include any item that is new to the project or any item that is deleted as
a result of the revised work. ltem numbers of items already in the project should be
provided. Iltem numbers for items that are not currently in the contract should be
provided if known.
e The estimated increase in cost or credit associated with the change order request.

The DCO Memorandum shall be submitted into Projectwise in accordance with Section 4.10

7.2.7 DCO CTDOT Standard Sheet Subsets

The designer shall prepare a DCO to a CTDOT Standard Drawing subset in accordance with the
following.

The DCO for a standard subset shall only include the added sheets, do not include all the

standards for the project. Follow Section 4.4 to prepare the standard subset, only include the
added sheets and check off only those sheets on the index sheets.
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When uploading to Projectwise add an “C##” to the end of the label attribute.

Update the 02-Revision Subset to record this change.

7.3 02-Revisions Subset

The project manager is responsible for managing this subset. The subset can be downloaded
from these links:

CTDOT Designed Projects - 02-Revisions Subset

Consultant Designed Projects - 02-Revisions CE Subset
Each project has a 02-Revisions subset and this subset only contains the, “Index of Revisions
Sheet(s)”. These revision sheets are used for tracking all sheet changes due to addenda (ADP)
and Design Initiated Change Order (DCO) with respect to the entire project. The 02-Revisions
subset starts out as an un-signed blank place holder in the project. The figure below is an
example of a blank 02-Revisions subset:

—
DESCRIPTION o FEV SHEET No. | DATE [E

[FEV. DATE
smmy no. | SHEET Moo | oy

SHEET M. HHE DESCRIPTION av iV

DATE |Z[=
o|E Mo, sy | 8

REV
DEL]

SHEET Mo DESCRIFTION BY

REV
DEL

Na.

T REHABILITATION OF - TOLLAND 142-148
E&sn\rz OF CONNECTICUT .@ ‘OFFICE OF ENGINEERING L I
= e evr
DEPARTMENT OF TATION ROUTE 74 OVER 1-84 REVISIONS SHEET —
02.01

Figure 85 - Blank 02-Revisions Subsets

ADDENDA:

When the project requires an Addendum, the Project Manager must record these changes on a
NEW 02-Revisions_A## subset, where A## equals the Addendum ##. New 02-Revisions subsets
shall contain all previous Addendum information. For example, Addendum 4 shall include all
changes made from Addendums 1, 2, 3 and 4.

Note: A New 02-Revisions subset is required for each addendum because there are times when
multiple addendums are being submitted to processing for the same project. An example of this
is if Addendum 1 and Addendum 2 are submitted to processing at the same time, two
addendum revision sheets must be submitted.

DESIGN INITIATED CHANGE ORDER:

When a project requires a Design Initiated Change Order (DCO), the following process shall be
followed:
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For each DCO, the Project Manager shall AMMEND the 02-Revisions subset. The 02-Revision
subset shall always contain all previous Addendum information and the new DCO information.
For example, when DCO #1 is prepared, the 02-Revisions subset shall include all Addendum
information as well as the changes made for DCO #1.

The following figures are an example of the “Index of Revisions Sheet(s)” completed up to
Addendum #3:
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Figure 86 - Index of Revisions Sheet

Detail A from figure 1 shows the information typed in for a change to the contract plans. The
project designer inputs the Addendum or DCO number, the sheet number, the date, a
description of the change, the person who made the change, and checks the appropriate box
for: new sheet added, revised sheet or deleted sheet.

—_—
REV'M Braiion E é g DESCRIWIDN\? PHE:' SH
01.01.003A1 01/28/11 v ENTIRE SHEET REPLACED JES Al [03.08)
Al | 01.0L.004A1 01/26/11 v ENTIRE SHEET REPLACED JES Al [03.08)
Al | 01.01.005A1 01/28/11 v ENTIRE SHEET REPLACED JES / Al |03.08.
01.01.006A1 01/28/11 v ENTIRE SHEET REPLACED b
Al J07AL 01/Z8/11 v ENTIRE SHEET REPLACED JES Al [04.09)
Al | 01.01.008A] 11 ( ENTIRE SHEET R.EFLICED___’,’ JES Al [04.090
Al | 01.01.009A1 01/28/11 PLACED JES Al [04.090
Al | 01.0L010AL 01/28/11 v ENTIRE SHEET REPLACED Al |04.090
Al | 01.01.011A1 01/28/11 ( ENTIRE SHEET REPLACED Al [04.090
Al | 01.01.012A1 01/28/11 W ENTIRE SHEET REPLACED b - - Al [04.090
Al | 01.0LO13AL 01/Z8/11 ' ENTIRE SHEET REPLACED UE I Al [04.090
Al | 01.01.014A1 01/28/11 ( ENTIRE SHEET REPLACED Al [04.090
Al [04.090
Al | 0102.001A1 01/Z8/11 v ENTIRE SHEET REPLACED JES Al [04.090
Al [04.090
Al | 01.03.005A1 01/28/11 v ENTIRE SHEET REPLACED JES Al [04.090
Al | 01.03.006A1 01/Z8/11 v ENTIRE SHEET REPLACED JES Al [04.090
S e bl T L et

Figure 87 - Detail A

Detail B from figure 1 shows the title block information.
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RECONSTRUCTION OF THE _ [ REve1
MOSES WHEELER BRIDGE REVISIONS
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Figure 88 - Detail B

7.3.1 02_Revisions Subset Workflow - Addenda

Each time an addendum is issued, the “Index of Revisions sheet” must be updated by the Project
Manager as follows:

1. The user will export/download the latest 02-Revisions subset out of Projectwise to their
local computer.

2. With your digital signature USB key inserted within the USB, right click on the Signature
Box and select Clear Signature as shown below, this is the first Addendum this step can
be skipped since the subset will not have a signature on it:

s
PROJECT 1

/ BPCT VT 1T 7 7 =
< Clear Signature [%
walidate Signature
Wisw Signed Yersion

Compare Signed Ysrsion to Current Yarsion

RTATION

Show Signature Froperties. .

Legal Notice. ..

RB-01.dgn
in €

Figure 89 Clearing the Digital Signature

3. Enter the information into form fields as described in Section 7.3.4.

4. Add note “ADDENDUM NO. Y” in the bottom right hand corner of the sheet above the
title block, where Y = the Addendum number.

5. Add new revision sheet each time previous sheet becomes full. Add note “NEW SHEET
ADDED BY ADDENDUM NO. “Y”, where “Y” equals the addenda number. Follow section
7.3.3 of this document.

6. When finished sign using a certifying signature as shown in Section 5.6.2
7. Upload the document into Projectwise.

8. Attribute the subset: Main Category = CON, Sub-Category = ADP, Label = 02-
Revisions_A##

9. Make the document description 02-Revisions_A##.
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7.3.2 02_Revisions Subset Workflow - DCO

The following workflow shall be used by the Project Manager for recording DCOs to the 02-
Revisions subset. In this workflow the user edits the subset in Projectwise, they do not have to
export the document out and submit a new subset:

1. Check out the 02-Revisions subset from Projectwise.

2. With your digital signature USB key inserted within the USB, right click on the Signature
Box and select Clear Signature as shown below, this is the first Addendum this step can
be skipped since the subset will not have a signature on it:

s
PROJECT 1

/ BPCT VT 1T 7 7 =
S Clear Signature [% b
i Validate Signaturs
4
L View Signed Yersion

RTATION

Compare Signed Ysrsion to Current Yarsion

Show Signature Eroperties. ..

Legal Notice. ..

RB-01.dgn
in €

Figure 90 Clearing the Digital Signature

3. Enter the information into form fields as described in section 7.3.4.

4. Edit the note above the title block with “DESIGN INITIATED CHANGE ORDER NO. Y -
mm/dd/yy”

5. If a new revisions sheet is added, add the note above the title block with “NEW SHEET
ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y — mm/dd/yy”

6. Resign the 02-Revision subset in accordance with Section 5.6.2

7. Instep 7 “Check In” the document into Projectwise

7.3.3 Adding a New Revisions Sheet to the
02_Revisions Subset

1. Download a new “Index of Revisions sheet” from Section 7.3.
2. Insert the new sheet into the existing 02-Revisions subset pdf. Update the title block
information and update the sheet accordingly.

7.3.4 Filling Out Revision Index Sheet

To fill out a form field simply click on the box and begin typing. The first column is the
Addendum or Design Initiated Change Order. The second column is the revised or new sheet
number. The third column is the date, followed by a brief description that is similar to the
description on the actual sheet being revised. Finally click in the appropriate check box per row
to describe the action taken, new sheet, revised sheet, or sheet deleted. Note: The Engineer is
not required to input changes numerically by Sheet No. If another changed sheet is added to an
Addendum in the eleventh hour, it can be placed at the bottom of the list on the “Index of
Revisions Subset”.
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REV. DATE |2 |> |4 R
No.| SHEET No. | gons @@ @ DESCRIPTION BY [\
Addenda a1\ 02.06.00341 01/01/11 ¥ REMOVED DETAIL MIC
\‘ A1l ||03.05.00141 01/01/11 v J|DELETED sHEET MIC
A2 foa.05.00342 oy20/11 | | v | AlBEARING DETAILS MIC
#2/| 02.06.003-1a2 ozoi1t [v)] ABUTMENT DETAILS MIC
" CTN 04.01.026C1 02/15/11 (/) WINGWALL DETAILS MIC
| c2 Jo3.04.055-1c2 03/02/11 e ALL 101 DETAILS MIC
< -
Design Initiated \ Deleted Sheet
Change Order \ Revised Sheet
New sheet

Figure 91 Modifying the “Index of Revisions Subset”

7.4 Placing Stamps on Affected Sheets - Revised, or
Deleted Sheets

A digital stamp that crosses out the entire sheet shall be placed on digital contract sheets that
are affected by Addenda or Design Initiated Change Order. The stamp shall be placed using
Bluebeam’s Stamp tools and can be found in the tool chest under the miscellaneous stamps or
in Markup>Stamps as shown below:

Markup | Measure

William Pratt.pdf

JND - Ae |l B

01-Addendum_and_Change Order.pdf [l
v

END STATE PROJ, NO.

s FAP NO. O

3 BEGIN STATE PROJ. NO. 092-612 STA. 75400 43BN Sah T

FAP NO. 0911(123) m LIMIT OF PAVEMENT |

I STA. 67+00 (SB), STA. 63+00 (NB) MATCH

LINIT OF MILL AND OVERLAY 4

LINIT OF PAVEMENT MARKINGS
MATCH EXISTING

The Addendum and -
» Change Order Stamp ~
can be found
in both places —

sy

Figure 92 - Addendum and Change Order Stamp
If you do not have the stamp in the tool chest you need to download the CTDOT Bluebeam User

Profile as shown in Appendix A. If you do not have the stamp in the Markups>Stamp area, see
Appendix A — Bluebeam Stamps

WARNING — When placing the stamps, removing the digital signature is not allowed.
Table 4-1 below lists the notes that shall be used for addenda, construction order requests, and
as built notes. These notes should be used in conjunction with the cross-out stamp.
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The following shows how to apply the stamp to the sheet that needs to be crossed out for an

Addendum or Change Order.
1.

Measure

Markup

Select the stamp from the Tool chest or Markup>Stamps and place it:

William Pratt.pdf

BEGIN STATE PROJ. NO.092-612

FAP NO.0911(123)

STA. 67400 (SB), STA. 63+00 (NB)

LIMIT OF MILL AND OVERLAY
MARKINGS

The Addendum and
.« Change Order Stamp :
can be found

- in both places

END STATE PROJ. NO.
NO. 0

STA. 75+00 (snl STA 734
LT OF MILL AND

0 o - g P

v A

AL —

AT A Ed &

MR
T

Figure 93 - Addendum and Change Order Stamp

After the stamp is placed a box will pop up. Enter the applicable note from table 4-1
below in all caps as shown below:

BRI ey SRR

Add. or CO Mote

Enter Mote:

| oK || Cancel |

T TILDo® THICTLNT Lorar LT

IR AR
LI T Ay
BSETY DENCGE MO, 0T 1.
SEd AR SeeiEER 3

SURVEY BY DISTRICT L SUANEF

EF
-Il'r'l F I'T ﬁll' ﬁl\.":Fl"' I'.-n kl\.l' u'l '1'|

Figure 94 - Enter Note for Addendum and Change Order Stamp

Table 7-1 Modifications to Existing Sheets by Addendum, Construction Orders and As-Builts

Addendum Notes

Description of Use

THIS SHEET REPLACED BY ADDENDUM NO. Y

The revised sheet is considered to replace, in
total, the original sheet.

VOIDED BY ADDENDUM NO. Y

Sheet is voided by Addendum.

Design Initiated Change Order Notes

Description of Use

THIS SHEET REPLACED BY DESIGN INITIATED
CHANGE ORDER NO. Y - mm/dd/yy

Used for revisions to existing sheets. Changes
must be noted only on the revised sheet.

VOIDED BY DESIGN INITIATED CHANGE
ORDER NO. Y - mm/dd/yy

Use this for voiding of existing sheets.
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3. The following shows a completed stamp.

GENERAL NOTES LIST OF DRAWINGS

TROT Plan_Stamp.pdf

Text input through
dialog box

REPLACED BY ADDENDUM NO. 1

REPLACEMENT OF BRIDGE 93-166

-&stﬂs OF CONNECTICUT @ OFFICE OF ENGINEERING NEWINGTON e
- o NO, 04324 (ROUTE 175 OVER e Su2

DEFARTMENT OF TRANSPORTATION —
M= ABANDONED RATL ROAD) GENERAL PLAN -1 0102

Figure 95 Typical Sheet Replaced by Addendum 1

ANW IOPJOLC LA

'ANS 10 & 11.

AND DISPOSE EXISTING B!
iCK, DECK JOINTS AND STEEL

'E AND ERECT NEW STEEL ROADWAY
INTS, CONCRETE SIDEWALK, BARRIER CU
'ANS 10 & 11.

AND DISPOSE EXISTING ELASTOMERIC BEARINGS 10 LOCATIONS
PORTLAND VIADUCT.

TE AND INSTALL ELASTOMERIC BEARINGS AT 10 LOCATION:
PORTLAND VIADUCT.

“ONCRETE BASE PEDESTALS AT 4 LOCATIONS IN THE PORTLAND

HE EXISTING BRIDGE DRAINAGE SYSTEM (SCUPPERS AND DOWNSPOUTS)
IRIDGE SPANS INCLUDING CLEANING OF DRAINAGE TROUGHS AT
10 AND 11..

MO WUJIWLRLIC DARMRICR MANLY DLULYMLR LY

INOUS \'l‘EAIUNG SURFACE, CONCRETE FILLED
STRINGERS IN ARCH SPANS 10 & 11.

NGERS, CONCRETE FILLED GRID DECK,
D INCIDENTALS IN

TIMATED QUANTITIES OF
3ED ON LIMITED INVES-
0 WAY WARRANTED TO
W TUAL QUANTITIEp—BFR

ORK wHICH wiJTHES SHEET REPLACED BY DESIGN INITIATED CHANGE ORDER

NO. Y - dd
- mm/dd/yy

82-299

TY REPAIRS TO THE | MyppIETOWN PORTLAND e —
IRIGONI BRIDGE el STR-2
NOTES AND s

TABLE OF QUANTITIES | 03.02

Figure 96 Typical Sheet Replaced by DCO
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Section 8 As-Built Comments - Final Plans

As stated in the CTDOT’s Construction Manual chapter 1-313 “Final Revisions of Plans and Cross
Sections”, it is the responsibility of either the Contracting Engineers (Consultant Inspectors) or
State Forces (Office of Construction) to perform final as-built revisions of Contract Plans. As-
Built revisions shall be recorded in accordance with Chapter 1-313 of the Construction Manual,
amended as follows:

Final as-built revisions will be applied to the digitally signed PDF plans as a digital
comment, using Adobe or Bluebeam’s commenting tools. Digital comments are placed
over the top of the digital signature and its security, therefore, the original content of
the PDF plans can never be altered. Because as-built comments are digital and placed
over the top of the plans they are easily recognizable, searchable, and may be turned off
if necessary.

As-built comments shall be applied to the latest sheet, whether it’s the original,
addenda, or construction order plans, located in ProjectWise within the project’s
100_Contract Plans folder.

If additional As-Built information has been created, (information that cannot be placed
on the digitally signed contract plans), these sheets shall be combined by subset number
and uploaded into the 100_Contract Plans folder in Projectwise.

CAD drawings may be updated, at the discretion of each design office, to reflect any
addenda, change orders, and as-built revisions for use in the future; however the
original digitally signed as-built PDF plans shall not be replaced and shall be the PDF set
for permanent records.

8.1 As-Built Revisions (Digital Comments) Workflow

Two methods for applying as-built revisions to the digital PDF plans are provided in the following
sections; 5.1.1 and 5.1.2.

The first method, Section 5.1.1 Post Construction, district staff shall record as-built revisions on
their record set (paper copies) during construction. Once construction is completed these
revisions shall then be applied as comments to the digital PDF per the workflow in section 8.1.1.

The second method, using Section 5.1.2 Active As-Built, district staff shall record as-built
revisions on their record set (paper copies), and shall apply them as comment to the final set of
digital PDF plans on an intermittent bases, during construction. By using this method as-built
information becomes available to all parties that have access to ProjectWise during the
construction process, improving communication and transparency.
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8.1.1 Post Construction As-Built

As-Built Workflow

Step Personnel

Task

1 Chief Inspector

Notify the Contracting Engineer or Designated District Staff that
As-Builts can be applied to the Contract Plans.

2 Contracting Engineer
or District Staff

Apply As-Built revisions to the Contract Plans in accordance
with Section 8.3

3 Contracting Engineer
or District Staff

Notify all applicable personnel list in the Section 8.4.2 that the

As-Builts have been completed for this project.

8.2 As-Built Markup of Contract Plans

All as-built information will be placed using a few basic Bluebeam commenting tools. These
tools include text tools, line and arrow tools, and stamp tools (all other tools will still be
available under the main toolbar). These tools will be in the right-hand panel under “CTDOT As
Built Tools” tool box when the CTDOT As-Builts Profile is selected (see CTDOT Bluebeam Profile):

R Ro

-

Pyl

kv T o= 4

MNew Open Save Print E-ma Studio

EwEEC®-%e v

& |

Recent Tools

u

Comment

Construction Started Construction Started and

and Completed Date Completed Date
= | As-Built Stamps This sheet not comected
= | Az-Built Stamps This sheet comected
= | As-Built Stamps Typical Section comected
— | Az-Built Stamps These quantities not comected

Text Box

Callout Use to Add a Callout

Line Use to Cross Out

Amow

NN B>

eview Tools
op/Waorking Drawing Review Tools
Buitt Tools

Figure 97 - As-Built Commenting Tools
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8.3 Applying As-Built Comments to Contract Plans

8.3.1 Before Using Bluebeam for As-Builts

All CTDOT users are required to complete the steps in Appendix A prior to applying as-built
revisions. By completing these steps as-built revisions will be standardized across the all
CTDOT users. These steps only need to be completed the first time using Bluebeam or when
the user logs into a new computer.

. Perform the initial login steps for Bluebeam. Initial Log Into Bluebeam

. Download the CTDOT Bluebeam profile. Download CTDOT Bluebeam Profile

. The user must have a ProjectWise login/password. Contact Julie Annino if you do
not have a Projectwise Username and Password.

8.3.2 Opening the Contract Plans from Projectwise

The contract plans are located in the 100_Contract_Plans folder of the project in Projectwise, as

shown below:

EE @ - SearngQ

v| P> Interface| CTDOT_Doc_code

v| \«’iE‘W‘Dﬂ(umant v Spat\alView:E

Address pw:i\ctdot.projectwiseonline.com:CTDOT\Documentsy01.0 - Projects - Active'\0085-01414100_Contract_Plans [F % | b Go

- B

(% 0063-0637 # | | Label {User Defined) Description Main Categary 5t
L—: 0063-0639 /B 01_ceneral 01_General Con Fl
L_'“ 0063-0641 & 0063-0671 /Bl nz_revisions Revisions Subset CON F
L7 00630643 & 0093-0180 / Bl v3-Highway 03-Highway Con F
"% 0063-0644 =
L-x 00630570 _/ 04_Structures Structual Subset COM Fl
% noecer # B o5_Traffic 05-TRAFFIC con Fl
% 00630673 # B os_ate1_FIO ATaT _Utiity_Plan con Fl
[ 00630679 # B cTooT _Highway_STD CT_CON_STD_D085-0141_CTOOT_Highway_STD COml 5
(% noss-0079 B cTooT_TRAFFIC_STD CTDOT_TRAFFIC_STD con s
[ oro-011s
" 0070-0116
* 00730173
[ nora-0174
" 0076-0216
{* no79-0235
" nos1-0088
55 onet 001 Contract Plans
"% noaz-0259 H
i P are located in the
=% 00350141
L 100_Contract_Flans (PDF} 1 Oo_contraCt Pla ns
L 120_Contractor_Submittals (PDF) fOIder Of the ProjeCt
L 130_50il_Archaeological_Misc_Reports (FDF
L= 210_Construction
L 220_FHwA ¢
L 230_Contract_Administration -
{ 240_Contract_Development Project Properties | Folder Properties | Dependency Service | Access Control
L= 241 _Contrack_Development_Confidential =
L_— 310_Preliminary_Design_DocumentsiPDF) BENERAL - Project Numbei(s)
L 320_Permit_applications
[ 330_Design_Data GEMNERAL - Pragram Murnber
[ 340_Admininstation GEMERAL - Praject Title
{341 _Corfidential_administration GEMERAL - CTDOT Impravement Type
' 500_Pre_Design GEMERAL - General Description
#4 Saved Searches GEMERAL - Federal Proj Oversight
L-: 0085-0142 GEMERAL - Project Cunent Phaze
Figure 98 - Location of the Contract Plans in Projectwise
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1. Login into Projectwise, then browse to the 100_Contract_Plans folder of the project you

are working on.

2. To open a document with Bluebeam right click on the document, and select “Open

With” as shown below:

{PDF

ial
F)

# | Label (User Defined) Description

,/ n 01_General

_/ 02 _Revision

/ 03-Highwway

/a 04 _Skruckur

-/ a 05 _Traffic Cpen With...

Z Blos_atar PR ——n

/CTDOT_Higf View E-0141_CTDOT Mighway STD

# Bl cToot_TRe 51D i i
Check Out Right click on the
. plan subset to open

opy Ol
" H "
— and select "Open With
Start Studio Session..,
= Refresh Local Copy

Purge Local Copy
Purge Workspace
Cut

£ Copy

Documnert Properti to Preview | Dependency Service | Access Control | Compon

= Copy Ta... [

GEMERAL -Proj  Move Tao..,
GENERAL - Proi  Rename...

Figure 99 - Open With Bluebeam

3. Select the Bluebeam icon and check “Always use this program” and select OK. The
document will now be checked out of Projectwise and open with Bluebeam:

= Open document with

Select I
Program
MName | Description | Application
lIl:“JF’DF Document PDF Document "C:\Program Files\Bluebeam Software'Blusbeam Revu'Revu'Revu,exe”™ ™01
B sdobe Reader 9.3 Adobe Reader 9.3 C:\PROGRA1\adobe\READER ~2. 0'reader\acrord32. exe "%1"
F.. Adobe Acrobat Document Acrobat "C:\Program Files\Adobe\Acrobat 10.0\Acrobat\Acrobat.exe” " 1”
Select
| i

A
i NE use this program Select

Browse |

[~ Open document as read-only

Click here for a list of suggested document viewers

Figure 100 - Open with Bluebeam

Note: Since we checked “Always use this program”, the next time you open a pdfin
ProjectWise all you need to do is double click on the file.
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4. After the As-Builts are applied to the contract plans click save in Bluebeam and then
select “Check In” when a projectwise dialog box pops up. If the document is not
checked back into Projectwise the As-Builts will not be uploaded to Projectwise.

8.3.3 Applying Digital As-Built Stamps

8.3.3.1 Construction Started & Completed Dates

The construction started and complete date stamps must be applied to the PDF title sheet,
located in the 01_General subset, as stated below:

1. Select the "ConstructionStartedandCompletedDates”: stamp from the “CTDOT As Built
Tools” tool box and place it at a conspicuous location on the title sheet:

)

Print E-mai Studic Create ‘Combine Batch

%iNE g

e
Recent Tools
CTDOT Review Tools
CTDOT Shop/Working Drawing Review Tools
CTDOT As Buitt Tools
Subject Ci
~—_ |Construction Started | Construction Started and ——— =1
and Completed Date Completed Date
e O T e R STATE
Comected N
=== |This Sheet Comected | This sheet comected
— gﬁ:ﬂ;ﬁdion Typical Section comected
""" gﬁzaﬁe!;amﬂies B These guantities not comected
A Text Box
a
E Callout Use to Add a Callout
{ Line Use to CI'OSE OLI't [CONSTRUCTION STARTED DATE 01,01 /2011
[ CONSTRUCTION END DATE 02/02/2012
/ Amow _:
-
Figure 101 - Construction Started and Completed Date Stamp
2. Enter Start and end and click OK as shown below:
Construction Started and End Dates
JavaScript Window
Type Construction Started and End Dates
Inspector:
nstruction Started Date mm/ddAryyy: 12/12/2014
Construction End Date mm./dd Ay 12/13/2015
Lok [

'Enter Start and End Date
and then click OK

Figure 102 - Entering the Dates for the Stamp
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Below is an example of the placed stamp:

IENT OF TRANSPORTATION

Yans For

EHABILITATION
'E 2, 207 & 430

n(s)/City of

\, MANSFIELD

RLBOROUGH
AINTEMANCE
SPONSIBILITY LENGTH

STATE 00D FEET

Issued 10/2017

INSPECTOR

CONSTRUCTION STARTED DATE 12/12/2015
CONSTRUCTION END DATE

Figure 103 - Placed Stamp
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8.3.3.2 This Sheet Not Corrected Stamp

This stamp must be placed on all PDF sheets that do not contain as-built revisions. Detail
Estimate Sheets must never be revised; therefore, they always receive this stamp.

1. To place the “THIS SHEET NOT CORRECTED” stamp on an individual PDF sheet, select
that stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand
corner of the sheet, by clicking once.

If the majority of the sheets do not contain as-built revisions it is easier to apply this note to
every sheet included in plan set, including the as-built revised sheets, and then go back and
remove it from the sheets that were corrected.

1. To place the “THIS SHEET NOT CORRECTED” stamp on the entire plan set, select that
stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand corner
of the first sheet in the plan set:

| TH@ A @

CT_CON_FDP_0009-0094_03-Highway™

SUBSET 03 - HIGHWAY
INDEX OF DRAWINGS

Figure 104 - Placing the "This Sheet Not Corrected Stamp"
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2. Right click on the stamp that was placed and select “Apply to All Pages”:

Cut

Copy Ctri+C

Paste Ctri+v

Delete Del

Open Pop-Up Note

Tz

Change Colors

Layer

Right click Order

Alignment

Edit Action

''''' - Lock Ctrl+5hift+L

Reply

Set Status

Check

Add to Tool Chest

Sel as Default

Apply to All Pages

Properties

Figure 105 - Placing the Stamp on All Pages

This will place the “THIS SHEET NOT CORRECTED” stamp on every plan sheet within the
pdf set.

NOTE: You must go back and replace this note on the sheets that contain as-built revisions
with the appropriate stamp.
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This Sheet Corrected

8.3.3.3

This stamp must be applied to all PDF sheets that contain as-built revisions.

1. To place the “THIS SHEET CORRECTED” stamp on an individual PDF sheet, select that
stamp from the CTDOT As-Built Tools tool box and place it in the lower right-hand
corner of the sheet, by clicking once.

If the majority of the sheets contain as-built revisions it is easier to apply this note to every
sheet included in plan set, including sheets that do not contain as-built revisions, and then go
back and replace it, with the appropriate stamp, on the sheets that were not corrected.

1. To place the “THIS SHEET CORRECTED” stamp on the entire plan set, select that stamp
from the CTDOT As Built Tools tool box and place it in the lower right-hand corner of the
first sheet in the plan set:

2. NOTE: You must go back and replace this note on the sheets that do not contain as-
built revisions with the “THIS SHEET NOT CORRECTED” stamp.

8.3.4 Applying Digital As-Built Notes

To place an as-built revision, simply select any of the provided tools located within the as-built
tool box shown below and apply it to the document that is being as-built.

Recent Tools

CTDOT Review Tools

CTDOT Shop/Working Drawing Review ...
CTDOT As Built Tools

Comment

Construction Started
and Completed Date

| This shest Not

Comected

* | This Sheet Comected

| Typical Section

Comected

| These Quantities Mot

Comected

Text Box

o

Construction Started
and Completed Date

This sheet not
comected

This sheet comected

Typical Section
comected

These quarntities not
comected

Line Tool

Use to Add a Callout

x

Line

Use to Cross Out

N\ B >

Amow
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In the following example, the Line tool was used to cross out the existing text and the Text Box
tool was used to add text:

BITU MINBU
CONCRET
- PARIK-LCURBIN

\ Line Tool
\ \L I P\ Text Tool h /L’

N

Figure 107 - As-Built Note Example

Additional tools are available by selecting Markup:

WP (@ Fie Edt  View Document  Makup  Measw=  Window  Help

"hkeE-Sma4 - KA\

New  Open Save Print Emsi  Studo Text Pen Lnes  Shapes  Image  Hypeink  Atchment  Stmp
ERmEEo@- -y i I SiNE (/| TND A W

LI 9

Figure 108 - Other Markup Tools

These tools include:

ARFE '/

A B C DE F G H I J KLM NO P Q R

List of Commenting Tools:

Text — commonly used tool for as-builts
Typewriter — Do Not Use for As-Builts — cannot edit text

Note - Do Not Use for As-Builts — will not print

A.

B

C

D. Flag
E Pen

F Highlight

G Eraser - Do Not Use for As-Builts — cannot edit graphics
H Line— commonly used tool for as-builts

l. Arrow— commonly used tool for as-builts

J. Arc

K Polyline

L Callout— commonly used tool for as-builts
M. Dimension
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N. Box

0] Circle

P. Polygon

Q Cloud — Do Not Use for As-Builts - this may be confused with change orders or
addendums

R. Picture — Pictures can be inserted into a document or attached. It is

reccommended that pictures be attached as not to obstruct any part of the pdf.

Do not add a note to a comment by double clicking on the comment. For example, if a line
was placed the user could double click on the line and add notes to it:

N

Line

/ Fonald Tellier Supe... 10/11/20

Y A s R

Figure 109 - Incorect Way to Add Text

If notes are added this way they do not print.

8.3.4.1 Digital As-Built Stamps and Notes Using
ADOBE

The following stamp files need to be downloaded to the user’s computer and placed in this
folder:

C:\Documents and Settings\User\Application Data\Adobe\Acrobat\8.0\Stamps\. This could be
either C:\ or D:\ Drive depending on your computer. With the “User” folder being the current
user’s login Username. If Acrobat version 9 is being used, replace 8.0 with 9.0 in the previous
sentence, if version 10 is used replace with 10.

Stamp Files

As-Built stamps.pdf

Construction started and completed dates.pdf

These stamps are to be placed following Section 8.3 above.

As-Built notes shall be placed on the plans in accordance with Section 8.3 using the Adobe
commenting tools in the following format:
1. Text Font shall be Cambria 16, and the color Red.

2. Allline work shall be line width 2 and the color Red.
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8.3.5 Additional As-Built Information

Additional As-Built Information that cannot be applied to the contract plans can be uploaded to

Projectwise for future use. This information shall be uploaded to Projectwise in accordance with

the following:

1. Combine the additional As-Built information into (1) PDF for each discipline subset.
For example if the 03-Highway and the 04-Structures set had additional As-Built
information, 2 separate PDFs would need to be uploaded to Projectwise.

2. After the additional As-Built information is combined into their respective files they
will need to be uploaded and attributed into Projectwise in accordance with the

following:

© oo oo

Log into Projectwise Explorer.

Make sure the Interface “CTDOT_Doc_Code” is selected.

Drag and drop the PDF into the 100 Contract Plans folder in Projectwise.
Select the advanced wizard.

Click next until you get to the attributes page shown below and assign the

following attributes:

Discipline = CT

Main Category = CON

Sub-Category = ASB

Label = Subset No. and name, for example for the 03-Highway set
type 03-Highways.

Description = Additional As-Built information for....

Advanced Document Creation Wizard B

Define Document Aftributes
*You should define environment specific document attributes.

Lisi s & Fill these in :

cT

Main Category ain Category Description
CON
Sub Category Eub Category Description
ASB

Project Number(s)
00580329

-

- All Cortract Plans & Specs

As-Built Plans

Label (User Defined)

03-Highways -
Description
Additional As-Buitt Information for Loop Detectors

03-Highways _CT_ASE_0058-0329

Bridge No(s) Sign Structures

Then Click Next w:)

Document Date (mm/dd/yyyy)

m

[Aauto FillInd

CTDOT Asset Tags

| []

[ <Back l‘]L Next > 4])[ Cancel

Figure 110 - Additional As-Built Information

f. Then click next until the document uploads.
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8.3.6 Setting Documents to Final Status in

Proje

ctwise

After the As-Builts are completed it is ready for permanent storage a final status will be applied
to the document as shown below:

Select all the files or one at a time and then right click and select Change State>Set Final Status.

Right Click on the file

and select Change

State>Set Final Status

Label (User Defined)

/8

A= Projebt Schedul

Description
172-464 90%_TR_Review_TR_Final_0172-0464
90% Design Review Request

é- » AT

Open
Open as Read-Only
QOpen With...
Markup

View

Check Out
ChecklIn

Delete

(|

’-FrE? ”~ o =

ect Schedule

.

b =eds Assessment Form

beam end repair bearing replacement

| <neen. Propeti Freview | Dependency Viewer | Access Ci
DMScenf 3
IRaa\ (Docum contorm P;J
Madify..
Name r Modify Spatial Attributes... Document Securi
Enter filter here Add Comment Fo | &% | X || 2 | =2
€ ADMINISTR, ot r r r ~r ~ F
€ BRE-Admin K  F M ¥ F
g Bruce.Bourg. Eeeii ' F [~ 2l [~ P [
€ CDI-Admin Copy List To 'y O
€ ChucklL ~\ rF F F F F F
€ cis-Admin Change State , } Next [
€5 ConnDOT I J previous [
€ Consultant ... ESTeh P r
: Change... r
€= Contractors Praperties... —
€ Copy of IMA... ( Set Final Status
€ Copy of SVC.. Change filename to CT_Code —_—
! CTCodeCha..
é ﬂd;:w{zm Edit attributes for multiple documents i_ i_ 'l_ 'r 'r F

Figure 111 - Set Final Status

This will lock the file so no one can delete it. If a user needs to remove the final status contact

DOT.AECApplications@ct.gov
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8.3.7 Construction Completion Project Polygon

If the project limits were changed in construction, the project polygon KML file shall be updated.
The following shows how to do this.
1. Browse out to the 170 Row Files folder under the project in Projectwise and double

M 0031-0131
- 0032-0130
- 0032-0140
- 0032-0145
- 0032-0146
- 0032-0148
- 0032-0149
L% 0033-0127
M 0033-0128
-7 0033-0129
-2 0033-0130
{1 0033-0131
M 0033-0132
-4~ 100_Contract_Plans (PDF)
-4 110_Contract_Docurments

1 120_Contractor_Submittals (PDF)
-4 130_Final_Engineering_Reports

O e O O O O O O O O O

]

-4~ 131 _Engineering_Reports_Confidential

-4 140_Project_Administration

1 141 Project_Administration_Ceonfidential
-4 142_Project Administration Correspondence
-4~ 150_Quantity Calculations

-4 151_Final Design Calculations

..{Z7 170_ROW Files |
4L _Construction

L 220_FHWA
1 230_Contract_Administration
-4 240_Contract_Development

-4 241_Contract_Development_Confidential
- 310_Milestone_Submissions

1 320_Permit_Development

-, 330_Design_Data

- 500_Survey

-4 600_Project Initation Documents

-4 Saved Searches

-1 0034-0305

2. Open the file with Google Earth. It may say KML like below.

click on the FDP Boun

lan |

dary
List |4 Spatial

Labol fllc e Do o

_/'& DA Boundary
_/m DA Boundary
_/&‘ FDP Boundary
/’m FDP Boundary

Figure 112 - Project Polygons

Description

‘a Open document with |E|
Select
Program
Name Description Application
KM kML "C:\Program Files (x86)Google\Google Earth Pro'\dient\googleearth.exe™ "%:1"
4 1 +
[ Always use this program
[] Open document as read-only
Click here for a list of suggested document viewers
==
Figure 113 - Google Earth
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3. After the polygon opens, right click on Style 1 and select properties. This will allow

you to edit the polygon.

= Google Earth Pro
File Edit View Tools Add Help

¥ Search

x: 15213
Get Directions

¥ Places
Q My Places
Vs Temporary Places
4 Q polygon
4 V1D Levels
4 V& 100! Prelim_Proj_Polygon
oD

Delete
Rename
Save to My Places

Save Place As...
Post to Google Earth Community Forum

Email...

Snapshot View

Show Elevation Profile

Properties

m| EIE
v Layers
—@% Primary Database
> V] @ The new Google Earth
¢ 1Y Borders and Labels
Places
¥ = photos
V= Roads
v Ol 30 Buildings
=

Figure 114 - Editing the Polygon

4.

Then adjust the polygon as necessary by dragging the red points.

b~ - i s,

>
A?_’
£
S
2
&

=
&
o~
4= :
] P

Figure 115 - Adjusting the Project Limits
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5. Then click OK on the properties box.

Description | Style, Color_| View | Altitude

Figure 116 - Adjusting the Project Polygon

6. Then right click on Style 1 and select Save Place As
ile Edit View Tools Add Help

¥ Search
| Search
x: 37 25' 19.1°N, 122 05' 06"W
Get Directions History

r Places

Q My Places
Vs Temporary Places
4 & polygon

4 [V Levels

N =) TOOt-Prefirg_Proj_Polygon

VI£5 stylel

Add 4

Cut

Copy
Delete

Rename

Save to My Places

L Save Place As...
Post to Google Earth E:mmunity Forum

Email...

Snapshot View
Show Elevation Profile

Properties

Figure 117 - Saving Project Polygon
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7. Name the file construction polygon and save it as a KML file:

o Save file... (=3
o
@Uv|- Desktop » - | "v-,| | Search Desktop 0 |
Organize » Mew folder g= = @
S Favorites * Name Ttem type Date modified ni
. Creative Clos i =| project polygon.kml 5KB KML 10/25/2017 2:27 PM
Bl Desktop =] 17.kml 623,233 KB KML 10/20/2017 815 AM =
& Downloads =] SV_C5.172 444 001_SHP.kml 3KB  KML 10/4/2017 11:30 AM
=l Recent Places L =] SEDIT#Label$_SEDIT2Discipline$__0016-0098.km| 6,565 KB KML 9/7/2017 8:45 AM
Gb Music 3 =] polygon.kml TKB KML 8/28/2017 219 AM
[#] Dacuments - All Documents 1KB Internet Shortcut 2/6/20151:04 PM
4 Libraries @ Mew Projectwise User 1KB Internet Shortcut
@ Documents . ROW Submissions File folder
J’ Music g , 0137-0158 File folder 10/4/2017 9:57 AM
[E5] Pictures . DPD Revision History File folder 9/25/2017 T:53 AM
E Videos . Signals File folder 9/19/2017 3:00 PM
) Export 02.2 - Asset - Signal Intersections File folder 9/14/2017 8:28 AM
1% Computer J MIC File folder 9/13/2017 &:06 AM
& OSDigk (C:) . Attributes File folder 9/7/2017 7:23 AM
—a Data (D) . Training Videos File folder 8/28/2017 1:34 PM
&% DVD RW Drive (E: . Railroad crossings File folder 6/20/2017 8:38 AM

L (315 Nata (141

Artinre Retantinn Srhadulac

Filz faldar

EARANT 010 AR

File name:

Construction Polygon.kml

Save as type: [Km\ (*kml)

* Hide Folders

Save

Cancel I

Figure 118 - Saving a KML

8. Then upload this file into the 170 Row Files folder in Projectwise and label the file
Construction:

OJECTVVISE LXpIoTer
rce | Folder

Search [0 *kml

Document

Export View Tools

Window Help

§ '%‘> - lll :Address & | pwihctdot.projectwiseonline.com: CTDOT\Documents\01.0 - Projects - Active\0033-0132\170_ROW Files\polyg ~ bGo

[
[
[
[
[
[
[
[
[
[
[
[

o[ 0031-0131
o[ 0032-0130
o[ 0032-0140
o[ 0032-0145
o[ 0032-0146
o[ 0032-0148
o[ 0032-0149
o[ 0033-0127
o[ 0033-0128
o[ 0033-0129
o[ 0033-0130
o[ 0033-0131
[ 0033-0132

100_Contract_Plans (PDF)

110 Centract_Documents

120 _Centractor_Submittals (PDF)
130_Final_Engineering_Reports
131_Engineering_Reports_Confidential
140_Project_Administration
141_Project_Administration_Cenfidential
142_Project Administration Correspondence
150_Quantity Calculations

151_Final Design Calculations

160_Project s
170_ROW Files i
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210_Censtruction

220_FHWA
230_Centract_Administration
240_Contract_Development
241_Contract_Development_Cenfidential
310_Milestone_Submissions
320_Permit_Development
330_Design_Data

500_Survey

600_Project Initation Documents
Saved Searches

. nnRd-nans

Figure 119 - Saving Polygon to Projectwise
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Label (User Defined)

# & DA Boundary
,/m DA Boundary
# & FDP Boundary
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8.4 Notifications

Issued 10/2017

8.4.1 Notifying Department Personnel

After the as-built information has been completed, the person responsible for the as-built
revisions shall notify the appropriate Department personnel (via e-mail):

Lead Designer

Chief Inspector

Central Surveys

ROW

Central Construction

Bridge Maintenance (if a structure is on the project)

Mathew Calkins and Julie Annino — AEC Applications Email Mathew Calkins
and Julie Annino

126 Version 4.03
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Section 9 Contractor Submittals

9.1 Introduction

This section details how various contractor submittals shall be formatted, submitted, and
reviewed by CTDOT for projects that are not using a Document Control Software such as
SharePoint or Primavera Contract Manager.

The contractor submittals that are detailed in this section are as follows:
e Working Drawings for Permanent Structures
e  Working Drawings for Temporary Structures
e Shop Drawings
e Product Data
e Submittals
e RFIs
e RFCs

The following workflows take advantage of Bluebeam and CTDOT’s Projectwise site, which allow
the Contractor and CTDOT to collaborate on the Contractor Submittals in a centralized location.
Projectwise also allows the Contractor to access the Department’s comments quickly after the
submittals are reviewed.

Contractor Requirements
The Contractor requirements for this procedure are as follows:

e Purchase a license of Blubeam REVU or Extreme. This can be purchased from
www.bluebeam.com or various resellers.

e All submittals that require a PE Stamp are required to be digitally signed using an ADOBE
CDS or AATL Signature.

e Upload all submittals into CTDOT’s Projectwise Site. Fill out the following form to have a
CTDOT Projectwise username and password set up for your company: CTDOT
Projectwise New User Form

e The Contractor’s instructions for this procedure can be found here: Contractor Submittal
Instructions

9.2 Contractor Submittal Review Process
(CTDOT/Consultant)

CTDOT/Consultant shall review the contractor submittals using Bluebeam as follows. Before
starting a review make sure you have downloaded the CTDOT Bluebeam profile. This profile
contains all the markup tools as well as the submittal stamp that needs to be applied to all
contractor submittals.

CTDOT Newington Employees — The profile is located on the X:// Drive in the V8
Admin>Bluebeam Resources>Settings folder. Just double click on the file called CTDOT
Bluebeam User.

CTDOT District Construction Employees — Save this file to your desktop and then double click on
it: Bluebeam Profile

Outside Consultants/Designers — A custom stamp must be created that includes your
company’s information. See Appendix D of this manual to download and edit the stamp for
your firm.
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9.2.1 Contractor Submittal Review

Shop Drawing/Product Data Review
The following shows how to review a shop drawing or product data contractor submittal. These
submittals shall be sent directly to the designer. In the case the submittal needs to be reviewed
by another designer or design unit, the link can be forwarded to them and the following steps
can be followed.

1. Loginto Projectwise.

2. Browse out to your project and open the 120_Contractor Submittal folder of that

project.

3. Then change the state of the submittal to be reviewed to REVIEWING. To do this right
click on the submittal, select Change State, and then Next. This puts the submittal in a
Reviewing state, which blocks the contractor from viewing the file.

Sl List | @ Geospatial |
=

Description

5

5

Open

/a 004-C033000-01 5 Open as Read-0Onk
/ [B) 005-C033000-01 5 P _ ly
2 Bloos-cozo00-ot s OpenViEn Right click on a
/ [B) 007-C033000-01 5 Markup .
/B 008-C051200-01 5 View submittal and select
jg ﬁﬂiﬁﬁiﬁfgggf Check Out Change State>Next
B 010-C053100-01 CheckIn

VIF T o oNNCP 0000000000000

iz CL.-Adron Adn. o acount, 4 a [ 1 d [+
s Chuck.Lawson Chuck Lawson cdiySpstaliiuiss v [v [v [ [
€ Cl5-Admin  Admin Account Add Comment 2N T2 EZN
giiCnnnDOT_In..‘ List of Internal Co. Set » [+ I [ [V I~
§5§Consu|tant E.. Userlist for Consu [ [ [ n n
€= Contractors List of Contractor: SendTo ' - I - ’_ I~
s Copy of IMA... Admin account fo RS ' [ [v [v [ [
s Copy of SVC... Service Account fi :.m L Lo Lo Lo il L
g CTCodeCha... User for monitorin Change State 4 MNext )

. ctdot-service  ctdot-service TTETTETTE -
é Dave.Brumb... Dave Brumbaugh Batch Print '

Change...
s Douglas.Harz  Douglas Harz Properties...
€ EMK-Admin  Admin Account f Set Final Status
€ Extraction _Senvice Account Change filename to CT_Code Remove Final Status
€ Greq.Sardins... Grea Sardinskas L S e S S L | T T T T
Figure 120 - Changing the State of the Submittal
Change Document To State x|

Comments |

Erter Commert:

Click OK you
do not need to 5]
enter a comment

p —
(o ] Jere |

Figure 121 - Changing the State
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4. Then double click on the contractor submittal file to open and check out the file.

5. Inthe case a submittal needs to be resubmitted, the new submittal must include any
sheets/documents from the previous submittal that were stamped “No Exceptions
Noted” or “Exceptions as Noted” along with the new sheets/documents so CTDOT is
always working with a complete submittal package. If the revised submittal is not a
complete package, the submittal should be rejected and the contractor shall resubmit a
complete package.

6. To review the drawings/document markup the drawings/document with comments

using the markup tools located in the tool chest shown below.

LERORROE ST OND A

L-EECEEA

The file will open To review use the

LOCATION

arr. . .

seuteier | seax | e jy g new tab and you CTDOT Shop/Working
z PIER2 3 BIIEE ; . .

5 PiER 2 3 = can start your review drawing Review tools Gt s
[ FiER2 3 5 . evisn Stam;
: e | me e o o 4« 4 . s located in the tool chest Hiigh

sz A2
Soue 7| SoLE P . - | Highight
L2 2 T
ML L -1 -!;m\ Tet Box Use to Add test
B Ao | W@ [ Callout Use to Add a Callout
[ t Use o Clowd

g ! | ! ) Bl Carrections

=

5 23 H | . Uss to Cross Dt

g :

e 77| | \ \I\Z / :

& 1 1 3lg

a I =

] 1 | i I \1‘ HE COVER PLATE

3 g . PLAE

3 | | T £l A5 36 (UNPANTED)

— - - MR EXSTNG HOLES I BEw FLAioe
— L 11GA (.1195" NOW.) INTERMAL SHiv/ ] [HE o
_Lm_ﬁ_gaé‘%’ RMAL SHIM, __I oo & ; (14} TOTAL REQUIRED
ELAN VIEW TN AROUND 1, B
CETAI R SEE_SHEET GM1 OF 1 FOR GENERAL MOTES
B T W L LWANATED PAD STATE OF CONNECTICUT

ANT ON TOP— BEVELED SOLE PLATE 50 DUROMETER NEOPRENE GRADE 3 HAVING A SHEAR DEPARTMENT OF TRANSPORTATION

\CE OF SOLE TH 8 CLx B MODULUS OF 095 KSI +1S% A\ BRIDGE NO. 01702

FLD WELDING - WLCRIZED 16 SOL Fate a3 ROUTE 2 WESTHOUND OVER

z|e ) uIF ~ QUARRY ROAD
. = 'S rEst-n T DISTRICT 1 — SITE 6
8 SeAne I 5 W x L UAWINATED PAD MMELEY TOWN OF GLASTONAURY

L0 =1 50 DuRouETER ophele SHICE St A e i e o |

, )Y 0 ONY o SoLE pLaTE A \ Ll S . T WY
1 E ,f = (1) REQUIRED

\SEE DETAIL 1
ELEVATION viEW

IANSION_ELASTOMERIC. BEARING ASSEMBLY

Figure 122 — Shop/Working Drawing Review Tools
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Submittal Review Stamp

7.

8.

For CTDOT employees the submittal review stamp is located in the tool chest in
Bluebeam and should be placed on an open area of the drawing. For Consultants
Appendix D must be followed before their stamp is located in the tool chest.

To place the stamp, left click on the stamp in the tool chest and then place it. All shop
drawing sheets must be stamped with the action stamp. Product data sheets only need
to have the first sheet stamped.

Left click on
the stamp
and place.
ACTION STAMP
2
REHABIUTATION OF BRI
. 03912 AND 03913
TOWN OF NEW BRITAN, CT  STATE PROJECT NO.
e ERECTION DRAWING
e A L -
ROTHA CONTRACTING CO, INC. _|5/10/1
PROJ. NG, [CHECKED BY: DRAWIN .
C1372 [ Bh 8017 G
T S - 7 |callout
Text Box
T = T - T r— 2 Q Cloud Cusem oy
{ Line Use to Cross Out

Figure 123 - Placing Submittal Stamp

9. Next select the appropriate option from the java script window and click OK.

BRI LTAENTeS § UL PR WTULIILY

R OALL STEEL. SHIFPING MARKS AT THE END AS SHOWN Of
Submittal Review =
THE JavaScript Window
Action

@ Mo Exceptions Noted
1 Bxceptions as Moted
IN A () Revise and Resubmit

HOTH B RE]EC‘tEd

Date of Review
Date: 12/14/2017

Figure 124 - Submittal Review Stamp
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10. If the stamp is too big and is covering part of the drawing, resize the stamp by dragging
a corner as shown below:

FANNNNNY

™A

— R
~! airags .k 0=1
— LOCATION — BEARING CIMENSIONS
MLARK i ANUTPIER SEAN BEA{S) TIPE L'Pl::]:? L w T L]
ERALD T FER 2 ] BE R BT £ L] L3 L 175" r
EBQ-D 4 mEm 2 a 812 e ™ T L LTy L
IRAY-O 1 =ER D L] ™ o ¥ i T L
TEST.O 1 WS, ACTION STAMP 3 ™ r v LTA8 Mk
. ' B
o a
. ]
| | e e
[T | L. i f/’f__,-’}‘x
. | L = .a.K.-:‘{ ’ ....-..-T”.- K#’}z
| h_. - '\. F
SEalE gall | |, eS| SSSSNRSSSST :
L . = Y S— | {
5.2 _ : sy 1 of
Hala | I /x\._'..-_'L?'*.\'x%.x-.... - ik
¥l ! ] ", ] | # =&
;‘! 3 N .
. — s 10 resize the stamp,
a4 first click on the middle
e e Of the stamp so the
mrermet yellow circles appear,
L@ fme| | P then click on a corner and
s | I— 1 » *
g T N = - drag it to the size
T T e . that fits.
Figure 125 - Submittal Review Stamp
The stamp is now resized as shown below:
CT_CON_SDR_0004-0133_0153468-Bearings. pdf* D-1* -
BEARING | LOCATION BEARING |
MARK " | ABUTPIER SPAN BEAM(S) TYPE ‘
EBA1-D 2 PIER2 3 B-1ME&B-11W EXP.
EBA2-D 4 PIER 2 3 B-12 EXP
EBA3-D 1 _PIER2 3 B12 EXP
TEST-D 1 NA NIA NIA EXP.
A2 AS2
"SOLE PL | SOLE PL | _Agugn_ww_‘
-
L o T P £ | = >
LAM. PAD | LAM, PAD /
J BEARING | | //‘/;
i o ] = - | / .
RS e o gl
| < |
Bl
|
|

The stamp is
now resized

) ' L\;ﬁm_\:

I
!1
‘l

11GA (1196 NOM.) INTERNAL SHIM /
{3) REQUIRED

I
I
Figure 126 - Resized Stamp

Issued 10/2017 131 Version 4.03



Connecticut Department of Transportation — Digital Project Development Manual

11. After the review is completed, close the file and click yes to save.

01! * D1+
BEARING ' Locm BEARING TOTAL BEARING DIMENSIONS STEEL SOLE PLA"
mark | 9T e LoADS
ABUT/PIER SPAN M(S) TYP KIPS) L w T A B Th
EBA1-D 2 PIER 2 3 \[eEaBygw EXP 75 8" 9" 1.735" 9" 11304 3.09"
__EBAZ-D 4 PIER 2 3 N B12 W 10" 3.09"
EBA3-D 1 FIER 2 3 B-12 10° 191"
TESTD 1 NiA A |\ N | Close the file NiA NiA
a2 A2 \ .
e ] [semmackeen | and click yes to save ,
V] L2 B Z .T._
h a
LA, PAD | LAM. PAD LAMINAIED FAU 1U
Gk BE VULCANIZED TO —
BEARING THE SOLE FLATE 1
- - ) mla
r—— =
FE | 1 . / L
ala L5 I i L= A S »
[
aly S8 x|l |
3 7|2 gs ! | ! o
El-m|l |
Ell | Bluebeam Re . -
= T T : ] %
" o | | Save changes to following PDF files? 3 E =
% alg I I ElE
] e | | | I File Path Z|z COVE|
oy 7|2 | I D-1.pdf Bl PL 3/8
CRE | ! . 2|5 ASTM A3E
O = L E e 10 BE FIELD
”””” V168 ( £ EXISTING HOLES
l e (14) ToTA
BLAN VIEW
AHEAD —
STATION ™ N STATE (
MO PAINT ON TOP— BEVELED SOLE PLAT DEPARTMER
SURFACE OF SOLE THOCLx B xA BRID!
PLATE FOR FIELD WELDING . ~ ROUTE 2
o Fle Q ves I Mo ][ cancel | R u
® | *‘ BeaRNG | © - ] DISTRI
(_ — —l— 50 DUROMETER NEOFRENE GRADE 3 HAVING A SHEAR e
MODULUS OF 085 KSI +15% A [
- = PAD ONLY — NO SOLE PLATE | PR, WO 171
— (1) REQUIRED | -
) \SEE DETAIL 1 !I \,": LAMJ.\J?:;';
ELEVATION WIEW L
]
EXPANSION ELASTOMERIC BEARING ASSEMBLY g."_”’,'—

Figure 127 - Saving the Shop Drawing

12. Repeat the review process for the each drawing/document in the submittal.
13. Then save the file and close Bluebeam. Then check the document back into Projectwise
by clicking on Check In in the Check In dialog box as shown below:

1,

General |

i~ Documents

ame | File Mame
CT_COM,.. CT_CON_SDR_DE76-5432_0156478-Bearing_( 11.pdf

K i
Falder: 01.0 - Projects - ActivelShop Drawing Testh120_Contractor_Submittals (PDF)

™ Create new version during Che

Jersn ,7) Click Check In ———

| Check In ' Update Server Copy | Free | Cancel

Figure 128 - Check In Dialog
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14. Next prepare the response back to the Contractor as required by your business unit. If a

separate document is created, save that file in 120 Contractor Submittals folder and
make sure the label attribute of the response matches the label of the file submitted by
the contractor. Also make sure to add Response in the description as shown below:

om:CTDOTDocumentsy01.0 - Projects - Activel0118-0169'120_Contractor_Subr b Gao

-~

List |. Spaﬁal|

i 1} nwrinﬁnn
/ 001-1302931A-00 Watermain Insulation Submittal-118-169

/ 001-1302931A-00 RESPOMSE - Watermain Insulation Submittal-118-169

Format_Cor

# B rA1
,/’ RFI-1 Response
# B RrA-2 [ )
,/ RFI-2 Response
# B RF1-3
# [B) RF1-3 response SmeittaI and

7 BRI .
Response Files

\—

Figure 129 - Response Document
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15. Then change the state of the submittal and response to CLOSED. If the state is not

changed to CLOSED the Contractor will not be able to open the stamped

drawings/document. Note: You will have to follow these steps twice to change the

state of the response from Open to Closed.

# B uz0s105-structural steel Struckural Steel Shop drawings for Bridge 01564 and 01457 D02-CLOSED
d Steel Ba Deformed Steel Bars Shop drawings for Bridge 01564 and 01457 02-CLOSED
....... T D01-OPEN

Open
Open as Read-Orly
Open With. .
Marlup

Yiew

Right Click on heckout

CheckIn

the submittal | -
- Copy Out

and select =
Change State>Next \?”“"

tart Studio Session.. .
. ‘:pwt Dependency Map(=) ..

9F)

iport Dependency Map(s)..

Documert Prapeties |
late Server Copy.

View: | <Defaults Reefresh Lacal Copy

[ Pulge Local Copy

review | Dependency Viewer | Access Contiol | Components

| Property value

- [ - .‘W””GD“E CT_CON_SDR_9876-5432_Templ:
| | i 120_Cortractor_Submittals (PDF)

CTOOT_Design_Envir
CT_CON_SDR_3676-5432_Templ:
120_Contractor_Scbrmittals
MIC-Admin

MIC-Admin
MIC-Admin
Checked Tn
15t Submission

izl Attributes. .,

add Cormnent

Set | »

SendTo | »

Copy List 3

bt N

Next D

Batch Frint

Sl Change...
Preperis. et Finelstabus

Edit attributes for rltiple documents Remove Finsl Status

lan_2011a

Figure 130 — Changing the State of a Document
B
Comments |

Enter Comment:

Click OK you
do not need to =]
enter a comment

V —
@ Jeorca |

Figure 131 - Changing the State

16. For Shop Drawings, Product Data, or Other types of Submittals, the Designer shall send

an email notification to the Contractor stating their review is complete.
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Working Drawing Review

The following shows how to review a working drawing contractor submittal. These submittals

shall be sent to District Construction.
Log into Projectwise.
Browse out to your project and open the 120_Contractor Submittal folder of that
project.

3. Then change the state of the submittal to be reviewed to REVIEWING. To do this right

click on the submittal, select Change State, and then Next. This puts the submittal in a
Reviewing state, which blocks the contractor from viewing the file.

E=l List | @) Geospatial |
Label (User Defined)
P - l001-c200500-01

Description

5

5
B 004-co33000-01 5
/B 005-co33000-01 5 Open “_Read'only
o B 006-C022000-01 S FpEDpNIE Right click on a
/B 007-C033000-01 5 Markup _
/ [B) 008-C051200-01 5 W submittal and select
j oy Check Out Change State>Next
/B 010-C053100-01 CheckIn

Free

VI F TP o oNCP L0000 00000000

- CL. -Adnon Adn. . acesunt . % |\; [V 1 ,". P
§ Chuck.Lawson Chuck Lawson R Pt R RO e |7 |7 |7 |7 |7
g CLS-Admin Admin Account Add Comment |7 |7 |7 |7 |7
€= ConnDOT In... List of Internal Co. = R F - F F -
sEECon;ultant E... Userlist for Consu I_ l_ I_ l_ I_
€= Contractors List of Contractor: el ' I_ l_ I_ l_ I_
§ Copy of IMA... Admin account fo opy List To b F F F F F
s Copy of SVC... Service Account f > il il L i~ I
s CTCodeCha.. Userfor monitorirl Change State 3 Mext
ctdot-service  ctdot-service
é Dave.Brumb... Dave Brumbaugh e ' e
Change...

: Douglas.Harz  Douglas Harz Properties...
s EMK-Admin  Admin Account f Set Final Status
s Extraction _Service Account Change filename to CT_Code Remove Final Status
€ Grea.Sardins... Grea Sardinskas L O S S S | ™ ™ ™ T

Figure 132 - Changing the State of the Submittal

Change Document To State ll

Comments |

Erter Commert:

Click OK you
do not need to =]
enter a comment

| —

(o] Jeme |

Figure 133 - Changing the State
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4. Next if the submittal needs to be reviewed by a designer, forward the designer a link to
the submittal.

Reviewing the Working Drawing Submittal

5. Double click on the contractor submittal file to open and check out the file.

6. Inthe case a submittal needs to be resubmitted, the new submittal must include any
sheets/documents from the previous submittal that were stamped “No Exceptions
Noted” or “Exceptions as Noted” along with the new sheets/documents so CTDOT is
always working with a complete submittal package. If the revised submittal is not a
complete package, the submittal should be rejected and the contractor shall resubmit a

complete package.
7. To review the drawings/document markup the drawings/document with comments
using the markup tools located in the tool chest shown below.

/S o o I 7 % L0 SPacate A K Py VR -RECIEN RN RN - TR oo -]

The file will open To review use the

LOCATION
aTyY. -
povier | sm | % in a new tab and you CTDOT Shop/Working —
2 PIER 2 3 B-11E - -
4 PR B > = can start your review drawing Review tools = |5 i Gontenty it
1 PIER2 3 - - e Sy
: o W e e e 4 ., . .| located in the tool chest T
az A2
SOLE PL | SOLE PL. | Highlight
w2 2 T
w/m wjm (. T 'g'm‘ Test Box Use to Add test
v
>DLE [u\ BE_WULCANIZED TO -
HEAR NG THE SOLE PLATE o Callout Use to Add 5 Callout
e * Use to Cloud
o | ! \ [ e Corractions
H
5 23] | ) Use to Cross Out
s - B
S&h
a ] ]
£ 1 | I 8 -
a 1 1 Y
i I | 1 ‘ COVER PLATE
H 1 1 PL 3/8" X 6" X 4"
E] | I I ASTM A3 (UNPAINTED)
T | 1 . B 220 RS Dl
= B ) 5z ® DG HUES N (A b
_I et o 8|
PLAN VIEW AL AROUND 1P
288 ) e SO ST G 0GR
STATION BEVELED SOLE PLATE % L™ LAMINATED PAD STATE OF CONNECTICUT
EAA ' Hizs B e
L G o ROUTE 2 W[STBOUND OVER
=3 (7) REQUIRED QUAL
. 3 @ IEST-D e nmm:r w - swr 6
. T i LT LIATED PAD Ry B & ED 0 OF GLASTONRURY
.= {1} REQUI mzn
\SEZ DETAIL 1

IANSION_ELASTOMERIC._BEARING ASSEMALY

Figure 134 — Shop/Working Drawing Review Tools
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Submittal Review Stamp
8. For CTDOT employees the submittal review stamp is located in the tool chest in

Bluebeam and should be placed on an open area of the drawing. For Consultants
Appendix D must be followed before their stamp is located in the tool chest.

Designer Review

The designer shall place a Reviewed stamp on the working drawing submittal. The Action
stamp will be placed by District Construction.

9. To place the Reviewed stamp, left click on the stamp in the tool chest and then place it.
All working drawing plan sheets shall be stamped with the reviewed stamp. Calculations
and supporting documents only need to have the first sheet stamped with the reviewed

stamp.

New Britain 88-187 - Submittal 18 Rev A - Temp Support of Utilities™

DESIGNER'S REVIEW

Reviewed, No Comments -
Reviewed With Comments (|
L i ﬂ | &2 L[{ l This Stamp Shall Only be Applied to

Working Drawings

CONNECTICUT DEPARTMENT OF TRANSPORTATION
BUREAU OF ENGINEERING AND CONSTRUCTION

. 000 x a0 S

NG T2 AL/ B
7 ANEOILULES
T pezEs] Haelzd
RLcE & 2557 Losw

O 4<L2UIT Pz TUE

Stamp Digtal Signature Place Holder Stamp

Left click on
the stamp and

2B ODSpelD = IS o 9
CF 2o — CoNSER 7=
éﬁ i % ::‘
/ al" ﬂ_‘wm = C} :xiaux lse tn Clond Comections.
Figure 135 - Reviewed Stamp
10. Then select the appropriate option.
= 1101 1X ] 1
| submittal Review (25
'-j JavaScript Window
Action

) Reviewed with Comments - Only For Warking Drawings

-.-tl_ @ Reviewed, No Comments - Onby For Working Drawings

Date of Review

1 Date: 1/23/2018
o
N

— — o

Figure 136 - Reviewed Stamp
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11. If the stamp is too big and is covering part of the drawing, resize the stamp by dragging

a corner as shown below:

bv A - Temp Support of Utilities™ =

DESIGNER'S REVIEW

Reviewed, No Comments
Reviewed With Comments

P This Stamp Shall Only be Applied to | &
Working Drawings

CONNECTICUT DEPARTMENT OF TRANSPORTATION
BUREAU OF ENGINEERING AND CONSTRUCTION

LN B ATLS%ZQMOB
0 : .

To resize the stamp, first click on
the middle of the stamp so the
yellow circles appear, then click
on a corner and drag it to the size
that fits.

Figure 137 - Resizing the Stamp
The stamp is now resized as shown below:

‘emp Support of Utilities™ =

[+

° 2
DESIGNER'S REVIEW
Reviewsd, Mo Comments EI
Reviewed With Comments [:l
of This Stamp Shall Only be Applied to I

Working Drawings

CONNECTICUT DEPARTMENT OF TRANSPORTATION
BUREAU OF ENGINEERING AND CONSTRUCTION

M. Calkins Bridge
By: Diesign Date: 1/23/2018

"/ Pl HE DoTENTIKL
OlUE-TE <5 ol SLELD
w2 Ul geos-

Figure 138 - Resized Stamp
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12. After the sheets or documents have been stamped, click save and then check the file
back into Projectwise.

13. Then prepare a response back to District Construction as required by your business unit.
If a separate document is created, save that file in 120 Contractor Submittals folder and
make sure the label attribute of the response matches the label of the file submitted by
the contractor. Also make sure to add Designer’s RESPONSE in the description as shown
below:

List |. Spatial|
Label (User Defined)

/ 4 001-1302931A-00 Watermain Insulation Submittal-118-169
& [B) 001-1302931 A-00 Designer's RESPOMSE Watermain Insulation Submittal-118-169

Description Fc

# B rr-1

/ RFI-1 Response

# B rr1-2 4 Y
/ RFI-2 Response

B e Submittal and
/ Bre Designer's
Response Files

—

Figure 139 - Response Document

14. Then change the state of the Designer’s response to REVIEWING. If the state is not
changed to REVIEWING the Contractor will be able to open the designer’s response.

7 B 0205105 Structursl Steel Struckural Steel Shop drawings for Bridge 01564 and 01457 02-CLOSED
# Bl us0s205-Deformed Steel Ba Deformed Stesl Bars Shop drawings for Bridge 01564 and 01457 02-CLOSED

Template(Ttemi# = tlae . St ISOEFT
New 13

Open
Open as Read-0nly
Open With. .,
Markup

Yiew

Right Click on chedkou

Check Iy

the submittal Free

Copy Qut
and select F—
Change State>Next eco—

P ‘Dart Dependentcy Map(s)..

iport Dependency Map(s)..

oF)

DDEumEnIF’mpElllesl review | Dependency Viewer | Access Contiol | Components

b= Server, Copy
View: | <Default> Refresh Local Copy
- Pulls Lacal Copy
- Pure Workspace

| Property value
CT_CON_SDR_9876-5432_Templ:
120_Contractor_Submittals (PDF)
CTDOT_Design_Envir

Cop CT_CON_SDR,_3676-5432_Templ:

Pasts 120_Contractor_Submittals
MIC-Addmin

copy MIC-Adrin

Move TR... MIC-Admin

Renamey. . Checked In
Delete 1t Submission

Sat 3
send To »
Copy List 3

Properties...

Change...

Set Final status
Edit attributes For multiple dacuments Remove Finel Status

lan_2011a

Figure 140 — Changing the State of a Document
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Click OK you

do not need to —3
enter a comment

Y —
C Joea |

Figure 141 - Changing the State

15. Then notify District Construction that the response has been uploaded.

District Construction Review
After the designer has reviewed the working drawing submittal, district construction do the

following:

a. Review the designer’s comments and update the comments on the
drawings/documents as necessary. District has the final say on what comments
the contractor should be able to see.

b. Stamp each working drawing sheet with the action stamp, stamp the first page
of any calculations or supporting documents with the action stamp

c. Create the CTDOT response back to the contractor.

16. Open the file from Projectwise.
17. To place the action stamp, left click on the stamp in the tool chest and then place it.
Each plan sheet in a working drawing submittals shall be stamped. For calculations and

supporting documents in a working drawing submittal, only the first sheet of those files

needs to be stamped.

s
o

Left click on
the stamp
and place.

ACTION STAMP.
o
EI. -
HOS. 03912 AMD 03213 == |5uperseded
TOWN OF NEW BRITAM, CT  STATE PROJECT NO.
e ERECTION DRAWING Highlight
(l:?OTHﬂ CSNIRKCTING €0, INC. 5/10/1 p
ROJ. 0, CHECKED BY: | DA = Highlight
C1372 | BH 871017 G
FRINT_RECORD
HD. ISSUED T0 / FOR j Callout
Text Box
S Use to Cloud
| > ; 5 | — s |Coud Lt
/ Line Use to Cross Out

Figure 142 - Placing Submittal Stamp
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18. Next select the appropriate option from the java script window and click OK.

L R T MY TR J

R ML STEEL. SHIPPING MARKS AT THE END AS SHOWN 01
Submittal Review [
TVPE| .
THE JavaScript Window
Action
@ Mo Exceptions Moted
) Exceptions as Moted
IN A ") Revise and Resubmit
NOTE ) Rejected
Date of Review
Date: 12114/217

Figure 143 - Submittal Review Stamp

19. If the stamp is too big and is covering part of the drawing, resize the stamp by dragging
a corner as shown below:

- ~ L, by
S [ % Rl
p— LOCATION mEamme | TOTAL BEARING DINENEIONS
MARK A AOUTIPIER SPAN BEAM[S) TPE m’: i w T &
ERALD I FER 2 ) BnE & B11W £ [E] [3 L 1. Fhg L
B0 4 mem 2 a B2 L -] & v 1Ly L
TRAY-O 1 PER 2 B ™ 3 ¥ L TaE L
TESTO 1 Hi ACTION STAMP [ ) 3 ¥ LTa¥ [
—a T
=Ta 7 [T, [
= -
S - :f-",?"/ _-ﬂ_:,"'-\-__ wasasts Fa
[ 4] . o :‘,&_,/ o, Mg
i I A S Y
| [ R
o |& L RIS of nAESmILr Ah Gt | SRR .
'| ¥3 FEIN |
1§ 5t i o I S— 1
! E - ; - - e fll
:.'_ y _ I L i | ::
| *|3 1l ™, | | / =&
;: 3 i .
_— t w10 Fesize the stamp,
| L . i
Lo vEw first click on the middle
M- of the stamp so the
. v e yellow circles appear,

then click on a corner and
drag it to the size
that fits.

Figure 144 - Submittal Review Stamp
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The stamp is now resized as shown below:

ON_SDR_0004-0133_0153468-Bearings. pdf* D-1* >
BEARING LOCATION BEARING ]
MARK ary. TYPE :
ABUT/PIER SPAN BEAM(S) '
EBA1-D 2 PIER 2 3 B-11E& B-11W EXP
 EBA2D 4 PIER 2 3 B-12 EXP
EBA3.D 1 PIER 2 3 812 EXP
TEST-D 1 N/A N/A NIA P
AS2 Af2
"SOLE 7 SOLE FL | ACTION STAM
N
L/2 L/2 | 3
LAM. PAD | LAM, PAD ‘
| BEARING |
'..4 19 llr.____L____j A
old 5 1 J/V ATETTTS
! f
i -
The stamp is | ol eSS

now resized

i
I

Sy *1E |
B B |
| ! 1 L ~
! . 11GA (.1196° NOM.) INTERNAL SHIM/
(3) REQUIRED
Figure 145 - Resized Stamp
20. After the review is completed, close the file and click yes to save.
01! o D-1°
BEARING Locw BEARING TOTAL BEARING DIMENSIONS STEEL SOLE PLA®
mark | 9T TYPE LoADS
ABUTIPIER SPAN\ Mﬁ(s; IPS) L w T A B i)
EBAID 2 PIER 2 3 \|BrEaBgwW| e 75 & o 735" o A | a0
__EBA2D 4 PIER 2 3 \ B12 W 10" 3.00"
EBA3-D 1 PIER 2 ) 3 B-12 T 1o 391'
TEST-D 1 NiA NA |\ NA [ Close the file NiA NA |
A2 A/2 LY -
SolE P Soe P | susmrTTaL irew and click yes to save .
SEsiGuE s REAGY
L/2 Liz % . - ,T,._
LaM. PAD | LaM. PAD = i Fay 10
S G 7 BE VULCANZED 70 i
BEARING THE SOLE PLATE %
— - 1 mla
| i |

poo1R | | .
ald o fs Ll ‘ ! “tt

W 2E ez
’ g % DEQ | | | ®

s 2« | . »

w E : : Save changes Iuk following POF files? £ E ==
sldgf |l | : Fie Path EE covel
Wy 72 | [ D1.pdf g PL 3/87

e Jr ! S 10 B¢ PELD

be—eg——- - E] EXISTING HOLES
I n6a (1 - (14) TOTA
PLAN VIEW
AHERD e
Sano BEVELED SOLE FLAT o ATE
SURFACE oF ‘DL | THE CLx At BRIDH
PLATE FOR FIELD WELDING . ROUTE 2
“ [ QL
® 1 fBEﬂR\Nc = = ™ ( ‘Yes = No Cancel = OISTRI
2 [_ — e 50 DuRcw:l:q NEOPRENE GRADE 3 HAVING A SHEAR B
A JODULUS OF 035 KS| £15% o
- = = UN] OMLY — NO SOLE PLATE PROU. ¥O.: 171
)\ (1) REQUIRED 1 FIE
“Csee DETAL 1 [ LAMINATEL
ELEVATION VIEW | e
EXPANSION ELASTOMERIC BEARING ASSEWALY | Eoimy
Figure 146 - Saving the Shop Drawing
21. Repeat the review process for the each drawing/document in the submittal.
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22. Then save the file and close Bluebeam. Then check the document back into Projectwise

by clicking on Check In in the Check In dialog box as shown below:

Check In
General |
i~ Documents
ame | File Mame

CT_COM... CT_COM_SDR_0876-5432_0156478-Bearing_(1).pdf

C — i

Falder: 01.0 - Projects - ActivelShop Drawing Testh120_Caontractor_Submittals (PDF)

™ Create new version during Che

v ,7) Click Check In ———

| Check In ' Update Server Copy | Free | Cancel

Figure 147 - Check In Dialog

23. Next prepare the response back to the Contractor as required by your business unit. If a
separate document is created, save that file in 120 Contractor Submittals folder and
make sure the label attribute of the response matches the label of the file submitted by
the contractor. Also make sure to add Response in the description as shown below:

om: CTOOT\Documents'01.0 - Projects - Active'0118-01694120_Contractor_Subr } Go

A nwrirﬂ'i fata)

/ 001-1302931A-00 Watermain Insulation Submittal-118-169
/ 001-1302931A-00 RESPOMSE - Watermain Insulation Submittal-118-169

7 RFI—-l
# B rA1-2
# B rA1-3
# B rF1-4

Issued 10/2017

/ RFI-1 Response
/ RFI-2 Response

/ RFI-3 response

Format_Cor
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Submittal and
Response Files
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24. Then change the state of the submittal and response to CLOSED. If the state is not

changed to CLOSED the Contractor will not be able to open the stamped

drawings/document. Note: You will have to follow these steps twice to change the

state of the response from Open to Closed.

# B uz0s105-structural steel Struckural Steel Shop drawings for Bridge 01564 and 01457 D02-CLOSED
d Steel Ba Deformed Steel Bars Shop drawings for Bridge 01564 and 01457 02-CLOSED
....... T D01-OPEN

Open
Open as Read-Orly
Open With. .
Marlup

Yiew

Right Click on heckout

CheckIn

the submittal | -
- Copy Out

and select =
Change State>Next \?”“"

tart Studio Session.. .
. ‘:pwt Dependency Map(=) ..

9F)

iport Dependency Map(s)..

Documert Prapeties |
late Server Copy.

View: | <Defaults Reefresh Lacal Copy

[ Pulge Local Copy

review | Dependency Viewer | Access Contiol | Components

| Property value

- [ - .‘W””GD“E CT_CON_SDR_9876-5432_Templ:
| | i 120_Cortractor_Submittals (PDF)

CTOOT_Design_Envir
CT_CON_SDR_3676-5432_Templ:
120_Contractor_Scbrmittals
MIC-Admin

MIC-Admin
MIC-Admin
Checked Tn
15t Submission

izl Attributes. .,

add Cormnent

Set | »

SendTo | »

Copy List 3

bt N

Next D

Batch Frint

Sl Change...
Preperis. et Finelstabus

Edit attributes for rltiple documents Remove Finsl Status

lan_2011a

Figure 148 — Changing the State of a Document
B
Comments |

Enter Comment:

Click OK you
do not need to =]
enter a comment

V —
@ Jeorca |

Figure 149 - Changing the State

25. For Shop Drawings, Product Data, or Other types of Submittals, the Designer shall send

an email notification to the Contractor stating their review is complete.
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Section 10 Digital Review and Commenting

This section details the digital review process using Bluebeam’s collaborative online review tool
called “Studio”. The procedures outlined below describe how to: 1) Create a review session, 2)
Invite people to a session, 3) Join a session, 4) Comment in a session, 5) Close the session, and
6) Respond to comments made in the session. Also, directions for locking the documents after
the review process to create a read-only final record copy to be stored for future use are also
provided.

The following link in to a Bluebeam Resources website. On this website are videos for the Digital
Review process: Bluebeam Resources These videos show an overview, but specific details are
found in this document

10.1 Introduction

A digital review is when a document is reviewed in its native digital format or as a digital copy of
the original paper document. Any required markups are placed directly on the document using
a computer with software designed for managing digital reviews. The documents can also be
printed from the review session and the paper copy marked up; however, those markups must
get transferred back to the digital copy.
Advantages of a Digital Review Compared to Conventional Paper Review

1. Higher Transparency — Increased Collaboration.

2. Digital markups are searchable and sortable, by comment, author, etc.

3. Real time collaboration review process improves turnaround time and quality of the
review.
Real time feedback allows easier handling of large amounts of data.
Reduces the time required to compile and resolve comments.
Eliminates document mailing time.
Reduces document printing.
Eliminates shipping cost.
. Easily store a permanent digital record on the cloud.
10. Overall reduction in review time.

©wNO VA

Types of Reviews:
This manual may be used as a guide to perform a digital document review on any digital
document. Below is a list of examples of the types of documents that may be reviewed:
e Preliminary Design Plans
e Structure Type Studies
e Semi-Final Plans
e Final Plans for Review
e Special provisions
e Engineering Reports
Review Process:
To help participants of a digital review more easily track the digital review process it has been
split up into six Phases as listed below:
e Phase 1 — Preparation of the Digital Documents
e Phase 2 — Set Up Digital Review
e Phase 3 — Invite Attendees to Review
e Phase 4 - Digital Review
e Phase 5 - Ending the Digital Review
e Phase 6 — Resolve Comments
Each phase and its required steps will be discussed later in detail.
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Digital Comments:

In this review process, all comments must be applied to the documents in the review session.
Reviewers have the ability to print the digital review documents to paper and mark them up,
however, when done, all must be transferred from paper to the digital documents, see Section
10.7.3. If a unit cannot print their own paper copies they should contact MaryAnn Cass by email
MaryAnn.Cass@ct.gov. In the email include the project number and list documents that need to
be printed, and include the address of where they are to be mailed. In the case of preliminary
contract plan reviews, the original digital documents, with comments, will become the final
record.

All comments associated with a design submission should be applied to the digital documents.
Telephone of email comments must be applied to the correct digital document by the staff
member who received them. Be sure to use engineering judgment to determine the most
appropriate location for the comments in the document. General project comments can be
placed on the first sheet of the document using the note markup tool in Bluebeam. This process
is detailed in Section 10.7.3. If any outside entities (railroads or utilities) will not participate in
the digital review, their comments with your responses should be attached to the final record
copy in accordance with Section 10.7.3. Itis not necessary to transpose these comments
individually as all comments can be attached at one time.

FOI Requests
Contract Document Digital Reviews - After a digital review session has been completed and all

the comments have been resolved, a read-only copy of the review documents with the
comments and resolutions will be stored in the 310_Milestone_Submissions folder under the
project.
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10.2

Prerequisites

1. CTDOT has standardized its digital review process using the document format PDF, and
the software Bluebeam. This software was chosen for the following reasons:

a.

Includes a collaborative live review feature (STUDIO) with real time feedback,
enabling all reviewers to comment on the same document at the same time out
on the cloud.

A license for Bluebeam is more cost effective than competitive software like
Adobe Acrobat. Thus it is much less expensive to purchase and maintain.
Only the Organizer of the review is required to have a licensed copy of
Bluebeam. All other attendees can participate in the digital review using
Bluebeam’s free version, Bluebeam VU.

Bluebeam is integrated with ProjectWise. This simplifies the delivery of the
original review documents as well as saves the final reviewed copies and their
comments.

2. The following table lists the software required to organize and/or participate in a CTDOT
digital review. Note: Itis recommended that the latest version of the software be used.

Role Software

Organizer — Manages review Bluebeam Extreme or Revu Standard and Projectwise Explorer

Author — Produces documents Projectwise Explorer

Reviewer — Reviews documents | Bluebeam Extreme or Revu Standard or Bluebeam VU*

*Bluebeam VU is a free viewer that allows reviewers to participate in a digital review (NOT create/organize a review).
When a staff or consultant is invited to a digital review and they do not have Bluebeam VU or a licensed copy of
Bluebeam Revu Standard installed on their computer, a link to download Bluebeam VU will be included with the
invitation. Note: An IT administrator may have to install this software on the computer.

3. Al CTDOT digital review participants are required to complete the steps provided in
Appendix A prior to organizing or joining a review session. Completing these steps will
standardize the Bluebeam format across all CTDOT digital reviews.
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10.3 Digital Review Workflow

F
éﬁp’
es‘dﬂ
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\ o A 3 £ "
¥ ot oF o \‘\‘ﬁf‘ I8 qf-"sh Opc’lf" Q—e‘:&:‘é\ of
PHASE 1 PHASE 2 PHASE 3 PHASE 4 PHASE 5 PHASE 6
Figure 150

All CTDOT digital review participants are required to complete the steps provided in Appendix
A prior to organizing or joining a review session. Completing these steps will standardize the

Bluebeam format across all CTDOT digital reviews.

Roles

Organizer — The organizer sets up and coordinates the review session. For in-house projects this

would be the project lead and for consultant jobs this will be the Consultant Liaison.
Author - Group that produces a document(s) for the review.

Reviewer — Group that participates in the review session to review documents.

Step ‘ Role ‘ Task ‘ Section
Phase 1 — Preparation and Delivery of the Digital Documents
11 Organizer Coordinate the organization and preparation of the review Section 10.4
documents. Request all Authors to upload their review
documents into Projectwise.
1.2 Author Prepare and upload review documents into Projectwise. Section 10.4
Notify the Organizer that this step has been completed.
1.3 Organizer Check that all review documents have been prepared and Section 10.4
uploaded correctly into Projectwise.
Phase 2 — Set up Digital Review
2.1 Organizer Start a Bluebeam review session and then change the state Section 10.5
of the review documents in Projectwise to “Reviewing”.
Phase 3 — Invitation to Review
3.1 Organizer Create a Digital Review memo, which includes a link to the Section 10.6

digital review session, and send it to all Reviewers.

Phase 4 - Digital

Review

41 Reviewer Join the review session by clicking on the link provided in the | Section 10.7.1
review memo. Become familiar with the review session and Section
layout. 10.7.2

4.2 Reviewer Set Status to “Reviewing” Section 10.7.3

4.3 Reviewer Review the documents in the Bluebeam review session and Section 10.7.3
place comments on documents as necessary. Documents
can be printed, marked up, and then comments transferred
the PDFs. If the documents cannot be printed out, send a
request to engineering records.

4.4 Reviewer When finished reviewing, in Bluebeam, Set Status to Section 10.7.3
“Finished”

4.5 Reviewer Send a Review Comment Memo to the Review Organizer Section 10.7.3
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Phase 5— Closing the Digital Review

5.1 Organizer Close the Bluebeam review session and check the Section 10.8
documents back into Projectwise.

Phase 6 — Resolve Comments

6.1 Organizer Notify the Authors that they can review the markups on Section 10.9.1
their review documents in Projectwise. Provide them with a
link to the folder in Projectwise.

6.2 Author Open the specific document(s) from Projectwise. Section 10.9.2
6.3 Author For each comment on your document, type a final Section 10.9.2
resolution.
6.4 Author After all resolutions are applied to comments, Notify the
Organizer that you applied your resolutions.
6.5 Organizer Change the state of the review documents to “Review Section 10.10

Complete” to make all review documents read only after the
resolutions have been applied.

6.6 Organizer Send out a Completion of Review Session Memo to all the Section 10.10
personnel associated with the review session that the all
comments have been resolved on the documents located in
Projectwise.

10.4 Phase 1 - Digital Document Preparation

10.4.1 Organization
Below are the guidelines by which the review documents should be organized:

Preliminary Contract Document Reviews — PD, SF, FPFR, etc.

1. Plans - Must be in discipline subsets. The review Organizer is responsible for assigning
each Author a subset number in accordance with Section 4.1 Note: CTDOT Standard
Subsets cannot be added to a review session because they are combined in a PDF
Package (Portfolio).

2. Special provisions — Each discipline shall combine all of their special provisions into one
(1) PDF document. Each discipline’s special provisions will remain separate throughout
the review session; they will not be combined with the other discipline’s special
provisions.

3. Other Documents — Shall be individual PDF documents.

4. All Authors must upload their documents into the 310_Milestone_Submissions folder
under the project in Projectwise.

Other Reviews

1. The only requirement for the organization of other types of reviews is that the
documents must be in PDF format.

10.4.2 Preparation and Format

Authors shall prepare their digital documents in accordance with the following guidelines:
Preliminary Contract Document Reviews — PD, SF, FPFR, etc.

1. Plans:

a. Must be in PDF format

b. Plans must be in discipline subsets

c. Plans must be sized 34" x 22”

d. Do not need watermarks, sheet numbers or to be digitally signed.
2. Special provisions:
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a. Each discipline shall combine all of their special provisions for review into one
(1) PDF document.
b. Sized 8.5” x 11”
3. Other Documents:
a. Must be in PDF Format

Other Reviews

1. Documents:
a. Must be in PDF Format

10.4.3 Uploading Digital Documents

Authors shall upload their digital documents into Projectwise in accordance with the following:
For Preliminary Contract Document Reviews — PD, SF, FPFR, etc.

1. Launch Projectwise and log in.

2. Browse out to the project this review is for and open up the
310_Milestone_Submissions folder and the specific review folder: If the three
subfolders are not in the project contact Mathew.Calkins@ct.gov

|_:_|1__,_""= CTDOT_Project_Template_lan_2011
100_Contract_Plans (PDF)
110_Contract_Documents
120_Contractor_Submittals (PDF)
130_Final_Engineering_Reports
131_Engineering_Reports_Confidential
140 _Project_Administration
141_Project_Administration_Cenfidential
150_GIS

151 _Project Photos

160_Property Maps

210_Construction

220_FHWA
230_Contract_Administration
240_Contract_Development

[l
=

R EE

241 _Contract_Development_Confidential

SR 310:MiIestu:une_Sul::lmissiu:uns
.[7 30% Review
-l 60% Review
{7 90% Review

i 20_Fermit_Levelopment
- 330_Design_Data
¢ L]0 01 - Final Design Calculations

Figure 151 - Projectwise Project

Issued 10/2017 150 Version 4.03


mailto:Mathew.Calkins@ct.gov

Connecticut Department of Transportation — Digital Project Development Manual

3. Make sure the

“CTDOT_Doc_Code” Interface is selected and drag your file(s) one at a

time into Projectwise as shown below:

Note: If the interface box is not displayed, go to the menu View>Toolbars>Interface. Then

you will be able to

B ProjectWise Explorer Vi (SELECTseries 4)
Documen: _Exgort(View ) Tooks Window  Help

If the Interface
dropdown is not

there, go to View>

select the correct Interface.

et =] © © 8 sean ) . [;Gm)ew[:nm
0

: Address [© pwe\\ctdot.projectwiseonline.com:CTDOT\Dacuments\01.0 - Projects - Active\0001 10_Review Docume > [ GO
“xplorer Datasources - | List | @ Geaspatial| /

njc-admin)

stion File Updated ~File Upda
ments

0 - Projects - Active (1) Make sure

£ 0001-0100

Toolbar>and make : CTDOT Doc Code

sure Interface is
checked

4. Select Advance

/ Select a Wizard [g

1 100_Contract_Plans (PDF)

[ 110_Contract_Specifications, is selected
-+ 120_Contractor_Submittals (

-+ 130_Final_Engineering_Repo

{7 131_Engineering_Reports_Confidential
{7 140_Project_Administration

= 141 Project_Administration_Cenfidential
= 150_GIS

[ 151_Praject Photos

o 210_Construction

o7 220_FHWA

1= 230_Contract_Administration

o 40
1 241_Contract_Development_Confidential
1 310_Review_Documents

L7 30% Review

Contract_Development

{7 60% Review .
L 90% Review (2) Drag and Drop file
- 320_Permit_Development

{I 330_Design_Data into this area in

{7 500_Pre_Design
8 Soved Searches Projectwise
178 0004-0116
74 non4-n118

Figure 152 - Uploading Documents into Projectwise

d Wizard

Document &e@
x| | ca:

MNo Wizard Advanced
Wizard

S——
[ Make this wizard the default.
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5. Click next until the attributes screen appears as shown below. Enter the correct

attributes from the attribute table Projectwise Attribute Table and then click next until
the document uploads.

Advanced Document Creation Wizard [‘5_4

Define Document Attributes
“ou should define environment specific document attributes.

4
Discipline / (1 ) SE|ECt 2y
= = appropriate
Main Category Main Category Descri
[con | | Cortract Plans & Spece |
Sub Category Sub Category Descg[:
|PRE v| [ Pians_01 - Preliminary Pidhs (2) Type
Project Number(s) / apprC)F)rlate

[0004-0116_00040118 ‘ |

Label (User Defined)

30% -01-General v

Description

P1-General Preliminary Dasign Plans

CT Code {Auto Fill In)
|CT7[:ON7F‘HE70|)D4—D11670004—0113730‘1.-01-Genem\

\sset Tags

(3) Click Next ] Signal Intersections
. \

[ i
< &
S —
[ < Back (L Mt > 11 Cancel ]
Figure 154 - Attributing a Document
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For Other Reviews

1. Launch Projectwise and log in.

2. Browse to the folder where the digital documents are to be stored.

3. Make sure the “CTDOT_Doc_Code” Interface is selected and drag your file(s) one at a
time into Projectwise as shown below:

Note: If the interface box is not displayed, go to the menu View>Toolbars>Interface. Then
you will be able to select the correct Interface.

=< ProjectWise Explorer V8i (SELECTseries 3)

Datasource Folder Document Tools  Window Help

A % 2| o e @ 84 - |searcn D v‘(Inteﬁa(elUDOT_Duc_Code |  viw| Document -

P BRI

‘Address [ pw:\\ctdot, projectwiseonline com:CTOOT\Documents\01.0 - Projects - Active\0004-0116 &!4-0118\310_F‘rel v [P Go

Select View> Explorer Datasources e
(mjc-admin) Label (User Defined) Description Msin Category | Sub Category
01.0 - Projects - Active

Toolbars>Interface
of the Interface box %57 o (1) Select

is not displayed i comi i CTDOT_Doc_Code

120_Contractor_Submittals (PDF)
130_Sol_Archasological_Misc_Reports FOF) 9§ t h e | n te rface
210_Construction

220_FHWA

230_Contract_administration
240_Contract_Development
241_Contract_Development_Confidential

#

310_Preliminary_Design_Documents(PDF)

320_Permit_Applications

330_Design_Data

340_Administration q

®
(SASACACAGARARASASARARAGARAS

341_Administration_Confidential
[ 500_Pre_Design
4 saved Searches

{*% 0003-0094

{*% 0011-0151

-7 0014-0177 (2) Dl'ag and dl’Op

{* 00140183

w % oot 033 file into this area
= 0017-0183 - - -
2 & omoun in Projectwise

{* no25-0118

PR NN

Figure 155 - Uploading Documents into Projectwise

4. Select Advanced Wizard

/" Select a Wizard El

=
& B

Mo Wizard Advanced
Wizard

Document Creapeh VWizards

[] Malke this wizard the defautt.

Figure 156 - Advanced Wizard
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5. Click Next until the attribute screen appears shown below. Enter the correct attributes
for the review documents and then click next until the document uploads. Make sure a
good label and description are entered.

Advanced Document Creation Wizard

Define Document Altributes
*You should define environment specific document attributes. frvl_

[():i:cipline . / (1) SeIeCt

Main Category Main Category
CON v | Contract Plars & Specs |

Sub Category Sub Category C

|soR | [ Approved Shop ey (2) Type in
Project Number(s) / these

[0004-0116_0004-0118 ‘ |

Label (User Defined)
tem# 0605252 v

Description

Structural Steel Shop Drawing Review

CT Code (Auto Fill In)
[CT_CON_SDR_0004-0116_0004-0118_ttem 0605252

——

H DOT Asset Tags
(3) CIICk \ Signal Intersections -

| 1\ N -
[ﬁ' ([ _net> ) coce |

Figure 157 - Uploading Documents

|-

6. Notify the Organizer that the documents have been uploaded into Projectwise.
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10.5 Phase 2 - Set Up Digital Review

The Organizer shall set up the review session in accordance with the following: Note: The
example below is for initiating a Semi-Final review but can be followed for other types of

reviews.

1. Launch Projectwise Explorer from the shortcut on your desktop or the start menu.

2. Browse out to the project’s 310_Milestone Submissions folder. (For other reviews
browse out to the folder in Projectwise where the documents are located. Note: The
document does not need to be in Projectwise to use Bluebeam’s Studio feature.)

Issued 10/2017

D'I..-—R cT

Eﬁﬁrﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁ

DOT_Project_Template_Jan_2011
100_Contract_Plans (PDF)
110_Contract_Documents
120_Contractor_Submittals (PDF)
130_Final_Engineering_Reports
131_Engineering_Reports_Confidential
140_Project_Administration

141 Project_Administration_Cenfidential
150_GIS

151 _Project Photos

160_Property Maps

210_Construction

220_FHWA

230_Contract_Administration
240_Contract_Development

241_Contract Development_Confidential

310_Milestone_Submissions
|- 30% Review
{7 60% Review
1= 90% Review

Figure 158 - Preliminary Design Documents Folder

240_Fermit_Lrevelopment
330_Design_Data
1= 01 - Final Design Calculations
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3. Next select all the documents that are to be included in the studio session, right click,
and select Start Studio Session:

ey

I e

e R L L T b L I

line.com: CTOOT Documentsi06.0 - ProjectWise Administration\01 - Administrators\h V| ’- Go

Right Click on the

e’ List | & Geospatial |
Label

# [B) 30% - 01-General
# B 30% - 03-Highways
# B 30% - 04-Traffic

# [B) 30% - 05-Structures
# B 30% - PD Statement

Select View

Description

01-General Preliminary Design Plans
03-Highway Preliminary Design Plans
04-Traffic Preliminary Design Plans
05-5tructures Preliminary Design Plans
Project 120-086 PD Statement

LRSS

documents and select

"Start Studio Session”

“Ur)

:_Reports (PDF)

Confidential
Jments{POF)

itial

Issued 10/2017

Purge Local Copy

Refresh Local Copy

Cut

Copy
Paste...

<

Figure 159 - Start Studio Session
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4. Using the naming guidelines from the table below, type in the applicable review session

name in the box entitled “Session Name”.

Review Review Name
Preliminary Design (30%) Project #XXXX-XXXX PD Review
Structure Type Study Project #XXXX-XXXX Structure Type Study Review
Semi-Final (60%) Project #XXXX-XXXX SF Review
Final Plans for Review (90%) | Project #XXXX-XXXX FPFR Review
Other Include Project number if necessary and give a good description

of the review

Also, as shown in the figure below, make sure that all the options are checked. Note: Setting
the Session Expires date is optional. If set, this date can always be changed after the session is

created.

Start Studic Session =

) %
Session Mame:  Project #0123-0123 PD Review

Uocuments

File name Path

v4]| CT_CON_PRE_30%-04-T... PW:ctdot projectwiseoriin...
CT_COM_PRE__30%-03-H... PW:ctdot projectwiseonlin. ..

r Y

v

Options

Pemission

Save As
Prirt
Markup
Markup et
] Add Documents

Session Expires May 22, 2015 B~ || 500 FM | ,

o Dot

(1) Type in the
session name

_. (2) Uncheck

(3) Optional - Set if

Restnct Attendees by E-mail Address / necessa ry

— (4) Click OK

Figure 160 — Initiating a Review Session
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5. Inthe next dialog box click copy invitation as shown below. The invitation will be copied
to the clipboard of the computer and then can be pasted into an email or memo.

Session Invitation

Session Information

B

Session Mame:  Session
Session ID; 068578012
Invitzes
E-mail Address
*]

Click to copy
invitation to

L__clipboard

= [@

Message (Optional)

Note: A Session is limited to 500 Attendees

Figure 161 - Adding Email Address to Studio Session

Next paste the invitation into a blank Word Document or email. The following is an invitation
that has been pasted into an email. Note how the session URL appears in blue. Then you can
copy the URL from the blank document or email into a formal memo.

S H9 [ Untitled - Message (HTML) o B =
Message | Insert  Options  FormatTest  Review  Developer  Adobe PDF o @
=3 PO @ i dall ¥ Follow Up ~ [ 5]
’ Calibri (Body ~ 11 = A" A 8B &8l @ g /E = .
- - b . A - |[=] A v E —J‘J 9 High Importance A
Paste . A [= Address Check | Aftach Attach Signature | Assign Zoom
- < Format Painter B 7 U LBl — Book Mames  File Ttem= > Policy - # LowImportance
Clipboard Basic Text ] Names Include Tags 2| Zoom
Ta..
— (-
Send
Subject:
&
You have been invited by M. Calkins AEC Applications (mathew.calkins@ct.gov) to join a Bluebeam Studio Session:
Session
Session 1D: 08528012
Session UR(: https://studio.blueb 1.com/fjoin.htmI?1D=068-578-012 > I - If needed copy URL
Mathew Calkins, P.E. into formal memo.
Transportation Engineer 3
AEC Applications
Connecticut Department of Transportation
2800 Berlin Turnpike
P.O. Box 317546
Newington, CT 06131-7546
860-594-2988
Mathew.calkins@ct.gov
1 i 3
Click on a photo to see social network updates and email messages from this person. 2 v

Figure 162 - Session URL
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6. After the session has been created go back to Projectwise, Select all the documents that
are included in the session.

- search| I ~| B> interface sub category 1 | i view| Dacument v
seonline.com:CTDOT\Documents'06.0 - ProjectWise Administration\01 - Administrators\h % | b Go
) List | @ Geospatial |
Description Main_Cat Sub_Cat Cat_Description

- 01-General 01-General Preliminary Design Plans Ccon PRE Plans & Specs_01 - Preliminary
- 03-Highways 03-Highway Preliminary Design Plans Ccon PRE Plans & Specs_01 - Preliminary
- 04-Traffic 04-Traffic Preliminary Design Plans CON PRE Plans & Specs_01 - Preliminary
- 05-5tructures 05-tructures Preliminary Design Plans CON PRE Plans & Specs_01 - Preliminary

- PD Statement Project 120-086 PD Statement DocC MDO Misc Documentation
60% - 01-General 01-General Semi Final Plans CON PRE Plans & Specs_01 - Preliminary
0% - 03-Highways 03-Highway Semi Final Plans CON FRE Plans & Specs_01 - Preliminary
60% - 04-Traffic 04-Traffic Semi Final Plans CON PRE Plans & Specs_01 - Preliminary
60% - 05-5tructures CON PRE Plans & Specs_01 - Preliminary

0% - Cost
= 50% - HWY-Specs

05:Structures Semi Final Plans
t Estimate
Highway Semi Fin

Select all documents es-Lot-Premnay
to be included in the
review session

Figure 163 - Select Documents to be Included in Bluebeam Review Session

7. Then change the state of the documents to “REVIEWING” as shown below:

|

mie W - Frojeavise

>

List \. Geospatial |

Description

o - 01-General 01-General Prelminary Design Plans
03-Highway Prelminary Design Pians
04-Traffic Prelminary Design Plans
05-Structures Preliminary Design Plans

Froject 120-086 FD Statement

Select View

New
(1) Right click on the
Check Qut
documents and select
copy Change State>Next
irts (PDF) Export...
Start Studio Session.
lential
3(PDF)
Refresh Local Copy
Purge Local Copy
Cut
< Copy
| Dooum Pt jertes | Photo Prefew || Dependency Senvice | Acces:
=]
GEN
irts (PDF) GEN
GEN  Delete
GEN  Modify...
GEN  Modify Linear Attributes...
Modify Spatial Attributes.
GEN
‘;”“5‘ Gey | Add Comment
ASS) Set »
ASS SendTo » {'
ASS) Copy List To »
| tiuin .

oo W —
¥ Drevious

Desit ~garerrPrm

Desit

Desi Set Final Status
Desii  Change filename to CT_Code

Desi|

Des,  Editatrbutes for muitiple documents
Desit  Old Audit Trail Repart

Desig - Digially Signe:

Placinn - BAW 81 TTH

Figure 164 - Changing the State to Reviewing

Then click OK next on the box that pops up. The documents will now be in the

Reviewing state.
List |. Geospatiall P |
&

Label (User Defined) Description Document Date (mm/... Application State

/ B Inspection Report Condition Assessment/Inspection Report Arrigeni Brid 6/10/201512:00:00 AM  Acrobat PDF | REVIEWING
RSR for Project Mo, 82-312 Arrigoni Bridge Mo. 00524 _ 8/7/201512:00:00 AM  Acrobat PDF | REVIEWING
RSR for Project Mo, 82-312 Arrigoni Bridge Mo, 00524 3/22/201612:00:00 AM  Acrobat PDF | REVIEWING
RSR for Project No. 82-312 Arrigoni Bridge No. 00524 3 3/22/201612:00:00 AM  Acrobat PDF | REVIEWING
GPR Condition Evaluation of Arrigoni Bridge-Project Sum 3/28/201612:00:00 AM  Acrobat PDF | REVIEWING

_/ GPR Report_Arrigoni Bridg GPR Evaluation of the Arrigoni Bridge Deck / 3/29/2016 12:00:00 AM  Acrobat PDF § REVIEWING

Figure 165 - State of Documents
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10.6 Phase 3 - Invitation to Review Session

The Organizer shall invite Reviewers to the review session in accordance with the following:
For Preliminary Contract Document Reviews — PD, SF, FPFR, etc.

The invitation to the digital review will be a PDF version of a review memorandum that includes
the following:

1. Atable of all documents that are in the review session.

2. Links to relevant documents that are not included in the review session but still need to
be referenced. These documents shall be located in Projectwise and Projectwise links
shall be included. (Not shown in the example below)

3. Alink to this manual (Digital Project Development Manual)

4. Alink to the Review session. To do this, paste the invitation that was copied when you
created the review session.

The PDF of the review memorandum shall be emailed to all Reviewers; this should include the
Principal, Supervisor and TE3 level of the reviewing unit where applicable. It is the Organizer’s
responsibility to compile a complete distribution list so the review invitation gets sent to the
applicable personnel. Below is an example of a memorandum for a preliminary design review:

STATE OF CONNECTICUT ubject:PRELIMINARY DESIGN REVIEW
DEPARTMENT OF TRANSPORTATION Project No. 0124-0162
Rotary Upgrade to Modem Roundabout
Route 188 at Route 334 and Holbrook
Road
Town of Seymour

memorandum date: December 11, 2012

10: THOSE LISTED BELOW from: Wiliam W. Britnell List all documents

Transportation Principal Engineer

Bureau of Engineering and Cunslrur.liun/ in the review and

Attached are the Preliminary Design Statement and the Bicycle and Pedestrian Needs Assessment our
e e ey o o e et leatn revioes o et v contfone o who authored them
recommendations to the following Preliminary Design Documents included in the digital ga#ffew referenced
below, by Tuesday, January 8, 2013
[ [ |
Document Document Author -
[LGeneral [ ighway Design ) Include a link

Comments and recommendations shall be applied to the documents in M to the Digital Project
d
peument Cj_i ital Project Development ManuD Development Manual

The following is a link to a live review of the 30% Preliminary Design of this project. Click on the following
link to join the review session

t Invitation to live Review of the Preliminary Design of this prmeaﬁ—
Units that receive paper plans can review the documents on paper, but must transfer their comments to the Include the link

digital pdf documents in the above review session.

to the review session

A Preliminary Design Meeting is scheduled for Wednesday, December 19, 2012 at 1:30pm in Room 3130 of
the Department's Administration Building, 2800 Berlin Turnpike, Newington.

Review comments must be applied to the electronic documents and comment memos must be sent to
Highway Design prior to January 8, 2013. Please contact Matthew R. Vail, Project Engineer, at (860) 594-

3342 should you have any questions or require additional information

DISTRIBUTION:

Thomas ). O'Hala Leo L. Fontaine - Michael F. McDonnell

John DeCastro Gregory M. Dorosh

Charles 5. Harlow - Mark F. Makuch Sohrab Afrazi

Delois L. Barnes Donald Ward - Mary Bajer - Hard Copy to Follow

Mark W. Alexander - Kimberly Lesay Colleen A. Kissane
Leo L. Fontaine - EdgardoD. Block
Lewis 5. Cannon - District 4 (Acting District Engineer) - Hard Copy to Follow

Attachments
Stephen Hall/sh

Figure 166 - Sample Review Memo

The Organizer shall also send out a reminder notification to all the reviewers two weeks prior to
the end of the review session.

For Other Reviews

Invitations for less formal reviews may not require a memo. It is recommended that an email be
sent which includes the links to this manual and the review session.
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10.7 Phase 4 - Digital Review

10.7.1

Joining a Review Session

To join a review session, either click on the link provided in the review memorandum for a
preliminary design review, or for less formal reviews, click on the link in the email. Below is an
example of an email for a preliminary design review (semi-final). Remember the link to the
review session is included in the memo that was emailed to all the reviewers.

1. Open the email from the Organizer and open the review memorandum.

<

U0 @) From

Subject

4 Date: Today
.4 @ Bourgoin, Bruce R

4 Date: Last Week
DOT Webmaster
1es DPD Manual =
[~4 DOTWebmaster
[~ Savader Asset Advisors LLC

(1) Open the email
from the Review
Organizer

Bentley Technical Support
Molly Watts@bentley.com
Pratt, William S

Richard, Elaine H

Rinaldi, John 5

Robert Brickley

Rinaldi John S

tp, DOT

DIDDDDPE

(2) Open the Review

Memorandum

i

Chhabra, Greg M
Maolly Watts@bentley.com
0 Hanley, Richard C

€1IDBADT@REMTI EV AR

{4 PilePro
=]
b=d
=]

Issued 10/2017

RESHQ3 Conf Room 3130, DOT  Accepted: Smart Board

Project 120-086 Semi Final Review

ConnDOT eAlert: News from the Con|
ConnDOT edlert: Construction News
Bloomberg Public Finance Conferen
RE: AEC Applications Database

ConnDOT eAlert: Construction News
ConnDOT eAlert: Construction News,

Received Size
Mon 10/1/2012 7:36 AM 51 KB
Mon 10/1/2012 1:40 AM 95 KB

File Message

i

=] + ¥ |5

Bluebeam ProjectWise

x —ﬁ] —ﬁk] _$ [5] Meeting

Project 120-086 Semi Final Review - Message

(=8 New e-mail to: N3 S Rules- (¥ Mark Unre:

Before it's too late

RE: proj 25-138: Pilot projectwise Chi
RE: Code Changer

FW: Bluebeam PDF problem

How did we do?

RE: ST Mumber: {ticketno:[300146157¢
FW: 10:30

RE: [GWGA] CT DOT DDE question
RE: [GWGA] CT DOT DDE guestion

RE: Projectwise
JFM

VAC 09/28/2012
sinar: Next Gen Imag
20T DDE question
- Board

Webinar Oct 2: Designing Combined
Using the 84" interactive board in §
RE: ST Mumber: {ticketno:[300146157¢

Bluebeam PDF problem

ST Miimbar firlabnn RANTAST ETATL

) 3 Reply Al = A onehote B Categorize
« Delete | Reply Reply Forward & - Move
& Junk A 2 More (23 test ] Actions - | ¥ Follow Up
Delete Respond Quick Steps Move Tags
From: Bourgoin, Bruce R
To: Calkins, Mathew J
Co
Subject: Project 120-086 Semi Final Review

Please read the attached Digital Review Memorandum for State Project 120-086

Project 120-086
Semi Final Rev...

Bruce R Bourgoin, P.E.
Transportation Supervising Engineer
Division of Design Services

Architecture, Engineering & Construction Applications

Connecticut Department of Transportation

860-594-2760

Bruce.bourgoin@ct.goyv

Figure 167 - Review Memorandum
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2. Click on the link to the Review Session.

STATE OF CONNECTICUT ubject:PRELIMINARY DESIGN REVIEW
DEPARTMENT OF TRANSPORTATION Project No. 0124-0162
Rotary Upgrade to Modemn Roundabout,
guutde 188 at Route 334 and Holbrook
oa

Town of Seymour

memorandim date: December 11, 2012

10:THOSE LISTED BELOW from: William W. Britnell
Transportation Principal Engineer
Bureau of Engineering and Construction

Attached are the Preliminary Design Statement and the Bicycle and Pedestrian Needs Assessment for your
use in the preliminary desizn review for this project. Please review and apply your comments and
recommendations to the following Preliminary Design Documents included in the digital review referenced
below, by Tuesday, January 8, 2013

[Document [ Document Author |
| o1-General | Highway Design

Comments and recommendstions shall be spplied to the documents in accardance with the following
document.
Digital Project Development Manual

The following is 3 link ta a live review of the 30% Preliminary Design of this project. Click on the following
link to join the review session.

( Invitation to live Review of the Preliminary Design of this DrniEM
Units that receive paper plans can review the documents on paper, but must transfer their comments to the Click on the link

digitsl pdf documents in the above review session

the Department's Administration Building, 2800 Berlin Turnpike, Newingten.

Review comments must be applied to the electronic documents and comment memos must be sent to
Highway Design prior to January 8, 2013. Please contact Matthew R. Vail, Project Engineer, at (860) 594~
3342 should you have any questions or require additional information.

DISTRIBUTION:
Thomas J. O'Hala Leo L. Fontaine - Michael F. McDonnell
John DeCastro Gregary M. Darash
Charles 5. Harlow - Mark F. Makuch Sohrab Afrazi
Delois L Barnes Donald Ward - Mary Baier - Hard Copy to Follow
Mark W. Alexander - Kimberly Lesay Colleen A. Kissane

Leo L. Fontaine - EdgardoD. Block
Lewis 5. Cannon - District 4 {Acting District Engineer) - Hard Capy to Follow

Attachments
Stephen Hall/sh

Figure 168 - Link to the Review Session
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3. Click Allow on the box that pops up in Internet Explorer. Ignore the text written in the

webpage as shown below:

: |\§“ https://studio.bluebeam... O ~ @ € || (& Bluebeam Studio ‘ ‘

(===

s [ Transmittals - All tems .« Installing SharePoint 2013 ... F% Sean Keene's Blog - Peer... [ Documents - All Docume... [[7] Signin to Office 365 2 eB

oining Bluebeam Studio Session...
Session: 600-702-866

Unable to determine if a compatible version of Bluebeam Revu or Vu is installed. If the meeting does not open click here to download Bluebeam Revu or Vu. l

\ Ignore this text

To join a session click
Allow
N\

Internet Explorer

[ \‘ AMllowing web content to open a program can be useful, but it can
\a potertially ham your computer. Do not allow it unless you trust
- the source of the content. What's the risk?

Figure 169 - Accessing the Review Session

4. Bluebeam will now launch. If this is the first time in a review session, a Studio Account
must be created. To do so click on Create Account and then enter in a State email
address and a password. In the Name box type in the First Initial then Last name and

unit. See below for an example.

Login

Studio Server:  studio bluebeam.com

If you do not

Domain / E-mail:

have an

Password: |

account click e —

Lost Password

create account

[ Use Windows Authentication

Figure 170 - Creating a Studio Account

Create Studio Account

&
&

/

E-mail: mathew calkins@ct.gov

Password:

Corfirm:

q?:

Login with Existing Account

emember password
Select

M. Calkins AEC Applications

@)

Click OK

Figure 171 - Studio Session Account
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If this is not the first time in a review session, enter the studio login information as shown

below: If you forgot your password click lost password and an email will be sent to you.

Please review and apply your and recom d to the Semi Final decuments in
the review session referenced below by September 28, 2012, Comments and recommendations
shall be applied fo the documenis in accordance with the following document. This document
contalns instructions for steps that need to be completed before joining the review session above.

The following is a link to a live review of the 30% Preliminary Design of this project. Click on the
fallowing link to join the review session.

Invitation io live Review of the Prelimin. sign of this projec

LDigital Deslon Review hanual

The Semi Final Design M

Depart ‘s Adk
Please contact Project B

DISTRIBUTION:
Highway Design
Hydraulics

Construction

Attachments

E-mail: |mathew calkins @ct .gov
‘assword:

Remember password Lost Password

g =0

Malhew Calkins/co

ol James H Nnrrn_f_n L . B
Enter your studio
session email and
password and click

OK

Figure 172 - Review Session

5. If this is your first time into a review session you must import the CTDOT Bluebeam
Profile, See Appendix A

Issued 10/2017
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10.7.2 Review Session Layout

Below is the typical layout in the review session. On the right tab, there are the tool chest for
commenting, the attendees of the session, and the documents in the session. On the bottom,
there are the list of comments.

Form  Morkup  Messure  Window  Help

BSOSO N i/ QND A~

ROTARY UPGRADE TO MNAREDN DAINNARAIT </
aitaiiran, . ROUTE 183'ATool Chest for
Nz ¥ 2 7] - -

HOLBF
Yo i
seyy Review Tools

Status in the
zreview session
A
Attendees

1< NN\

Documents in

Click here to
open comment

List of Comments

0124-0162  [5i]

Record | Notdications  Pending

Figure 173 - Review Session Layout

All comments that are made get saved instantly to the Bluebeam review session; these do not
need to be manually saved. Each user can only delete their own comments and can leave and
rejoin as many times as they want as long as the review session has not been closed. The review
session will be closed by the Organizer in accordance with the date on the review memao.
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10.7.3 Reviewing

This section shows the procedures for reviewing and commenting on documents in a digital
review. Reviewers may print digital review documents to paper by going to File>Print and mark
them up; however, they must transfer these comments onto the digital review documents in
accordance with this section. If a unit cannot print their own paper copies they should contact
MaryAnn Cass by email MaryAnn.Cass@ct.gov. Inthe email include the project number and list
documents that need to be printed, and included the address of where they are to be mailed.

In the case of preliminary contract plan reviews, the original digital documents, with comments,
will become the final record.

All comments associated with a design submission should be applied to the digital documents,
including any email or phone call comments. These types of comments must be applied, by the
staff member who received the email or phone call, to the correct digital document, use
engineering judgment to determine the most appropriate location.

General Project wide comments can be placed on the first sheet of the document using the note
markup tool in Bluebeam as shown below: Using the note tool you can copy and paste text
from any source such as an email or a Word document. This allows larger project wide
comments to be applied to the plans.

v File Edit View Document Form Markup Measure Window Help

k- wil om- 4 PARAR S5 B SN
New Open

-

= Print E-mz Studio Shapes Image Hyperink  Attachment Stamp

‘.-:E';'"g"\/?r‘ﬁq' By o« Q i l}_’/’i ..

- W
¥ R £ @& 151-273 wall OH Cant X-Sections 2* = ifee M

|E Mote N o '

Recents Flag  Shift+F
B 151273 w__.

Figure 174 - Note Markup Tool
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Note about Commenting in a Review Session and Supervisor Approvals

In most cases, the unit that reviews a document has an internal approval process whereby the
supervisor finalizes the comments from staff members. The workflow described in this Chapter
does not specify or dictate an approval process within each unit; rather, it outlines the review
procedures once the review comments have been compiled from each unit. Therefore, it is
important that only the reviewing unit’s final comments be added to the review session. Once
the session ends, the comments made in a review session will be considered final.

The following shows a few options for a supervisor approval procedure, but the digital review
process is flexible for any procedure a reviewing unit develops. The only restriction is the final
comments must be placed on the digital documents located in the review session before the
reviews session ends:

1. Alower level employee can join the session and comment on the documents in the
review session. Then the supervisor can join the session and filter out their
subordinates comments for their review. If there is an issue with a comment the
supervisor will have to direct the lower level employee to fix that comment. If there are
not any issues with the lower level employee’s comments then nothing has to be fixed.
After this supervisor review, a lower level employee will join the session and fix the
applicable comments. In section 10.1 of this manual there is a list of advantages to
using this digital review process. With this option, all of these advantages are realized.

2. Alower level employee can join the review session and save a copy of the review
documents to their computer. Then they can markup the documents offline and have
their supervisor approve those comments. After the supervisor approves the
comments, those comments can then be imported into the documents in the review
session. In section 10.1 of this manual there are a number of advantages to this digital
review process. With this option, advantages 3 and 4 are eliminated due to the
comments made offline.

3. Alower level employee can join the session and print the documents in that review
session. Then they can markup the prints and have their supervisor approve the
comments. After the approval, a lower level employee can transfer the comments to
the digital documents in the review session. In section 10.1 of this manual there is a list
of advantages to this digital review process. With this option, advantages 3 and 4 are
eliminated due to the comments made offline.

Notes about Outside Entities that will not Participate in a Digital Review

If an outside entity such as a railroad or utility company will not participate in a digital review it
is still important to add their comments to the final record document in Projectwise. It is
encouraged to have these entities participate in the digital review and AEC Applications is
available to provide support and technical assistance in these efforts.

The following details how the comments from a non-participating entity and your responses to
those comments shall be attached to the final record document in Projectwise:
1. Create a PDF document that includes the non-participating outside entity’s comments
and your responses to those comments.
2. Then add the pages from that document to the end of the final record document in
Projectwise in accordance with section 10.9.1.
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Reviewer
1. First set your review status to Reviewing by clicking on the drop down shown below:

Note: If you leave the session and return your status will stay as Reviewing.

/a4 Set Status

Figure 175 - Set Status to Reviewing

2. Next select a document to review from the studio session tab. The document will open
up and can be reviewed.

"SUBSET 05" - "STRUCTURES"
INDEX OF DRAWINGS

Select a document =
to comment on

Figure 176 - Selecting a Document to Comment On
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3. Select a commenting tool from the tool chest and mark up the plans. If you do not have
the CTDOT Review Tools show below, follow Appendix A to have them imported in the

Bluebeam Profile. Below are the commenting tools a CTDOT user will have available to
them in Bluebeam.

ing Review Tools

Comment

816 Stamps

January Supplements to
the 816 Stamps

Figure 177 - Bluebeam Commenting Tools

Custom tools can also be created. Contact DOT.AECApplications@ct.gov for custom tool
development.
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MUST READ BEFORE PLACING COMMENTS
The following shows best practice for applying text notes in a review session.

There are two basic commenting tools in Bluebeam: Text Tools and Non-Text Tools (line, arrow,
cloud, rectangle, etc.). Each type can have a note attached to them. The text tools already have
a note when you type text, but the non-text tools can also have a note attached to them. To
attach a text note to a non-text tool place the comment and then double click on that markup.
Then you can type in your note. The text note box must be closed after the comment is made
by clicking on the X in the top right corner of the note. The example below shows a note being
attached to the cloud tool the correct way:

1.Place Cloud 2. Left click on the 3. Double click

cloud so the on the cloud
yellow circles and type text

show /

Update Road Lis{ E
LITY LENGTH

ROUTE 77 N/A
ROUTE 80 N/A
ROUTE 146 N/A
ROUTE 33 N/A
ROUTE 106 N/A
ROUTE 123 N/A
ROUTE 124 STATE N/A

aNVv1SI

MAINTENANCE
F.A.P. # RESPONSIBILITY PROJECT #
000R(825) STATE 173-440

Figure 178 — Correct Way to Add Text to a Non Text Commenting Tool

General Project wide comments can be placed on the first sheet of the document using the note
markup tool located in the tool chest. Text can be copied and pasted into the note tool as
necessary.
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4. After you have completed your set your status to Finished.

Note: You can still enter the session if your status is set to Finished. You can also change your

status back to Reviewing if necessary. This status is for the Organizer so they know which
Reviewers have completed their reviews.

LIPCR
YT ——t iy Set Status

?{l Home N

FIOJECT HU | AHAR

~ Aitendees 7
i‘ M. Calkins AEC Applic... CT_CON_PRE-030_0120-.. / ]

Figure 179 - Set Review Status

5. Create a review comment report of your comments. First filter out the comments so
only your comments are displayed as shown below:

EEREE Ve
°
| Y Filter )E |i-j'i'| Columns + 4* ‘ O 6 v | k Summary ~

- @ - (2) Click
[A]
' The bituminous material specified for use in the ooy

Page 03.02
‘Bituminous Concrete Surface’item is 0.375"HMA
but it says 0.5" here

Qo Do N (CD orl::z;l:? :,K;elgse; :f;r:;;e Conetniction N1 - M Calkine TE? P=je 03.02 (3) Select your
(1) Select %

ial specified for use in the Construction D1 - M. Calkins TE2 Page 03.03 n a m e

F i Ite r Surface’tem is 0.375"HMA

01 the raised splitter Islands  Construction D1 - M. Calkins TE2 Page 03.03
show a stamped concrete pattem, please indicate
this on the typical sections.

. Are there proposals for utility relocation prior to Construction D1 - M. Calkins TE2 Page 03.05
start of construction?

Figure 180 - Filtering Comments
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6. Now that the comments are filtered by your name create a comment report as shown
below:

OFFICE OF ENGINEERING |ROUTE 15 SAFETY
STATE OF CONMECTICUT | i AL
DERARTMENT OF 1o & BRIDGE fMP

BE S
|

Select Summary

: and select PDF
PDF Summary Su mmary

FrinL Surminary

Capture Summary

Figure 181 - Creating a Comment Report

Next type in a title for the comment report that includes Project No, What review it is plus the
word “Comments”, and what document this comment report is for. See below for an example:

Project #it##-##t## Semi Final Review Comments 03-Highways

Make sure all the settings are set as shown below and click OK:

PDF Summary E|
(Page Range \
Pages |All Pages (1-5) w [of 5
Summay Opions _ (1) Make sure all
7S .
Exclude Fitered Markups these settlngs

Exclude Hidden Columns

are selected

POF Cptions
Include Totals Include Page Content

Title:  |Project 0121-0980 Semi Final Review Commerts 03-

Style: | Flow W
Proview: T -
Page Size: |Letter b

\ (%) Potrat ¢ Landscape ) i
: _ (2) Click

Figure 182 - Comment Report
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7. The comment report will now be created and opened in Bluebeam, leave the comment
report open in Bluebeam. We will be copying this report into the comment report
memo.

8. Next save the following review comment memo to your computer: Review Comment
Memo.

9. Open the memo and fill in the correct information.

10. Then copy all the pages from the comment report as shown below:

@ Rw Fe Edt Vew Document Fom  Makup  Measwre  Window  Help

vhw =
s  (2) Select the : : . :
. Bl thumbnail view el : _—

)-0086_03-Highways Review Comment Memo CT_CON_PRE-SF_0120-0086_03-Hig... * *

(1) Click on the
b Pogesetip.. comment report
document

Copy Pages

Copy Page to Snapshot  Ctrl-+AIt+C

(3) Select all
pages and then
right click on them S ale) e
and select Copy Pages b Exvactboges..  ChliShRiX

Ctrl+5hift+Y

Apply Stamp...

. InsertBlank Page... Ctrl+Shift+N

Ctrl+Shift+R

Export Pages

E-mail Pages...

Print Pages...

Repair Page Content

Flatten... Ctrl+Shift-+M

¥ X
|V Fiter g [N | jiii Coumns - 4 G E- v BB summay -

Author

Markup Summary

Figure 183 - Copying the Comment Report Memo
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11. Then paste the pages into the memo as shown below:
File Edit View Document Form Markup Measure Window Help

- smq

Pint  Ema

(2) Select the
thumbnail view

e I F & 00 SV AR

03-Highways Review Comment Memo*® % (T_CON_PRE-SF_0120-0086_03-Highway...*

ubject: Review Comments
DEPARTMENT OF Project No, 120:086
s FAP Project No. FAP 0125R

==\ (1) Select the comment
=—— report memo document

M Pratimnan Stidine 31 Samiinal (0% - 70%)

(3) Right click below

Page Setup... e

the thumbnail of

L the memo and select
Canv Dana tn Snanchnt Cirlaaltar paste pages

Paste Pages it Ao 8.

Apply Stamp...

Insert Blank Page... Ctrl+Shift+N
Insert Pages... Ctrl+Shift+I
Extract Pages... Ctrl+Shift+X
d Replace Pages... Ctrl+5hift+Y
Rotate Pages... Ctrl+Shift+R

Number Pages...

Export Pages

e maoges. Ve

&= PrintPages... - n
v BB simay -
Repair Page Content PE 5

Figure 184 - Pasting the Comment Report Pages

12. Save the memo and process this memo as your unit requires.
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10.8 Phase 5 - Closing the Digital Review

The Organizer will be responsible for closing the review. The review session will be closed per
the date on the review memorandum.

1. Loginto Projectwise and browse out to the review documents folder.

2. Then select the documents that are in the session that is to be closed, right click on the
documents, select Change State>Next: If this step is not performed the session cannot
be closed. This will place the documents in the CLOSE REVIEW state.

Label (User Defined) Description Filc Updated  File Updated By  Document Date (mm/... Application  State
PP : Tinspection Report Condition Assessment/Inspection Report Arrigoni Bridge No. 00524 3/23/201611:22:34 A... B.Brako-Frempo... 6/10/201512:00:00 AM Acrobat PDF

RSR for Project No. 82-312 Arrigoni Bridge No. 00524_Original 4/14/2016 2:36:58 PM  Gregg.Hendricks..  8/7/20151200.00 AM  Acrobat PDF
RSR for Project No.82-312 Aniigoni Bridge No. 00524 3 New i Acrobat PDF
RSR for Praject No. 82-312 Arrigoni Bridge No. 00524 Acrobat PDF
GPR Condition Evaluation of Arrigor  dridce-Praject Summary Report E! Open Acrobat PDF
PPd | GPR Report Arrigoni Bridg GPR Evaluation of the Arrigoni Br .ige Deck 3 Open as Read-Only Acrobat PDF

Open With...
Markup
View
Check Out
Select the documents that are in the creceln
Free
session that is to be closed, right click Copy Out
p ,and select Change State>Next P PPN PO PIPP OO OSIPOLOOIOOPIOIPSIS
Sec L
Send To >
Copy List Te L4
v
Change State 4 Next )
Batch Print G rreneus
Change...
Properties...
Set Final Status
Change filename to CT_Code Remove Final Status
- B - . r

Figure 185 - CLOSE Review State

3. Then open up Bluebeam and join your session.
4. Then Click Finish to close a Bluebeam Review Session as shown below:

EDR*
Eave %-Finish .

ew - 197

-

inis T ! CT_CON_PRE-PD_012

Click Finish

"SUBSE
I

Eidron

ost Estimate pdf

'D Statement pdf

DRAWING TI'

Figure 186 - Terminating a Session
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5. Make sure all the reviewers in the list below are selected (they will be by default) and

the Save (Overwrite Existing) button is checked and click OK.

Finish Session

Include Markups

FMIS RFI Review - 844-141-744

=5

MName

M. Calkins
B.Bourgoin Supervi...
H. AbdissaTEI AEC ..
mahoneylkm

E-mail i

mathew calkins @ct gov |E |
bruce bourgoin@ct.gov

henok abdissa@ct gov . Ve ry I m po rta “ t -

kevin mahoney@ct.gov

4| 1]

Sa

/ selected

@ Save (Overwrite Exdsting)

() Save In Folder

) Do not save files

Report Cptions
[7] Generate Report

D:\Users'calkinsmj\Documents

[ Close files after finishing

D:M\Usershcalkinsmj\Documerts PMIS RFI F

Figure 187 - Terminating a Session

6. Click OK in the figure below.

Issued 10/2017

Finished...

01 - Administrators . Mathew Calkins“\Digital Review Examples’.124- -
162_Session 14310_Review_Documents\CT_CON_PRE__30% - 04 -
Traffic.pdf. 102693.1...

CT_CON_PRE, s pdf checked outto

PW ctdot projer = DOT06.0 - Project\Wise Administration
\01 -Adminite GG K \Digta Review Bamplest 12
162_Session 1" nts"\CT_CON_PRE__30%-03 -

|Highways.pdf.1 0 K

«

Bluebeam Revu xb4... 100% ER

Figure 188 - Overwriting Existing Documents
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7. Close Bluebeam Revu and check in each document to Projectwise. Note: A check in box
will pop up for each document in the review session.

Check In
“General |
Documents
Name Label (User Defined) Description Main
'{a CT_DOC... PD Statement Project 120-086 PD Statement poC

< |

Folder: 06.0 - ProjectiVise Administration'01 - Administrators\Mathew
Calkins\0123-0145310_Preliminar

[ create new version during Check In . S e I ect C h ec k I n
/

Version: |

Check In

&

u Update Server Copy ][ Free ][ Cancel
-

Figure 189 - Checking a Document Into Projectwise

8. Notify the Document Authors that the session has been closed so they can resolve the
comments on their documents.
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10.9 Phase 6 — Resolve Comments

This section shows how the comments from the review session will be resolved by the
Document Authors. After the comments have been resolved in the PDF documents located in
Projectwise the Document Author shall notify the Organizer that they have finished applying
their resolutions to the documents.

Note: Comments cannot be resolved until the review session has been finished. The Review
Organizer will notify the Document Authors when the session has been finished. If the
document authors go into the documents located in Projectwise before the session is finished
there will be no comments on the documents.

10.9.1 Resolving Comments

All comments on the review documents shall be resolved by the Document Author directly on
the digital PDF review documents using Bluebeam. The following shows the steps for resolving
comments.

1. Open your document(s) from Projectwise.
2. Next select a comment in the comment list and right click. The select Reply.

@ CT_DOC_MDO_Pa 0 pof
AL pdf Edma HE

| i-i-i‘l Columns ~ 3 ‘ 9 - H - |E-' s Summary ~
Comments A Author
+ Link doesn't work (1)
* Cloud Link doesn't work M. Calkins TE 2 AEC Applications
+ Wrong Date (1)
~ 4 Cloud Wio TE 2 AEC Appl

(1) Right click Crisshits
on a comment e (2) Select
e Reply

Properties

Figure 190 - Comment Resolutions
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3. Inthe box that pops up, type in a final resolution in the following format:

Note: For plan sheets, include “Change Plans” or “No Change to Plans” where necessary.
Resolution — Type in resolution...No Change to Plans

The resolutions applied to the plans shall be the final resolution decided by the Document
Author’s unit. There shall only be one resolution for each comment.

Below is an example of a resolution:

Type in a resolution
in the box

Author

: rattankd
ost. 1t &l 1as the benefit of
ater harg.: #‘u:l_u:lrtn:una y, Iltlhin

e: Text Box o Resolution: Included - This e Townto  Hallsd
correction will be made on I i

deratic
This Pole S

te: Cloud e is con 2c Hallsd

rattankd

Hallsd

rattankd

Figure 191 - Typing in a Resolution
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| | 'V Fiter § mns i [ Summary. -
Subject Author S Do Page

—— §(1) Sort by Author

~ CMarie District Drainage Eng -

~  HendricksonGW (2)
- 4 Coud

» HendricksonGWautilities (1)
Test Box enc es 6:56 AM Page 01.01

- Al dffarances in arade wil and then conminatad at the firt it

Figure 192 — Resolutions

4. Next attach a PDF document that includes any non-participating entities comments with
your responses to the review document. This should be done by adding that PDF
document to the end of the review document as shown below:

Qo File Edit View Document Form Markup

o9 9 R

e Print == ] atures - =
r stamp...
EeswESEfcm-SFeveRin- ks

- =ﬂ Pages from 03-Highways_CT_FDP_0043-0128* = [ Insert Pages... Ctrl+Shift+«1 o

R o= 25000

Insert Blank Page... Ctrl+Shift+N

INSEIT LayEerea Fage...

Add the document by Insert from Scanner... @
. ] selecting Documel‘lt> Extract Pages... Ctrl+Shift+X

RELD

Split Docume ;
Split Document... SIDEWALE RAMA |
([ (TYPE $E}

Replace Pages... Ctrl+Shift+Y

Delete Pages... Ctrl+Shift+D 4?;?&2”1’?5“513';5
b 15D - GRANTTE
Rotate Pages... Ctrl+Shift+R STONE |CUREY

; WruRE

Crop Pages... Shift+Alt+0 3 (=1

Number Pages...

COPCRETE 5
H PAWING BRICK

Figure 193 - Attaching Comments
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5. Browse out to the PDF document you want to add and then select to insert after the last

page:
.
Insert Pages | E3 |
Insert Files
File Path Pages

4] | 20152-EC pof D\Usershcalkinsm...  All{1-3 of 3)

F Y

L

Options

[ Include Bookmarks [7] Use Filename as Page Label

[7] Include Fil Attachmerts Select After
and Last Page
"and then click

OK

) Page: |12 of 38 ¥

)

[] Merge Document Properties
[] Merge Layers

After

Figure 194 - Adding Comments

6. When all the resolutions have been applied, make sure to save the documents and
check them back into Projectwise.

7. Notify the Review Organizer that you have completed your resolutions.

8. Send out Completion of Review Memo to all the personnel associated with the review
session indicating that the review session is over and all comments have been resolved
on the documents in Projectwise. Link to: Completion of Design Review Memo
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10.10 Locking the Review Documents after the
Review

The Organizer shall change the state of the documents to make them document read-only after
the resolutions have been applied to the review documents.

To make the documents read-only, change the state of the documents in Projectwise to “Review
Completed” as shown below:

1. Select the document(s) and change the state of the documents to “Review Completed”
as shown below:

won -
Ust | @ Gecspatial
Label (User Defined)

\ | ey

Description

Main Category | Sub¢

Select View

Hew

Creckout (1) Right click on the
e documents and select
o "Change State>Next"

Start Studio Session. ..

Refresh Local Copy
Purge Local Copy

Cut
Copy

Delete

Modify.

Modify Linear Atirbutes.

Modify Spatial Attributes. ..

Add Comment

set »
< SendTo » 1

Document Properties | Copy List To ¥ Freviel|| Dependency Service | Access Corir
b

View: | <Default>

— Batch Print » b

I I crcc

. Set Final Statu 310 pr

<t Final Status oroon

BOE Change flkename to CT_Code crcc

—— - Digital

| | Ecit attributes for multile documents MEA
MIC-A

Old Audit Trail Report MICA

Staus Checke

Version
File Revisinn

Figure 195 - Changing the State to Review

AWNE.COM:LIVUNUBCUMENTS 6. - FIOJECWISE AOMINISTIATIONIWL - AQMINISTAtors\ ¥ | = L0

List | @ Geospatial

bel {User Defined)
'B) o1-General

' B) 03-+ighways
' Bl o4-Traffic

' B) o5-structures
' B) 30% Specs

' ) Cost Estmate
' B P statement

Issued 10/2017

Desription

Project 120-086 PD Statement

Main Category
Ccon
con
Ccon
con

Sub Category
FRE-FD
PRE-PD
PRE-FD
PRE-PD

Notice State column,

the documents are
now in the Review
Complete state.

Figure 196 - Review Complete State
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Sub Category Description
DOC_01 - Preliminary Docs
DOC_D1 - Preliminary Docs
DOC_01 - Preliminary Docs
DOC_D1 - Preliminary Docs

Application

Adrobat PDF
Adobat PDF
Adrobat PDF
Adobat POF

0C_D1 - Preliminary Docs
J0C_01 Acobat PDF
0801 -Prefiminary Docs ~ Arobat PDF

State

REVIEW COMPLETE
REVIEW COMPLETE
REVIEW COMPLETE
REVIEW COMPLETE

REVIEW COMPLETE
REVIEW COMPLETE
REVIEW COMPLETE
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2. Thenright click on all the documents again and select Change State > Set Final Status.
This will lock the documents.

- General

LI [R—
|DocwnentProperties|

Real (Docum - L

MName 4

Enter filter here 9

Bridge No. 05579 6

New

Open

Open as Read-Only
Open With...
Markup

View

Check Out
Check In

Free

Copy Out

Export...
Import
Start Studio Session...

Export Dependency Map(s)...
Import Dependency Map(s)...

Update Server Copy
Refresh Local Copy
Purge Local Copy
Purge Workspace

Cut

Copy
Paste...

Copy To...

Move To...

Rename...

Delete

DMScenform

Modify...

Modify Spatial Attributes...
Delete Audit Trail

Add Comment

Set
Send To
Copy List To

BaioL

Acrobat PDF
Acrobat PDF
Acrobat PDF
Acrobat PDF
Acrobat PDF
Acrobat PDF
Acrobat PDF
Acrobat PDF
Acrobat PDF

Viewer

7

Access Control

Components

Document Security

= |%[x[@[~7

% [ @]

Change State

Issued 10/2017

Batch Print
Properties...
Change filename to CT_Code

Edit attributes for multiple documents

) Nex

Previous

Change...

Set Final Status

EMOVE FIina

atus

Figure 197 - Setting Final Status
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Section 11 Design Phase Project Scheduling

An Engineering working group evaluated several scheduling software options to support the
mission statement. Microsoft Project 2010 was selected because it offers the following features
and advantages:

e Accommodates any number of milestones and tasks (i.e., easily scalable),

e Graphically displays series and parallel tasks,

e Provides baseline and tracking Gantt charts,

e Displays the critical path,

e Ability to link notes and documents, and

e Interfaces with Outlook, Excel, SharePoint and other Microsoft products.

Microsoft Project 2010 shall be used to develop design phase schedules meeting the following
minimum requirements:
1. Includes all the activities identified by the Minimum Requirement Schedule
Template; more detailed templates and project-specific schedules are encouraged,
2. Baseline schedule,
Task Indicator columns are used to link applicable instructional and reference
documents,
Explanations for changes in task durations are added as task notes,
Tracking View/Gantt chart functions are used,
Task-level progress is tracked regularly,
Files are stored in the ProjectWise project container as indicated by the Digital

Project Development Manual, and

w

No vk

8. Microsoft Project files are maintained and current, with projected schedules in
accord with the obligation plan.

Base templates were developed by a committee that included Engineering Management and
Subject Matter Experts (SMEs) from each engineering discipline. The Office of Engineering SMEs
are as follows:

e Bridge Design — Kevin Blasi and David Gruttadauria

e Consultant Bridge Design — Derick Lessard and Marc Byrnes

e Highway Design — Scott Bushee, Jordan Pike, and Vitalij Staroverov

e Consultant Design State Roads — Nilesh Patel and Meredith Andrews

e Traffic Projects Design — Barry Schilling and Michael Chachakis

e Traffic Studies & Safety — Erika Lindeberg, Daniel Veronesi and Colin Baummer

e Facilities Design — Eric Feldblum and Jesse Benson

The SMEs are responsible for developing and maintaining division specific project templates and
corresponding task libraries in ProjectWise. They shall be the first point of contact regarding
discipline specific template and guidance document inquiries and maintenance.

For questions, suggestions and issues pertaining to Microsoft Project and the Scheduling
Directive, please contact Bruce Bourgoin (Bruce.Bourgoin@ct.gov) or Nick Langer
(Nicholas.Langer@ct.gov).
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The table below details the minimum tasks included in the template:

Table 2 - List of Minimum Tasks

Task Name

Project XXXX-XXXX

Project Initiation

Prepare and Submit PPI

Prepare and Approve RPM

Secure Funding/Authorization

Prel

iminary Design

Survey

NEPA/CEPA

Develop PD through Design Approval

Design Approval

Final Design

Prepare Semi-Final Design Submission

Prepare Final Design Submission

ROW Coordination

Prepare and Submit Final Accepted Property Maps

Acquire Properties

Permit Acquisition Process

Permit A

o Prepare and Submit Permits to Regulatory Authority

o Regulatory Authority Review and Issuance of Permit

Permit B

o Prepare and Submit Permits to Regulatory Authority

o Regulatory Authority Review and Issuance of Permit

Permit C

o Prepare and Submit Permits to Regulatory Authority

o Regulatory Authority Review and Issuance of Permit

FDP

DCD

ADV

The Minimum Requirement Schedule template is stored in ProjectWise and can be found here:
AEC Scheduling Documents (Minimum Req)
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11.1 Microsoft Project File Set Up

The following steps show how to set up a Microsoft Project file:
1. Open ProjectWise Explorer by going to Start> All Programs> Bentley> ProjectWise
V8i (SELECT series 4), and click on ProjectWise Explorer as shown below:
IF 3

| www.bentley.com -
. COMMECTION client
. Dgn Index Service
. i-model ODBC Driver for Windows 7
. InRoads Group Vi (SELECTseries 2) Langer, Nicholas A.
. MicroStation V8i (SELECTseries 3]
. ProjectWise Deliverables Management ||
. ProjectWise V8i (SELECTseries 4)
E Administration - Geospatial Map Eni
;E Map Author - Geospatial Map Engin Music
“ysg ProjectWise Administrator
B ProjectWise Explorer Computer

Documents

Pictures

m

. Administrative Tools

. Documentation Tl e

. iDesktop Integration

. Tools Devices and Printers
. StormCAD VEi
Bluebeam Software Default Programs
Garmes
Google Earth Pro 8 Help and Support
1 Back

| Search programs and fites 2| NEEEE
Blecllalalrle e

Figure 198 — Launching Projectwise

2. Then double Click on CTDOT and then sign into ProjectWise with your username and
password. If thisis your first time logging into Projectwise, you will be asked to

create a working directory, click Yes:
o ProjectWise Explorer V8i (SELECTseries 4]

Datasource View Tools Window Help
: = i :__fi,'.:. By 8p e EEEE @ : @ - |search
i da - & - BB :Address [

El--UJ Broisctlilicr Explorer Datasources Mame

' ProjectWise Explorer Log in

Datasource: | CTDOT

User Mame: PWOMLINE \Micholas.Langer

Password: ssssssss

Figure 199 — Logging Into Projectwise
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3. Browse to Documents>04.00 Engineering Libraries>Scheduling Directive. Select the
applicable division’s Scheduling Documents folder. The below example presents
where the Minimum Requirement Schedule Template is located:

B ProjectWise Explorer VBi (SELEC Tseries 4)

Datasource  Folder

0

'

=

Document  View Tools Window Help

@ : @& - search (O

Op

= HeR =5

+ P> iintertoce|CDOTDoe Code__v] [ Viewlpoiger ]

Q:l A LJ|> - [ﬁ Address |” NDocuments'04.00 - Engineering Libraries\Scheduling Directive\AEC Scheduling Documents [Minimum Reql, - D Go

Ll 03

1 - Traffic Counts

57 04,

.00 - Engineering Libraries

67 67 07 0 B B T T 6 B 6 6

04.02 - Asset Management
04.03 - Research Administration
04.06 - Project Management
AEC Applications

Bridge Structures
Construction

CTDOT Standard Drawings
Directives & Bulletins
Engineering Administration
Engineering Templates
Environmental Planning
Facilities

Highway

Hydraulics & Drainage
OSTA
Permit_Documentation

Proprietary Product Approvals 2
Rails
—-{_ Scheduling Directive )

AEC Scheduling Decuments (Minimum Req)
Bridge Division Scheduling Documents

Facilities & Transit Division Scheduling Documents
Highway Division Scheduling Documents

'y
'
&
&
4_ Traffic Division Scheduling Documents

AL

Traffic

List ‘. Geospatial

MName

Description

@-:..‘ Minimum Requirement Schedule Template ’

Minimum Requirement Schedule Template

# | AEC Schedule Task Library

mn

- 3 - Click speci

[

AEC ScheduleTask Library

fic division's

Scheduling folder

For Help, press F1

4:45 PM

Figure 200 - Schedule Templates

4. Right click on the most applicable template and select Copy

%

" ProjectWise Explorer V8i (SELECTseries 4)

Datasource

T ey

Folder Document View Tools Window Help

@ | #4 - search (O

o

fl]

b=

-

[p> Interface| CTDOT_Doc_Code -y

@+ - [ address (= pwiicidot projectwiseonline,com: CTDOT\Documents\04.00 - Engineering Libraries\Scheduling Directive\AEC ~ [P Go

02.0 - Asset - Bridges
021 - Asset - Bridges (under 20' Town owned)

-

List | ¥ Geospatial |
B

= 022 - A Sianal b Mame Description A
- .2 - Asset - Signal Intersections
LL: 023 - Ascet - S\gn Stru A7 AEC Schedule Task Library AEC ScheduleTask Library
- ‘ H H [= Master - Master Schedule Master - Master Schedule b
poaase-towns 4. Right Click | ZEVetr-Meste Master - Maste
(7 024_B - Asset - Towns = J
 ws-ase-suanz: the Template %m
[T 026 - Asset - Radio Toy Nicks AEC_DOC_M I
- 02.7 - Asset - Railroad Crossing Signals Open
-4 02.8 - Asset - Routes (For Standard Assets) Open as Read-Only
17 03.0 - Imagery -
Open With...
-4 031 - Traffic Counts e
=-{Z" 04.00 - Engineering Libraries Markup
- 04.02 - Asset Management View
{7 04.03 - Research Administration
{_" 04.06 - Project Management HrzdH e
-7’ AEC Applications CheckIn
- Bridge Structures Free
-{=" Construction Copy Out
{7 CTDOT Standard Drawings
--{_ Directives & Bulletins Export...
--{_ Engineering Administration Import
= Engineering Templates Start Studio Session...
| Environmental Planning
{7 Facilities Export Dependency Map(s)...
-E7 Highway Import Dependency Map(s)... |
-[" Hydraulics & Drainage < !
- OSTA Document Properties :Fo\del Update Server Copy e
{_" Permit_Documentation Refresh Local Copy
L= PPIRequests View: :(Defaub Purge Local Copy
-{" Proprietary Product Approvals _I
LL: Railz i o l,-" Prop Purge Workspace
= L- Scheduling Directive L | — MNam Cut
|7 AEC Scheduling Documents (Minimum Req)
: C
| B[ AEC Schedule Task Library 2. Select copy ey D
{7 Permit Acquisition Process rie Paste..
Y W
T Prepare and Approve RPM ol T T
1 Prepare and Submit Permits to Regulatory Authol Creat|
. Prepare and Submit PPI Upda R

Figure 201 - Copying a MS Project Schedule
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5. The next step is dependent upon if a project is in the Project Initiation Phase or has
progressed to Preliminary Design Phase. Project Initiation is typically complete
when Funding and Authorization is received, and a ProjectWise project container is
created. If a ProjectWise container has not been created, contact Julie Annino in
AEC Applications.

Projects in Project Initiation Phase

a. Ifthe project is in Project Initiation the MS Project schedule should be
pasted to the respective discipline specific Initiation Phase Scheduling
ProjectWise folder:

Figure 202 - Discipline Specific Initiation Phase Scheduling folders

&

Proprietary Product Approvals

_" Rails

Scheduling Directive

[E1-{Z" AEC Scheduling Documents (Minimum Req)
L- AEC Initiation Phase Scheduling

L- AEC Schedule Task Library

=" Bridge Division Scheduling Documents

. Bridge Initiation Phase Scheduling

@-{_ Bndge Schedule Task Library
= Facilities & Transit Division Scheduling Documents

‘1.- Facilities Initiation Phase Scheduling ’
ey Facilities Schedule Task Library

=i Highway Division Scheduling Documents
-1 Highway Initiatiocn Phase Scheduling >

1 Hwy Schedule Task Library

= Traffic Division Scheduling Documents

‘_ i _" Traffic Initiation Phase Scheduling ’

L.l Traffic Schedule Task Library

-0 Traffic

Projects in Preliminary Phase

b. If the project is in preliminary design phase the schedule should be saved to

the ProjectWise 140_Project Administration folder under the project.

- ProjectWise Explorer Datasources
-l CTDOT (mjc-admin)
[ Documents

E||_, 01.0 - Projects - Active

&% 0001-0100

100_Contract_Plans (PDF)

110_Contract_Specifications_&_Permits (PDF)
120_Contractor_Submittalz (PDF)
130_Final_Engineering_Reports_and_Informatic

it List |. Geuspaiial|

= com=g e =

140_Project_Administration|

150_GIS
210_Construction

220 FHWA
230_Contract_Administration
240_Contract_Development

=

310_Review_Documents

W

320_Permit_Development
330_Design_Data

i-4_ 500_Pre_Design

084 Saved Searches

1-[/* 0001-0999

5. (1% 0004-0116

D[P 004-0118

v

Figure 203 - Project 140_Project Administration Folder
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6. To paste the project file, right click on the folder and select Paste and then Yes.

B8 ProjectWise Explorer V8i (SELECTseries 4) =D '
Datasource  Folder Document  View Tools Window Help New 3
j T E:"r Op 25 @ : # - Search O Open
@ -0 L’j Address =) pw:\\ctdot projectwiseonline.com:CTDOT\Documents\OL0 - Projects - Active\0001-010 Open as Read-Only
E|U-J ProjectWise Explorer Datasources = List | @ Geospatial Open With...

]

B[lﬁ CTDOT (PWONLIME\Michelas.Langer)

L7 b El Label (User Defin... File Name| Markup
= Documents

: View
= OL0 - Projects - Active
- 0001-0100 Check Out
- 100_Contract_Plans (PDF) Check In
-1 110_Contract_Specifications_&_Permits (PDF) Free
1 120_Contractor_Submittals (PDF)
.. 130_Final_Engineering_Reports_and_Information Copy Out
F i 1 B PR S -) opfid- it
= = el onf Export...
_" 140_Project_Administration 1
n . Import
el —Project_Administration_Ce ial
[ 150_GIS Start Studio Session...

b4 210_Construction
- 220 FHWA

1 230_Centract_Administration Import Dependency Map(s)...
- 240_Contract_Development

Export Dependency Map(s)...

X X Update Server Copy
- 241 Contract Development_Confidential

[T 310_Review_Documents Refresh Local Copy

- 320_Permit_Development Purge Local Copy
b4 330_Design_Data Purge Workspace
b4 500_Pre_Design
0% Saved Searches Cut
£ 0001-0999 Copy
o[/ 0004-0116 2. Past
0™ 0004-0118
(7% 0004-0133 < LIL} Copy To...
{7 0006-0122 Proiect Pronerties | Enldar Branad Move To... ]

Figure 204 - Save schedules to the 140 Project Administration Folder

7. Then click Advanced Wizard and click OK.
8. Then click next until you get to the attributes screen shown below, then assign the

attributes as shown below:
Advanced Document Creation Wizard

Define Document Altributes
*You should define environment specific document attributes.

Discipline Discipline Description

HW - Highways

Main Category ¢

SCHEDULES
Sub Category Sub-Category Descriptig
Working Working Schedule
Project Number(s) Document Date (
0001-0100

abel (User Defined)

— Select these
attributes.

/ddiy) - Discipline = Your
discipline

Project Schedule -

T

CTDOT Asset Tags
Bridge No(s) Building Mo(s)

[] [

signal Intersections No(s) State Route No(s)

[

Sign Structures No(s) JELT L L

J Town Mo(s)
Railroad Crossing Signal No(s) J

]

[ <Back |[ Ned> | [ Cancel

Figure 205 - ProjectWise Attributes
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9. Then click next until the file uploads.
10. Next open the project file.
11. Then click on the File menu, select Info, select the Project Information dropdown
and then Advanced Properties as shown below:

Bl A~ { | Gantt Chart Tools Projectl - Microsoft Projec
Task Resource Project View Acrobat Format

Information About Projectl | =

Organize Global Template

g Move project elements such as views, reports, and tables between two local files,
or between a local file and the global template file.

Organizer

S

Recent

Project Information +

~#igd] Advanced Properties
H View advanced and custom
properties of this project,

New

Print [

See key statistics related to
Save & Send your project.
uuuuuuuuuu Touay

N fr::ue"ct Calendar ft_a_ndard

Figure 206 - Setting Advanced Project Properties

12. In the dialogue box that pops up, fill out the information as shown below

MAL -Minimum Requirement Schedule Template Prop... -@
General | Summary | Statistics | Contents | Custom |
Title: Project X00K-3000 J
Subject: Write the type of Project/short description
Author: Mick Langer
Manager: Project Manager Mame
h Company: |State of Connecticut Dept of Transportation j
Category:
Keywords: 1. Some information
Comments: must be provided after
Proj. Initiation, such as
Hyperlink Proj. No. & PM Name
base:
Templake:
|:| Save preview picture 2
‘| Ok D Cancel

Figure 207 - Project Information
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13. Next set the project start date by selecting the File menu > select Info, then select
the date as shown below:

| Gantt Chart Tools Project] - Microsoft Project
Task Resource Project View Acrobat Format
=] . .
Information About Projectl
Bl salgas
#l Save R Adobe PDF . Organize Global Template
Ij T § E Move project elements such as views, reperts, and tables between twoe local files,
D or between a local file and the global template file,
[ Close Organizer
‘ Info ’
Recent

Project Information ~

R 10_;1’_«20150
4

Print Finish Date October, 2015 3
" Schedule from 50 Mo Tu We Th Fr 52
Current Date 12 3
e fesend Status Date 568 7 8 300
- 11 12 13[18) 15 165 17
Help Project Calendar 18 19 20 21 22 23 24
Friority 25 26 27 3B 29 30 3

] Options

XS

Figure 208 - Setting the Start Date

11.2 Basic MS Project Function

This section presents the following schedule basic terminology and functions:
e Scheduling Terminology
e Task Relationships (Predecessors and Successors)
e Adding, Renaming, Indenting and Deleting a Task
e Adding/Adjusting Durations
e Lead and Lag Times
e Adding Hyperlinks
e Combining Multiple Projects

11.2.1  Scheduling Terminology

The most common scheduling view is the Gantt chart view, which illustrates a project schedule
using task names, durations, start and finish dates on the left, and bar charts presenting these
dates and durations to the right.

EBliH=9- |= Gantt Chart Tools Minimum Requirement Schedule Template - Microsoft Project

File Task Resource Project View ProjectWise Format
a = [y - E Status Date: (5] 3/23/15 = ==
= oy T = : H ==
E E H_‘ _I_‘E;l = 22 =g = 3 ni ;_l 2]& 3

=| update Project
Subproject Project  Custom Links Between WEBS Change Calculate Set Move Visual Reports Compare Spelling

Information  Fielde Braiscte = Warkinn Tima | Draisct Racaling ~ Project Reports Projects
| Grey Bar - Parent Task

s Task Indicator Column & St Esbers
) ask Name oy | [JJune 1 |October 11 [February 21 [Julyl 4  [November 11 [March 21 [August1
| S/24 [ 7/26 [ 9/27 [11/29] 1/31 [ 4/3 | &/5 [ g7 [ 10/9 [12/11] 2/12 | 4/16 | 6/18 | 8/20 [10/
v

o = Project XXXX-XXXX 38.65 mons Project KXXX-XXXX (7
= 1Project Initiation 17 mons Project Initiation G =l

R 1.1 Prepare and Submit PPI 10 mons frepare and Submit P!
RN 1.2 Prepare and Approve RP e Prepare and Approve RPM Milestone
4 1.3 Secure Funding/Authori; Red - Critical Path Secure Funding/Authorization
5 = 2 Preliminary Design 6 mons Preliminary Design (g
v
(] 2.1Survey 3mons /., Survey [l
7 2.2 NEPA/CEPA & mons Blue - Non Critical Task NEPA/CEP)
= Develop PD through Design Approval 6 mons
Hyperlink == ER2esen e )
Design Approval 0 mons Design Approval 4f,9/7
10 = 3 Final Design 13 mons Final Design .r

Figure 209 - Basic Terms

Task Indicator Column - Present task Notes and Hyperlinks.
Milestone - A major schedule date, such as an FDP.
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Parent Task - Shown as a Grey Bar, signifies it is a Parent Task. Its duration is populated by the
Child Tasks.

Critical Path - Shown in Red, signifies the task relationships that control major milestone dates.
Non-Critical Task - Shown in Blue, signifies sub-tasks that do not control major milestone dates.

11.2.2 Task Relationships (Predecessor and
Successors)

Predecessor is a task which has a start or finish date that affects the start or finish of another
task.

Successor is a task which has a start or finish date that is affected by another task.
There are different ways of defining task relationships, these are

e Finish-to-Start: This is the default dependency in Microsoft Project in which the successor
cannot begin until the predecessor is complete. A Finish-to Start task relation is denoted by
FS, or simply, as the predecessor’s Task ID. A Task ID is found on the column to the far left.

(5 ) Task  |TaskName - |Duration  |Start + |Finish + |Predecessors | [Mar6,'16 __|Mar13,'16 __|Mar20,'16 Mar 27, '16 _

Mode sMITIW[T[F[s[s[M[TIW[T[F[s[s[M[TW[T[F[s[s[M[TIW[T[F[s
1

2

3 ?) Predecessor 10 days Mon 3/7/16 Fri 3/18/16 L ‘—l

4 =3 Successor 10 days Mon 3/21/16  Fri4/1/16 3

Figure 210 - Finish to Start relation

e  Start-to-Start: The successor cannot begin until the predecessor begins. The successor task
can start at any time after predecessor begins. Start-to-Start relationship is designated by

SS.
(i Task  [Task Name - |Duration . |Start « |Finish - |Predecessors || [Mar 6, '16 [Mar 13, 16 |
Mode sIM[TIW[T[F[s[s[M[T[W[T[F[s]
1 3
2
3 2 Predecessor 10 days Mon 3/7/16  Fri 3/18/16 [:r
= = Successor 10 days Mon 3/7/16  Fri3/18/16 ‘ 355 ’ ¥

Figure 211 - Finish to Finish relation

e Finish-to-Finish: the successor cannot be completed until the predecessor is completed.
The successor can be completed at any time after the predecessor is completed. Finish-to-
Finish task relation is denoted by FF.

- |Duration _ |Start + |Finish + |Predecessors Mar 6,'16 Mar 13, '16

o Task , Task Name

v

Mode sIMITIW[T[F[s[s[M[T[WI[T[F[s

> w N [
ob gb

Predecessor 10 days Mon 3/7/16  Fri3/18/16 C ‘J
Successor 6 days Fri 3/11/16 Fri 3/18/16 ‘ 3FF ’ ¢
—

Figure 212 - Start to Finish relation
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Start-to-Finish: the successor cannot be completed until the predecessor begins. The

-

[ )
successor can be completed at any time after the predecessor has started. The Start-to-
Finish task relation is denoted by SF.
2
3 = Predecessor 10 days Mon 3/7/16  Fri 3/18/16
4 =S Successor 6 days Fri 2/26/16 Mon 3/7/16  3SF
l 1

Figure 213 - Start to Finish relation

The schedule should have a Predecessors column where task relationships can be defined. To
define a task relation, enter the Task ID and the Task Relationship in the associated task’s
Predecessor Cell. For example, in the Figure below the PPl is a predecessor and the RPM is a
successor task. The PPI must Finish before the RPM can Start. This relationship is denoted in the
RPM Process row’s Predecessors cell, as the number 2. The number 2 represents the
Predecessor’s Task ID. The absence of a task relationship abbreviation means that the relation is
a Finish-to-Start or FS. A FS is the standard task relationship and therefore the abbreviation is
not presented, unless it is accompanied by a Lead or Lag time, as discussed in a later section.

™ = .;ur.:‘;uu;;b-‘ Microsoft Project
Task | Resource  Project  View  ProjectWise Format
= = et . I e e eee = . [~} (A e 'ﬁ z [a] Notes
BB 2 copy - o " B RS R Ak en T % % HE e Predecessor 22 .
Gantt | Paste B|7 U &-A-| g @8 s» g5 5P Respectlinks Auto || Inspect Move Mode | Tas rmation -
o ormat Painter Sthedule| - = = e Column T Add to Timelir
| v TaskID ., Font Schedule Tasks ya Properties
& y
Minimum *ulrament Schedule Template {
@ [ToskName . |Duration _ |start . |Finisn - |Predeced®rs [October 11~ [February 21
7/26 | 9/27 [11/29] 1/31 | a/3 |
T‘ = Project XXXX-XXXX 34.65 mons Fri 12/4/15 Wed 8/1/18 ‘ HOE OO0 ===
1 = 1 Project Initiation 13 mons Fri 12/4f15 Thu 12/1/16 dject Initiation Q————
2 @ 1.1 Prepare and Submit PPI 6 mons Fri 12/4/15 Thu 5/19/16 and Submit PP |
3 % 1.2 Prepare and Approve RPM 4 mons Fri 5/20/16 Thu 9/8/16 2 Prepare and Approve RPM
1 @ 1.3 Secure Funding/Authorization 3 mons Fri9/9/16 Thu 12/1/16 3 \ Secure Funding/Auth
5 = 2 Preliminary Design 6 mons Fri 12/2/16 Thu 5/18/17 FS relation
6 2.1Survey 3 mons Fri12/2/16 Thu 2/23/17 4
7 2.2 NEPA/CEPA & mons Fri 12/2/16 Thu 5/18/17 4
8 2.3 Develop PD through Design Approval 6 mons Fri 12/2/16 Thu 5/18/17 755
9 2.4 Design Approval 0 mons Thu 5/18/17 Thu 5/18/17 8
10 - 3 Final Design 13 mons Fri 5/19/17 Thu5/17/18
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If the Predecessors column is not shown in the template, double click in the “Add New Column”
cell and start typing “predecessor,” and from the short list click on Predecessors to add it to the

current columns. If Add New Column is not shown right click on any

column label and select

Insert Column and then start typing in Predecessors, as presented below:

Gantt Chart Tools
Resource Project View Developer Format

% @ :_H Ligl & Critical Tasks [ -= e ey ey ey ey ey
‘e u [ column Settings - S [ sl = - 21 gl gl | | ===
sTt:igs Gndv\mes Layout Clgls:l;tn 4 Custom Fields Forvmat ] Late Tasks Basslme Shpeage P & P & P &
Format Columns Bar Styles .
b’:‘l o Task Name - |Duration _ Start + |Finish - I
i 0 = Project 44.85 mon: Mon 8/3/15 Wed 1/9/1%
1 = Project Initiation & mons Mon 8/3/15  Fri 1/15/16
2 aR PRI 2 mons Mon 8/3/15  Fri9/25/15
3 @ RPM Process 4 mons Mon 9/28/15  Fri1/15/16
4 = Preliminary Design 12 mons Wed 6/15/16 Tue 5/16/17
5 Project Start up(Survey,NEPA,Design Data) 6 mons Wed 6/15/16 Tue 11/29/16
5 Develop PD through Design Approval 6 mons Wed 11/30/16 Tue5/16/17
7 ROW OBL 0 mons Tue 6/13/17  Tue6/13/17
8 = Final Design 19 mons Wed 5/17/17 Tue 10/30/18

Figure 215 - Add new column

Project View Developer Format

x @ e "y ical Tasks [ _a —_— —
Te t_ Gridlines La :n [nfn B F:u.l;a.t e Ea'_\;1 <:J:' e l l l l
Styles ST SRR olumn [ Custom Fields : Late Tasks SoeinE slepags A A A A hd A
Format Columns Bar Styles
ETEJ o Task Name + |Duration . |Start + Finish _
- —
a = Project 44.85 mons Mon 8/3/15 -
il = Project Initiation 9 6 mons JLouasB
ERE T el oFF Mons/3/15  Fris/[lo @
ERNL N RPM Process Click hereamons Mon 9/28/15  Fri 1/ Project Engineer (Text2)
= P . Project Manager ( Textl) =
q Preliminary Design 12 mons Wed 6/15/16 Tue 5716717
5 Project Start up{Survey, NEPA,Design Data) 6 mons Wed 6/15/16 Tue 11/29/16 1
3 Develop PD through Design Approval 6 mons Wed 11/30/16 Tue 5/16/17 Start t‘_-pmg
7 ROW OBL a Tue 6/13/17 Tue 6/13/17
’ - mons ue 6/13/ uet/13/17 sprodecessors
8 - Final Design 19 mons Wed 5/17/17 Tue 10/30/18
8 =/ ROW acquisition Process 18 mons Wed 6/14/17 Tue 10/30/18
10 (& Prepare and submit maps to ROW 6 mons Wed 6/14/17 Tue 11/28/17
Figure 216 - Adding predecessor column
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11.2.3 Adding, Renaming, Indenting and Deleting
a Task
Adding a Task

To add a task, right click on the task which will follow the new task and select Insert Task. For
example, to add a new task between NEPA/CEPA and Survey, right click NEPA/CEPA and select
Insert Task, as shown below:

1016-03-09_Project Schedule_HW_Draft_0001-0100

o Task Name + |Duration ~ |Start ~ Finish ~ |Predecessors
0 ~ Project 0001-0100 38.r° oA fatan P dnadan
1 = 1 Project Initiation 17r
i , 1. nght click an

ERL N 1.1 Prepare and Submit PPI bl
ERRL 1.2 Prepare and Approve RPM am ex|5t|ng task to insert a
7 @ 1.3 Securr "I';f"-"“"' 'l'i"“-": — 3m

aliori - A’ b
s -~ 2 Prelimina el sm NEW task dlrectly above
6 2.15urvel B £ M-S Im_ I L
7 | | & 2.2 NEPA/CEDA Y lsmons Fri 3/’24!1? Thu 9/?!1? 4
8 2.3 Devel = wroval 6 mons Fri 3/24/17 Thu9/7/17 755
2 2.4 Desigl == Lopy Cell 0 mons Thu9/7/17 Thu9/7/17 8
10 - 3 Final Desig b Paste 13 mons Friof8f17 Thu9/6/18
11 3.1Prepa Paste Special... nission 7 mons Fri9/8/17 Thu 3/22/18 9
12 27Prena ¢ Scrall to Task 5mons Fri3/23/18 Thu 8/9/18 11
13 2 m 9 mons Fri 9/8/17 Thu 5/17/18
i4 TereteToor ccepted Property Maps 3 mons Frig/s/17 Thu 11/30/17 9
15 3.3.2A 6 mons Fri12/1/17 Thu5/17/18 14

Manually Schedul

16 = 3.4Permi f anually scnedule 12 mons Frio/8/17 Thu 9/6/12
17 -3.4qp| > AU Schedule 7 mons Friof8f17 Thu 3/22/18
15 @ 3418 Assign Resources.., rmits to Regulatory Authority 3 mons Fri9/fe/17 Thu 11/30/17 7
19 3.4.] Eill Down eview and Issuance of Permit 4 mons Fri12/1/17 Thu 3/22/18 18
20 - 3.4.2P Clear Contents 7 mons Fri 0/8/17 Thu 2/22/18
21 3.4.] fl Information.. rmits to Regulatory Authority 3 mons Fri9fa/17 Thu 11/30/17 1855
22 3.4 1 not eview and Issuance of Permit 4 mons Fri12/1/17 Thu 3/22/18 21

. otes..
23 -'3.43P & mons Fri1/26/18 Thu 9/6/18

IE  Addto Timeline . 5 ;
24 3.4.% rmits to Regulatory Authority 2 mons Fri1/26/18 Thu 3/22/18 22FF,19FF
25 3.4 % Hperink.. eview and Issuance of Permit 6mons Fri3/23/18 Thu 9/6/18 22,19
76 ([ 1n

Figure 217 - Adding a Task

Renaming a Task
Tasks can be renamed by double clicking on the task to be edited. In the pop up window under
General tab you can edit the task name. (Do Not Rename the Base Template Tasks in Bold)

Task Infornination 2
= =
: General }Predecessors] Resources] .ﬁ.dvanced] Motes ] Custom Fields]
Mame: PFI ’ 2 Duration: 2 mons : |:| Estimated
Percent complete: 0% : Priority: 500 :
Schedule Mode: () Manually Scheduled
@ Auto Scheduled
Dates
Start: Mon 8/3/15 ~  Einish: Fri 9/25/15 -

[~ Digplay on Timeline
[ Hide Bar

[ Rollup Then Click

|

)

Figure 218 - Renaming a task
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Outdenting & Indenting

Outdenting and Indenting provides schedule customization. Outdenting moves a task to the left
of the task column and indenting moves a task to the right. Indenting a task makes it a ‘child’ of
the preceding, outdented ‘Parent’ task. Parent task durations are populated by their
accumulative child task durations, therefore, parent task durations should not be manually
entered. To set your task as a child or “sub-task”, select the row you would like to modify and
click the Indent Button in the main toolbar area shown:

= & Gantt Chart U,;;A_=;|
Task Resource Project View ProjectWise Format
= [ Cut -
o E & Cu Calibri i1 - P ES S MarkonTack -
Gantt | Past ~a copy Ay A 5
an aste - . i5 | &8 &5 55 i
Chart = - \}’Format Painter o E— @ EEAp
View Clipboard Font Schedule
i
e Task Name OUtdent & - |Duration
: Indent Buttons
0 = Project XOOCK-XXXX 34.65 mor
1 = 1 Project Initiation 13 mons?
2 % 1.1 Prepare and Submit PPI 6 mons
5 | | 1.2 <New Task>
s @ 1.3 Prepare and Approve RPM 4 mons
5 % 1.4 Secure Funding/Authorization 3 mons

Figure 219 - Outdent and indent

Deleting a Task

A user may delete, enter zero, or enter any small duration for a task if it is irrelevant. By
entering zero for the duration the MS Project will view the task as a milestone, if a report is
generated the report will present all zero duration tasks as milestones. This may confuse report
reviewers. A small duration may push back critical milestone dates. It is therefore
recommended that project managers manually delete and revise predecessor and successor
relations, as described below. To delete a task right click on it and select delete task. (Do Not
Delete the Base Template Tasks in Bold)

@ [roskname . |puration  |start . |Finish . |Predecessors | [July 21 |may 1 | February 11 | November 21 |Sej
7/7 [11/24] 4/13 [8/31 | 1/18 | 6/7 [10/25] 3/13 [ 7/3:
o - Project pa. T s 44.85 mon: Mon 8/3/15 Wed 1/3/19 '3::
1 = Project Initial 6 mons? Meon 8/3/15  Fri1/15/16 =y 0%
2 2% PPl B L D AT 2mons  Mon8/3/15  Fris/25/15 = o
3 | [ Demo Jamons?  Mons/3/1s  Fris/2s/15 =|o%
Y RPM Proce ® CutCel 4 mons Mon9/28/15 Fri1/15/16 2 :
5 = Preliminaryp "2 Copy Cell 12mons  Wed 6/15/16 Tue 5/16/17
6 Project Sta 1 Data) 6 mons Wed 6/15/16 Tue 11/29/16 A4F5+5.35 mons
7 Develop PI I 6 mons Wed 11/30/16 Tue 5/16/17 6
8 ROW OBL T Scroll to Task 0 mons Tue 6/13/17  Tue 6/13/17 7FS+dwks
9 = Final Design Insert Task 19 mons Wed 5/17/17 Tue 10/30/18
10 = ROW acqui 18 mons Wed 6/14/17 Tue 10/30/18 8
u @ Prepare 6 mons Wed 6/14/17 Tue 11/28/17
12 (@ Acquire fj Manuzly Schedule 12mons  Wed 11/29/17 Tue 10/30/18 11
13 = Permit Acg | ) Aute Schedule 12mons  Wed5/17/17 Tue 4/17/18
14 Prepare B Assign Resources... llatory Agencie 4 mons Wed 5/17/17 Tue 9/5/17 7
15 |& Acquire Fill Down 8 mons Wed 9/6/17 Tue4/17/18 14
16 Prepare Fit Clear Contents 18 mons Wed 5/17/17 Tue 10/2/18 7
17 |y B mromation.. 1min Wed 10/31/18 Wed 10/31/18 9
1B (& FDP | otes.. 0 mons Wed 10/21/18 Wed 10/31/18 17
19 DCD el B 0 mons Wed 12/12/18 Wed 12/12/18 18FS+6 ewks
B2 Addto Timeline
20 ADV 0 mons Wed 1/9/19  Wed 1/9/19  19F5+4 ewks
&, Hyperlink...
Figure 220 - Deleting a task
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When a schedule is started the user should remove tasks that do not relate and estimate all
other pertinent task durations. It is critical to note if the task being deleted is a predecessor.
You can determine this by following the lines stemming from a task in the Gantt chart. If a task is

erroneous and must be deleted, but is also a predecessor for other tasks that should not be
deleted, the successor task must be corrected. Failing to update a new predecessor will likely

disrupt task connectivity.

For example, if a project does not require a Preliminary Hydraulic Analysis, the step should be

deleted. However, the Hydraulics Analysis is a predecessor for the ABC Analysis; therefore the

ABC Analysis’ predecessor task should be updated. In this case the Utility Coordination will be

the new predecessor. See the task relationship and Gantt chart prior to task deletion:

jantt | Paste By A | T | ae | eeeh & i Manually| Aut Inspect M Mod
ot | P g romatpanter | 7 U | v~ A~ | o | 46 | o0 06 Drespectunis | Manuaty IR | imspect Move Mot
fiew Clipboard Font Schedule Tasks
T o HTask Name = VDuratior vr VStart - 7Finisl'v VPredecessors % - |Bu
Com
728 1.2.3.5 Preliminary Hydraulic Analysis S51days Tue Tue 16 0% )
11/24/15 2/2/16
1.2.3.6 Hyw/Traffic/Landsc oordination 1day Tue Tue 16 0%
11/24/15 11/24/1
1.2.3.7 Utility Coordination ~ Delete 15days Tue Mon 16 Change 0%
11/24/15 12/14/1 to 19
1.2.3.8 Kick-Off Meeting 1day Wed Wed 18 days 0%
__ New predecessor ID 12/9/15  12/9/1
21 29 1.2.3.9 ABC Analysis 10days Wed Tue 0%
2/3/16 2/16/11
29 &b 1177 1ANEN ArOTA Timn Rncinlammnnn . AC Ancen Tem Toim ac nos
Figure 221 — Before task deletion table
|October November December January February
[ B [ Mm [ E o 7 A = B [ M [ E B | M [ E B [ M [ E
Hyw/Traffic/Landscape Coordination 57—0%?'—-
Utility Coordination g > 0%
Kick-Off Meeting T 0%
< v
ABC Analysis 0%
Figure 222 — Before task deletion Gantt chart
See Task relationship and Gantt chart after task deletion:
o Task Name o |Duratior _ Start  _ (Finisk _ |Predecessors - % - Du
| _Comp
16 2@ 1.2.3.4 Survey 64days Wed Mon 15 0% ||
8/26/15 11/23/1 [
17 1.2.3.5 Hyw/Traffic/Landscape Coordination 1day Tue Tue 16 0%
; 11/24/15 11/24/1
8 & 1.2.3.6 Utility Coordination 15days Tue Mon 16 0%
11/24/15 12/14/1
19 1.2.3.7 Kick-Off Meeting 1day Wed Wed  17FS+10days 0%
) 12/9/15 12/9/
20 &@ 1.2.3.8 ABC Analysis 10days Tue Mon 0%
. 12/15/15 12/28
21 \/Q 1.2.3.9 RSR or STR. Type Development 46days Tue Tue 16 0%
11/24/15 1/26/16|
Figure 223 — Post task deletion and predecessor update table
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| October | November | December |January

|F

o5 I . S T . = I " [ < Y . =

0%

4
Hyw/Traffic/Landscape Coordination E'*O%—

>
Utility Coordination : =1 0%

. Lo Kick-Off Meeting T 0%
Notice the critical

path has changed ABC Analysis (< 0%

RSR or STR. Type Development |

Figure 224 - Post task deletion and predecessor update Gantt chart

lO‘)e

After the Hydraulic Analysis has been deleted and the new predecessor has been assigned, MS
Project automatically reconfigures the schedule to show the new critical path. The critical path is
shown in red and highlights the task relationships that determine a projects finish date.

11.2.4 Adding and Adjusting Durations

All tasks require duration estimates that may vary as projects progress. To set a duration click
the Duration Cell to the right of the task and enter the task’s estimated period and the

applicable unit, as presented below:
e Mons: for months
e Wks: for weeks
e Days: fordays
e Hrs: for hours
e Mins: for minutes

Task Name Duration Start Finish Predecessors

- -

1. Rename the Task

0 ~ Project 44.85 mon: Mon 8/3/15 Wed 1/3/19

1 = Project Initiation / 6 mons Mon 8/3/15  Fri 1/15/16 2. Tvype in the
2 ad PPI 2 mons Mon 8/3/15  Fri 925 Lhhammmes Duration

3 C__ Demo __) (2 maons _)m?_}'ls Fri9/25/15

a @ RPM Process 4 mons Mon 9/28/15  Fri 1/15/16 2

= = Neallmimame Naciee AN mmnne wt~nAd clariac Towm rlacias

Figure 225 - Adding durations

-

Jul

1/18 6/7

If the duration unit is already entered, then the duration value may directly entered, without
including the unit. Do not modify durations for parent tasks. Parent tasks are signified by
having a gray bar in the Gantt chart area and a maximize/minimize arrow. Parent task durations

are automatically calculated by their subtask durations.
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If a parent duration is manually entered, select the parent task and re-select Auto Schedule.
This will recalculate the appropriate parent duration, based on its child tasks. See below:

BEH9-&-|- Ganttchart Tools
File @ Resource Project View ProjectWise Format
E * cut Calibri c11 - BB ES HakonTrad - |_D—| E
Gantt P_EStE e (Blr u ®&-A-| o | 6| e b =2 i Iffspect Move Mod'e
Chart = + . Format Painter = - @ | 89 | = g2 Respectlink ° = =
View Clipboard
Make sure Auto
-03-09_Project Schedule_HW_Drz
(i Task Name SChed ule is selected - » |Finish - |Predecessors | Jslj’gil =
0 ~ Project 0001-0100 38.65 mons Fri 12/4/15 Wed 11/21/18 Project 0(
1 = 1 Project Initiation 17 mons Fri 12/4f15 Thu 3/23/17 Project
2 @ 1.1 Prepare and Submit PPI 10 mons Fri 12/4/15 Thu 9/8/16 repare and §
3 @ 1.2 Prepare and Approve RPM 4 mons Fri 9/9/16 Thu 12/29/16 2
4 @ 1.3 Secure Funding/Authorization 3 mons Fri 12/30/16 Thu 3/23/17 3
5 | =2 Preliminary Design Fri 3f2af17 Thu 12/28/17
6 2.1Survey 3 mons Fri3f24/17 Thu 6/15/17 4
7 2.2 NEPA/CEPA 6 mons Fri 3/24/17 Thu 9/7/17 4

Figure 226 - Auto Schedule

11.2.5 Lead and Lag Times

In defining a task relation, a task may have to be delayed or started early.
e The Lead time will tend to push your duration and a plus sign is used.
o The Lag time will tend to shorten your duration and a minus sign is used.

To add a Lead or Lag time: type in the task relation type, then the predecessor task number, a
plus or minus, and the amount of delay or early start.

For example, Task 18: DCD, is 6 weeks after task 17: FDP, this can be described as 17FS+6wks

- roject x0oo_xoc
Task Resource Project View Developer Format

% @ y LU (== =5 Iy E ot Tasks £ _e» Py emmy ey pemay ey e g
“@8 U @ colmnsettings - | =[] Stack = —= 21 %l %l 21 ﬁl ﬁl =
ST';?(:S Grldvllnes Layout CI:Isuer:‘tn ] Custom Fields Forvmat O vate Tasks Bassllne Sllpeage & & & & & &
Format Columns Bar Styles
Ejl o Task Name « |Duration  |Start « Finish « |Predecessors - E
o = Project 44 .85 mon: Mon 8/3/15 Wed 1/9/19
1 -/ Project Initiation 6 mons Mon 8/3f15  Fri 1/15/16
2 Rl PPI 2 mons Mon 8/3/15 Fri 9/25/15
3 @ RPM Process 4 mons Mon 9/28/15  Fri 1/15/16 2
4 = Preliminary Design 12 mons Wed 6/15/16 Tue 5/16/17
5 Project Start up{Survey,NEPA,Design Data) 6 mons Wed 6/15/16 Tue 11/29/16 3F5+5.35 mons
& Develop PD through Design Approval 6 mons Wed 11/30/16 Tue 5/16/17 5
7 ROW OBL 0 mons Tue6/13/17 Tue6/13/17  6FS+d wks
8 =/ Final Design 19 mons Wed 5/17/17 Tue 10/30/18
9 = ROW acquisition Process 18 mons Wed 6/14/17 Tue 10/30/18 7
10 |& Prepare and submit maps to ROW 6 mons Wwed 6/14/17 Tue 11/28/17
11 |& Acquire Properties 12 mons Wed 11/29/17 Tue 10/30/18 10
1z = Permit Acquisition Process 12 mons wed 5/17/17 Tue 4f17/18 Task
13 Prepare & Submit Permits to Regulatory Agencie 4 mons wed 5/17/17 Tue 9/5/17 6 .
14 (& Acquire Permits 2 mons Wed 9/6/17 Tue 4/17/18 13 relation
15 Prepare Final Design Submission 18 mons Wed 5/17/17 Tue 10/2/18 6 “‘itll lead
L S ————————— 1 min wed 10/31/18 Wed 10/31/18 8 { Hime
17 & | FDP Ioynons Wed 10/31/18 Wed 10/31/18 16
138 DCD j’nons wed 12/12/18 wed 12{12{18(17FS+5 ewks ,
19 ADV 0 mans Wwed 1/9/19  wed 1/9/19 1 EWKs

Figure 227 - Task relation
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This can also be set by right clicking on a task and selecting Information. Then go to the
Predecessors tab as shown below, and enter the predecessor ID or Task Name, the relationship
type and then a positive duration for a lead time or a negative duration for a lag time in the Lag
column.

Task Information i |
General Predecessors l Resources ] Advanced ] Motes ] Custom Fields ]
Mame: | DCD Duration: | 0 mons = Estimated
Predecessors:
FDFP -

e Task Mame Type Lag

17 FDP | = AFinish-to-Start (FS) Sew

Help [ [a]lq ] | Cancel

Figure 228 - Task relation in Project Information

11.2.6  Adding Notes and Hyperlinks to a Task
Adding Task Notes

As stated in the Directive: “Explanations for changes in task durations are added as task notes.”
Notes are reserved to clearly indicate when a specific Project Task duration is adjusted from the
baseline. The note should be placed in the respective task’s indicator column. The note should
state:

e The date of the entry,

e The person writing the note,

e Justification for the task duration adjustment and
e Recommended: Recipient Notification.

The Recipient Notification list is left up to the Project Managers discretion. The purpose is to
outline a step where project team members who may be interested or are directly impacted by
a duration change, are notified. Once a note is drafted and the duration is adjusted, it is
recommended that a notification email be sent to the relevant recipients and that the
correspondence is saved to the subject project’s 140 Project Administration folder in
ProjectWise. The recipients may typically include:

e AEC’s Project Management Unit —Bruce.Bourgoin@ct.gov or Nicholas.Langer@ct.gov

e Finance, such as the Office of Capitol Planning.

e Design Engineers within the Project Manager’s division.

e The group involved with the duration change or the group affected by the change, if
applicable. For example, if the 6 month estimated duration for a project survey needs to
be pushed back, the respective survey supervisor who is involved with the task should
be included as a recipient in the notification email.
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The purpose of the recipient list is to improve communication between units and to harvest
project data. Meaning, AEC will collect a repository of duration change notes in order to
continuously reevaluate and improve schedule templates.

To add a note right click on a task and select Notes... as shown below:

= Project 44.85 mons Meon 8/3/15 Wed 1/9/19
= Project Initiation 6 mons Mon 8/3/15  Fri 1/15/16
A N PPI 2 mons Mon 8/3/15 Frig9/25/15
L o BETRRE 4 mons Mon 9/28/15  Fri1/15/16 2
B I O-A-esds S 12 mons Wed 6/15/16 Tue 5/16/17

=2y, NEPA Design Data) 6 mons Wed 6/15/16 Tue 11/29/16 3FS+5.3%

W e o n s Wk e O

|_ o; cut CeTI ~*Tough Design Approval 6 mons Wed 11/30/16 Tue 5/16/17 5
B3 CopyCel 0 mons Tue 6/13/17 Tue 6/13/17 6FS+dw
B paste 19 mons Wed5f17/17 Tue 10/30/18
- on Process 18 mons Wed 6/14/17 Tue 10/30/18 7
10 (& Paste Special... submit maps to ROW 6 mons Wed 5/14/17 Tue 11/28/17
11 @& T SeolitoTask berties 12 mons Wed 11/29/17 Tue 10/30/18 10
1z Insert Task tion Process 12 mons Wed 5/17/17 Tue 4f17/18
13 Delete Task ubmit Permits to Regulatory Agencie 4 mons Wed 5/17/17 Tue 9/5/17 6
14 & #  Manually Schedule mits 8 mons wed 9/6/17  Tue 4/17/18 13
15 = auto schedule design Submission 18 mons Wed 5/17/17 Tue 10/2/18 &
15 By 1min wed 10/31/18 Wed 10/31/18 8
17 (@ | B Assign Resources.. 0 mons Wed 10/21/18 Wed 10/31/18 16
18 Fill Down 0 mons Wed 12/12/18 Wed 12/12/18 17FS+6¢
19 Clear Contents 0 mons Wed 1/9/19 Wed 1/9/19 18FS+d e

[EH Information...

k] MNotes..
E  Addto Timeline

35",) Hyperlink...

Tacking tant

Figure 229 - Adding Notes
Then type/insert your notes in the popup window.

The other option to access the notes window is to double click on the task and in the Task
Information window and click on the Notes tab.

Adding Hyperlinks to a Task

As stated in the Directive: “Task Indicator columns are used to link applicable instructional and
reference documents.” For all templates, hyperlinks shall be used to link a task to a division
specific Schedule Task Library folder located in the Scheduling Directive PW folder. Contact your
SME or AEC Applications for ProjectWise folder and template document management.

For example, a Permit Task should provide a link to a corresponding ProjectWise folder that
contains the permit’s regulatory document, suggested points of contact or experts, pre-written
memorandums, etc... These documents must be added, actively maintained and updated.
Division SME’s and AEC shall be the active maintainers of the division library modifications.
When a document is incorrect or has been superseded it is critical that users report this to a
unit’s SME or to AEC so documents can be updated and maintained. It is suggested that users
go through their SMEs to hyperlink documents, but the procedure is explained below.
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To add a Hyperlink, right click on the task that you want to add a link to and select Hyperlink

- RPMI g 7 oo s A - oew o5 52 - 4mons Mon 9/28/15  Fri 1/15/16 2
= pPreliminary weogm - 12 mons wed 6/15/16  Tue 5/16/17
Proje % cutcen esign Data) I mons wed 6/15/16 Tue 11/29/16 3FS+5.35 mons
Devel ol oo e broval 6 mons Wed 11/30/16 Tue 5/16/17 5
ROWOE o oo Omons Tue 6/13/17  Tue 6/13/17  6FS+4 wks
= Final De ;aste Special.. 19 mons Wed 5/17/17 Tue 10/30/18
E=) - 'ROW| = 18 mons Wed 6/14/17 Tue 10/30/18 7
10 |& Pre * Scrollto Task ROW & mons Wed 6/14/17 Tue 11/28/17
11 & Ac Insert Task 12 mons Wed 11/29/17 Tue 10/30/18 10
12 = Perm Delete Task 12 mons Wed 5/17/17 Tue 4/17/18
13 Pre . manually Schedule Regulatory Agencie 4 mons Wed 5/17/17 Tue 9/5/17 6
12 | & ACE) auto Schedule 8 mons Wed 9/6/17 Tue4/17/18 13
15 Preps n 18 mons Wed 5/17/17 Tue10/2/18 &
16 |G | | Acsign Recounces 1min wed 10/31/18 wed 10/31/18 8
17 |& FDP Eill Down 0 mons Wed 10/31/18 Wed 10/31/18 16
18 DCD Clear Contents 0 mons Wed 12/12/18 Wed 12/12/18 17FS+6 ewks
19 ADV B8 nformation... 0 mons wed 1/9/19  Wed 1/9/19  18FS+4 ewks

el HNotes...
TE  Addto Timeline

Figure 230 - Adding Hyperlink

Then in the following window, insert web address\navigate to a file.
Insert Hyperlink e x ]

Link to: Textto display@d )
Look in: C My Documents I|

Existing File or

Web Page . I ArcGIs \ - Bookmark. ..
otie] 1, Bridge Final.zip ﬂs :
Folder |} Camtasia Studio You may use this to
Place in This ; FME .
Document Boweed G1S DataBase point to| a file

Pages My Data Sources
; My FME Workspaces

0
CreateNew | | pecent |(Z My Shapes Web link Then
Document Files | OneMNote Notebooks l k
clic

. pp p
Address: ch::fﬁd\".h"n.ct.gov,‘dotsi,‘sihefdefault.asp _)’ Iy OK

E-mail Address
t OK T) Cancel l

Figure 231 - Add link/browse to a file

1

To remove a link right click on the link (Task)> Hyperlink> Edit hyperlink > Remove link
Edit Hyperlink D |-

Link to: Text to display: |pw:\\cbdot. projectwiseonline. com: CTDOT \Documents Y04, 0% 20-%3620Engi
Look in: | My Documents Iz‘

Existing File or

"::Ho"l[_jee’:t i, Bridge Final.zip |;|
, Camtasia Studio |
Place in This ; FME
Document Browsed GI5 DataBase

Pages My Data Sources
. My FME Workspaces

Create New Recent |5 My Shapes
Document Files , OneMote Notebooks 1
. pp -

Address: pw:\\cbdot.projectwiseonline.com:C'I'DOT\.DoGJments‘l,O4.0%20—%20EndZ| "
Then click here =g ([ ok  |) canl |

Figure 232 - Removing a link

E-mail Address

To access a hyperlink hold the ctrl key and left click the hyperlink icon located in the Indicator
column.

11.2.7 Combining Multiple Projects

It is critical that project managers can combine project schedules to better manage several
schedules from the same file. MS Project provides this ability through the Subproject combine
function. As outlined in Section 8, schedules must be stored in the project container:
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140_Project Administration folder. However, to use the combine function, MS Project schedules
must be exported from the ProjectWise folder to a local server drive, such as the X-Drive.
Schedules located in a local network can then be combined using the subproject tool. Exporting

is only recommended when a user wants to use the combine tool.

The following steps show how to combine Microsoft Project files:
Browse to the ProjectWise Project container’s 140_Project Administration folder.
Right click the Project Schedule and select Export, as shown below:

1.

;H ProjectWise Explorer V8i (SELECTseries 4)

Datasource Folder Document View Tools

Window Help

i = | &2 0p o, @ | @ - Search O v [B» iInterface| CTDOT Doc_Code il
- - [1| Address[’-;,| roetlobdnd nrniachaicannline rome TRAT\Documents\01.0 - Projects - Active’0001-01001140_Project_Administ - DGO

=2 01.0 - Projects -
(% 0001-0100

2. Right Clic

List |. Geospahall

Label (User Defin... File Name

Start Studio Session...

1= 100 _Cor = . "
-4 110_Contract_Specifications_&_Permits (PDF) = AEC Bample Pro DUOCAO oo
= 120_Centractor_Submittals (PDF) = '
1 130_Final_Engineering_Reports_and_Information Open
libaginacingeRapasssagnfidential
140_Project_Administration ey as.Read ok
o ministration_Lonfidential Open With...
My Markup
- View
My Check Out
. Check In
1. Browse to Project e
Admin Folder Copy Out
-{_ 330_Design_Data Export..
1 500_Pre_Design Import
-4 Saved Searches &
3. Click Export

- 0001-0999
@ 1": 0004-0116 Export Dependency Map(s)...
[#-7% 0004-0118 . -
(% 0004-0133 Import Dependency Map(s)...
& (%% 0006-0122 Update Server Copy
2% 0007-0162 Refresh Local Copy
-/ 0007-0182 & 0170-3155 < . Local €
urge Local Cof

-2 0007-0183 Document Properties | Project P 2 £y
- 0003-0094 Purge Workspace

- - e v |

Figure 233 - Schedule Export

2. Highlight Export and Click Next as shown below:

Document Export Wizard

il

Welcome to the Document Export
Wizard

Chogse an action to perform

(@) Export - Locks file, changes can be re-imported ,

(7) Send to Folder - Crea nmanaged local copy

The Export option will lock an -
selected documents so they 1 L] c I |6k EXPOI't nd

later imported using DOCUMEN . - s w

2. Click Next

< Back [ Mext = ] Cancel ]

Figure 234 - Export Option
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3. Browse to the network folder where you will keep the schedule file image. This
network file will likely be in the division specific X-Drive>all_data-folder.

NOTE: DO NOT DELETE THE EXPORTED FILE

The floppy disk means that the file has been exported so the schedule is now read only. A user
can still access the Project file by double clicking it and opening the file as Read Only.

Jocuments\01.0 - Projects - Active'0001-0100%140_Project_Administ + b‘ Go

List | Geospatial

Label (User Defin... File Mame Description
AEC Example Proj 300003000 mpp The ﬂOPPY disk means AEC Examnple Proj 300G00-3000(

the file is exported

Figure 235 - Exported File

4. Create a new “Master” MS Project file that will be used as the container for the
combined Subprojects. This Master Schedule file can be stored in the local network
drive (such as the X-Dirve) or on ProjectWise. Browse to the local network schedule
(the one stored in the X-Drive) and click Insert as shown below:

e roj = Micrr ro)

Task

==

Resource View Developer Format

H_E,'\ﬂ @ Eﬂ E{" E Status Date: 5] 10/6/15 “ E i’lg y

=7] update Project

Project  Custom Links Between WBS Change Calculate  Set Move Visual Reports Compare | Spelling
Information Fields Projects -~ Working Time | Project Baseline - Project Reports Projects
Properties Schedule status Reports Proofing

o Task L Task Name - |Duration . Start - Finish - Predecessors . Resource Names o Add nNew Column - Sep 27, '15
Mode: T s
[B] Insert Project =]
@u-|@ » Libraries » Documents b ~ [5 | [ search Dos = =
Organize ~ New folder =~ M @
> [B] Microsoft Project — Documents library P
Includes: 2 locations
A7 s MName Date modified Type Size
B Desktop
B Downlosds | ArcGIS 3/16/2015 3:38 PM  File folder
| Recent Places | Camtasia Studio 9/18/2015 11:50 AM  File folder
- L i FME 9/22/2014 12:38 PM  File folder
4 (B9 Libraries | GIS DataBase 3/20/2015 10:39 AM  File folder
> %] Decuments My Data Seurces 8/5/2015 2:06 PM File folder
> @ Music i My FME Werkspaces 10/24/2014 1:20 PM  File folder
> [ Pictures My Shapes 7/25/20141:04 PM  File folder
- BE videos | OneNote Notebooks 2/26/201511:19 AM  File folder
L4 i pp 1/20/2015 3:17 PM  File folder
4188 Computer | Project resources 6/5/201512:49 PM  File folder
> &, OSDisk (C:) i Snagit 5/27/2015 11:57 AM  File folder
> e Data (D:) (E¥] Highway Template2__.mpp 8/10/2015 10:45 AM  Microsoft Project ... 439 K|
= :
> &9 GIS Data (L)
- ARANDE AL ERCNRSEM - " Then Click here ' '
QDBC... Link to project
File name: Browse to vour file ~  [Microgbft Project Files (“.mpp;* ~
3 j Pp;
Tools ~ (] Inset || ) Cancel |

Figure 236 - Subproject

The schedule has been inserted into the Master Schedule, where it can be actively updated and
maintained. Initially, sub-tasks will be hidden, but they can be shown by clicking the project’s
outline symbol.
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L

Task

Resource Project View Developer Format

5 o ’ = Status Date: [ 10/6/15 -
B OE E [ = =2 B Sl | 55
- D’ - = @ = ilUpdate Project
Subproject Project  Custom Links Between WES Change Calculate  Set Move Visual Reports Compare | Spelling
Information Fields Projects - ‘Working Time Project Baseline * Project Reports Projects
Insert Properties Schedule Status Reports Proofing
o Thu 9/24/15 Sat 11/14,/15
=
T
S
=
o Task , Task Name - |Duration _ |Start - |Finish » |Predecessors _ |Resource Names Add New Column
Mode T !
1 @ 898 days  Fri9/18/15 Wed 2/27/19
2 @ —

=3 roject 1- signing
EQ roject 2-signinig 897 days Mon 8/3/15 Wed 1/9/19
Click the plus signs to expand

Figure 237 - Added Subprojects

A user can view the most updated schedule via the ProjectWise file by right clicking the schedule
file and selecting Update Server Copy as shown below:

List |. Geospatia||

L 1l Dlefi il Il
éﬁ . ek

? |
1. Right click [

exported schedule ...
Markup

View
Check Out
CheckIn
Free

Copy Out

2. Click Update Export...

Server Copy Import
Start Studio Session...

Export Dependency Map(s)...
Import Dependency Map(s)...

Update Server Copy ’
Refresh Local Copy

4

Purge Local Copy

=

[ s .| DPrriact Dranariz

Figure 238 - Update server copy

5. This step updates the ProjectWise schedule from the local network image file that is
maintained by the user’s Master schedule. This allows any person to view the most-
up-to-date project schedule directly from ProjectWise.

6. To Import a project schedule back into ProjectWise the user must right click on the
ProjectWise schedule and click Import. As shown below:
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List |. Geospatial|

Labalileae Dafin Eile hlapas
@E‘ AEC Example Proj X3X-X0 annn

Al

Open

- - o] Read-Cnl
1. Right click pen == ResdrEnY

Open With...
exported schedule Markup

View
Check Qut
Check In

2. Click Import Free

Copy Out

Export...

Import

Start Studio Session...

Figure 239- Import

7. If you look back to the local server where the project image file had been saved,
you will notice that it is no longer there, this is because the file has been imported
back into ProjectWise. Now the file can once again be managed directly from
ProjectWise. If a user wishes to maintain their schedule continuously from their
master schedule, they should avoid importing the schedule. Once a file is imported
the user must re-export and re-add the schedule to their master schedule.

11.3 Tracking the Project

11.3.1 Baselining the Project

Each project file must have a baseline set at the start of Preliminary Design. The baseline is
essentially a stamp of the schedule at the start of the Preliminary Design phase. The purpose of
the baseline is to gage how much a schedule varies from the initial baseline. Projects shall not
be re-baselined unless there is a major scope change. Re-baselining requires Engineering
Administrator approval.

1. To set the baseline, under the Project tab select set baseline and select Set
Baseline from the dropdown as shown below

ighway_AEC__.mpp = Mici

Status Date: [ 3/23/15 “ é ) ég
Update Project
3

File Task Resource

B omE R E B

Subproject Project  Custom Links Between WBS Change

Visual Reports Compare | Spelling

Information Fields Projects > Working Time Reports Projects
Insert Properties =% Set Baseline... Status Reports Proofing
o Task iTask Name & Clear Baseline ation  |Start + |Finish + |Predecessors Z
Mode : | €
- = 3 {
0 =3 Project XXXX-XXXX 38.7 mons Thu 10/1/15 Wed 9/19/18 it
1 2 =~ 1 Proiect Initiation 11 mons Thu 10/1/15 Wed 8/3/16 lec

Figure 240 - Set Baseline Dropdown
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2. Inthe dialog box that pops ups, keep the default values and click OK.

Set Bazeline =

@ﬂ baseline

Baseline -

Set irnterim plan
Scheduled Start/Finizh
Start 1/ Fimish 1
Fags
@ Eptire project
Selected tasks

Rall up basalines:
To all summary tasks

Erom subtasks into selected summary task(s)

Clhick OK

Figure 241 - Setting a baseline

Re-Baselining
If Re-baselining is needed and is approved by the Engineering Administrator, the baseline will be
set in accordance with the following:

1. Go to Projects > Set Baseline > Set Baseline.
2. Then select Set Interim plan, select Baseline from the copy drop down button, then
select Baseline 10 for the Into dropdown list.

Set Baseline @
(1) Select the "Set © Set haseine
~

— (2) Select "Baseline™
Interim Plan™

e

i (3) Select "Baseline10”

Copy: {Baseline

For:

e
(4) Make sure this is R
Roll up baselines:
selected To g summary taks
Erom subtasks into selected summary task(s) (5) Se I ect O K
‘ OK ) Cancel

Figure 242 - Re-Baselining

3. Next, go to Project > Set Baseline> set Baseline.
4. Then in the dialog box that pops up just click OK to save a new Baseline.
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Set Baseline @

(@ Set baseline

Baseline -

© Setinterim n Keep the default
opy: | Baseline
iw o values and select
For: OK

(@ Entire project
(7 Selected tasks

Raoll up baselines:

To all summary tasks

From subtasks into selected summary

az Default

C= )l a=

Figure 243 - Re-Baselining

(%]

5. When a pop up window asks you if you want to overwrite click yes

Microsoft Project 2

Baseline has already been used on Thu 2/11/16. Are you sure you want to overwrite the data in this baseline?

=

Figure 244 - Re-Baselining

6. After the project has been re-baselined add a note to the top left Identifier cell
located in the Project No. row. The note should include the details outlined in the
Adding Notes and Hyperlinks to a Task section. The recipient list should include all

parties affected by the base-line adjustment.

Gantt Chart Tools A inimum uiremnt icr re

Project View Format

7 I < — Status Date:  [==9 =l es
w @ E [ TIEE = il W
“_w - =& e e e
Subproject | Project  Custom Links Between WES  Change | Calculate  Set  Move Update Visual Reports Compare | Spelling
Information Fields Projects - ‘Working Time Project Baseline = Project Project Prote tuals | Reports Projects
Insert Properties Schedule Status Reports Proofing
E‘J o Task _ |Task Name - |Duration . start  |Finish , Predecessors Add
N Mod
7] =l - PP RYAYATATR YAV, TS i
O% Put a note here 4465mons  Fril2/a/15  Wed 5/8/19
1 b= = 1 Project Initiation 21 mons Fri 12/a/15 Thu 7/13/17
2 ef = 1.1 Prepare and Submit PPI 10 mons Fri 12/4/15 Thu 9/8/16
EL 1.2 Prapare and Approve RPM & mons Fri9/9/16 Thu 4/20/17 2
4 2w 2 1.3 Secure Funding/Authorization 3mons Fri 4/21/17 Thu 7/13/17 3

Figure 245 - Re-Baselining Note

After the project has been re-baselined change the view to a Tracking Gantt view.

1. Inthe left dark grey bar shown below, right click and select Tracking Gantt.
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| HwY-o- = Gantt Chart Tools _New Minimum Requiremnts__ - Microsoft Proje:

Task Resource Project View Format
E j MNetwork Diagram ~ =l ,_=§Resource Usage ~ Al & Highlight: [Mo Highlight] ~ Timescale: ._'__'] G
J Calendar = -‘“8 _a Resource Sheet - Z = “F Filter: [Mo Filter] - | |[18] Weeks - _%‘ 4
Team = Sort  Outline Tables Zoom Entire Sele
Usage - ﬂ Other Views ~ Planner ~ (8 Other Views - - - - Group by: [No Group] - - Project Ta
Task Views Resource Views Data Zoom
o Task _ |Task Name . |Duration . |Start . |Finish

Mod
2 ~ Project XXXX-XXXX 34.65 mons  Fri 12/4/15 Wed 8/
= = 1 Project Initiation 13 mons Fri 12/4/15 Thu 12/1
= 1.1 Prepare and Submit PPI 6 mons Fri12/4/15 Thu 5/1¢
= 1.2 Prepare and Approve RPM 4mons Fri 5/20/16 Thu 9/8/
= 1.3 Secure Funding/Authorization 3 mons Frig/9/16 Thu 12/1
=S =2 Preliminary Design nght click on this portlon of 6 mons Fr! 12/2/16 Thu 5/18
2 2.1 Survey 3 mons Fri12/2/16 Thu 2/23
2 2ee the window 6 mons Fri12/2/16 Thu 5/18
= .3 Develop PD through Design Approval 6 mons Fri12/2/16 Thu 5/18&
= 2.4 Design Approval 0 mons Thu 5/18/17 Thu 5/1€&
= = 3 Final Design 13 mons Fri 5/19/17 Thu 517
=2 3.1 Prepare Semi-Final Design Submission 7 mons Fri5/19/17 Thu 11/3
= 3.2 Prepare Final Design Submission 5 mons Fri12/1/17 Thu 4/1¢
=S ~' 3.3 ROW Coordination 9 mons Fri5f19/17 Thu 1/28
= 3.3.1 Prepare and Submit Final Accepted Property Maps 3 mons Fri5/19/17 Thu 8/1C
2 3.3.2 Acquire Properties 6 mons Fri8/11/17 Thu 1/25
= | I 2 = 3.4 Permit Acquisition Process 13 mons Fri 5/19/17 Thu 517
—E:: 17 = = 3.4.1 Permit A 7 mons Fri 5/19/17 Thu 11/3
E 1B 2d 2 3.4.1.1 Prepare and Submit Permits to Regulatory Authority 3 mons Fri5/19/17 Thu &/1C
ol 19 =2 3.4.1.2 Regulatory Authority Review and Issuance of Permit 4 mons Fri 8/11/17 Thu 11/3
20 = = 3.4.2PermitB 7 mons Fri5/f19/17 Thu 11/3
1 2 3.4.2.1 Prepare and Submit Permits to Regulatory Authority 3 mons Fri5/19/17 Thu 8/1C
22 = 3.4.2.2 Regulatory Authority Review and Issuance of Permit 4mons Fri 8/11/17 Thu 11/3
23 2 = 3.4.3 Permit C 8 mons Fri 10/6/17 Thu 5/17
24 = 3.4.3.1 Prepare and Submit Permits to Regulatory Authority 2 mons Fri 10/6/17 Thu 11/3
25 = 3.4.3.2 Regulatory Authority Review and Issuance of Permit 6 mons Fri12/1/17 Thu 5/13

x @ %

27 = 5FDP 0 mons Wed 5/23/18 Wed 5/2
28 = 6 DCD 0 mons Wed 7/4/18 Wed 7/4
29 =S 7 ADV 0mons Wwed g/1/18 Wwed g/1

Figure 246 - Changing to a Tracking Gantt

Notice the Gantt shows two bars stacked over each other. The grey bar is the baseline and the
one on top is the actual duration. If there is a slip in a task schedule it will be shown as an
offset.

Qtfr 3, 2015 [atr 4, 2015 [atr1,2016 [atr2,2016 [atr3, 2016 [atr4,2016 [atr1,2017 [atr2,2017 [atr3,2017 [atra, 2017
| |
v
Project Initiation E—————y 12[1
Prepare and Submit PPl § {'\ current (Actual)

0%

Prepare and App RPM

Secure Fanding/Authorization

Preli y Design ¥ 0%
0%

NEPMCEPAC 0%

! 1 0%

Design Approval O‘Z 5/18
Final Design T

o 4

Prepare Semi-Final Design Submission § “g()%

Figure 247 — Tracking Gantt view

2. Next to change the table of tasks to the tracking mode, click on the left upper corner
cell to select the entire schedule, then right click and select tracking.
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Project XXXX-XXXX
P tiati

& o
Prepare and Approve RPM B 0%
Secure Funding/Authorization 48/
Prclimin P— 0%

Develop PD Submissior
ROW Activities ¥

0%
3 o% |
Design Approval-30% &

1
Final Design
Prepare Semi-Final Design Submission F: 5 0%
Thu 1/19/17 Permit Acquisition Process P —————————— 0%
0P Review & 3 0%
OEEP Review ox
Authorize ROW £ 3 0%

Generate Property Maps. z o%
Last il Property Maps Dok to ROW 45 10/25

Condct Evahustiony Negotisions EES3) 0%
Acquire Properties EE——————
z — O

b%

Dummy Task /0%
0’—>+rx
]
o 90

Figure 248 - Changing to tracking table

The table of tasks will now be in the tracking mode,

3. Then click save.

11.3.2 Recording Task Progress

The project manager will be required to record the project progress by keeping an up to date
record of the % complete for each task in the project. This shall be recorded in 25% increments.

The following shows how to record the progress of a task:
1. Click on a task.
2. Thenin the task menu select the appropriate % complete as shown below:

2™ e |+ ntt € ighway_AEC__ mpp - Microso
File @ source Project View Developer Format 3
B B - - A ERR
T Calibri ST Mark on Track ~ 2» [ - g
53 Copy ~ L4 = s
Gantt Paste B 7 U s espect Links Manually| Auto Inspect Move Mode Task Summary Milestone | I
Chart~ - < Format Painter - Schedule |Schedule - - - -
View Clipboard Font Schedule Tasks Insert
Task Name  |Act.Start  _ |Act Finish _ |% Comp Rem. Dur. Add New Colum| |1 September 1
6/7 [ &2 [9/27 [1
0~ Project XXXX-XXXX Thu 10/1/15 NA 4% 1.71 mons : ons N B
1 = Project Initiation Thu 10/1/15 NA 25% 2.89 mons 8.66 mol Then select the &
2 Define scope/cost est./schedule Thu 10/1/15 NA 25% 1.75 mons 5.25 mons [
P ) % to update
3 PPI NA NA 0% 0 mons 0 mons
4 £ Prepare and Approve RPM i Fri4/29/16 NA 25% 1mon 3 mons ti
]
5 Secure Funding/Authorizati MNA NA 0% 0 mons 0 mons
& = Preliminary Design NA NA 2% 0 mons 6 mons
7 . ans - - .
Make sure the task to be updated is
8 Develop PD Submission .
- ROW Activitics clicked on (Selected)

2

Pimcimn Lmmenaal 3000 nin nos Ao [ ———

Figure 249 - task update tools

Important Note: When the task is completed, do not select 100% complete. You will need
to type in the actual finish date for that task. If 100% complete is selected, Microsoft Project will
calculate the actual finish date instead of recording the physical date the task was completed.

In the tracking Gantt, the task will show the percent complete of the task as shown below:
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0% :
This task is

2%  25%

Coémpleted

l%. 225% o
- 0%

B
¥

Arquire Properties &

Figure 250 - Updated task view

Also when a task is not started and/or finished on time, it will show as a slipping bar as in the

following figure.
[October 11 [February 21 [iuly1 [November 11 [March 21 [August 1 [December 11 [April 21 1 [January1l [May21 [Octobe
9/27 [11/29]1/31 | 4/3 | &/5 | 8/7 | 10/9 [12/11] 2/12 [ 4/16 | 6/18 | 8/20 [10/22]12/24] 2/25 [ a/29 | 7/1 | 9/2 [11/a | 1/6 [ 3/10 [5/12 [ 7/14 [9/15 [1
== 5%
ation TP ¥ 12/1
= 0%
Preliminary Design [ 5%
: = »%
+ . .
EZO% Slipped from the baseline
%
Design Approval OVTSﬂE—
Final Design f P 6%
Prepare Semi-Final Design Submissi Hé%
/% 0%
pa v
Prepare and Submit Final Accepted 'C an 25%
————
Acquire P) o D%
Permit Acquisition Process P 0%
¥ P 0%
=%
-
0%
-

<& /17
o 11/28
& e 12/26

Figure 251 - Tracking View
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11.4 Generating Reports and Summaries

Microsoft Project provides different forms of reports and visual summaries. MS Project has
three reporting options:

1. Standard Reports
2. Custom Reports
3. Visual Reports

Standard Reports

Standard Reports are reports predefined by Microsoft on; Overview, Current, Costs,

assignments and workload.

Under Overview the following is reported:

Project Summary
Top-Level Tasks
Critical Tasks
Milestones
Working days

Under Current the following is reported:

Un started Tasks

Tasks Starting Soon

Tasks In-Progress
Completed Tasks

Should have Started Tasks
Slipping Tasks

Under Cost the following is reported:

Under Assignments the following is reported:

Cash Flow

Budget

Overbudget Tasks
Overbudget Resources
Earned Value

Who does what

Who does what when
To-do List

Overallocated Resources

Under Workload the following is reported:
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To access these report options go to Project > Reports

[LI0"  AdSRa k] ‘.‘;m.:a:a.u.‘,a._| Highway AEC_mpp - Microsaft Project )
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=
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10 Design Approval-30% NA| o Design Approval-30%4r 2/2
11 = Final Design NA DUUU Final Design W 0%
12 Prepare Semi-Final Design NA e Prepare Semi-Final Design Submissi 0%
Submission
. o Assignments... Workload... Custom... ; -
13 = Permit Acquisition Process NA Permit Acquisition Process 0%
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Figure 252 - Report options
Custom Reports

A custom report has the ability to customize the report based on templates in the following
categories:

e Task
e Resource
e Monthly Calendar
e Crosstab
To access custom report tool, go to Project > Reports > and double click on Custom

‘Gantt Chart Tools ighway_AEC_. icr roj
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= = Status Date: [if] 3/23/15 ==
== = (== ¥
L) il = &
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Information Fields Projects - Working Time | Project Baseline ~ Project Reports Projects
Insert Properties Schedule Status REparts Proofing
Task Name ~ |Act.Start  , |Act Finish . % Comp.  |Act.Dur. . |Rem.Dur. - Add New Colum | _[July 1 November 21 | A
6/7 | 8/16 [10/25] 1/3 [ 3/1
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. P - n A
- e —
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2 Define scope/cost est./schedule — — @l
s il ; +
G Prepare and Approve RPM m E Prepare and Approve RPM =
5 Secure Funding/Authorization . i Secure Funding/Autk
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12 = Darmit Aranicitinn Drarace nA M oz Amane 11 mane

Figure 253 - Custom Reports
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Then the report to be edited is first selected from the list of available custom report. Next, click
the Edit button. The dialog will show the current report’s setting and all the available report

settings.
= Project Initiati e 5 3%  3.94mons 7.61 mons Initiation §j e 8/18
Define scope/cos| Sl P5% 1.75 mons 5.25 mons _JElﬁ%
PPI Reports: 0% 0 mons 0 mons 4713
Prepare and Appr| | Resource Usage ,2 B0% 2 mans 2 mons Prepate and Approve RPM 50%
N Resource Usage (material) H 3 irati
Secure Funding/4 Recource Usage (nork) ’ 0% 0 mons 0 mons Il 5| Secure Funding/Authorization 8/18
= preliminary Design | | Should Have Started Tasks — 0% o [|Design| Py (3
YDESEN || g ke Task Report g =5
0% o )‘lB/lB
itony petails | Sort | -
Develop PD Sub Tasks In Progress = 0% 0 0%
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OEP Review NA NA 0%  og Ot MlTess M Ll [ tee | OFP ReviewcL] o%
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Figure 254 - Customizing a report template

Other than the Definitions tab you may utilize details and sort tabs for further customization.
Visual Reports

Unlike the standard/customized reports which are text based, visual reports present the report
graphically. Visual reports are pre-formatted excel pivot-tables and pivot-charts as well as Visio
pivot-diagrams.

To access go to Projects tab > Visual Reports
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Figure 255 - Visual Reports
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Section 12 Electronic Engineering Data
(EED)

12.1 Introduction

12.1.1  Purpose

The intent of this section is to provide standards and guidelines to promote consistent, uniform,
and useable deliverables for CTDOT construction projects. It is not the intent of this section to
add unnecessary additional responsibilities to the designer, but rather to have the projects
delivered in a consistent manner following best practices and industry standards used in the
today's CAD environment.

12.1.2 Definition of EED

Electronic Engineering Data (EED) refers to the Computer Aided Design (CAD) files and the
Digital Civil Engineering data files (from applications like OpenRoads and InRoads) that were
used to create the pdf contact plans. These files include:
e Geospatially correct 2D project location polygon
e 2D and 3D geospatially located CAD files
o MicroStation (DGN) Design Models
e InRoads Data
o Coordinate geometry - Horizontal and Vertical alignments (ALG) files
o Roadway Surfaces - InRoads digital terrain models (DTM) files
e OpenRoads Infrastructure Consensus Models (ICM) & i-Models
o Coordinate geometry
o Digital Terrain Models
o Storm Drainage, Structure and Pipe Data — Subsurface Utility Engineering (SUE)

In the future, EED may contain additional information such as asset data (signs, signals,
guiderail, etc.).

In conjunction with an emerging project delivery method or technology initiative, the
Department may provide bidders and contractors with:

e CAD files of the Base Technical Concepts in conjunction with alternative
contracting methods (e.g., Design-Build, Construction Manager/General Contractor
and Construction Manager at Risk).

12.1.3 Implementation Phases

The requirements for EED will be implemented in three phases. A phased structure was
developed to facilitate the transition of the Department into the 2D/3D modeling arena. This
guide has been divided to detail the files submittal types for all phases. The following sections
outline the data requirements based on the Project type for each phase of implementation.

12.1.3.1 Phase 1

Phase 1 will focus on the practice of submitting proposed MicroStation 2D CAD, InRoads
geometry files and a 2D project location polygon. These files are to be free of any extraneous
data and match the contract plans. All projects designed using InRoads SS2 will follow the data
requirement in Section 12.4.
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12.1.3.2 Phase 1A

+* Note: The original Phase 2 requirements have been replaced by Phase 1A goals.
Phase 1 requirements remain in place.

Phase 1A will add the goals of submitting curb to curb 3D roadway top surfaces using the
Department’s current modeling software, InRoads SS2. These 3D surfaces will not be required
submissions; the designers are encouraged to develop the models which can be utilized not only
during the construction phase but the design phase as well. These projects are designed in-
house on the internal network or by consultants on an external network. All projects designed
using InRoads SS2 should follow the data requirements in Section 12.5. If there are design
submissions in this phase they should have the 2D models to be complete from curb to curb for
the entire project, along with the Phase 1 requirements.

12.1.3.3 Phase 3

Phase 3 will change the data delivery files type using OpenRoads technology (OpenRoads
Designer and beyond). In the upcoming years all new roadway projects designed at CTDOT will
require the use of OpenRoads Technology. All projects designed using this technology will
follow the data requirement in Section 12.6. For these future projects 3D models will include
finished (or “top”) design surface and any subgrade excavation surfaces within the grading limits
for the entire project. Phase 3 will also include Phase 1 requirements.

12.1.4 Why and When Should a 2D/3D Model be
Developed?

Nationally the civil industry is quickly recognizing business improvements and lower costs by
changing field operations to incorporate the use of EED. One of these practices is the utilization
of 2D/3D modeling for the development of model based digital design data.
The concept of model centric design, and the generation of digital design data for use in
construction, involves the following key steps:

1. Collection and development of geospatially located survey data for an accurate

existing conditions model to be used for design, and also to be delivered for use
in bidding on the project.

2. Utilization of the survey model in design, with design software capable of 3D
model output.

3. Proposed output from design of critical digital deliverables for use in bidding,
construction and inspection purposes on the project.

4. Utilization of digital deliverables in constructing the project in an automated
fashion.

5. Field collection of as-constructed and inspection measurements and
observations using modern positioning technology, relative to the engineered
model data.

6. Archiving and preservation of digital model data for future use, including asset
management.
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FHWA has promoted the adoption of this technology through their Every Day Counts 2 and 3
initiatives. According to FHWA, “Three-dimensional (3D) modeling in transportation
construction is a mature technology that serves as the building block for the modern-day
digital jobsite. The technology allows for faster, more accurate and more efficient planning
and construction.”

For more information on please visit the U.S. Department of Transportation, Federal Highway
Administration, EDC2 Website titled 3D Engineered Models website at:

https://www.fhwa.dot.gov/construction/3d/about.cfm

Digital 3D models of a highway project can convey a greater level of design intent than a 2D
model; therefore, design projects should be developed in 3D when it is practical to do so.
Essentially, if the designer is using surfaces (existing and proposed) to develop contract plans,
then a 3D model shall be delivered. The following are guidelines to help determine projects in
which 3D models may be beneficial:

e Cross sections will be included in the final plan set.

e Reconstruction is proposed within the project limits. If the reconstruction is only a
component of the overall project (e.g., mill and overlay scope of work with a section of
reconstruction) only the reconstruction area should be designed in 3D unless an
accurate surface was obtained of the entire project.

e Major roadway rehabilitation (structural enhancements that both extend the service life
of an existing pavement and/or improve its load-carrying capability).

e Complex storm water and drainage in order to check for clearances under roadway
subbase and clash detection (i.e. utility conflicts).

e Intersections

e Subsurface utility information that is field located.
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12.2 Project Types and Phases

This section defines the types of projects that EED will be delivered, along with the contract
plans, at FDP. To determine what requirements are to be delivered in each phase, classify the
type of project from Table 3 — EED Project Types and then use Table 4 — Project Deliverables to

identify the deliverables.

Project Type 1 — No Earth Work

2D Projects

Project Type 2 — Site Earth
Work

Project Type 3 -
Roadway Earth Work

Bridge Deck/Superstructure
Replacement

3D Site Projects
Bicycle/Pedestrian Facility
(Multiuse Trails)

3D Roadway Projects

Grade Crossing - Major
Improvement

Bridge Bridge Replacement Intersection
Restoration/Rehabilitation W/Realignment Of Approaches Improvement - Minor
Bridge Drainage - Major Intersection Realighment
Substructure/Superstructure

Repairs

Concrete Barrier Rail

Facility Construction (Site
Work)

New Interchange

Drainage - Minor

Hazardous Waste Removal

Operational Lane

Facility Rehabilitation

Retaining Walls/Slope
Stabilization

Realignment

Fixed Objects Modification

Wetland
Replacement/Restoration

Widening - Major (4r
Projects)

Grade Crossing - Minor
Improvement

Guiderail Improvements

lllumination

Intelligent Trans Systems

Landscaping

Maintenance

Noise Barriers

Resurfacing By Contract

Roadside Safety Improvements

Traffic - Paint & Epoxy
Pavement Markings

Traffic - Signal Installation

Traffic - Signal System
Improvement

Traffic - Signing

Transit

Utility Projects

Widening (3r Projects) -
Minor
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Project Type 1 Project Type 2 Project Type 3
No Earth Work Site Earth Work Roadway Earth Work
Phase | Phase | Phase | Phase | Phase | Phase | Phase | Phase | Phase
1 1A 3 1 1A 3 1 1A 3
Proposed
MicroStation File R R R R R R R R R
[%2]
Q .
c | bestine Ground D D D D D D R R R
2 MicroStation File
(&)
Project Polygon R R R R R R R R R
" Geometry ALG File D D D D D R R
(]
E
2 Top Surface Curb to G G
z Curb DTM File
(a4
£ | Existing Surface DTM
. R R
File
Geometry Data D D R
Top Surface Dat
op Sur ac.e ata R R
2 Terrain
LE Subsurfacg Data R R
Re) Terrain
(g%}
=
s OpenRoads Terrain R R
S——
Existing Surface Data
. D R
Terrain
Storm Drainage Data
D
SUE R
Table 4 — EED Project Deliverables
R = Required
D = Discretionary (Required if used during design)
G = Phase 1A Goals (Submission is at the discretion of the designer)
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12.3 Contract Plans and EED Conflicts

In all cases the EED will be issued as “For Information Only” purposes and the contract plans
shall govern. An EED Notice to Contractor will be issued with each contract informing the
potential users of this information as such.

12.4 Phase 1 Requirements
Note: Also see Section 12.8 EED Phase 1 Quick Start

Phase 1 will require the delivery of MicroStation 2D CAD models, InRoads alighnments and
existing ground surfaces. CTDOT uses Bentley software products for all their computer aided
design needs, with MicroStation (.dgn format) being the foundation to all computer modeling.
Therefore it is critical that MicroStation EED files be submitted to the CTDOT and conforms to
the criteria outlined in this section.

InRoads | PHASE 1 DEL'VERABLES
Existing DTM
| InRoads ALG ﬁl

Megeion B, Perform = s
] QA >é
; : Check List

’ : Fill out Submit Files

Submittal to
Create EED Manifest ProjectWise

Figure 256 - Phase 1 EED Deliverables
12.4.1 Existing Survey

12.4.1.1 3D Ground Model(s) (.dgn)

e All elements shall be placed using CTDOT’s customized MicroStation Task Manager or
be generated by InRoads Survey Tools. This will ensure that all CAD graphics have the
correct attributes (color, weight, line style, level).

e Must be compatible with CTDOT’s current SELECTSeries DDE.

e Elements must be placed in real world modified state plane coordinates (see Section
3.0 of CTDOT’s Location Survey Manual, June 1997) and be geospatially correct

e Only one design model per dgn file; no drawing or sheet models are to be used

All elements representing existing topography features shall be drawn according to the current
CTDOT Survey standards; CTDOT’s Location Survey Manual, June 1997. These MicroStation
file(s) shall contain a single 3D design model including both 3D and 2D elements of the existing
survey. 2D elements included but are not limited to ROW lines and control lines. 3D element
includes tangible elements such as edges of pavement, shoulders, curbs, gutters, sidewalks and
retaining walls.
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12.4.1.2  Existing Survey Surface File (.dtm)

Existing Digital Terrain Models represent existing ground conditions at the time that surveying
data was collected. This original ground DTM represents the undisturbed ground surface prior
to construction. There may be several existing DTM’s depending on the length of the project
and the number of project site locations. The existing surface dtm will adhere to the
specifications outlined in CTDOT’s Location Survey Manual, June 1997.

See Section 12.5.4 for more information.

12.4.2 Proposed Master Design Models (.dgn)

CTDOT uses Bentley software products for all their computer aided design needs, with
MicroStation (.dgn format) being the foundation to all computer modeling. Therefore it is
critical that MicroStation EED files be submitted to the CTDOT and conforms to the following
criteria:

o All elements shall be placed using CTDOT’s customized MicroStation Task Manager or
be generated by InRoads using the CTDOT preference files (CT_civil.XIN). This will
ensure that all CAD graphics have the correct attributes (color, weight, line style, level)
and follow CTDOT's CAD standards.

e  Must be compatible with CTDOT’s current SELECTSeries DDE.

e Elements must be placed in real world modified state plane coordinates and be

geospatially correct

o Ifa 3D model is developed during design, it should be exported to a 2D model. Any 2D
files generated from a 3D file must be in direct correlation to the 3D parent file.

e Only one design model per dgn file; no drawing or sheet models are to be used

12.4.2.1 Proposed Master Highway Models

This 2D Design Model DGN will include geometric line work such as centerlines, and proposed
right of way lines. This file will also include right of way dimensions, roadway dimensions and
centerline annotation. All features that are to be quantified shall be included in this file (i.e.
guide rail, fences, etc.).

‘ Level of Detail ‘
Patterned Riprap Channels

Patterned Riprap Slopes

Patterned Pavement Removal

Patterned Milling

Erosion control Matting for Channels

Erosion control Matting for Slopes

Processed Aggregate

Pavement for Railing

Sodding

Turf Establishment

Planting Details (may be in a separate model)

Project Polygon

Figure 257 LOD Prosed Master Highway Model for Areas
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Level of Detail

Sedimentation Control Fences

Cut limit

Fill limit

Fence

Front face of landscape wall

Single PCBC

Double PCPC

Temporary PCBC

Cut Pavement

Parking lot

Driveway

ROW - graphical representation of an InRoads alighment.

Centerline and Baseline — graphical representation of an InRoads alighment.
Guide Rail -The end anchor should be placed in the correct location. The
smart line is to be offset from EOR so it can be graphically seen (Connecticut
Standard Details for placement will supersede plan placement).

Figure 258 - LOD Proposed Master Highway Model for 2D Smartlines

12.4.2.2 Proposed Master Structure/Bridge
Models

The lead structural designer shall submit to the CTDOT a single 2D design model, per site and
project, in a single 2D DGN file for every project that contains a new footing (including new box
culverts). Each 2D design model shall include all components associated to the particular site
and project.

The single 2D DGN file and its corresponding model shall conform to the following formats and
include the following components:

e All components must be referenced into a single model

e Elements shall be placed using CTDOT’s customized MicroStation Task Manager.
e Components modeled in MicroStation shall be Feature Model Elements.

o All elements shall be geospatially correct.

e All elements shall be placed at 1:1 scale.

The master structural model shall include but not be limited to the following components:

Level of Detail

Structure excavation earth and rock
Pervious structure back fill
Granular fill

Figure 259 - LOD Structure Elements Earth

12.4.2.3 Proposed Master Environmental
Compliance Models

The master environmental compliance model shall include a single DGN file with one 2D design
model per file, per location, per project. All features that are to be quantified shall be included
in this model.
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12.4.2.4 Proposed Master Traffic Models

The master traffic model shall include one 2D design model per site. This model shall include all
items that are to be quantified.

12.4.2.5 Proposed Master Miscellaneous Models

These models could be (but not limited to staging plans and or other disciplines not listed above
that have items to quantify.

12.4.3 Project Polygon (Geo-Spatial Boundary)

** Note: This is the only EED file that is required before FDP.

A Project Polygon (geo-spatial boundary) shall be submitted at the completion of Design
Approval. This will replace a cursory project polygon created at design development by the
project sponsor. Any changes to that boundary during final design or construction warrant a
resubmission of the Project Polygon after Design Approval, at DCD or Construction Completion.

See section 13 for more information.

12.4.4 Coordinate Geometry Files (.ALG)

If used, an InRoads (.alg) file shall be submitted per discipline. Submit only final alignments. Do
not include preliminary or alternates information). The .ALG files shall:
e All centerline and baseline horizontals with a maximum of one vertical geometry
alignment per horizontal alignment (including structures).
e All geometry contained in these file shall have names representative of the designed
alignments and features found in the plans (Centerline = Route_84 Eastbound).
e All coordinate geometry information must be provided in the native InRoads (*.alg)
format.
e Engineering discretion shall be used in determining which geometry elements shall be
displayed in the master highway model.
e Alignments shall follow the specifications outlined in CTDOT’s Location Survey Manual,
June 1997.

Horizontal alignments for all roadway centerlines/baselines

Type 2 Projects only - Vertical alignments for all roadway centerlines/baselines
Horizontal alignments for all proposed ROW

Special alignments used for drainage purposes, skewed driveways or stage construction
Alignments used for design features such as edge of roads, sidewalks & retaining walls
Structure centerlines of bearings

Structure centerlines of girders

Figure 260 - LOD ALG Files
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12.5 Phase 1A Goals

PHASE 1A DELIVERABLES
| InRoads ALG “I

Microstation § ‘-___._ Perform 1 1} . s
:I-Ir.i - . D'A == —— I
EE Check List
1 . Fill out Submit Files
Submittal to
Create EED Manifest ProjectWise

Figure 261 - Phase 1A EED Deliverables

12.5.1 Existing Survey Ground File(s) (.dgn)
See Section 12.4.1

12.5.2 Proposed Master Design Files (.dgn)
See Section 12.4.2

12.5.3 Coordinate Geometry Files (.ALG)
See Section 12.4.3

12.5.4 Digital Terrain Models (DTM)

A Digital Terrain Model (DTM) is a three-dimensional topographic model which mathematically
and graphically represents the existing and proposed surfaces. It consists of a triangulated
surface with features. A feature is a named set of points in a Digital Terrain Model (DTM). There
are five feature types which define the structure of the feature and controls how it affects the
triangulated model. Each of these feature types has a feature style or styles, which controls how
they are displayed.

e Random - “spot” points which have no direct relationship with other points

e Breakline - groups of points with a direct linear relationship

e Exterior - Surface boundary extent; closed and only one per surface

e Interior - defines undefined areas; closed and no limit to number

e Contour - groups of points with a direct linear relationship and same elevation

Any DTM used to generate final contract plans must be submitted. For Phase 1 Type 2 projects
this will include all surfaces curb to curb for the entire project. These projects would also be the
type which in most situations will require the inclusion of Item 9.80 Construction Staking. Files
must meet the following criteria to be submitted with the EDD for CTDOT projects:
e InRoads uses DTM data to produce contours, display the existing and proposed ground
lines in profile and cross section grids, and in the calculation of cut and fill quantities.

Supplied surface files must be in the native InRoads .dtm format.

e Project model deliverables shall include at a minimum, two proposed DTMs and an
existing DTM. One proposed surface shall be a finished grade DTM, and the other shall
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be a top of subgrade DTM. It is important to note that the subgrade data is available
with the top surface DTM but when the top surface gets exported using LAND XML for
use with AMG technology the subgrade data gets automatically dropped. For this
reason a separate subgrade surface needs to be delivered.

3D design has no overlaps of breaklines or visual inconsistencies of features.

Surface features are continuous over their entire length, not broken into multiple pieces.

2D contract plans match the surface models.

No vertical faces are present (all vertical surfaces are to be offset a minimum of 1/12 in—1/8 in
to be accepted into the AMG software).

Accuracy clash detection, spot check x, y and z coordinates.

In critical areas (i.e. intersections), contours should be displayed at construction equipment
tolerance intervals (typically 1” or less) to insure smooth surfaces for automated machine
control/guidance purposes.

Figure 262 - LOD DTM Files

12.5.4.1  Existing
Existing Digital Terrain Models represent existing ground conditions at the time that surveying
data was collected. This original ground DTM represents the undisturbed ground surface prior to
construction. There may be several existing DTM’s depending on the length of the project and
the number of project site locations.

12.5.4.2 Design

Proposed Digital Terrain Models represent the project design as generated by InRoads using the
horizontal alignments, vertical alignments, templates, roadway definitions and surfaced editing
tools.

A top surface for each corridor will need to be created representing at minimum the proposed
finished grade curb to curb as part of the design data deliverables. All proposed DTM surfaces
shall be defined by a breakline density interval (frequency of cutting templates) of no more than
five feet, and at every event location. In tightly constrained or critical drainage areas, or on the
outside of sharp horizontal curves, the break line interval may need to be reduced to two feet or
less.

12.5.4.3 Substratum

All files created to represent the approximate Substratum surfaces will also need to be supplied.
Substratum surfaces are used to represent assumed existing subsurface layers, such as rock,
sand, clay etc.

12.5.4.4 Subgrade (Structure)

If underground structures are involved multiple subgrade surfaces will need to be generated to
include all bottoms of footings, granular fill, box culverts, piers, walls, abutments, sign supports
and bottom of excavation.
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12.5.4.5 Proposed Master Storm Drainage Models
The Storm Drainage Model DGN file will be either 3D using InRoads Storm and Sanitary or 2D
using StormCAD. The master Storm Drainage Models shall include but not be limited to the
following:

Level of Detail \

Pipes — Double line representing the inside Diameter at invert elevations
Culvert ends — 2D cell placed at invert elevations

Endwalls, Riprap Splash Pads and Scour Holes — 2D shape at invert elevation
Catch Basins — 2D cell placed at top of grate elevation

Paved Apron- 2D shape at grate elevation

Manhole - 2D cell placed at top of frame elevation

Figure 263 - LOD Storm Drainage Using Storm and Sanitary

Level of Detail |

Pipes — Double line representing the inside Diameter at elevation 0
Culvert ends — 2D cell placed at elevation 0

Endwalls, Riprap Splash Pads and Scour Holes — 2D shape at elevation 0
Catch Basins & Structures — 2D cell placed at elevation 0

Paved Apron- 2D shape at elevation 0

Manhole - 2D cell placed at top of elevation 0

Figure 264 - LOD Storm Drainage Using StormCAD
12.6 Phase 3 Requirements

12.6.1 Overview of Phase 3

Phase 3 will consist of delivering a full 3D model of the entire project, slope limit to slope limit.

This will be accomplished using Bentley’s OpenRoads Designer (ORD). This software allows the
designer to create a 3D model much more easily than the current production software, InRoads
Select Series 2.

The deliverables for Phase 3 will just be the MicroStation dgn file itself. All of the engineering
data is written to the dgn including the coordinate geometry, surfaces, and CAD line work. The
dgn is simply saved as an i-Model which can be consumed by the GPS field equipment directly
with no conversions necessary.

Bentley is currently developing the production version. After the release of ORD and testing,
CTDOT will be adopting ORD as the production software sometime later this year.

12.6.1.1  Existing Survey Ground File

Details coming soon

12.6.1.2 Proposed Master Design Files

Details coming soon

12.6.1.3 Coordinate Geometry Files

Details coming soon
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12.6.1.4 Integrated Civil Models

Details coming soon
12.7 Submission Procedures

12.7.1  Submission Dates

All required EED documents shall be delivered:
e AtFDP
e At award of Contract (includes all addenda)

e After design initiated change orders, that the lead design deems necessary to supply to
the contractor.

12.7.2 EED Delivery Manifest

The EED delivery manifest must be delivered to the CTDOT with every EED submittal. A blank
copy can be found by clicking on the following link: EED File Manifest. This form will include
general project information; the datum used for the ground survey; file names and specific
information about each EED file being submitted. The contact information for the lead designer
and lead surveyor must also be provided. For a sample manifest see EED File Manifest Example.

12.7.3 Projectwise File Location

Each discipline will upload their EED files in a zip folder into the 01.0 - Projects - Active\XXXX-
XXXX\240_Contract_Development\ folder where XXXX-XXXX is the project number. For
uploading documents to ProjectWise see Section 6.

12.7.4 EED Notice to Contractor (NTC)

The Notice to Contractor (EED Notice to Contractor) must be filled out by the lead designer with
the correct project number in the last line of the notice. This NTC informs the Office of
Construction and the contractors that the EED will be available, along with the contract plans, at
advertisement. The NTC also states that all EED files are for information only. This will be
submitted along with the specifications at FDP.

For uploading documents to ProjectWise see Section 6.

12.7.5 Converted Data

AEC will convert MicroStation CAD files (dgn) into a dxf format, InRoads alignment files (alg) into
xml, and InRoads surface files (dtm) into xml. These conversions are necessary to be utilized in
the GPS field equipment and automated machine guidance/control equipment. It will be AECs
responsibility to zip all files, both native and converted, and upload to the 100_Contract_Plans
(PDF) folder in ProjectWise. Contracts will be notified so that the EED zip file can be posted
along with the contract plans, specifications, and estimates on the State’s contracting portal at
advertisement.

The converted data is being provided by CTDOT to insure that inspectors and contractors are
utilizing the same set of data.
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12.7.1 Addendum and Design Initiated Change
Orders

Changes to the EED that require edits to the CAD models, surfaces or alignments shall be
submitted along with submission of the revised contract plans.

For uploading documents to ProjectWise see Section 6.

A new zip file will be created containing the renamed updated files and uploaded to
ProjectWise. AEC will then be notified that the amended files are complete.

12.8 EED Phase 1 Quick Start

Note: EED is due with the FDP plans at FDP. The only exception is the project polygon. This is
required to be submitted at Design Approval, DCD, and when any Change Order that affects
project polygon. See section 13 for more information on project polygon locations.

Ensure that the MicroStation Design Models meet the requirements of Section 12.4.2 for your

discipline. 3D CAD models will be exported to 2D CAD models.

a. All graphical elements are at the correct geospatial location and are on the correct level.

b. Models are free of all cross sections, profiles, construction lines for design purposes.

c. Models are free of annotation that should reside in the cut sheets.

d. Models have clean reference attachments, only needed reference files & no redundant
references.

e. Models are a 2D design model, not a sheet or drawing model

f.  Files contain only one model

Ensure that the InRoads Coordinate Geometry file(s) meets the requirements of Section 12.4.3.

a. Only final alignments included (do not include preliminary or alternates information).

b. Alignments names and descriptions are intuitive.

c. Each horizontal alignment has only one child vertical alighnment.

At FDP:

a. Check that the EED Checklist criteria is met.

b. Fill out EED File Manifest for all files (native data only). Also see EED File Manifest Example.

c. Upload the MicroStation dgn and InRoads alg (if applicable) in a zip folder into the
ProjectWise folder 01.0\Projects - Active\XXXX-XXXX\240_Contract_Development\ where
XXXX-XXXX is the project number. For uploading documents to ProjectWise see Section 6.

Send a link to AEC Applications at ronald.tellier@ct.gov that the files are ready.
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12.9 EED Checklist

Check List

MicroStation Design Models

All graphical elements are at the correct geospatial location.

All graphical elements are placed on the correct CT DOT Level.

Files are free of all cross sections, profiles, construction lines for design purposes.

Files are free of annotation that should reside in the cut sheets.

Files have clean reference attachments, only needed reference files & no redundant
references.

All 3D files have lines and elements at the proper elevation (no spikes).

Files are a 2D or 3D design model, not a sheet or drawing model

Files contain only one model

dinate Geometry

Only final alignments are included (preliminary and alternate information has been
removed).

Alignments names and descriptions are intuitive.

a|g| O |g|O|g|g] o |\gjg|g|o
o

Each horizontal alignment has only one child vertical alignment.

Surface Models

(]

Visualized breakline features and they appear to be consistent and match the 2D
MicroStation file.

Visualized breakline features, no vertical faces are present; breaklines appear to be
horizontally offset.

Visualized both the contours and triangles in a 3D file. Looked at it from the top and front,
side, and isometric view. No irregular dips, spikes or voids in the surface are apparent.

Triangles were viewed on top of the proposed design file. The triangles do not cross
obvious breaklines such as centerlines, edges of pavement, edges of shoulders, etc.

(0 I I I O A

Contours were viewed to ensure the low points line up with the proposed drainage
structures and structure flowlines match the proposed surface.

O

If automated machine control/ guidance will be used during construction, at intersections
or other critical areas, contours should be viewed at a 0.1 foot interval to ensure the
model is accurate enough for automated machine control/ guidance use.
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12.10 Electronic Data Definitions

3D Model — Models includes all engineering data which is geospatially positioned and graphically
displayed on project related datums and are used to describe the existing conditions or
proposed design of a capital project. This can include multiple DTM surfaces and related
Graphics Information. The “Model” is what is generally what is referred to as the deliverable for
projects which anticipate using AMG.

Automated Construction and Inspection — Automated Construction & Inspection include all
technologies used for the construction and inspection of capital projects, and require the input
of reliable EED to operate effectively. Examples of this may include Automated Machine
Guidance, Automated Stakeout & Inspection, and Intelligent Compaction operations.

Automated Machine Guidance (AMG) — AMG uses computers and survey technology on
construction equipment to automate the calculation and interpolation between a proposed
digital terrain surface (or a control alignment with templates) and survey geospatial positioning.
This interpolation provides visual horizontal and vertical guidance to the operator of the
construction equipment. AMG is also referred to as Machine Control or Automated Machine
Operations.

Automated Stakeout & Inspection — Use of computers and survey technology to automate the
calculation and interpolation between a proposed digital terrain surface (or a control alignment
with templates) and survey geospatial positioning. This interpolation provides horizontal and
vertical guidance to the operator of the equipment, for the stakeout of proposed work or
positional verification or measurement of completed work.

CAD Model (design) — Master Design CAD dgn file. The model usually consists of one dgn file (for
large projects there may be more than one) that contains all of the proposed design work. There
are separate models for each discipline that is doing design for the project (Highways, Traffic,
Bridge, etc.) This model is referenced into the individual cut sheets and clipped to the correct
size.

CAD Model (existing) - Master existing CAD dgn file. The model usually consists of one dgn file
(for large projects there may be more than one) that contains all of the existing survey. This
model will also contain other information such as the datum used and control tie box
information.

CAD files — refers to any CAD files that are not defined as a CAD model (see above). Examples of
these files would be the title sheet, miscellaneous details, detailed estimate sheet, plan sheets,
etc. Plan sheets would have CAD models referenced into them but would not contain any
design work in the file itself.

Digital Terrain Model (DTM) — A DTM is a digital map representation of a three dimensional
topographic surface. (Also referred to as Digital Elevation Model DEM, or a Triangulated
Irregular Network TIN). DTMs are visualized electronically by draping a surface over
triangulated points which are generally determined along breaklines where changes occur in the
slope of the surface. The points are defined geospatially by coordinates and elevation values. In
the civil engineering industry, DTMs can represent existing natural terrain of the earth’s surface,
or proposed terrain intended to represent a completed surface. DTMs can portray triangulated
and/or non-triangulated features, shapes and solids.

Documents & Publications — Includes reports, manuals, contract proposals, specifications or
other publications which record or document decisions, standards, policies, procedures or other
legal requirements related to capital projects.

Electronic Engineering Data (EED) — Includes all types of design project related engineering data
which is used for the defining, developing, designing, documenting, spatially locating,
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constructing, and historical recording on a CTDOT Project. This includes Documents and
Publications, Geospatial Data, Digital Terrain Models, and Graphics Information.

Elements — Elements are points or lines which are described geospatially in two or three
dimensions.

Features — Features consist of points and lines which may be connected to form geospatial
objects, and can be used to form the ground surface displayed in a DTM. Features can be either
3D triangulated (including elevations) or 2D non-triangulated (without elevation). Features
store attribute information about the symbology, level, and text.

Finished Grade DTM — FG DTM shall include the entire proposed project surface area which will
be disturbed by construction operations out to all limits of work. The FG DTM shall be a true
representation of the entire finished surface that the Designer intends to be built. The outer
limits of a project’s DTM shall include all disturbed/modified terrain surfaces that require
excavation or fill of greater than 6” from the existing ground surface over a 1,000 sqft area.

Geospatial Data — This information identifies the geographic position and characteristics of
natural or proposed constructed elements, features and boundaries and how they are
positioned related to the earth’s surface.

Graphics Information — Graphical representations of project information portrayed either by
raster or vector images. Files include graphical representations of points, lines or shapes, text
annotation, and images. CAD files are generally in MicroStation DGN formats, and include all
associated reference files. Graphics are generally published in PDF format.

GPS — Global positioning system, the Global Positioning System (GPS) is a space-based satellite
navigation system that provides location and time information in all weather, anywhere on or
near the Earth, where there is an unobstructed line of sight to four or more GPS satellites. It is
maintained by the United States government and is freely accessible to anyone with a GPS
receiver.

GPS Rover — GPS device that collects the data in the field. Typically consists of a receiver
(antenna), a fixed rod and a data collector. The receiver can also be mounted to a vehicle.

LOD — Level of detail.

RTK — Real Time Kinematics, Real Time Kinematic (RTK) satellite navigation is a technique used in
land survey and in hydrographic survey based on the use of carrier phase measurements of the
GPS, GLONASS and/or Galileo signals where a single reference station provides the real-time
corrections, providing up to centimeter-level accuracy.

RTN — Real Time Network is similar to RTK yet it uses a network of base stations located on
maintenance garages, the internet, satellites and host server software. Though fairly new to the
U.S., these types of networks have been very successful in Europe and Asia where networks
span entire countries where utilization is spreading beyond surveying to mapping, utilities,
emergency response, agriculture, forestry, public safety, transportation, machine control for
construction, environmental, and scientific research.

RTS — Robotic Total Station. This equipment utilizes the same software as the GPS rovers but
does not rely on satellites for locations. RTS equipment localizes to a project area by calibrating
using control points set by traditional survey techniques.
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12.11 Benefits

Construction operations which may produce the greatest productivity gains by the use of EED

are for material excavation or placement. Construction items which optimize the efficiency and
accuracy of AMG are earth excavation, fill and subbase courses. These items are all volume
measured and their quantities can directly be calculated from the terrain models for the existing
surface, the finished grade surface, and the top of subgrade surface.
Other construction installations which would benefit most from providing EED for stakeout and
inspection verification are bridge substructures, public and private utilities, curbing, sidewalks,
commercial driveways, signs, lighting & signal posts, and pile driving. Bridge superstructure and
substructure layout could be modernized to provide contractors with 2D or 3D spatial
descriptions (features) of all structural elements and critical control lines. This information
could be used by AMG for the excavation of the footings, backfills up to finished grades, by pile
drivers to position proposed pile locations, by carpenters to automate the layout and building of
concrete forms, by steel workers to automate the positioning of steel supports and for installing
of reinforcement, and by DOT Inspectors to verify the correct spatial locations.
Projects which do not contain 3D DTMs can also benefit from using supplied EED. Sign or
guiderail replacements, or pavement striping contracts could benefit from locations derived by
GIS approximated or GPS field measured 2D coordinates for positional locations. Using
geospatially described locations (coordinates) or station-offsets provided by alignment files
instead of record plan scaled stations and offsets will provide more clearly defined designer
intent as to the location of the items.
General:

e Greater ease of design implementation at time of construction.

e Enhanced quality of constructed facilities.

e Greatly reduces the need for construction staking which in turn reduces survey costs

e Contractor and agency labor savings when measuring and documenting as-built
guantities and pay-quantity management.

e Increased accuracy and data intelligence going into design.

e Enhanced visualization capabilities during the design process.

e Identify clashes and constructability issues prior to construction.
e Greater accuracy for quantity computations

Construction:
e Points or alignments of features can be used by Contractors to locate items in the field

by using Total Stations or GPS/RTK survey equipment (available in CT).

e Breaklines, features and other alignments included with digital terrain models (DTMs)
are used by Contractors for Automated Machine Guidance (AMG) operations. Use of
GPS for AMG allows for the most efficient operation of earthwork machinery, less
operator time is required for construction, idle time and rework.

e Uniform compaction

e Check constructability

e Track stage construction

e Improved Safety for the inspectors and contractor personnel

e Equipment resource savings
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Machine idle time can be reduced when there is less waiting for excavation and
embankment staking and clarifications.

Finish grading iterations are lessened or nullified because of GPS accuracy,
therefore resulting in a reduction of machine hours.

e Earthwork construction tasks are shortened because:

Contractors can mobilize to the site and begin work without waiting for
surveyors to position grade stakes for the initial lifts.

Checking grades and rechecking spot locations immediately versus calling and
scheduling a survey crew.

Time saved in layout and grade checking can be devoted to machine movement
and cycle time efficiency.

Reduction in rework - Jobsite grade and location errors are more easily spotted
and corrected with GPS technology than with reliance upon 2 dimensional
drawings and surveyor’s grade stakes.

Construction field managers can make decisions more quickly and accurately
because position and grade information is provided in real time.

Construction Inspection:
e Accurate quantity take off for pay-items (point locations, areas, volumes)

e Pay-items are easily tracked

e Asingle person can locate and document exact x,y,z positions providing real-time

verification of an item being inspected or a point location being disputed.

e Reduction of conflict resolution time.

e Electronic as-built data can be produced and easily incorporated on the electronic

contract plans either during construction (“live” as-builts) or post construction.
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Section 13 Project Location (Geo-Spatial
Boundary or Route ID and Mileage)

A Project Polygon (geo-spatial boundary) shall be submitted to ProjectWise at project
milestones of DA (Design Approval) and DCD (Design Completion Date) by the lead designer and
at Construction Completion by the Inspector. The Design Approval submission will replace a
cursory project polygon created at project development by the project sponsor. The DCD
submission will replace the Design Approval submission at DCD. The construction Completion
submission is required if the DCD polygon does not reflect the project’s completed limits. The
inspector shall obtain the DCD polygon and modify the limits to represent as-built conditions if
required at construction completion.

The Project Polygons will be used in the Department’s Project Web-GIS feature layer to identify
spatial location, each section of State and Local Roads contained within the boundary for FHWA
FMIS reporting, and future CIM (Civil Integrated Management) of roadway assets. The Project
Polygon will also aid in the ROW (Right of Way) Web-GIS mapping process. The Design Approval
Polygon shall not be public facing on any CTDOT Web-GIS mapping.

13.1 Project Polygon Requirements
Capital Projects that include Location Survey

Note: If a project has multiple sites, a project polygon file shall be created for each site.
Project Polygon Milestone Deliveries:
e DA (Design Approval):
o The Project Polygon shall include the entire project extents per site and include

all existing and proposed ROW boundaries and portions of local affected roads.
The polygon shall be drawn up to and following the ROW lines, then it shall
cross the roads at the project limits. The following figure shows a Design
Approval Polygon Note The Polygon does not include slope limits.

e

DA Polygon drawn'to
EX|st|ng ROW. Line or "

2
proposed ROW Lines §\\
At

1
1

BITUMINOUS
13'- CUT B
17'- CUT B
BITUMINOUS
372'- CUT

APPROXIMA
5 CONCRET.
SIDEWALK

el Ae__ﬂ.ﬁ,_;-!g\ e

—&_

+iTz

Figure 265 - Design Approval Project Polygon
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e DCD (Design Completion Date):

o The Project Polygon shall include the entire project extents per site and include
all ROW boundaries and portions of local affected roads. The polygon shall be
drawn up to and following the right of way lines. When Rights and/or Defined
Easements extend beyond the ROW, these lines shall be followed. The polygon
shall cross the roads at the project limits.

| [ Swrewnen nmne [ | [ [
/ I ///" /

| Project Limits s / Include Temporary

on Local Roads / Work Areas

52400 53

Slope limits inside of ‘ Slope limits outside of
the ROW, draw to the the ROW, draw to the
ROW line slope limits

Figure 266 - DCD Project Polygon

e Construction Completion:
o The inspector shall obtain the DCD polygon and modify the limits to represent
as-built conditions if required at construction completion. See Section 8.3.7 for
more detail.

Capital Projects without Location Survey

This type of project could involve, but not limited to the following:
e Guard rail replacement

e Rumble Strips

e Barrier replacement

e Pavement rehabilitation
e [llumination

e Signing

The project limits will be identified By Route ID and Mileage. AEC Applications will get the route
and mileage from the project’s Design Report. Note: An option to get authoritative mileages for
the Design Report can be to reference in a WMS (web mapping service) into Micorstatoin. See
section 13.4 for instructions.
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The fo

13.2 Creating a Project Polygon for Projects with
Location Survey
llowing steps explain how to create and submit the Project Polygon file(s). If the project

consists of multiple “sites,” a separate file shall be created for each polygon.

1.

Note the datum and units (e.g. NAD 83 Survey Feet) of the Highway Design file to be
referenced. This can usually be found within the ground survey file title block. If there
is no survey for the project use the 2D Poly 83 FT seed file shown in the next step.

In House CTDOT Users: Create a new MicroStation design file using the 2D_Poly_83FT
seed file located in the W: Drive. See folder address below:

W:/CTDOT_V8_Workspaces\Workspace\Standards\seed\Geospatial\

Note: If your project is NAD 27 FT still use the 83FT seed.

;ar\)

@ Select Seed File - \\sh3dgs184CTDOT_V8_Workspace

/ erE

d:

0

Look in: Geospatial

Date modified Size
7/17/2014 1259 PM
7/17/2014 1:10 PM

8/26/2014 12:51 PM

7/17/2014 1:03 PM

Type
Bentley MicroStati...
Bentley MicroStati...
Bentley MicroStati...
Bentley MicroStati...

Name
42D Poly_27FT dgn

Recent Places | 2505 poy 270 dan
= 42D Poly_83FT dgn
J730_Poly_83M.dgn

Desktop

L
= 31 KB
kB
87 KB

KB

=
Libraries

.

Computer

@

MNetwork

File name: CT_Design_30_V&i.dan

Files of type: MicroStation DGN Files (" dan)

Figure 267 — CTDOT CAD resource folders

Consultant Users: Download the seed files using this link: 2D Poly 83FT Seed File

3. Reference the Highway Design file into the newly created file using true scale off and
1.1 )
0 References (1 of 1 unique, 1 displayed) E\' [=] '@
Tools  Settings
e > - oo | mir y -
E -l o] g | glle] R0 a3 2 s } [Boundaries ~ |
Slet ¥ 4 File Name Model Description Logical Orientation Presentatior
1 HW_HWY _012... Design Desian Design Coincident Wireframe
Il [m 3
Scale | 1.000000 - | 1.0D0000 Rotation §00°00°00" (Offset X | 0.000 Y |0Q
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Figure 268 — MicroStation reference file settings
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4. Verify that the tentative coordinates of this file match the referenced design (using
stationing, grids, etc.). If your project is in NAD 83FT the coordinates should match and
you can proceed to step 5. If they do not match check that the scale of the reference is
1:1.

If the coordinates still do not match, the project is probably in NAD 27 FT and the
reference files will have to be moved so the coordinates are correct. To move the
reference file do the following:

a. Select Reference File.

b. Select Move Reference:

1| References (1 of 1 unique, 1 displayed) E\ (=] @

Tools  Settings

.E - ¢ﬁ| 134 Y‘ \)|( | [ |ﬁ _’Q| J|jj l\j‘ x'j|H|Ine Mode: [Boundaries

St ¥ [ File Name Model 1\'-1----"'Descnpmn Logical Qrientation Presentatior
1 HW_HWY_012... Design Design Design Coincident Wireframe

1 m b

Scale | 1.000000 © | 1.000000 Rotation | 00°0D0°00" Offset X | 0.000 Y 0C

’_rr?-'t' 11 IIJJFJFJ’_JJ Mested Attachmerts: Mo Mesting ™ Nesting Display Ovemides: | Alloy
MNew Level Display: Corrhg Variable ¥ | Georsferenced: |No

Figure 269 - Move Reference

c. Next when it prompts you to “Enter point to move from”, in the Key-In Box
key in XY=0,0 and click Enter.

e |

Highway

't Key-in — Ref s (1 of 1 unique, 1 display:
F— Key_ln XY_0,0 and @ [Ey erencTe (1 of 1 unique, 1 display
[or =004 Izl Tools Settings
= hit enter = | i ad e | g«
Property '5 = St ¥ [y File Name Mad
Structurd. [+ i ‘ 1 HW_HWY 012 Desi
Location| |accldaw
accfznap & Al -
Traffic
“J Drawing
& Drawing
& Terrain 1
Scale | 1.000000 2| 1.00
BRIy @i < [ e
New Level Display: |Config Viariable ~
-I—'ITasks ” % Projgct Explorer I
3 - © ~| ' ~[& naD83FT views ~] 1|2]3]|slsl7]el i X[ 215722 Y|[1582427
@e Reference > Enter point to move from j Reference attached

Figure 270 - Key In
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| ALIIUSS v

d. Then when it prompts you to “Move Reference>Enter Point to move to”, in the
Key-In Box key in DL=400124.9,500038.9.

“! Highway Operations v
igh
=~ I‘fav Lbean £ | References (1 of 1 unique, 1 dit
Landscap TE_:E . ﬁi‘ _ﬁ(\ _"] y‘ ]
Property IS * : I I = |4 File Name
structurd [% i Key-l n HW_HWY_D12...
Location)  |oeoudow | DL=400124.9,500038.9
Traffic -
: a0 Then Hit Enter
4 Drawing '
4 Drawing
A5 Terrain <
Scale | 1.000000 :
7= bal g |
Mew Level Display: Config Variable
—I_"a Tasks " % Project Expforer J A
1@ v = ~[EY NADB3FT Views ~| y 1|2]2]2]s]e]7]el i X 2157268 ¥Y|[ 1582233
@ve Reference > Enter point to move to ) Reference attached

Figure 271 - Move to Key In

Now the tentative coordinates of this file should match the referenced design (using stationing,

grids, etc.).

5. Set the MicroStation active level to “TOOL_Prelim_Proj_Polygon” for the Project
Polygon (Note: if this level is not yet available, use “SV_PARCEL_DATA")

6. Then place a closed polygon(s) using the shape tool or the smart line tool.

7. Then turn on the fill on the polygon.

8. After the polygon has been placed, turn off all reference displays and fit the polygon to
the view.

9. Verify that the polygon is spatially correct by exporting the MicroStation file as a kml
file to Google Earth.
Do this by choosing: File> Export> Google Earth.

10. Google Earth should then automatically open and zoom to the Project Polygon(s)

vicinity.
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13.3 Project Polygon File(s) Submission

The Project Polygon file(s) shall then be uploaded into ProjectWise in accordance with the
following:
Note: If a project has multiple sites, a project polygon file shall be created for each site.
1.
2.

E

U

GRULRY v o

Log into ProjectWise

Browse to your project’s 170_ROW and GIS Files folder. If this folder does not exist

under the project email DOT.AECApplications@ct.gov

Select the Interface, “CTDOT_Doc_Code.” If the interface box is not shown, select:
View>Toolbars and select interface
Drag and drop the file into Projectwise and use the Advanced Wizard.

Continue to click Next in the Advance Wizard until you get to the Attributes screen and
assign the attributes shown in the Projectwise Attribute Table

Click Next until the file uploads.
After the files have been uploaded into Projectwise email DOT.AECApplications@ct.gov

+ [ 00320148
o ¥ 3z-0140
[ 00330127
[ o033-0128
o % 033020
0 230130
I 0330131

% 0320132

b

]

100_Contract_Plans (POF)
110_Contract_Documents

130 Contracter_Submittals (PDF)
130_Finald_Engineering_Reports
13_Engineerng_Reports_Confidentasl
140_Project_Administration
141_Project_Administration_Confidential
142_Project Adminmtration Comespondence
150 Quantity Calculstions

151_Finad Design Caleulations

170_RMW andd GIS Files

lehchshchchchihchs Lehi AehchchchcRshahi

E
oF 1
5 (2% 0034-0308

U _Censtructen

M) FHWA

13 Contract_Administration
240_Contract_Development
M1_Contract_Derelapment_Confidential
310_Milestane_Subrassiond
320_Perenat_Developrent

330 Desagn_Data

500 _Siarvey

500 _Piaject Initatson Documents
Sarved Searches

&

£ L=t [ Spotal)

il -J-.n.IJIL].uu Dk J;

# | DA Boundary
o+ TRDA Boundary
# & | FOP Boundsry
AIBIFor Boundery

Description

Figure 272 — ProjectWise project polygon folder example
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13.4 Project Route ID and Mileage for Projects without
Location Survey

The following steps show how to get the route ID and Mileage for a project from within.
1. In House CTDOT Users: Create a new MicroStation design file using the 2D_Poly_83FT
seed file located in the W: Drive. See folder address below:

W:/CTDOT_V8_Workspaces\Workspace\Standards\seed\Geospatial\

@ Select Seed File - \1sh3dgs18\CTDOT_V8_Workspace p dy ial ) =
Lookiin Geospatial Q2 m- B[E
- Name Date modified Type Size
=P 20 Poly_27FT dgn 7/17/2014 1259 P Bentley MicroStati... 31 KB
Recent Places | 550 poly 27Mdan 7/17/20141:10PM  Bentley MicroStati... 3LKB
m 20 _Poly B3FT.dgn B/26/2014 1251 PM  Bentley MicroStati... #7 KB
T30 _Poly_Eam dgn JA7/2014103PM  Bentley MicroStati... 31KB
Decktop
Libraries
LY
Computer
=
@
Network

File name: CT_Design_30_V8idgn - "

Files of type: MicroStation DGN Fies (*.dan) v] Cancel

Figure 273 — CTDOT CAD resource folders

Consultant Users: Download the seed files using this link: 2D_Poly 83FT Seed File

2. Next go the raster manager and navigate to File>Attach>WMS

| Raster Manager : 0 of 0 listed

File | Edit View Display Seftings Utilities

New 2] 8 20 28] a0 B
Attach *|'& Raster...
= Description B Model ‘
Detach &) WMS...
Detach All 3 FromImage Server...
Reload % ECWP Image Server..
Saye As... & _Bing Maps.
Import 4

Batch Convert

o 3 1|2|3‘4‘5‘6|7|8 JJJﬂ Tint: [7] | Transparency !

Figure 274 - Attaching the WMS
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3. The attach file dialogue should appear. In-House Designers Browse to W:\XWMS and
select the Interstate Milepoints and the Non-Interstate Milepoints layer. Note this will
have to be done one at a time. Then click Attach in the Raster Attachment Options
Dialogue. Consultant Designers the WMS files can be found here: XWMS Files

Lookin: XWMS >~ 67 raE- =
: Name Date modified T Preview Attachment
o~ Bing Aerialxwms 12/28/2016 2:47 PM X R (R
Recent Places Bing Road.xwms 12/28/2016 2:47 PM X
! Interstate Milepointsxwms 12/28/2016 3:47 PM X
Interstates & State Routesxwms 12/28/2016 3:47 PM X
Desktop Non-Interstate Milepointsxwms 12/28/2016 347 PM X
LiI;ra;es
A
Computer
£ 16384 X 11850, RGB Alpha
m Origin X: 729443.706
¥: 558544.268
MNetwork
d 3
File name: Interstate Milepaints xwms -

Files oftype Web Map Server [ *xwms ] vl [ Cancel J

.
I Raster Attachment Option i=h

S ] Attachments|

Lo WAXWMS\Bing Roadxwms

Figure 275 - Attaching WMS
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Figure 276 - Attaching WMS
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4. You will need to zoom in to see the Route Numbers and Milepoints.

e
c.a@"“o\ >

Figure 277 - Route and Mileage
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Section 14 Project Information Management
— Under Development

This section details how project locations, project assets, project asset work codes, and other
project information is managed throughout the life cycle of the project. The project location
and the assignment of assets to a project are managed in ATLAS. The project asset work codes
and other project information is in managed in the Composite Project Database (CPD). The first
section goes over the Proposed Project Information process (PPl), which includes locating the
proposed project, filling out the PPl form, and how a proposed project containing in Projectwise
gets created. The second section goes over how to manage the project location and project
information after the proposed project receives is recommended project number.

14.1 Proposed Projects

14.1.1  PPI Project Location and Asset Selection
The following details how to locate a proposed project and select the applicable assets on the
project using ATLAS.
1. Gotothe ATLAS webpage - http://ec2-54-175-159-39.compute-
1.amazonaws.com/atlas/
2. Then at the top right of the screen click Login and enter your email and password. If
this is your first time logging in, select “Click here to sign up”.

=8 R |
Tol 2 fe3

Build 1.1.6730.10610 6/5/2018 [3628]
WIN-JDLKBR2HNJS (local) Atlas

Login

Not registered? Cli€k here to sign up.

Email | mathew.calkins@ct.gov |

b -
- . Password lnooooooo-oo 'I
] Remember Me ' Cancel
; u A
N

e ~' j './'\". < . R
s NN o AN

Figure 278 - Logging into ATLAS

3. Next navigate to the area on the map where the proposed project is located.
4. Then click on Asset Maintenance and select Add/Edit Construction Project Work Area.

sompute-1.amazonaws.com/atlas/ P~C ] & CT Atlas X

A Extract Layer Data

Report a bug

Figure 279 - Locating a Proposed Project
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5. Then in the Town dropdown, select Use Work Area and click next.

| @ hitp://ec2-54-175-159-39 compute-1.amazonaws.comyatlas/ p-cy
File Edit View Favorites Tools Help
& Prudential Retirement. CTDOT ROW Map Viewer Project De AlID... hi -dot-lib... --ctdot-a
P )¢ P

ngpAtIas

- Statewide
- District 1
- District 2
- District 3
174 - District 4

= Back to Setty

Prog

New PP: Specity td
new proposed proid

igned when the[ Beacon Falls
Berlin

istit « If add BEthany
roviouty ceined {Bethel

project n§Bethlehem
PP Numper | Bloomfield
Bolton

Brookfield

Brooklyn

active project, seled Burlington
Project Number [Canaan |

Figure 280 - Locating a Proposed Project
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6. Next pick how to locate the project in accordance with the following and click Next:

e By Administrative Area — District or Statewide Projects. Stop Sign
replacements, warning sign replacements, etc.

e Related to bridge(s) and/or signal(s) — Bridge joint or bearing projects affecting
multiple bridges or traffic signal head upgrades affecting multiple signal
locations, etc.

e [|'ll Draw a polygon — Intersection improvement projects, bridge replacement
projects, roadway improvement projects, etc. These projects could be at
multiple locations.

In the example below a polygon is going to be drawn for the proposed project.

U T

-

Cataleg  Define Project Work Area
= Back to Settings

Mext Proposed Project Number (PP) will be assigned
for town 093 when area is saved.

How do you want to specify the location?
)
‘! Hy Administrative area

. By Town(s)

'::' Helated to bridge(s) and/or signal(s)

Pick the
approprlate ® i draw a polygon
select and .
I upload a KML file

click Next

L O III specify a route and milepoints

Figure 281 - Locating a Proposed Project
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7. Then draw a polygon for the proposed project. When the polygon is completed double
click to close the polygon. This polygon should be drawn close to the State ROW line.
Use engineering judgement for where you think the ROW line is. Future
enhancements to ATLAS will have all the state ROW lines on a layer.

Figure 282 - Locating a Proposed Project

8. Then click Go.

lm = 0 QA =20 R«
Jump To:
[ =]

Catalog || Define Project Work Area @ |

Available Tools:

(") Navigate

@ Draw Polygon
(") Select a Drawing

Click and draw to define a new work area. Double-

click to complete the poly:
| X Close |

Figure 283 - Locating a Proposed Project
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9. When the polygon is drawn ATLAS will return any road segments and any assets that
are located within that polygon. On the next screen deselect or select the applicable
road segments and assets, then click next. By default the local roads are not selected.

 lumpTo: r A 1%

! =]

| Catalog  Define Project Work Area @ .
= Back to Settings

Select Roads to Include

I'US | Interstate Roadway Sections

oute Starting Ending
5N 74794 74956
5-S 74795 T4.964
76-N D.000 0076
N 27.204 27.366

Local Roadway Sections
Road Name Starting Ending

B3) GRISWOLDVILLE AY 0.000 0.060
83) LOUIS ST 0.476 0.510
Select Signals to Include
'93-229
Cancel Next > |

Figure 284 - Locating a Proposed Project

10. Then on the next screen click Go.
Jump To:

| =] :
Catalog = Define Project Work Area &

| == Back to Settings |

Review and Save

Mext Prop Project will be assigned for
town 082 when area is saved.

A work area pelygon will be defined for the polygon
you drew.

Selected Route and Road sections will be saved as
project road segments.

Route/Road Name Starting  Ending
15-M 74754 74.956
15-3 74785 T4.564
176-M 0.000 0.076
5-N 27.204 27.366
{93) GRISWOLDVILLE AV 0.000 0.0&0
{83) LOUIS 5T 0476 0.510

Selected signals will be saved as project assets.
093-229

The project "Signal Mumbers" attribute will be
updated with this list of signals.

Figure 285 - Locating a Proposed Project
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11. On the next screen you will see the proposed project number that ATLAS assigned to
the project and list of assets and road segments included in this project. Then click

Done.
Jump To:
| 2
Catalog = Define Project Work Area &
= Back to Settings
I Proposed project number PP0OS3-0011 assignedl
Work ares palygon saved for your drawn section.
Signal Control Area list zet for Project:
Proposed e
. Route/Road Name Starting Ending
P rOJ ect num be r (93) GRISWOLDVILLE &Y 0.000  D0.06D
(93)LOUIS 5T 0.476 0.510
15-M 74784 74858
15-5 74785 74884
1TE-M 0.000 0.076
S-M 27.204  27.385

Saved 4 route and 2 local road sections for project
PPOS93-0011.

Figure 286 - Locating a Proposed Project

14.1.2 Editing PPI Project Location and Assets
The following details how to edit the location or Assets of a Proposed Project.
1. Go tothe ATLAS webpage - http://ec2-54-175-159-39.compute-
1.amazonaws.com/atlas/
2. Then at the top right of the screen click Login and enter your email and password.

Build 1.1.6730.10610 6/5/2
WIN-JDLK3R2HNJS
Login

Not registered? here to sign up.
Email |maﬂ1ew.calldns@ctgov

.rdl

Figure 287 - Logging into ATLAS
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3. Then turn on the Proposed Project Local Work Area layer as shown below.
A Interstate
/A7 Route
Local Roads
Py
A Local Road
[ Route Milepoints
| Local Road Milepoints
|| Roadway Assets
Bridges
Traffic Signal Control Areas
| Rumble Strips
|- Project Information
- Proposed Projects

Local Work Areas (Polygons) @

(]

eee ee

In for Signature
B3 Submitted to Capital Programming
=2 Undefined
|| State/District Work Areas (Polygons) (@
|- Active Capital Projects
[ TLRS Road Sections
| I Local Work Areas (Polygons) ®
|| State/District Work Areas (Polygons) (i)
[ /VIP (Maintenance Resurfacing)
[ ROW
|- Investigations
|- Administrative Areas

Figure 288 - Proposed Project Layer

4. Next navigate to the area on the map where the proposed project is located.
5. Then select the Identify tool.

;:_Kl ) E http://ec2-54-175-159-39.compute-1.amazonaws.com/atlas/

CT Atlas

The Connecticut Asset Tracking & Location System

e I A S U )

1mp To:

=]

Catalog
7l Drawing and Markup
)odBEEOO
1/ Road Network
CT/US/ Interstate Routes
v
A/ Interstate

A7 Route
Local Roads

Py
A7 Local Road
[ Route Milepoints
Figure 289 - Proposed Project Location

6. Then draw a rectangle that includes part of the project.
d 1L S s

' L % \\1‘,.‘ A

Figure 290 - Proposed Project Location
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7. Onthe next screen choose the applicable option.
e To add or remove a road segment or asset select “Roads and Assets”
e [f the polygon needs to be extended or shortened select “Redraw Area”

Jump To:
b | i
Catalog  Identify

= Back to Settings

Detailed information for the area you clicked on the
map..

Project PP093-0011 (ID 8153) |
Work Area: 3812 |
Phase: Undefined
Title:

Lead
Engineer:

Project
Manager:

Bridges:

Signal
Intersections:

Sign

Structures:

Buildings:
Roads and Assets §Zoom-To ’-real Redraw Area I

KML Edit Area Delete Area CPD

State/U S/interstate Roadway Sections

Route Starting Ending /
15-N 74807 74829
5-N 27217 27.239

Figure 291 - Editing a Proposed Project Location

8. Based on what was selected in step 7, either select or deselect the assets or redraw the
polygon. Then click through the screens until the project location is updated.

14.1.3 Proposed Project Information Form

After a proposed project has been located a Proposed Project Information Form (PPI) will
automatically be created in CPD. The section shows how to fill out this form.
1. Gotothe CPD Website: http://dot-sdcdts303v/PW CompositeData/MainMenu.aspx
2. Then click on Proposed Project Information.

PUSILY L LUjvvL L/ ALA . LYLALLLL LY.

Version: Production

Your Windows Username: CalkinsMJ

‘ Data View Form

|
‘ Project Asset Form ‘
‘ Manage My Projects Lists ‘
\ |

Export to XML or CSV

Environmental Site Tracking

| ‘ Proposed Project Information

‘ Data Import Log

|
|
‘ Edit Users ‘
‘ TED Interface Adminisiration ‘
\ |

Developers' Form

Figure 292 - Proposed Project Information

Issued 10/2017 250 Version 4.03


http://www.ct.gov/dot/lib/dot/documents/aec/projectwise_attribute_tables.pdf

Connecticut Department of Transportation — Digital Project Development Manual

3. Select the PPl number that needs to be updated.

System Status: |

Instructions; Enter proposed project attribute Information in the areas Indicated beiow. ThiS Information will be used for prelminary SCOpe re!
Administrator for consideration priar to preparing the Recommended Project Memorandum (RPM) for formal approval. If you have questions i

Non-Promoted PPI's v/

Select Proposed Project 1D:

Refresh Filter:

Figure 293 - Updating a PPl Form

4. Next fill in any of the fields in the form and click the save project data button.

Proposed Project Information

Update PPI Location and Assets from ATLAS |

| Save Project Data

ATLAS Main Menu

ition will be used for preliminary scope review and priority determination as well as completing a funding eligibility determination. This completed form should be submitted

norandum (RPM) for formal approval. If you have questions about completing this form, please contact Jennifer Trio (x2901) or Bob Barrio (x2983)

n-Promoted PPI's v

:d Project Number: (none)

_ v
M

Figure 294 - Saving Project Data

When this button is clicked a Projectwise project container will be created under the 01.2 —

Projects — Proposed area in Projectwise. This will take about 5 minutes to show up in

Projectwise. This folder will be used to store any document during the proposed project phase
of the project. This folder is also where the completed PPI form will uploaded for signature.

ProjectWise Explorer Datasources
2 CTDOT (mathew.calkins@ct.gov)
EIL. Documents

- 010 - Projects - Active
- 011 - Projects - Legacy
s
- PPOOL-0011

- PPOOL-0012
[-L°% PPO02-0004
(- PPOOT-0002
[-{% PP010-0001
- PPO11-0004
(- PPO11-0005
[-L7% PPO11-0006
(- PPO11-0008
[-{% PP011-0009
- PPO11-0010
- PPO12-0001
[-L7% PP012-0003
(- PPO15-0017
[ PP020-0003
(- PPO27-0009
- PP0O28-0002
[-L7% PPO28-0004
- PPO34-0003
-0 PPO34-0004

IE

m

List | @ Spatial

Mame

/1% PP0O01-0012
[ pP001-0011
/1™ pP164-0005
7 1™ PP164-0004
% pp146-0011
/1% PP0a2-0030
/(1% PP158-0007
[ PP037-0003
/1% pp148-0006
/1™ PP164-0003
4 PPO11-0010
/% pp0a2-p031
/1™ PP0g3-0010
[ PP151-0012
/[ pp151-0011
1% pp0o15-0017
/1% PP1a5-0010
/™ ppP0o35-0003
/1% pp131-0010
/ [1™ PP094-0006

711 pPO76-0006
< |

Figure 295 - Proposed Project Area in Projectwise
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5. The following steps show how to complete the PPI form for capital planning. Note: If
an asset needs to be added or removed go to ATLAS by clicking on the ATLAS Link.

Update PPI Location and Assets from ATLAS

| Save Project Data | |ATLAS |Mam Menu

minary scope review and priority determination as well as completing a funding eligibility determination. This completed form should be submitted to the Engineering

have questions about completing this form, please contact Jennifer Trio (x2901) or Bob Barrio (x2983).

]

none)

Title™

l:l Email | ‘ Employee ID
l:l Email | ‘ Employee ID
l:l Email | ‘ Employee ID
1
Figure 296 - Updating Assets for a PPIF
6.  Firstfill out the General Information.
Select Proposed Project ID Refresh Filter: Update PPI Location and Asse
PPI Current Phase: \Development V\ Recommended Project Number: (none)
General Info:
DOT Improvement Type* I v]
FHWA Improvement Type™ ‘ V\
Transportation Mode™
Adds Capacity™
Project Dev Manager I v Phone: | | Email |
Project Dev Engineer* I v Phone: | | Email |
Project Manager I v Phone: | | Email |
Lead Engineer I v Phone: [ | Email |
\

Description™

Justification™

Figure 297 - PPl Form General Area

7. Thenfill out the Environmental Classification, Cost Estimate Information, Schedule

Information, and add any comments.

Environmental:

Environmental Classification® \ Unknown/Undetermined hd |

Cost Estimate:
PE(PD) - Preliminary

Phase: Design PE(FD) - Final Design Right-of-Way Cost Construction Cost Total
Estimate: | | [ | [ | \ \ 0.00
Schedule:
PE(PD) - Begin PE(FD) - Begin Final Begin Right-of-Way Anticipated # of
Phase: PreliminaryDesign Design Phase Anticipated FDP Construction Seasons
Date: | L | |
*Wednesdays Only

Comments: (Notes to Capital Programming)

Figure 298 - PPl Form
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8. Then verify the proposed road section information. If information needs to be edited,

click on Select and edit the information.
Proposed Road Sections:

MP MP Func

Route/Road State/Local Start End Miles ADT Interstate Class NHS Towns MPO CcOG Urban Area
Select gﬁ'SWOLDV'LLE Local 0 006 |006 [6700 |N 5 N |Newington |Capital Region |Capital Region :ferg‘"d’ CT Urbanized
Select |LOUIS ST Local 0476 (051 0.034 N 7 N |Newington |Capital Region |Capital Region :ferg‘"d’ CT Urbanized
Select [15-N State 74794 |74956 |0.162 |35100|N 3 Y |Newington  Capital Region |Capital Region :fef‘"d’ CT Urbanized
Select |15-S State 74795  |74.964 [0.169 |16800|N 3 Y  |Newington |Capital Region | Capital Region :fggord’ CT Urbanized

; " " n
Select 176-N X i " Hartford, CT Urbanized

Hartford, CT Urbanized

Newington Area

Select |5-N ‘State ‘27.204 ‘27.366 ‘0.162 ‘ ‘N ‘ ‘N Capital Region |Capital Region

Figure 299 - PPl Form Road Section Area

9. Thenfill out the Asset information. Select if there is a pavement treatment and enter
any bridge work codes if there is a bridge on the project by clicking on Select next to
the bridge.

Assets
Pavement Treatment:

Bridge Assets:

Capital Project History

Completed Active

Bridge Length| Suff. |Struct. Func. Work | Work Wk. - ECC Wk. Wk
No. L i ) Rtg. Def. |Obsol. Type | Codes [ EELED Type Codes . Date | Type | Codes

Select|05308 |Yes |No |o1z27| 93.7|No  [No | \ \ \ \ \

Traffic Signal Assets:
No Signals were found.

Sign Structures:
No Signs were found.
Figure 300 - PPl Form Asset Area

10. After the form is completed print the form to PDF. Frist click on the printer and then
print.

4 =8 =R
a@\@ hitp://dot-sdc /PW_CompositeData/PPL/ProposedProj : o-T oA
File Edit View Favorites Tools Help €
Ny - S— = 5
5 (6] CTDOT ROW Map Viewer &7 Development Composite .. £ eB [ How to Build an Advance.. &' g Benefit Soluti ( IR v [ | v||Page v Safety v Toolsv @+
¢ N &= Print.. cu ] "
| ¢ T o previe
p |4 Pagesetup..
L4
System Status: (
y ate PPI Location and Assets from ATLAS ‘ | Save Project Data ATLAS Main Menu
Instructions: Enter proposed project attribute information in the areas indicated below. This mfn? *q eligibility determination. This completed form should be submitted to the Engineering Administrator for
consideration prior to preparing the Recommended Project Memorandum (RPM) for formal appr 2983).
Select Proposed Project ID: PP054-0002 V| Refresh Filter:
PPI Current Phase: \ Development V\ Recomme:
General Info: <

DQT Improvement Type: \ 104 - MAJOR INTERSECTION €

Figure 301 - Printing to PDF
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11. Then select the Bluebeam Printer and click Print.

E%A Print @
General | Options
Select Printer
% Add Printer &9DOT-MH
Adoks DOE OT-MH
| = Bluebeam PDF =5 DOT-MH
[0 printer status: Ready | ¢
Status: [ Prirt ta file
Location:
Commert:
Page Range
@ Al Number of copies: 1 z
Selection Curent Page
() Pages: 1 Collate
Enter either a single page number or a single lll 212 313
page range. For example, 5-12
[ P |l cancel |[ Aol |

Figure 302 - Printing to PDF

12. Then save the file to your computer.
13. Next open the file and add the four signature fields for the approvals.

Comments:
T
PPI developed by: r | Manager Approval: f- | @I
Division Chief: r | Engineering Administrator: [- |
User ID Of Creator: |WashburnM Creation Date: |10/25/2017 4:45:00 PM
User ID Of Modifier: |WashburnM Last Modification Date: [11/1/2017 9:52:45 AM

Figure 303 - PPl Form Approval Area

14. Then upload the PPI form into the corresponding proposed project folder in
Projectwise. Fill in the label and description attribute fields with PPI Form for the label
and a project description in the description field.

- I,Il _ : Address [*f pw:ictdot.projectwiseanline.com:CTDOT\Documents\01.2 - Projects - Proposed\PPO12-0001% - b Go _
% PPO01-0012 [ [E st [® soail] -
'L'“ PP002-0004 Label (User Defmed]' Description State
{* PPO07-0002
(%% PPO10-0001 /a PPIForm Rotory Conversion to Medern Roundabout

- %% PPO11-0004

%% PPO11-0005

- [J% PPO11-0006

{* pPO11-0008
(% PPO11-0000 [
- PPO11-0010

[ e
[-{** PP012-0003

%% PPO15-0017
-[J% PP020-0003
- PP027-0009
/% PPO28-0002
%% PP025-0004

{75 PP034-0003

- [J% PP034-0004
- PP035-0003
WITH pPN7-NnAN?

m

Figure 304 - PPl Form Upload

15. Next have the form digitally signed by the submitter, Principal Engineer, Manger, and
Engineering Administrator. Do this by sending a Projectwise link to the PPI form.

Issued 10/2017 254 Version 4.03



Connecticut Department of Transportation — Digital Project Development Manual

14.2 Project Asset Form (PAF)

The project asset form (PAF) is used to manage project information after the RPM process
through construction. This form manages the following information:

e Project Team — Lead Design Unit and Support Design Units

e Project Assets through the use of ATLAS

e Project Asset Work Codes
At RPM the Project Assets and Asset work codes will be transferred to the PAF from the
Proposed Project Information Form (PPIF).

The PAF is required to be continuously updated as changes happen through the duration of the
project.

The following details how to update the PAF.

1. Gotothe CPD Website: http://dot-sdcdts303v/PW CompositeData/MainMenu.aspx
2. Then click on the Project Asset Form Button:

t}UDlLU L ].UJUUL A FCLCl, LVACLLILL 1VIN.

Version: Production

Your Windows Username: CalkinsMT

‘ Data View Form

|
‘ Project Asset Form |
‘ Manage My Projects Lists |
| |

Export to XML or CSV

Environmental Site Tracking

Proposed Project Information

Data Import Log

TED Interface Administration

|
|
‘ Edit Users
|
|

Developers' Form

Figure 305 - Project Asset Form

3. Next pick the project that needs to be updated:

Update Project Location and Assets from A

V| | ‘Number 0fpr0jectst| EE |Go to Projec‘ri‘ \_ 0077-0215 ~ J

0077-0217
0077-0223
0077-0224
0077-0225
0077-0227
0077-0228
0077-0234
0077-0236
0077-0241
00780080
0078-0090
uuiro-uudgt
0078-0092
0073-0093
0078-0094
0078-0095
0079-0202
0079-0206
0079-0209
0079-0210
0079-0212

Figure 306 - Project Asset Form
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4. Then fill in or updated the Project Design Team Section:

Project No:

[o130-0180
Inherited Projects: | Edit.. |

Proposed Project No:

Contract Number: .
When combined with other project(s)
[pf70-3250

Program Number.

~Pestprinforsation. Project Design Team

Primary Designer |Consultant v

ProjectManager | Cardinali Andrew J v

ProjectManager'sSection  [Consuitant Bridge & Bridge Design
1

ProjectManager'sEmail  [Andrew Cardinali@ct gov
Lead Engineer Kania, Dobieslawa A i Lead Engineer'sSection |
Lead Engineer’s Email |
Support Designer v Support Designer’s Section ‘%
Support Designer’s Email 17‘
Support Designer Support Designer's Section ‘i
e VYU Support Designer’s Email

Figure 307 - Project Design Team Section

5. Then update the Project Asset Area in accordance with the following:
e Updating Asset Works Codes: Click on Select next to the appropriate asset and

then fill in the work codes.

Project Asset Management (Selecied Assels by Project Manager):

Instructions for managing Asseis,
Work types and Codes

Pavement Treatment: Yes v
Bridge Assets:
‘Bridge Length Struct.| Func. | Work | , = z
No. | (@ | SUERE | psol Type Work Codes
Select 01155 280 66.8 Yes No RHB DF.G.QUVNN
Select 01156 227 626 Yes No RHB DFGQUVNN
Traffic Signal Assets:

No Signals were found.
Sign Structures:

No Signs were found

Figure 308 - Asset Work Codes

e Adding or Removing an Asset from the Project: Send an email to
DOT.AECApplications@ct.gov detailing the asset and if it is added or removed.
6. After the PAF has been updated click on the Save Project Data button at the top right

of the form.
orm

_ Update Project Location and Assets from ATLAS

ser of projects:| [2647 iGo to Project:| l 0130-0180 ~ ]

_ Save Project Data _

Figure 309 - Project Asset Form
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Appendix A - Initial Bluebeam Settings

Initial Log into Bluebeam

These steps only need to be completed the first time using Bluebeam or when the user logs into
a new computer.

4

Bluebeam
Revu

1. Open Bluebeam by selecting the desktop icon:

2. Then Open Bluebeam by double clicking on the shortcut.

3. Click on the settings icon in the top right hand corner and click Preferences as shown
below. If you cannot find the settings icon in the top right, go to the Edit menu and
select Preferences.

fCovs  File Edit = Document Form Markup Measure Window Help 2 = F X

vheow T Smoq =R
1 [} -

New Open ve Print E-ms 2 Fl o Shifte
Y- N-F-Y B ] R

Snap t

| | | ¢ Snapt

A EAAE LR MNAE S Preferences E Snap to

o O M I8 Ie |
P

Document Pronerties Cirl+D

Preferences Crl+K ’

Figure 310 - Bluebeam Preferences
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4. Click on File Access and make sure the box is checked as shown below: If ProjectWise is not
listed click on Add

-

Preferences @

Camera » | Recents

Documen Enzble Recent Files tems in Rec -
| Check this
— Show preview of PDF Recent ]
Ge.nelal Document Management Systems o pt ion

Grid & Snap ) )

Hyperiinks | | 2Nareroin Upuons... ]
Import,/Expart 5 Always show selection dialog

Markup [V Enable batch checiin when closing Sets

Markups Tab

Mavigation | Tvoe Location Status

PDFAA -

Presentation c I iC k Ad d

Rendering

Rendering 30

Sets

Sets (Advan...

Signature

Sketch Tools hl ()
[ Import ] [ Export ] [ QK ] [ Cancel ]

Figure 311 - Projectwise Integration

5. Then click Load and enter in your Projectwise Username and password and select the
Checkout on Open box, then click OK.

-

Add Docurnent Management Systemn @
Type: | ProjectWise V10 4] [ Load |
DataSource™ ctdut.pmjeu:twisennline.cnm:CTIjD y -

¥

Login Mam: PWOMNLINE Mathew Calking

Passworll:

1 Checkout on Upen
[ Checkout on Open from Hyperinks

TELLZL | oKk || cancel |

Figure 312 - Integrating Projectwise
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6. Inthe General section in the User area type in your name (First Initial and Last Name),
title, and your office name. An example for me would be M. Calkins TE 2 AEC
Applications. An example for a district construction user would be J. Smith TE 3 D2

Construction.

Preferences

(1) Click

Document Eners (2) Type in

( General ) { User: |M. Calkins TE 2 AEC Applications ) U s e r N a m e
|| Enable Document Recovery

Import/Export

Maricup Allow Multiple Instances

Markups Tab

Navigation Enable Auto-Complete

PDF/A Enable Single Key Shortcuts with Form Fields

Presentation

Rendering Enable JavaScript

Rendering 3D

Signature Show Splash Screen

Snapshot Find Hyperlinks in PDF Cortert

Speling (3) Make sure
Startup Dark Light L~

Sude Brgness: / these are
e unchecked
CD Classic Mode [ Classic Menu )

—

Figure 313 - General Preferences

7. Update the markups options to match the following:

Preferences
Document Maricup
File Access
General 6 Reuse Markup Tools \
Grid & Snap Chynamically Set as Default properties

Embed Forts

c% Autosize Texd Box and Callout Marups # Make sure these

Navigation .
PDF/A Show Author and Date in Pop-Ups op“ons are selected
Presentation
gendering 3D [] Copy selected text into Text Marups
ignature - 2 . -
Sngapshot (Highlight, Underine, Squigaly, Strikethrough)
Spelling Retain Layer Info. when copying Manwp.
g:ig:f [] Use Relative Paths for Hyperinks and Actions
Tablet Set 'Open in New Window” option for Hyperinks and Actions

WebTab
Defautt Image Encoding:
\ Drag Behavior for Shapes: j

Figure 314 - Markup Preferences

8. Update the markups tab options to match the following:
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Preferences . |X|

Document Markups Tab
File Access
General Zoom Fit Manwups when selected -_)
Grid & Snap -

Import/Export [] Use Rich Texd for Comments

METIP Wrap Comment Text

Marl'_:up_s Tab Fittered Annotation Dim Percent: C h ec k

FDF/A [ Exclude Fittered Markups on Export
Presentation
Rendering
Rendering 30
Signature
Snapshaot
Speliing
Startup
Studio

Tablet
WebTab

=

Figure 315 - Markup Preferences

9. Click on the Signature tab and set the algorithm to SHA-1.
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i "

Preferences @

Grid & Snap & | Signature
dink
Hyperiinks Password Timeout: |5 =
Import/Export
JavaScript Digital IDs:  D-\Users'calkinsm]*AppData*RoamingBluebeam So [:]

Markcup — Trusted Identities:  D-\Userscalkinsmj AppData Roaming \Bluebeam So E]

Markups Tab .

Mavigation LRER m
POF/A
Presentation [] Restrict changes to documents which invalidate digital signatures
Rendering
Rendering 30 E
Sets

Sets (Advanced)
Signature

o= o -
Sniapshot

Spelling

Startup

Studio il

[ Import H Export ] [ QK ][Cancel]

Minutes

Figure 316 - Signature Settings

10. Click on the Web Tab section and make sure the box for Open PDF hyperlinks in Web
Tabs is unchecked. This will open any hyperlink that is in a PDF document using Internet
Explorer instead of Bluebeam. This is the last preference you will need to update so you
can click Ok at the bottom right now.

Preferences f'E

Document WebTab
File Access
General

hen they are created

ﬁ:goifsgx?:pon [] Open POF Hyperdinks in WebTabs

Markup Open web PDFs in split-view

Markups Tab

Naavi;;tisona [ Use standardized favorites: | \ |
PDF/A Show script emrors

Presentation = o U n C h ec k
Rendering [ Edit Web Favortes... ]

Rendering 30

Signature

Snapshot

Spelling

Click

Studio
= Jull

Click

[ Impaort ” BExport ] QK H):anc:el ]

Figure 317 - Webtab Preferences
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Downloading the CTDOT Bluebeam Profile

1. Download this file and save it to your desktop: CTDOT Bluebeam Profile

2. Double click on the profile in the zipped folder on your desktop.

(9 ER
&S QFEEXK L N

Mew Open Favorites Add Extract Delete Wiew CheckOut

Name | Modified [ Size | Ratio | Packed | Path
L..g CTOOT As-Buiks Profle. bps ) 1/B/20129184M  EE7BE3  EEX 250627

Double click on
this file

+ = Selected 1 file, 555 kB Total 1 file, 555 kB [245 kE] @D

Figure 318 - Importing the Bluebeam Tools

Bluebeam Stamps

The following steps are for CTDOT Engineering only.
1. Select Markup>Stamp>Change Stamp folder as shown below:

e File Edit View Document Form Markup Mleaguze Window Help

oW TS q ARy 3 3 B¢

Open Print E-ma o e rage Hyperiink e
termark.pdf S

df
Date.pdf
Documentl™ =
DateTime.pdf
DraftPrint.pdf
EuropeanDate.pdf

EuropeanDateTime.pdf

Proprietary.pdf

Released.pdf

'
TN
ez
ozt
.
ey
=
Prtninan]
_
EE

Revised.pdf

RightPointingTag.pdf

Select Change Stamp
Folder

Seal.pdf

rmark.pdf

Change Stamp Folder...

Figure 319 - Changing the Stamp Folder
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2. Next browse out to this folder on the X: Drive and select your discipline
X:\V8_Admin\Bluebeam Resources
(%% Select Folder =
@\-_/6 _ ) Browse out to this folder on imResources | O]
—— the X: Drive and select your

TR_BUS_C2_URS2_2007
TR_BUS_C2_URS3_2007
TR_BUS_C3_BAKER_2007
TR_BUS_C3_LOCH_2007
TR_BUS_C3_SEA_2007
TR_BUS_C3_URS_2007
TR_BUS_C4_LOCH_2007
TRAFFIC_NONPROJECTS
TRAFFIC_SIGNAL_PLANS
V8_Admin

999 _TE1-2_Test
. 2008_AASHTO
. AASHTO
. Accident_Data
. Airport
. Archive_for_V8_Admin
. Assignments
. AutoCad
. barmenu
. BE_Awards
. Bentley Conference
. Bentley_Map
. Bentley_Master_Agreement
. BentleyTraining
. Bidding Documents
. Bluebeam Resources
. Budget

Buirzan Chisf

Folder: Bridges

discipline and then click
Select Folder

6,/19/2015 8:58 AM  File folder

File folder

File folder

. Decument Templ File folder
. Facilities File folder
. Highway Operations File folder
. Highways File folder
. Hydraulics File folder
. Other Watermarks File folder
. presentation File folder
. Settings File folder
. Traffic File folder

11/24/2014 8:10 AN

. Watermarks-Initials File folder

Cancel

I Select Folder

3.

Qo File  Edit Document  Form

=-

View

Markup

Figure 320 - Changing the Stamp Folder

Now your unit’s stamps will be available for use when Markup>Stamps is selected:

Measure Window Help

¥ B

N
Hyperink

_—
| I
I R
atermark.pdf

endum_and_Change Order.pdf

ew - 8

Documentl* &

a
a
a

B &

BEEEGE

B &
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ew.pdf
Bryan Reed.pdf
Discipline Specific ———p Bryan R

Stamps are available R R
Location Plan.pdf

Rabih Barakat.pdf
Create Stamp...

Import Stamp...

Change Stamp Folder...

Figure 321 - Changing the Stamp Folder
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Appendix B - Usability of PDF Docume

Usability of PDF Documents

This section contains information about viewing digital contract documents.

Structure of Digital Plans
Final Design Plans, Addendums, and Design Initiated Change Orders

nts

The contract plans are split up into discipline subsets, which are multiple sheet PDF documents

digitally signed by the Designer. Addendums and Change Orders are also submitted

as discipline

subset, with only the changed sheets. For example, an Addendum that affects the 03-Bridge

Subset will require the submission of a 03-Bridge_A1 subset.

Digital Plans are located in the 100_Contract_Plans folder in Projectwise. Below is an example

of a project’s discipline subsets in Projectwise:

L) List | @ Geospatial
Label {User Defined) Description Main Category | Sub Category Sub Category Description
ra @ 01_General 01 _General_revision.pdf CON FFL Plans_04 - Final Plans {adv)
# B 0z_Revisions 02 _revisions_ce.pdf COM FPL Plans_04 - Final Plans {adv)
ra @ 02_Revisions_ADL 02 _Revisions_a01 COoN ADP Plans_05 - Addenda
ra @ 03_Highway CON FFL Plans_04 - Final Plans {Adv)
7 @ 03_Highway_A01 03_Highway _a01 rev Con ADP Plans_05 - Addenda
ra E 04_Traffic 04_Traffic,pdf CON FFL Plans_04 - Final Plans {adv)
' B 05-Landscape 05_Landscape revl.pdf COM FPL Plans_04 - Final Plans {adv)
ra @ 06-Structures Bridge 02695 Structure Plans CON FPL Plans_04 - Final Plans {adv)
/' B CTDOT_HIGHWAY_STD chdot_highway _std.pdf CON 51D Flans_10 - Standard Drawings
r @ CTDOT_TRAFFIC_STD ctdot_traffic_std.pdf COon STD Plans_10 - Standard Drawings

Figure 322 - Discipline Subsets in Projectwise

As-Built’s
As-built’s will be placed directly on the PDF Subsets using Bluebeam.

Functionality of PDF Digital Plans

Application

Acrobat FDF
Acrobat PDF
Acrobat PDF
Acrobat FDF
Acrohat PDF
Acrobat FDF
Acrobat PDF
Acrobat PDF
Acrobat FDF
Acrohat PDF

The PDF digital plans have the following functions when the digital contract plans are created in

accordance with this manual:

Turn levels on and off

Search for all text on the documents.
PDF plans are measurable
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Digital Plan Levels

The plans have the ability to have their levels turned off and on. This can allow for easier
viewing of the contract sheets. See below for turning levels on and off:

@ 2w Fl=  Edi Documert  Form Makup  Measure Help

= - .‘v“v\\\\-

Frint E-mail = Image Hyperlink
HORL$mE S

Booo CT_CON_FPL_D026-0118_06-5TRUCT... =

Turn levels on
and off by clicking
here

STATE OF CO
DEPARTMENT OF T
oF EnamEERING

Yre
Figure 323 - Turning Levels On and Off
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Searching Digital Plans

The plans can be searched for any text located on them. This can be useful if searching for a
certain pay item.

See below for searching the PDF Plans for text.

Aw EYREE Scarch Tab PoS.... - ENCREN

Type in what
you want to
search for or select

an object to search for

@ Text |Cuncrele

O Wisual Get Rectangle

Select Current -
wes o P@0€ OF Whole

I —— document

Search Pages

[] Search File Properties
Search Form Fields
[ Search Markups
[[] Case Sensitive

[] whale ‘waords Only

FOR 3680 MM 3 [583 W4 CONCRETE BOX CULVERT

QUTLET INVEFT ELEVATION = 8.76
FNR EOA MM Y A8 WM CORCRETE R FI0 UFRT

™ Search options 1

SUBBASE WATERIAL STATICALLY ROLLED DT VIERATORY)
I MEMBAAKE WATERPROOFING (WOVEN GLASS FAERIC)

E DESCRIPTION OF WORK

3 = 1. IMSTALL HANOLING WATER SYSTEM. N || . RUCTURES. pdf

el 2. INSTALL COFFERDAM, CONSTRUCT CUTOFF WALLS, RETURN WALLS AND WINGWALL'

g 3 4.CLOSE ROUTE 143 AHD DETOUR TREFFIC SFE 'NAINTEMSNCE AMD PRATECTION [p.1] MM CONCRETE BOX CULVERT 1.

ol OF TRAFFIC* SPECTAL PROVISION,

g o TEFIC SFECIAL POV, {p.1] MM COMCRETE BEO% CULVERTE...
5. IRSTALL PRECAST COMCRETE BON CULVE [p.1] MM COMCRETE BOX CULYERT O...
£ CONSTRUCT MOSINGS AND HEADWALLS.

Tt PR A0 MG b | Search Results {p.1] MM CONCRETE BOX CULVERTA..
£ CONSTRICT RORDHAY STAUCTIFE 440 (p.1) PRECAST COMCRETE BOX CUL..
(p.1) EOX COMCRETE CULVERT 3600..
VENERAL BOTES ¢ [p.1] BOX CONCRETE CULVERT 3600..
L S ooy | oty oow FORY BIE (20041, SUFFLENENTAL {p.1] COMCRETE DEFORMED STEEL ...
2 S e T I I T B (AT CONEIETS Hly il
BRIDGE DESIGH HAKLAL (2903% [p.1) PRECAST COMCRETE RO CULY.
P, 3 ALOMRE 06O STFESSES i £+ 35 v {p.1] COMCRETE CUREING, SEE HIGH...
FC - 21 MA (p.1) PRECAST COMCRETE BOX CULY.

Z 148 %ﬁwsﬁ'&mﬁm TN CRE0E 420 ?ﬁiﬁﬁ 165 b P-

B :

— VELLED WIRE FAGRIC  VETH dig) o FS (EMSLELL 5 (p.1] PRECAST COMCRETE BOX CULV...

! A LVE LD 1L {p.1] FOR COMCRETE FORMLINER P4, .

5, FOUMDATION PRESSURES :SEE WINGWALL DETAILS SHEET . [p.1) COMCRETE." [IMSTALLING PRE...
s.mm;sum pALL mﬁmlgu &[‘g ;:E'Eng ﬁrﬁw&e%ﬁm JTFDﬂTstsnTw [p.1) COMCRETE COVER : ALL REINF...
TREE (BN PLAEE. TE CMITTED DIGITS SLL o5 ACELNED TO BE ZERDS. {p1] 0F CONCRETE SHALL BE BEVEL
INIT | AMOUNT | 7.CuASS "W CONGRETES CLASS "W CINCRETE SHALL BE USED FOR CAST-B-PLACE CONCRETE {p.1] 01-COMCRETE FOR STRUCTURE. ..
b L - 1) CONCRETE: CLASS " CONCRE
™ i) B.SILICOKE JOBNT SEAL @ SEE SPECIAL PROVISION 'SECTION G.81-COWCRETE FOR STRUCTURES® [D. ] - o
W | = | 9 EXPOSED EDGES 1 EXPOSED EDGES OF COMCRETE SHALL BE BEVELED 25 MM X 25 MM UNLESS [D.1] COMCRETE SHALL BE USED FO...
DIMERSIORED OTHERWISE.

[p.1] CASTAN-PLACE CONCRETE TH..
(p.1] CONCRETE

Lol COMCEETE EOD DOCCACT COkd )

3 [

-

Figure 324 - Searching for Text in PDF Plans

Issued 10/2017 266 Version 4.03



Connecticut Department of Transportation — Digital Project Development Manual

Measuring on the Digital Plans

The plans have the ability to be measured in PDF. This is helpful because a paper set does not
need to be created for on desk measuring.

See below for measuring in PDF.

S X 1 % 30 S geaby-d X W P Measuring Tool E

B

2. Select specific
measuring tool

1. Set Scale
Recalculate
N T
'5 MM_HMA S8.5 subkect: |
42,600 by g g Example of a W15z MM Fvia ST HIGHWAY TTEM). Lt | ‘
measurement Denth: | \
55 2600 15880 33 00_ e | 550 Sede: 1 wm=100mm
TYP) HLOA T~ WESTBOUND EASTBOUND ~[SHLDR |~ SIDEWALK Curert Total
Y, Lenglts 2500 im 37458 o
(TYP) |8 ROUTE 148 hiea o
>< BLLLC. concr | G i :
- P . y . . . Angle: ] ]
gwij_/;\ £ 2.0% 2.8 6.0 2.0 ; g rae o 0
———————————— F-—-a___ olume: ] ]
— T ] - Counn i i
\ WW2B Cloar
WHzh L| 450 MM NATURAL STREAM BED MATERIAL
A}

+

SUBBASE MATERIAL STATICALLY ROLLED (NOT VIBRATORY)
SECTION A ON MEMBRANE WATERPROOFING (WOVEN GLASS FABRIC) - ]

SCALE 1168 v

- WALL —_—
1. INSTALL HANDL

=

1+153.321

Figure 325 - Measuring Tool
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Digital Specification
The FDP specification package will be one PDF document and located in the
110_Contract_Special provisions folder. This package includes all special provisions, Notice to
Contractors, Wage information, etc.

The Addendum special provisions prepared in the same way as the FDP specification package
and will also be located in the 110_Contract Special provisions folder.

The Design Initiated Change Order special provisions will be contained in one PDF document
located in the 110_Contract Special provisions folder when they are released to the Contractor.

Some useful features on the digital specification package are:
e Search for any text in the document, see Searching Digital Plans
e Bookmarks for each section in the specification package

f? Qo File E dit Documert Faim Markup & Y Help

TReE o= q R 3 BN

Open Frint E-mail Studio e Image Hyperlink

Em-SERUEE:

TABLE OF CONTI

] Note: This Table of Co
] contract with the sole

herein; and no claims st
of Contents shall not be

B-8 v BB summay -

Figure 326 - Bookmarks in the Spec. Package
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Document Compare Tools

Bluebeam has the two tools for comparing documents: (1) Compare Documents and (2) Overlay
Pages. Compare Documents will compare two documents and create a third document that
clouds all the changes. Overlay pages will create a third document where the pages of
document A will become one color and the pages of document be will become another color.
When the pages are overlaid you will be able to see the changes from the difference in these
two colors. Both of these tools can be used for single and multipage PDF documents. The
following shows how to perform a document compare and how to use the overlay page tool.

Document Compare

1. Open the Revised document first and then open the original document that you want to
compare from Projectwise or your computer.

2. Next go to Document>Comparison>Compare Documents as shown below:

Edit Wigw Document Form I arkup

.":".rqu

Frint E-mail Studio

U.l.I.l.|1.|.I.|.E|.I.|.B.|.I.|

+ Recents
@ _COM_FDP__01-General.pdf Completion
@ _CON_DCD__01-General.pdf it

RO e...
By submitting thes farm it sgnifies 1
conitract plans.

Figure 327 - Compare Documents

3. Inthe window that pops up you will notice the two documents that were just opened.
Click OK to run the document compare as shown below:
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Compare Documents rz|
Di LA
Document; |d:\pw_working'\pwonline\mic-admin\dmsBS “ | [I]
|41l Pages (1 - 36) v |of 36 Documents
File [1of1]: CT_COWM_FPL_01 ?D-SDBSIVEIID 04-... that were
Pagesz Range [1-36
opened
Dacunent B
Document; |d:\pw_wc-rking\pwnnline\mic-admin'\dmsBE vl D
(4l Pages (1 - 36) v |of 36
b anual Alignment:
Select Windaw ] [ Pick Paints ]
Summary Beport;
Other Options:
Split-zcreen view [spnchronize] [ Tum an Dimmer
Comparison tppe; | Frinted Documents [zame printer]” v | -._._,,.—n C I ic k 0. K
| dvanced. || AddFies | (| ok [) Cancel |

Figure 328 - document Compare
Overlay Pages

1. Open the Revised document first and then open the original document that you want to

compare from Projectwise or your computer.

2. Next go to Document>Comparison>0Overlay pages as shown below:

@ File Edit View Document Form Markup Measure W

= « ® v B

EewmESESE- BE «» =

New

‘ Overlay Pages...
.

Select Document>

Comparison> Overlay
Pages

Figure 329 - Overlay Pages

3. Inthe window that pops up you will need to select which pages of each document you
want to overlay. To do this double click on a file, then in the window that pops up type
the pages you want to overlay. The example below shows pages 1-28. Once you select
the pages you want to overlay click OK.
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SIATF FRULIFE

INU R, FE=NL)

Overlay Pages... ’Eﬂ

p— To set which pages

Document Color Pages

P e S — ——— - to overlay double

<) Ndendom Mo 4o i oz click on a file

. |

Figure 330 - Overlay Pages
Add Layer @
Layer
Source:  Addendum Mo. 3.pdf v D N
Pages 128 - of 20) 4+ Type in which

Layer: @ Create Mew: Addendum No.3

() Use Source Layers

Appearance [Base Layer]
Caolor: E]
Background:

Opacity:

Blend:

100 %
Momal {none)

Absolute

Inches

LI

pages to overlay
then click OK

igure 331 - Overlay Pages
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Appendix C - Using the Set File

Note: Steps 1-5 of Appendix A must be followed to create and use the Set File feature
in Bluebeam.

Opening the Set File
Double click on the set file from Projectwise and open as shown below: This may take a while
please be patient. Note: The first time opening a set file will take longer than any subsequent
times.

v e o -
=

Deseription Main Categary |~ Sub Category Sub Category Description Application File Updated

New Set com chS Plans_08 - Consolidated 5/23j2013 11102112 M 5j2¢

Structural Shests oM FRL Acrobat PDF 5[22/20135:24:27 M 520

Title Shest oM FRL Acrobat PDF 5[22/20135:10:41 PN 520

Traffic Standards oM FRL Acrobat PDF 5[22/2013 2:38:09FM 520

way Standards con FRL Plans_0¢ - Final lans (ad) Acrcbat POF S22/2013 23709 P 520

oM FRL Plans_0¢ - Final Plans (Adv) Acrobat POF S[21j2013 1:29:01 M 5[2(

oM FRL Plans_0¢ - Final Plans (Adv) Acrobat POF 5/20j2013 LOL14PM 5

Com FRL Plans_0¢ - Final Plans (adv) Acrobat PDF 5/20/2013 1:00:16 PM - 5j2(

# B 10-Enwironmental Environmental com FRL Plans_0+ - Final Plans (Adv) ‘Acrobat POF S{20{2013 12:58:47 PR S{2(

7 B 0o-Electrical Electrical Shests. com FRL Flans_04 - Final Plans (Adv) Acrobat POF S{20{2013 12:58:46 FM 520

| 7 Bl os-mechanical ey 5846 PM 5[z
Z B1-mraffic iz pen document_vith 58:40PM (20

P 15747 PM G20

i Select = S7:01PM 520

% Double clickon ——
Program .
the set file and

Hame Description . En
(& Bluebeam Revu Set beam Rev. CI ICk o K vare|Bluebeam RevulRevuiRevU.exe" " No

<

Document Propeties | Project Propertes

Vv ’\z;p:rw name
Folder Name:
Envirorment.

File Name

Warkiiow <

Created By

frd
File Updated By

Status [ open dacument as read-oniy

Wersion Click here for 3 list o sungested document: viewers

Fie Revsion

Local File Revision

Loca i et ) corce |
Shareable:

Figure 332 - Opening a Set File

Viewing the Plans Sheets within a Set File

All the plans sheets will be combined and shown on the left hand side of the screen in a
thumbnail view. To view a sheet, simply click on that sheet and it will open up.
® Rw Fie Edt Document | Form  Markup e Help

> - @ <« g7

RN EESE-BE T - -k I i

@ CT_CON_FPL_DO01-0001_01-General &

CONNECTICUT [

M 45 5 4CHUSETTS
4 DISTRICT 1 DISTRICT 2

e s

Click on a thumbnail
_and the sheet will
-open on the right

CT_CON_FPL_0001-0001_02-Revisions pdf

- e
Pf{ﬁllltl 3

STATE OF CONNECTICUT

GENERAL NOTES:

1. FIDARA, ATD FRONCT NG,
Eowa REG]

Figure 333 - Viewing a Plan Sheet from a Set File
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Marking Up a Set File

1. Open up the set file. You will notice on the left hand side of the screen will be

thumbnails of all the sheets in the set file.

Sm-q '

Pint  E-ms sbe - Ruers  Interface
I =

@ CT_CON_ADP_0102-0278_01-04_TYP_AD2

SALE THEATMENT MLESS OTMERWISE SHECIFIED In-
TP—4.TIP=7. (SEE WISCELLAEOUS. CETAIL SSEETS
FOR SWALE ETALLS |

sex AL B

All the sheets in the project
will be shown in the thumbnail
view -

SWALE TRCATMEMT UNLESS OTERNISE SPECIFIED T
TIP4,TTR-T, (SEE MISCELLAMEDVS DETALL SHEETE
FOR SWALE DETAILE)

@ Fom - wa sn.e macen o8 Tt GRuLAR FTLL

00 - HA 505 (50R WARIMA LIFY)
LTy

S50~ Wk 53 (FLACE TN TWO WAL LIFTSH S = W 0.5 (SOmm MixTiM
ABGRESATE BASE Shem - i 55
NATEs BEFT OF FROCESSED ACGHEGATE Subast Skl 6€ EXISTING F.C.B.C. (41Sem 3 1145} = Wk 50,575 [ Soem MAKTMM LIFT)
FMERCASED O 4oem AT THE FOLLOWING LOSATEGRS: SEE SHAULDER TREATMENT MiGW 510G OF Sac = WA 0.5 (50mm WAXTMI LIFT)
130 30 ASEE OETATL OM SHT TYP-12) 1 emen
24780 TO 24420 UIMIMM TROS3 SLOPE 4% OF 45 SHOW O CROSS SECTIONS sy
21305 T0 3w020 WAL SEi AALL (SEE FLins FOR LIWITS) !
‘_':‘;‘-W ™ 30690 A50mn FITUMINGUS COMCRETE LIP C1Mt M5 #odo6. FOINT O
3 COHCRETE CURBING R
24655 T 24110 i
295 T0 22100 13t ConcAETE Stogas - chms 3

34300 10 3e438

STATE OF CONNECTICUT
JEPARTMENT OF THANSPOITATION

Figure 334 - Sheets in the Set File
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2. To mark up a sheet scroll down to the sheet that needs to be marked up and click on it.
You will notice that sheet opens up on the right:

@ CT_CON_ADP_0102-0278_01-04_TYP_A02 >

Scroll down to the
sheet that is to be
marked up and click

on it. You will notice it — - o
opens up on the right. S %4 -

=i
-5
-
=i
-4
-
-3
-
-
~if

[P —— - \_@ E g/s. s>/
_ TIPS urTe (SEE VESELNEDA BT SHETS v Ttz B
P SR BETARLS ) o §
o pE Las synsone i
WL SEETION ST 5|
STh, 2+560 10 2e101 sta, 23 1
et

® rom - w508 imceo e
g
0m - W 54 (BLAEE Du T . LIFTE)
By —
T8 e ) . 1 omen
ks 10 2se20 o
petide] & i s 2 o s e
Si3m 1 doene o e
it e s M
Tt 10 1m0 fosagh < Y i
ety i - oo
perdiged o .
i
T T - . S — :
= — & STATE OF CONNECTICUT = .
— s [ DEPARTMENT OF TRANSPORTATION -
N — — . EPARTMENT OF T TATH "
Pt = (e L
] i | | e A
| = =

|V Fiter §

Figure 335 - Marking Up a Sheet
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3. Next to markup the document we must unlock it (Check Out of Projectwise). To do this,
right click on the lock and select Check Out.

» 2 - ot -
= 5,
% A L P P B M M 9 1
CT_CON_FPL_0102-0278_01-01_GEM pdf
i
r
@ DEPAR~
/-|LDCATIDN oF
T
ENDING OF STATE
PROJECT W0, K2-278
165 §TA 44300

Right click on the lock _
and select Check Qut ———

01.01.001

AOIE

Figure 336 - Checking Out a Document

4. Notice the lock changes to a Check and you will be able to markup the document.

New Open

Save . -ma Studio

B wEEom - SEeVER:

y ER & BE CT_CON_ADP_0102-0278_01-04_TYP_AD2 =

SEE DETAIL B
ST TrR-1z

[
STA. 24520 TO 2+660

Figure 337 - Checking Out a Document for Editing
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5. To mark up the plans use the tools located in the tool chest shown below:

BOLSE: DD Aw o |Bik|5|L LT RTS8 4

aL=4

Click on the . TREATMENT UNLESS 0

5 TYP-T. (SEE MISCELLANE
too' CheSt SWALE DETAILS)

L R ey Markup the plans using - [ComtcionSsted s Conctucion St

STA. 2+420 TO 2+653 the CTDOT As Built Tools \ | hs-Buit Stamps Tizerzmin
= |As-Buitt Stamps This sheet comected

As Built S s Secton
Example\’  sew  Teeosme

PROPOSED 1-91 SB WIDENING

EXISTING 1-95 NE Callout Use to Add a Callout

£ | :

EXISTING GROUND

Line Use to Cross Out

3 X aOn NNEBr>
i

366m __ 366m _, _ 366m __ 360m . 3.60m
LANE LANE LANE LANE SHLDR -~
1 t 1 1 JP— o o
-
_ -~ Group Cross Out
VARIES veries| vaRIES | 2.00% .00% 7 Cloud

®_/®/EE DETAIL A

ON SHT TYP-12

SWALE TREATMENT UNLESS OTHERWISE SPEC
TYP-6+TYP-7. (SEE MISCELLANEOUS DETAI

o]
i

Figure 338 - Marking up the Plan Sheets
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6. When finished, click Save and then right click on the Check and select “Check In”.

New Open Save . E-nnadl Sttudio
REwTEOE-SHevelin-
an y u

n
B

u
|
-

T

Then right click on

the check and select
Check In
& I-95
TING T-35 58 EXTSTING I-95 NB
@2 59
; . 366m ., 366m MED. 366m . 366m . 366
LANE LANE 520 500 LANE LANE LAN!
i LM

1 ! ] 1 1

RPN

Figure 339 - Saving Markups and Checking Into Projectwise
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Searching a Set File

The Set feature in Bluebeam allows you to search across the entire set file. The following shows
how to search a set file:
1. Click on the Search Set file icon and then type in what you want to search for as shown

below:

R R Fle  Edt et Form  Markup  Measure

Type in what you
want to search for

Select "Current Set"

Click on the
search set file
icon

Search Pages

[] Search File Propetties
Search Form Fislds
[ Search Markups

[] Case Sensitive

01.01.02 [ Whale ‘wWaords Only

Figure 340 - Searching the Set File
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Creating a Consolidated PDF of the Files in the Set File

Bluebeam allows you to create a consolidated pdf of all the files in a set file. The following
shows how to create a consolidated pdf:
1. Select the Publish Icon and select Combine:
{(-’ [ File Edit View Document Form Markup Measure Window

-
- §

Combine Eatc]

Combine...

Package

(g [

Figure 341 - Consolidating Files

2. Next keep the default settings and click OK on the dialog box shown below:

Combine PDF Files (23w

Insert Files

»

Filz Path Pages

E] CT_CON_FDP_0M70-315... PW.ctdotproject...  1-12of 126 |
CT_CON_FDP_0M70-315... PW.ctdot project...  1of 3
CT_CON_FDP_M70-315... PW.ctdotproject...  13-17of 126

w | | CT_CON_FDP_0N70-315... PW.ctdotproject.. 2of 3
CT_CON_FDP_0170-315... PW.ctdotproject..  18of 126
CT_CON_ADP_0170-315... PW.ctdotproject.. 1of2

l.m |

&

T ikl CNiD 07N 918 DA st At s b 10 77 ~F 1730
o Add Open 5= Keep default
ions
Include Bookmarks [7] Use Filename as Page Label Setti n gs a n d

[ Include Fils Attachments

Merge Documert Properties // CI ic k OK

Merge Layers

Figure 342 - Consolidating Files
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3. Bluebeam will then create a consolidated file of all the PDF in the set file.

Edit View Document Form Markup Measure Window Help

Tomae = EBFE 7

Print E-ma Create e Batch A Markups

4

Document1*®

~~ Consolidated PDF of all

the files in the Set File

BOL$E:/

Figure 343 - Consolidated File
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Printing the Entire Set File

Bluebeam allows you to print the entire Set file, only the latest revisions, or previous revisions.
Printing the entire set will print all the sheets in the set file. Printing the latest revisions will
print the most up to date sheets and not print the previous revisions. Printing the previous
revisions will only print the sheets that were changed by a revision.
The following shows how print a set file:

1. Select the print set file icon and select the desired option:

r() fvu  File Edit Wiew Crocument Farm Markup Measure Window

= - ® < 5

Frint E-mail Studia Security Signatures Fages|

S E-9E o - I &

Select the arrow on the
print icon and select the
desired option

_—
01.01.02

Figure 344 - Printing a Set File
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Appendix D - Consultant Submittal Review
Stamps

Consultant Designers can import the Bluebeam User Profile using the following link. This profile
imports all the commenting tools in the correct format.
Download the profile from this link: CTDOT Bluebeam User Profile. Just double click on the file
located in the zip file and the profile will be imported.
After the profile is imported the following must be done.

1. Delete the Submittal Review stamp that is in the tool chest as shown below:

I+ £ -
In the tool chest PSS

select the Submittal sk ot
stamp and click Sk ing Drsving Feview T

— Subject Comment

th e d e I ete ico n ‘ - S ubmittal Contractor Submittal
- Review Stampl
- Highlight
= Highlight
é Text Box |Jze to Add et
& Callout IJze to Add a Callout
IJze to Cloud
@ s Corections
/ Line IJze ta Cross Out

CTDOT &

4k
4 CTDOT Mi

Figure 345 - Deleting the Stamp

2. Next Consultant Designers will need to save the following stamps to their computer and
edit it to add their company name and address. The following will show how to do that:

3. This file contains the Designer’s Review stamp and Action Stamp. Save these stamp files
to your computer in a folder somewhere called Blubeam Stamps. Note: The stamp files
will be a PDF- Consultant Submittal Review Stamp
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4. Open the stamp files using Bluebeam.

5. Update the Company Name and Address on both the Action stamp and the Designer’s

Review stamp as shown below:

Edit the firm
name and
address on both

ACTION STAMP

Mo Exceptions Noted D
Exceptions as Noted |
Revise and Resubmit D
Rejected D

S

DESIGNER'S REVIEW IS FOR GENERAL CONFORMANCE WITH
THE DESIGN COMMENTS SHALL NOT BE CONSTRUED AS
RELIEVING THE CONTRACTOR FROM COMPLIAMCE WITH THE
PROJECT PLANS AND SPECIFICATIONS, NOR DEPARTURES
THEREFROM. THE CONTRACTOR REMAINS RESPONSIBLE FOR
DETAILS AND ACCURACY, FOR  CONFIRMING AND
CORRELATING ALL QUANTITIES AND DIMENSIONS, FOR
SELECTING FABRICATION PROCESSES, FOR TECHNIQUES OF
ASSEMBLY AND FOR PERFORMING THEIR WORK IN A SAFE
MANNER.

g Enter Firm Name and nddress)

By: &[User] Date:

DESIGNER'S REVIEW

Reviewed, No Comments I:I
Reviewed With Comments D

hi\sstamp Shall Only be Applied to

Enter Firm Name and Address

By: Date:

Figure 346 - Updating Stamp for Company Name and Address

After the company name and address is updated it should look like the following:

ACTION STAMP

Mo Exceptions Noted (|
Exceptions as Noted (|
Revise and Resubmit D
Rejected D

—_—

DESIGNER'S REVIEW IS FOR GENERAL CONFORMANCE WITH
THE DESIGN COMMENTS SHALL NOT BE CONSTRUED AS
RELIEVING THE CONTRACTOR FROM COMPLIANCE WITH THE
PROJECT PLANS AND SPECIFICATIONS, NOR DEPARTURES
THEREFROM. THE CONTRACTOR REMAINS RESPONSIBLE FOR
DETAILS AND ACCURACY, FOR  CONFIRMING AND
CORRELATING ALL QUANTITIES AND DIMENSIONS, FOR
SELECTING FABRICATION PROCESSES, FOR TECHNIQUES OF
ASSEMBLY AND FOR PERFORMING THEIR WORK IN A SAFE
MANNER.,

BL Companies 150 Trumbull St. Hartford CT 06103

By: &[User] Date:

DESIGNER'S REVIEW

Reviewed, No Comments D
Reviewed With Comments :l

This Stamp Shall Only be Applied to
Working Drawings

BL Companies 150 Trumbull St. Hartford CT 06103

&[User]
By: Date:
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6. After the stamps have been updated click save.

7. Next go to Markup>Stamp> and Select Change Stamp Folder.

cument Farm Markup Measure Window

E‘ﬁ'd _

Fint E-mail Studio . o
Consultant_subrmittal

1_11 - Environmel | =i

Click on Markup
ol then Stamp
then change stamp folder

159-0181_11 - E...

ittal_Review. pdf

| IT=ENVIEKURMENTAL
Figure 348 - Changing the Stamp Folder

8. Browse out to where the stamps had been saved and click OK:

Browse out to the
folder where the
[a Deskbop .
=Qmoemens  Stamp is located
G e @nd click OK
2 Recydle Bin
AdobeCA

Mew Folder

H
&

||||||||||

15 old watermarks
IC3) POF Farms
1) Revisions Forms

1) schoal
[#-IC3) STC FORMS

[ MMake Mew Folder ] ' Cancel

Figure 349 - Browsing to the Stamp

9. Now when you click on Markup>Stamp the stamps will be in the list.
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10. Next go into the tool chest and open the “Recent tools” as shown below:

Sattings

X, Bluebeam Studia Projects -

v S @ e
] . -

| & I
1) My Tools
Recent Tools
Sequences & Actions
Curves

Shapes

Svmbols

CTDOT Shopy dng Drawing Review Tools

CTDOT As Built Tools

Sequence Tools

4F LiUul
A4 CTDOT W

Figure 350 - Bluebeam Recent Tools

11. Now place the stamps on any PDF document by selecting it in Markup>Stamp as shown
below:

Markup Measure Wirdow Help

)

-

Image Hyperlink Altachment ==ty ;
|“I consultant_subritk

’ / H N
|“I consultant_submitkal_review, pdf

Document1* Markup Stamp
and then select
t h e S ta m p Change Stamp Folder...

Create Stamp...

Figure 351 - Placing a Stamp in Bluebeam
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12. After the stamps have been placed you will see them in the recent tools. Drag them
from the recent tools into the CTDOT Shop/Working Drawing Review Tools as shown
below:

In the tool
chest drag the
recently placed

stamp and drop T st
it into this tool o Comment
bar 1 |submital

Highlight

Highlight
Text Box Jse to Add text

Callout Use to Add a Callout

Use to Cloud

Cloud Comections

Line Jse to Cross Out

4» CTDOT AsB
L
4» CTDOT

Figure 352 - Adding the Custom Stamp to the Tool Chest

13. Then Save Profile so the stamps will always be in the Tool Chest.

Q (Gvs  File Edit Wiew Document Markup Measure Window Help

vhow@ om q = )

Mty Open Save Frint E-mzil Studio Tabs Tawlbars — .
Construction

i‘ i w s E ';' , 5 . " C TDOT Bluebeam User
Al L aEEl GO to View, Financial In
all_Rell ) then click on the

Recents

Supplementary Progr a rrow a n d t h e n F, I'||:|';
iviigins save profile S

Tealet

Fuil Screen

Save Profile

EEEEGEIE-GS

Figure 353 - Saving Bluebeam Profile
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